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RedTitan EscapeE

The EscapeE program for reprocessing print files is the heart of the RedTitan EE
Applications Programming Interface. It can read PCL ®, PostScript ® and Epson ®

print files, AFP ® and Zenographics © print streams, RTF document format, PDF
and other image formats such as BMP, GIF, TIFF , JPEG , PNG  and Xerox ® IMG

. Also PCC, DICOM ® medical, DCX/PCX fax, STAR ® Point-Of-Sale and of
course, RedTitan DDF, IDF, RS2 and UberEd files. Wizards are provided for creating
documents in IDF which users may edit and export in other formats.

It is the host program for the EscapeE Software Development Kit.

This section describes 

What this document transform system can do: see About EscapeE conversion
resources .

How to download and install EscapeE from the internet; 'demonstration' and 'try-
before you buy' editions: see Downloading EscapeE from the internet .

How to register for a fully-functioning trial edition: see Registering your software.

About Updating and upgrading EscapeE .

How to move your EscapeE to a new system: see Transferring EscapeE to another
PC or Virtual Server .

Uninstalling EscapeE .

The RedTitan software licence agreement.

About EscapeE conversion resources

The RedTitan ® EscapeE program interprets print files and reads image files such
as:

DCM

DCX/PCX

RTF

TXT

CSV

XML

PCC

BMP

GIF

PNG

TIF/TIFF

JPEG/JPG

Adobe ®

PS ®

EPS
PDF
PDF/A

Epson ®

ESC/P®

ESC/P 2®

Hewlett-Packard ®

PCL®

PCL6
XL
HP-GL

IBM ®

AFP 

RedTitan ®

EE
EEC
DDF
PPO
PPI
PRE
HP
LOF
LSH
IDF
RS2
STAR micronics ®

STAR
Xerox ®

IMG
Zenographics ®

ZJS
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Typical uses for the program are:

 Viewing a print file

on screen  and printing  sample pages. This means you can view the layout of a
job before production printing.

 Converting a print file

to other formats . Some of these formats are useful for archiving documents: e.g.
TIFF (Tagged Image File Format), PDF (Portable Document Format), plain text or
the MS Windows Vista ®  default format XPS (XML paper specification). Other
formats are useful for transferring jobs to other printers, e.g. IBM ® IPDS and AFP
images,  Xerox ® IMG images, PostScript files and FDL (Forms Description
Language). You can export files manually  or set up EscapeE to run continuously
, converting new files as they arrive. EscapeE supports TCP/IP  input from a
specified port and can send its PDF output via LPR . EscapeE also can be controlled
remotely from a standard browser using the RedTitan nQ server .

 Extracting data from a print file

by marking out the position of the data fields  on a page. EscapeE then saves the
data in those positions into comma separated values (CSV ), extensible markup
language (XML ) or plain text (TXT ).

 Converting between image formats

Whole or part images, with options to change the compression , resolution ,
shading , smoothing  plus other format-specific options such as rotation .

 Building new documents

by extracting clipped areas  from existing images, documents and data files and
re-formatting them together (with new text if needed). Wizards simplify the
creation of regular documents such as booklets , multi-column  lists and music
parts ; data may also be extracted and used for mail-merges .

 See the Overview  section for an introduction to EscapeE. The functions available
depend on which edition of the program you have installed:

EscapeE Viewer has full viewing features.

EscapeE Transformer has full viewing features and many of the conversion format
options.

EscapeE Batch Automation has all the features of the Transformer plus the command
line execution feature which can act as an API to client systems.

EscapeE Professional has all the features of the Batch Automation, extensive
composite document features and IDF control capability.

For more details, see Compare features .

Important note: If you have downloaded  EscapeE from the Internet, you will need
to register it to use all of these features. See Registering your software  for more
information.

Downloading EscapeE from the internet

EscapeE can be downloaded from the RedTitan PCLViewer web-site.

A demonstration edition is available: just Download  and Install  the EXE file.

Fill out the Registration dialog too and you may try all the features free for one
month with no obligation to purchase. This may be done directly after downloading

 and installing  the EXE file or later from EscapeE: see  Registering your
software .
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Downloading the current EscapeE

1. View https://www.pclviewer.com/escdownload.htm web-page in you internet
browser.

2. Click download a free evaluation now or the DOWNLOAD image.

3. Click EscapeE Current Version (OPTION 1).

4. You will be prompted to "open binary file", e.g. "EE1051.EXE": click Save File.

5. You will be prompted to Show all downloads. Open the 'Downloads' folder to
see the EXE file in its list.

6. Double-click the EXE file.

o Any anti-virus security firewalls installed on your computer may request

that you confirm that it's OK to allow this change: click Yes to display the
RedTitan EscapeE Setup  dialog.

Setup RedTitan EscapeE 

With the 'Setup - RedTitan EscapeE' dialog (see steps above ) on view:

1. Read the License Agreement  set out in the dialog's scroll box.

2. Choose I accept the agreement then click Next.

o If you choose I do not accept the agreement instead, you will not be

able to continue the Setup: click Cancel to exit.
3. An edit box on the 'Select Destination Location' dialog shows a default file path,

e.g. 
C:\Program Files\RedTitan

You may use this location or type-in or Browse to a different location in which
to install EscapeE.
Then click Next.

4. An edit box on the 'Select RT.INI file folder' dialog shows a default file path,
e.g.
C:\users\public\redtitan

You may use this location or type-in or Browse to a different location in which
to store the RT.INI file .
Then click Next.

5. A drop-down box on the 'Default paper size' dialog lists a choice of paper sizes.
Choose A4 or Letter then click Next.

6. The Setup is now complete, ready for the installation of EscapeE on your
computer.
o Click Install: EscapeE can now be run in demonstration mode.

The Registration dialog is displayed automatically, see Registering your
software . Or 

o click Back if you want to review or change any settings. Or 

o Click Cancel to discontinue installation.

 Tip:  you may opt download an earlier version of EscapeE rather than the current
version, see Transferring EscapeE .

 Note

To run EscapeE on Vista ®, Windows ® 2008 or Windows ® 7 you must be
running version 8.50 or later. At least 33.8 MB of free disk space is required to install 
EscapeE.

20

20
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Registering your software

If you have downloaded EscapeE from pclviewer.com web-site you will only be able to
run it in demonstration  mode until you register it. You may register your EscapeE
software on completing the Installation  or later from EscapeE  itself.

Registering on installation

If you have just completed the download and installation of EscapeE, the
Registration dialog will be displayed automatically.

1. Select Register a trial version via the Internet.

1.1. Choose an edition :

o Viewer or 

o Transformer or 

o Batch Automation or 

o Professional.

1.2. Choose a language: 

o Deutsch or 

o English or 

o Espanol or 

o Francais or 

o Portuges.

1.3. Click OK.

2. The 'RedTitan Software Registration' form is displayed. Your computer's ID  is
supplied automatically but you need to enter:

2.1. Your name,

2.2. The name of your Company and

2.3. Your Email address.
(In addition you may also supply your Telephone number and Address
but these details are for convenience, not a requirement.)

2.4. Read the privacy policy then tick I accept the RedTitan privacy policy to
continue.

2.5. Click Register.

3. Thank you for registering – you should now see a message with your temporary
licence number, informing you that your licence RTZ file will be sent to your
Email address. Full instructions are included but should you need further help,
please contact the RedTitan Help Desk.

19

21 22

450

22
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Registering from EscapeE

If you have been running a demonstration edition and would like to try more
EscapeE features, you may register it from EscapeE itself:

1. Select Register EscapeE from the 'File' menu.

2. Click Offline to expand the setup dialog for offline details.

3. Please enter:

3.1. Your User's Name,

3.2. Your Company name and 

3.3. Your Email address.

Your computer's ID  and the Product name (ESCAPEE) are supplied
automatically; entering your Address, Country and Phone number are options
for convenience, not a requirement.

4. Send your registration details – either:

o Click Email data to RedTitan to set up an Email then click Send. Or 

o click Print to open a 'Save file as' dialog so that you may set up a file

containing your registration details.
Enter a File name (you may click Browse Folders to open a standard file
selection window) and select a type of file.
Click Save then please mail or fax the printout of the file to RedTitan
Technology Ltd .

You will be Emailed a temporary licence for one month during which time you can try
the features. You may upgrade to a full licence for that computer by sending payment
to RedTitan Technology Ltd: see https://www.pclviewer.com/about.html. Then:

1. Open EscapeE and select Install RTZ licence file from the 'File' menu.

2. Use your standard dialog to select and Open your RTZ file.

3. When informed that your licence has installed successfully, click OK.

See the Overview  section for an introduction to using EscapeE.

 Tip:  your ID and Licence number are shown on the About  box ('Help' menu).

Links
Downloading EscapeE from the internet  
EscapeE software licence agreement

22

444
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Updating and upgrading EscapeE

EscapeE is frequently updated and developed to support customers' needs and
handle emerging technologies.

To review EscapeE's update history, browse to www.pclviewer.com/
escdownload.htm web-page and click View release notes.

When EscapeE has been purchased directly from RedTitan® (rather than supplied as
part of an OEM  system), you may:

check whether there is a more recent version of EscapeE available by selecting 
Check for updates to EscapeE from the 'File' menu;

enable EscapeE to check for newer versions once a month automatically: tick 
Check the RedTitan web site each month for updates to EscapeE on the
'Automatic'  page of the 'Configuration' dialog (Options menu, or F8).

If you have a maintenance contract you can update to newer versions of EscapeE free
of charge. Just send an Email to help@redtitan.com requesting a licence update and
supplying your licence number  and company details.

If you do not have a maintenance contract and would like to update, please Email
help@redtitan.com and we will send you back a quote for an update.

Upgrading EscapeE

There are a number of permission codes which enable additional EscapeE features:
Email sales@redtitan.com for details. To install the licence or permission codes which
RedTitan Emails to you:

1. Select Install RTZ Licence file from the 'File' menu.

2. Enter/select your RTZ file then click Open to install it.

Licence number

Details relating to the installation (e.g. your ID and Licence number, the EscapeE
Edition and Version number) are shown on the 'About' dialog.

Select About from the 'Help' menu.

o Clicking the Copy to clipboard button is a convenient way to extract these

details for archiving or when upgrading or Transferring EscapeE  to another
PC or virtual server.

Links
Downloading EscapeE from the internet  
Transferring EscapeE to another PC or Virtual Server  

Transferring EscapeE

A licence  allows EscapeE to be run on a particular PC or virtual server, identified by
its ID and specified in the licence. It may be transferred to another computer or
virtual server (for example when you buy a new PC) but it cannot be run from a copy.
If you would like to run EscapeE on more than one computer please Email
help@redtitan.com and RedTitan® will supply details regarding the appropriate
licence.

Moving EscapeE

To install your existing EscapeE on a new PC or virtual server you must either Reuse
the original software  or Download it from the internet : see below.
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Reuse the original software

Your current EscapeE would have been supplied as a 'ZIP' or 'EXE' file. Install this
on the new PC or virtual server, then:

1. Once the installation is complete, run EscapeE (it opens in demonstration
mode).

2. Select About from the 'Help' menu. This displays the About  dialog showing
your computer's ID number, EscapeE details and licence information.

3. Click the Copy to clipboard button (or Ctrl C) – this will extract the
information in the dialog for you.

4. Create an Email and Paste the clipboard information into it. Add a note
explaining your requirements then send it to RedTitan. We will send back a
licence file  for the new computer.

Or 

Download from internet

If you have the latest version of EscapeE:

1. View pclviewer.com/escdownload.htm web-page in you internet browser.

2. Click download a free evaluation now or the DOWNLOAD image.

3. Click EscapeE Current Version (OPTION 1).

4. You will be prompted to "open binary file", e.g. "EE1051.EXE": click Save File
and follow the steps in Downloading EscapeE from the internet .

5. Then send an Email of the details to RedTitan as above .

If you have an earlier version of EscapeE:

1. View pclviewer.com/escdownload.htm web-page in your internet browser.

2. Click download a free evaluation now or the DOWNLOAD image.

3. Click EscapeE Previous Version (OPTION 2) and select the appropriate
version from the list.

4. You will be prompted to "open binary file", e.g. "EE0952.EXE": click Save File
and follow the steps in Downloading EscapeE from the internet .

5. Then send an Email of the details to RedTitan as above .

Virtual PC/Server environment

Virtual servers should run EscapeE in the same way a physical server would.

Virtualization convinces an application that the PC is physically present when it is not.
RedTitan has tested EscapeE on Windows  Virtual PC and VMware ® virtual server
without issues. If you do have problems running RedTitan software on a virtual
platform please contact EscapeE by Emailing help@redtitan.com or telephone one of
our offices: details can be found at pclviewer.com/about.html.

 Note

To run EscapeE on Vista , Windows  2008 or Windows  7 you must be running
version 8.50 or later.

Links
Registering your software  
Updating and upgrading EscapeE  
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Uninstalling EscapeE

To Uninstall EscapeE

1. Select Start | Settings | Control Panel from your desktop.

2. Double-click Add/Remove Programs icon
or
Right-click Add/Remove Programs icon then choose Open.

3. Select RedTitan EscapeE from the list of programs on the Install/Uninstall page
of the dialog.

4. Click Add/Remove.

5. Click OK.

Alternatively there is a command-line option /UNINSTALL: see Command line syntax

Links
Updating and upgrading EscapeE  
Transferring EscapeE to another PC or Virtual Server  
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RedTitan software licence agreement

These are the terms on which you ("the Licensee") can obtain the software product
known as EscapeE ("the Software") from RedTitan Limited of Aston Court, Kingsmead
Business Park, Frederick Place, High Wycombe HP11 1JU United Kingdom

("RedTitan")

If you ("the Licensee") wish to order the Software on the terms set out below, please
click "Accept licence" to acknowledge acceptance of these terms. These terms will
then govern any order which you place for the Software.

WHEREBY IT IS AGREED as follows :-

1. Definitions

In this Agreement, the following expressions shall have the following meanings:-

"Intellectual Property Rights" all copyrights, patents, registered and unregistered
design rights, topography rights, trademarks and service marks and applications for
any of the foregoing, together with all trade secrets, know-how, rights to confidence
and other intellectual and industrial property rights in all parts of the world.
"Licence Fee” the licence fee specified in the order form.
"Software” the Software identified in the order form.
"User Parameters” the specification of the hardware on which the Software may be
used, the location at which the Licensee may use the Software, and any other
parameters of use specified in the order form.

2. Licence

2.1  In consideration of the payment of the Licence Fee, RedTitan hereby grants to the
Licensee a non-exclusive, non-transferable Licence in object code to use the Software
only for its internal business purposes (which for the avoidance of doubt shall not
include facilities management or bureau services) and strictly in accordance with the
User Parameters and subject to any special conditions specified in the order form. 

2.2  Any use of the Software otherwise than in accordance with Clause 2.1 shall be
subject to RedTitan's prior written consent and any reasonable additional licence fee
which RedTitan determines.

2.3  The Licensee shall not, except to the extent permitted by law, modify, reverse
assemble, decompile or reverse engineer the Software nor shall it permit whether
directly or indirectly any third party to do any of the foregoing.

2.4 The Licensee shall pay any invoice correctly raised by RedTitan within 30 days of
the date of such invoice.

2.5 If the Licensee fails to pay any sum due under this Agreement when it is
expressed to be due, RedTitan shall be entitled to charge interest on a daily basis on
all overdue amounts and on outstanding interest from the date of such failure until
payment (both before and after judgement) at an annual rate 4% above the base rate
for the time being in force of Barclays Bank plc.

2.6 For the purposes of this Agreement, time of payment by the Licensee shall be of
the essence.
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3.  Confidentiality, Copying and Intellectual Property Rights

3.1 The Licensee acknowledges that the ideas and expressions contained in the
Software (and any modifications thereof or updates thereto provided to the Licensee
by RedTitan) and any particulars thereof provided to the Licensee by RedTitan are
confidential and the Licensee undertakes not to divulge such information to a third
party and only to divulge such information to its associated companies, agents and
employees as is strictly necessary to enable it to be used in accordance with and for
the purposes hereof and the Licensee undertakes to ensure that such entities maintain
such confidentiality and the Licensee acknowledges that the terms of this Clause and
Clause 4 shall survive the termination for whatever reason of this Agreement.

3.2 RedTitan shall be entitled to disclose the name of the Licensee as a user of the
Software.

3.3 Except for back-up purposes or otherwise in accordance with the law, the Licensee
shall not itself nor allow any third party to duplicate or otherwise reproduce in whole
or in part the Software.

3.4 The Licensee acknowledges that it obtains no Intellectual Property Rights
whatsoever in any software or documentation by virtue of this Agreement.

3.5 The Licensee will notify RedTitan of any claim which may be made against
RedTitan, or any related company or the Licensee alleging that the Software infringes
the Intellectual Property Rights of a third party as soon as it becomes aware of any
such actual or potential claim.

3.6 The Licensee shall immediately bring to the attention of RedTitan any
infringement or suspected infringement by any third party of any of the Intellectual
Property Rights in the Software of which it is aware and shall at the request and
expense of RedTitan take such action or assist RedTitan in taking such action as
RedTitan may deem appropriate to protect its Intellectual Property Rights.

3.7 The Licensee undertakes not to remove, delete or obscure any copyright notices or
confidentiality notices on or in the Software and to ensure the accurate reproduction
of the same on any copies of the Software which it is entitled to make in accordance
with the terms hereof.

4. Limitation of Liability and Warranties

4.1 The Software has not been written to meet the individual requirements of the
Licensee and it is the sole responsibility of the Licensee to satisfy itself prior to
entering this Agreement that the Software will meet its requirements and be
compatible with its hardware/software configuration. RedTitan makes no warranty or
representation in that respect and no failure of any part or the whole of the Software
to be suitable for the Licensee or for any liability of the Licensee to any third party
arising in any way in connection with this Agreement or otherwise whether or not such
loss has been discussed by the parties pre-contract.

4.2 RedTitan is not liable for any indirect loss, consequential loss, loss of profit,
revenue, data or goodwill howsoever arising suffered by the Licensee or for any
liability of the Licensee to any third party arising in any way in connection with this
Agreement or otherwise whether or not such loss has been discussed by the parties
pre-contract.

4.3 RedTitan shall not be liable for any loss or damage of whatsoever nature suffered
by the Licensee arising out of or in connection with any breach of this Agreement by
the Licensee or any act, misrepresentation, error or omission made by or on behalf of
the Licensee (including without prejudice use of the Software by someone with
inadequate training or experience) or arising from any cause beyond RedTitan's
reasonable control.
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4.4 Subject to Clauses 4.6 and 4.7 below, no matter how many claims are made and
whatever the basis of such claims, RedTitan's maximum aggregate liability to the
Licensee under or in connection with this Agreement, in respect of any direct loss (or
any other loss to the extent that such loss is not excluded by Clauses 4.1-4.3 above or
otherwise) whether such claim arises in contract or in tort shall not exceed a sum
equal to [insurance cover/twice] the Licence Fee paid by the Licensee.

4.5 Whilst RedTitan makes all reasonable attempts to exclude viruses from the
Software, it cannot ensure such exclusion and no liability is accepted for viruses.
Thus, the Licensee is recommended to insure itself against this risk.

4.6 None of the clauses above shall apply so as to restrict liability for death or
personal injury resulting from the negligence of RedTitan or its appointed agents.

4.7 RedTitan gives no warranties in connection with the Software other than that the
Software will perform substantially in accordance with the accompanying written
materials for a period of 30 days from the date of despatch to the Licensee. All other
warranties, express or implied, statutory or otherwise are excluded.

4.8 The Licensee hereby warrants that it has not been induced to enter into this
Agreement by any prior representations whether oral or written except as expressly
contained in this Agreement and the Licensee hereby waives any claim for breach of
any such representations which are not so contained.

5.  Termination

5.1 Either party may terminate this Agreement immediately by written notice to the
other in the event that any of the following occur:-
5.1.1 the other fails to pay any amount due hereunder within 30 days of its due date
or breaches any term of this Agreement and such breach is incapable of remedy or
continues for a period of 30 days after notice requiring the same to be remedied has
been given by the terminating party to the other party; or
5.1.2 an order is made or a resolution is passed for the winding up of the other party,
or if a provisional liquidator is appointed in respect of the other party, or if an
administration order is made in respect of the other, or if a receiver is appointed in
respect of the other or all or any of its assets or if the other is unable to pay any of its
debts within the meaning of Section 123 of the Insolvency Act 1986, or if any
voluntary arrangement is proposed under Part 1 of the Insolvency Act 1986 in respect
of the other.

5.2 RedTitan may terminate this Agreement forthwith if the Licensee purports to
breach Clause 6.4 hereunder.

5.3 Termination of this Agreement shall be without prejudice to any other rights or
remedies of the terminating party.

5.4 In the event of termination of this Agreement, the Licensee shall within 14 days
destroy the Software and any documentation supplied by RedTitan together with any
copies thereof and write to RedTitan certifying that this has been done.

6. General

6.1 Subject to Clause 6.2, this written Agreement together with the order form,
constitutes the entire agreement between the parties hereto relating to the subject
matter hereof and neither party has relied on any representation made by the other
party unless such representation is expressly included herein. Nothing in this Clause
6.1 shall relieve either party of liability for fraudulent misrepresentations and neither
party shall be entitled to any remedy for either any negligent or innocent
misrepresentation except to the extent (if any) that a court or arbitrator may allow
reliance on the same as being fair and reasonable.

6.2 No change, alteration or modification to this Agreement shall be valid unless in
writing and signed by duly authorised representatives of both parties.
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6.3 If any provision of this Agreement or part thereof shall be void for whatever
reason, it shall be deemed deleted and the remaining provisions shall continue in full
force and effect.

6.4 The rights and obligations of the Licensee under this Agreement are personal to
the Licensee and the Licensee undertakes that it shall not, without the prior written
consent of RedTitan, assign, lease, charge, sub-license, or otherwise transfer such
rights and obligations in whole or in part.

6.5 RedTitan reserves the right to sub-contract any of the work required to fulfil its
obligations hereunder.

6.6 Any notice given pursuant hereto may be served personally or sent by pre-paid
registered letter or recorded delivery to the addresses given hereabove. Such notice
shall be deemed to have been duly served upon and received by the addressee, when
served personally, at the time of such service or, when posted, 48 hours after the
same shall have been put into the post correctly addressed and pre-paid.

6.7 Neither party shall be liable for any loss suffered by the other party or be deemed
to be in default for any delays or failures in performance hereunder (other than in
relation to payment) resulting from acts or causes beyond its reasonable control or
from any acts of God, acts or regulations of any governmental or supra-national
authority.

6.8 Any delay or forbearance by either party in enforcing any provisions of this
Agreement or any of its rights hereunder shall not be construed as a waiver of such
provision or right thereafter to enforce the same.

6.9 Clause headings have been included in this Agreement for convenience only and
shall not be considered part of, or be used in interpreting, this Agreement.

6.10 This Agreement shall be governed by the laws of England and the parties submit
to the exclusive jurisdiction of the Courts of England and Wales.
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Overview

This section provides new users with an outline of how EscapeE may be used handle
print files. The topics include links to the detailed instructions found in subsequent
sections. 

What you see when you open a document in EscapeE and how to change it; about
the Console notebook for viewing document properties, PCL and IDF source code:
see About viewing pages .

Finding your way through a document; the page search, text search and
bookmark tools: see Navigating to a page .

General information on fonts, font packs and font libraries; symbolsets, character
recognition and header files: see Handling fonts .

General information on graphic images, vector graphics, shading and
transparency; about masks and alpha channel images: see Handling graphics .

Saving and copying documents, parts of documents, text and macros; stylesheet
files: see Saving and copying pages .

Printing options and the use of proofing printers, resources and plotters; trays
and bins. About unprintable areas, image scaling and cropping: see About
printing .

General set-up for outputting pages in a different file-format and generating log
files and macros. Manual and automatic operating; using TCP/IP: see About
exporting pages .

The Configuration dialog: setting general and format-specific options. Shading,
compression, resolution and page numbering: see Configuring files for export .

The Fields dialog: the relationship between data fields and tags. Composite fields
and conditions; setting up actions: see About fields and tags .

Outputting extracted data to CSV, XML and plain text log-files: see About
exporting data .

How to use parts of fields and pre-defined symbols; applying conditions: see 
Composite fields and conditions .

About Composite documents and IDF : the sweep-and-click feature for
assembling parts of existing pages into composite documents. Re-purposing
documents and creating new documents with Intelligent Document Format.

About User-friendly Mail merge and Composite document wizards; the dual-mode
editor for creating new documents: see IDF wizard documents .

About running EscapeE automatically from a Shortcut icon, directly from the
command-line or through a program: see Batch job running .

All in all, EscapeE is a powerful print stream and data reprocessing tool with a
comprehensive array of features. If you have a print data processing task you don't
think EscapeE can handle, Email help@redtitan.com and we'll see if we can find you a
solution.

32

32

33

34

35

35

36

36

37

38

38

39

39

40

mailto:help@redtitan.com


Overview32

About viewing pages

EscapeE is capable of reading files in a wide range of formats , including specialist
files such as those with non-standard extensions, see Configuring the input format .
When a file is open  you may just view the layout and print sample pages or you can
opt to export  all or part of a job to another format .
You can view the pages at a range of different sizes using the Zoom buttons  or the
menu command, see Choosing the view of the page . You may customize the
Viewing  options: for example, to use the current viewing scale each time you open
a file. The filename is usually shown in the title-bar at the top of the window.
Details about the page are displayed in the status bar  at the foot of the window,
though you can opt to turn this off. Normally, when the mouse is over the page
window, its coordinates on the page are displayed (in the units  of your choice). To
view details about a particular piece of text or a graphic on the page, right-click on
the object then choose from the pop-up menu. See Viewing page information .

You may choose whether to show any images or shaded areas on-screen or not: see 
Handling graphics . If your PCL file contains macros  which you cannot see on
screen, you can opt to view  the macros step by step.

Many PCL printers do not print exactly to the edge of the paper; EscapeE lets you see
if any part of the page will not print: see Viewing the unprintable area . The
maximum size of page that EscapeE will display is 32760 pixels wide by 32760 pixels
high.

The Console notebook  brings together the document's technical information: click

the Information icon on the Tool-bar  (below the title-bar). Each tabbed page
focuses on a different aspect of the job: its Properties , Source code , PJL , Log
and Error  messages. Further tabs are added when Intelligent Document Format
files are being created and edited, see About Composite documents and IDF .

The demonstration edition of EscapeE uses Windows TrueType® fonts to emulate the
resident printer fonts but the production editions can be supplied with outline fonts
which are a better match, see Handling fonts .

Links
Viewing files
Console notebook

Navigating to a page

The 'Page number' button on the Tool-bar shows which page of the document is on
view; to view a macro , select it from the drop-down list.
You may step through the pages of the job one by one, or move straight to the first or
the last pages: see Scrolling the document . You may also jump directly to a specific
page number: see Searching for a page .

The EscapeE text-search feature is not only fast but can be configured to search the
text or the data-fields, in just part or all of the job: see Searching for text . The
Bookmark feature enables you to annotate the page numbers with text to help you
return to particular pages: see Using bookmarks .

A progress indicator is shown on the status bar  (at the foot of the page) to keep
track of the location of the current page within the document.

Links
Navigating around a document  
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Handling fonts

Document files may contain all, some or none of the fonts that are needed to make
the document. When a font required by the document on view  is not downloaded as
part of the file, EscapeE will attempt to match it with one in its resident library .
EscapeE is delivered with a set of definitions which make use of some of the standard
Windows fonts. These are in a file called WINFONTS.FIF, but if you save fonts to the

resident font library, a file is created which is specific to your system (called 
RESIDENT.FIF in the PCL Resident Font Library). If there is no exact match with any of

the library fonts then the nearest one is chosen, which may result in a some variation
in the appearance of the text, see Viewing font information .
The demonstration edition  of EscapeE is supplied with a set of fonts  that simulate
the printer's Courier, Letter Gothic, Univers, Line-printer and HP-GL Stick fonts and
also uses the standard Windows fonts Arial, Times New Roman, Symbol and
Wingdings from your system. The standard Windows (19U) symbol set is provided,
together with the PC symbol set for the standard fixed pitch fonts (10U). EscapeE can
create most other symbol sets from the 19U set by remapping.

You may purchase a TrueType font pack  for matching the built-in fonts on printers
such as the HP4 and later models and a font pack  for fixed pitch fonts: Email
sales@redtitan.com. RedTitan can also supply customized fonts to order: please
contact help@redtitan.com.

EscapeE '.SUB' files can be generated to organize the substitution of fonts, see 
Setting up a Font Substitute file . Different substitute fonts may be used for viewing
on-screen and on paper: see Selecting substitute fonts .

A warning triangle  on the Tool-bar will alert you to any problems with font
mismatching . You can see the text that uses any fonts that were not completely
matched against available downloaded or library fonts by ticking the Show selected
fonts in red  option. (If the text of a substitute font is actually red, this option
defaults to blue instead!) You can view details of the font, and whether it is a
substitute, by right-clicking the text.

If you have problems reading a file after export, it may be because the download fonts
were created in a different symbolset when the PCL file was generated. For example,
an IBM mainframe could create fonts with EBCDIC character encoding. You can try
reading the file into EscapeE again and selecting a different symbolset from the
'Symbolset conversion' list, see About symbolsets . Download fonts are often
protected by permuting the character codes (e.g. HP3 printer drivers) so that they
make nonsense of the extracted text. EscapeE, however, can recognize characters
either optically (see Using plugins ) or by matching the character data in the
downloaded font. Character recognition codes may be set up in a database (using 
EEfonts, accessible from 'Fonts' menu, see Character codes ) or assigned individually,
see Assigning character codes .

Some printer drivers specify inappropriate point sizes, which can cause problems if
font substitution or character recognition are required. EscapeE has an option
(Calculate download font characteristics ) that enables more appropriate values for
point size, weight and style to be applied instead.

As an alternative to including all the fonts for a PCL page with each page file, you may
opt to export all the fonts for a multi-page job in a separate file . The fonts-file may
be installed in the Resident font library, supplied as the first of a list of files, or
specified as a header file . This reduces the size of each page file while ensuring that
the printer has all the fonts it needs for the job right from the start.

TrueType fonts downloaded with PCL files may be embedded in PDF files on export,
either whole or (to reduce file-sizes) in subsets .

Users may reset the font and image library  search paths.
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Handling graphics

Graphics – any objects you see in a page which are not text – are stored in a number
of different ways.

'Bitmapped graphics' are mosaics of monochrome (black-and-white) or colored pixels.
Some formats consist entirely of such images e.g. BMP, JPEG, PCL3GUI while others,
e.g. PDF files, can contain both text and graphics.

'Vector graphics' use a series of lines and shapes drawn on the page to form the
image and were originally used by plotters e.g. HP-GL. Modern 'Tensor' graphics
advance this concept to include complex colour-blends and axial shading.

The RedTitan Color Management System handles CMYK to RGB color conversion and
there is no limit to the number of CMYK colors that it can implement.

The 'Force monochrome' option can be used to change colored images to 'gray-scale'
or 'black-and-white' and supports a variety of conversion options. Several smoothing
methods are provided to ensure good results when scaling color and monochrome
images down for printing or viewing on-screen. See Image import/export options .

Images in AFP , PDF , TIFF  and PNG  files may contain transparent pixels, the
transparency information being stored in an extra layer in the image (the "alpha"
channel) much like a "soft mask". Each pixel in a soft mask assigns a degree of
transparency to the base image. This is how the edges of an image can be made to
fade into the background, or to allow an underlying image to show through it (e.g. in
Windows title-bars).

Alpha channel transparency is readily propagated into PDF documents, so the
exported PDF files are relatively compact. Images with transparency exported in other
formats, however, may require the whole page to be imaged, which usually results in
relatively large files.

Some formats also support 'shading': areas of black and white pixels arranged in a
repeating pattern, see Shading options . These areas are often used as backgrounds
for other elements, but they are liable to cause problems when layered on top of one
another and exported in different format. (For example, the 'white' pixels in PCL
shading patterns are transparent but the 'white' pixels in PDF patterns may be
transparent or opaque.) These options may be configured to handle such situations: 
Transparent white , Keep original element order  and Ignore Shading .

You may opt to remove images and/or shading from documents, for example when
you just need to read the text, or to keep file-sizes down. See Setting the 'Ignore'
options .

You may choose to save  an individual graphic from a page or export or print each
whole page (including all text, graphics etc.) as a single image: see Page Imaging,
scaling and cropping .

Links
Image import export options  
Optimizing the configuration  
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Saving and copying pages

EscapeE can export  pages and extract  text to a wide range of formats . In
addition, the Save Subset...  option allows you to cut out a section of a print file and
save it for reprinting, including any necessary fonts, macros and environment
definitions. This is a useful option when part of a PCL print run has failed; only a
sample of the file need be tested and analyzed for problems (e.g. missing fonts ).

The layout of the contents of a page may be rearranged  at the sweep of a mouse.
Clippings may be made and assembled to create new files, see About Composite
documents and IDF .

The text on a page may be copied  to the Windows clipboard and pasted into other
applications, see Extracted text options .

Macros can be extracted from pages and saved . Macros may also be created by
outputting page(s) as a macro .

The files for making stylesheets may also be output, see Creating XML stylesheets .

Links
Save and copy  

About printing

EscapeE can read files which have been prepared for printing on one printer and
output  them as files suitable for another printer. You may need to set up details of
the printer  or plotter  being emulated, the output printer  and their paper-trays

 and bins .

If you just need a paper copy of a document (or selected pages  from the document)
on view, you may use your regular printer (i.e. one set up under the Windows
mechanism) to print  it. To change the default printer, see Printer Setup . You may
also use PCL, PDF, PS and XPS printers directly , bypassing the printer's own printer-
driver (printer-drivers are often the root of printing difficulties).

Printing may be scaled to accommodate printer differences such as unprintable areas
: see Configuring the view . The page may be cropped to remove white margins.

You may choose to print pages according to their instructions or as a simple image,
see Page imaging, scaling and cropping . You can set up options  and overrides
to specify when one side of a sheet of paper is blank (duplex, simplex, simulated
simplex, no plex, mixed plex). There are options to print two pages on one side of a
sheet of paper: EscapeE rotates and scales the pages automatically and outputs them
as a "Booklet" or "2-up", see Booklets and 2ups .

When printing a page as an image it will always look the same as EscapeE shows it on
the screen. This allows you to see whether the resources are set up correctly or not
(whereas proofing uses the printer's own "resources" e.g. fonts). EscapeE can
generate a separate PCL fonts-file for printers requiring the fonts to be downloaded
before the page content: see PCL export options .

Links
Printing pages
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About exporting pages

EscapeE can export files (see File formats list ) to a wide range of formats  for
archiving pages and for printing jobs on other printers: see Choosing an export format

. A comprehensive array of Configuration  options enable you to export files
which include features specific to the chosen format.

The whole file, just one page or a specified range  of pages may be exported. You
can elect to ignore  some elements of a file – shading, images, fonts – to increase
speed, reduce file-sizes etc. to suit your requirements (e.g. when archiving). An IDF
control file may be used to combine several files (PCL, TIFF, PDF etc.), pages or
clippings into one document. These IDF documents may be exported in the format
that you choose. See About Composite documents and IDF .

You may set up data-fields  in the document which can be logged  in a separate
file in addition to the original document, see Setting Log file options . The output
file's name can be derived wholly or in part from the contents of a field; see Filenames
and wild-cards . A Log file is particularly useful when dealing with large documents,
e.g. for creating an index.

You may export the document only (in PDF , PostScript , TIFF , XPS , IMG ,
AFP , PCL  format and, if you have the option installed, IPDS ), both the
document and the Log file , or the Log file only (in CSV , XML  or Plain text
format). You may configure EscapeE to retain the current "plex" or switch to a
different mode, see Simplex and duplex options . Finally, on export to PCL , PDF
and PostScript  formats, alternative Duplex overrides  may be selected.

EscapeE supports TCP/IP  input from a specified port and can send AFP, PCL, PDF
and PostScript output via LPR . It can also send TIFF, IMG and PNG image files via
LPR (this is especially useful for users of the RedTitan 'nPortal' spooler). It can be
controlled remotely from a standard browser using the RedTitan nQ  server.

You can export pages manually  or you can set up the program to convert files
automatically  whenever a new file arrives in a given folder.

Expert users may set options from the command line, e.g. for batch  operation.

Links
Export files  

Configuring files for export

One multi-page dialog provides the export configuration set-up. Some of the settings
apply to most formats, see Convert pages to other formats  section, but others may
only be relevant to one particular format, see Export files  section. For example, PDF
documents  may be digitally signed, encrypted and time-stamped.

You may open the Configuration dialog by pressing the 'F8' key; this displays the
'General ' set-up page. Then select the format from the drop-down list; when there
are format-specific options, buttons are shown so that you can display these options
on subsidiary pages. Alternatively, these configuration pages may be accessed from
the Export  dialog.

When exporting pages automatically  you can set various features such as the time
interval to check for files, the input and output filenames and whether to use LPR
output.

Image  options such as resolution , compression , borders and the image area
can be specified. There are smoothing options for colored/screen and monochrome
images. There are two grades of shading  patterns: one uses dots on a transparent
background and the other uses opaque solid grays instead.
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'Preambles' and 'PJL comments' may be exported, suppressed or removed on export
to PCL , PostScript , PDF , PDF/A  formats, see Preamble and PJL options . The
EscapeE 'prefix' feature enables fields to be created from PJL comments and job

commands, see Setting the fields file options .

You may set up a page numbering scheme for a document on export in the
Configuration dialog's Layout  page. For details of the 'Bates' numbering scheme,
see About page numbers .

When you have set up options manually from the Configuration dialog you can save
them in different ways:

Click the Save button to retain these settings after you exit  the program.
Click the Save as button to save these settings to a file (*.INI).
Click Shortcut to create a Shortcut  icon on your desktop which applies all the
options you have set.

Links
Convert pages to other formats  

About fields and tags

EscapeE allows you to define data-fields and tags on the document's pages and then
extract the content or add text. Text found at these field positions may be exported
into one or more log-files, see about exporting data . Fields may also be defined to
store data calculated from other fields or parts  of other fields: these are Composite
fields . Data extraction can be automated .

Regular data-fields are defined  by their position on a page. Fields can also be
defined as being located at some offset relative to a search tag  which is matched
against items in a specified area of the page. A search tag can be a text string, a
graphic or part of a graphic, or a font characteristic such as a particular style, point
size, typeface, weight etc., see Setting search tag options .

If you rearrange  the contents of a page, any fields found in the areas moved are
relocated along with the clip-areas. When a document is exported to IDF  or RTF
you may choose to extract everything on the pages or just those fields already
defined. These features enable you to regain control of existing information and re-
purpose documents.

Composite data-fields are not defined by a position on a page. They are composed of
the values of other fields and are typically used to store the results of a condition .
The hierarchy of fields and their related tags can be viewed as a tree  in the Field
dialog . This makes it easy to reorganize fields, say to become 'children' of different
tags. Note that a field will only be output on condition that all its 'parent' tags are
recognized.
You may specify what action  is to be taken when a field is found, not found or
changed. For example, you may choose to start a new log, set or file. You may force a
new front or back page and specify which tray, bin or overlay to use.
The Tagged Text  feature enables automatic form-filling. Tags are set up to call on
the AddText Plugin and insert new text where and when required.

A field may be set up to load a new a field definitions file  for the document
dynamically. This allows each document, or even each page in a document, to invoke
a different field definitions file. A tag can be linked to an overlay by specifying a 
macro  number, and whether that overlay is to be turned on or off when it
recognizes the selected tag. See Setting advanced options in field definitions .

You may specify how fields are to be rendered in some formats: for example PDF
forms, DICOM  elements and XML  stylesheets.
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About exporting data

The text extracted from data-fields can be exported to log-files in plain text
(extension .LOG), CSV  (with field names in the first record) or XML  (you may opt
to create XSL and CSS stylesheets  too) formats. When exporting the document in
an image format, all log-files are given the extension ".LOG ". Pages and sheets may
be logged, see Setting Log file options . Log-files can be imported into a database or
fed to the RedTitan Dynamic Document Formatter .

Plugins  are available which add special features to EscapeE. For example, text may
be extracted by optical character recognition, changed and repositioned; field-values
may be used as barcodes or to handle dynamic images etc..

If you are exporting proportionally spaced text into fixed-pitch plain text, EscapeE can
strip or add spaces and control the way text is aligned, see Setting advanced options
in field definitions .

Note that in order to extract meaningful text you may need to reconfigure the 
symbolset . If the document was created by a driver which assigns arbitrary codes
to the characters, then it will be necessary to match the downloaded characters to
those in the character recognition database EEfonts.

When exporting to IDF  and RTF , you may choose to output everything on a page
or just those areas which contain fields.

Links
Extract data
Export data

Composite fields and conditions

Composite fields  are fields designed to store data calculated from the values of
other fields .

To create  a Composite field, you do not need to mark-out an area of a page: simply
select "New" from the Fields menu and enter its definition directly into the Field dialog

. There is a drop-down list of the fields already in the document and pre-defined
symbols to speed the setting-up process.

Pre-defined symbols  are used to contain commonly-used data values related to
documents such as the file and page details, dates and PJL commands. They can be
recognized by their leading underscore character.

You may specify a constant value  for a Composite field or you may set up a
condition . For example, they can check for the presence or absence of a string ,
whether a field value has changed , set up counters  and prompt the User to input
data .

Composed fields are denoted by enclosing them in braces ;  arithmetic expressions
 and logic expressions  may be used when calculating numerical values.

Links
Composite fields  
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About Composite documents and IDF

EscapeE is well known for its capability to take a file in a wide range of formats and
directly output its equivalent in another format. EscapeE can, however, also output
documents in an intermediate document description language, IDF . IDF files can
be edited  then output in your chosen format. This spares you the bother and
expense of installing specialist programs for every format which you may need to edit.

EscapeE includes a feature to create a "Composite document" – a single document
composed from a collection of other "component" documents. The component
documents are just regular files  such as PCL, PDF etc..

When the component documents are all entire files, a simple 'List Of Files' control file
will suffice, see Creating a data control file . If you require just pages and/or parts of
pages from any of the component documents, however, IDF control files provide the
solution. Just open a new IDF file, sweep out the part of the page you want to use,
then click Copy & Add section to IDF. You can add more clippings from this or other
files to the same IDF document: just sweep and click. EscapeE does the coding to
create the file for you: see Creating an IDF document . Composite IDF documents
may be used as templates for new documents. Open the IDF file in EscapeE to view
the document and display its code in the Console: see Editing an IDF document .

The IDF syntax  section provides details on IDF code and notation but you don't
need to be a programmer to edit a control file. The "plain English" nature of IDF
elements and attributes make this a genuinely user-friendly format, see IDF editing
tips .

See also IDF wizard documents  

Links
Data control files  
IDF Documents  

IDF wizard documents

EscapeE "wizards" take composite documents  to a whole new level. They can also
generate task-specific documents, such as mail-merge letters. The output is fully-
fledged professional documents, but you are not limited to a one-size-fits-all solution.
The underlying code is in IDF so if you want to add your own special touches, you can.

Mail-merge wizard  handles "mail shots" – customized letters to individuals whose
details are provided by a data-file.

The Composite document wizard  gives you a choice of layouts for you to output
content as lists, columns, booklets etc..  You may even separate a full music score
into its individual parts! The wizard takes care of any scaling, rotation and splicing
issues automatically.

To output non-standard documents, use the IDF dual-mode editor. In 'Tree' mode,
the document is shown schematically: clicking on an element displays its properties,
which you may alter by choosing from drop-down lists, dialogs or edit-boxes. You can
see the code generated by EscapeE by switching to 'Text' mode. If you're familiar
with xml  elements and attributes you may, of course, edit the code in this window
from the keyboard. See Other documents .

Links
About composite documents and IDF  
IDF wizards  
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Batch job running
(Applies to EscapeE Professional and Batch Automation editions  only)

 EscapeE makes batch job Shortcuts  easy to set up and easy to use: just
specify its location – desktop, Start menu or elsewhere on your system.

 Advanced users can run  EscapeE directly from the command line. (IDF files
may also be run.) There are over a hundred command-line options  for export ,
printer-specific , composite document  and many other  configuration options.
The configuration may be saved as an INI  file.
EscapeE may be called from an external program  using the /PIPE command. /X is
used to exit.

Batch jobs often require that a large number of files are processed. These files may be
accessed from LOF or CSV control files (see About Control files ) which call on
associated field definitions files: see About .EE files for control files . The field
definitions files themselves can be grouped together to form a custom job LOF or JOB
file for ease of use, see Run custom jobs .

Links
Run from the command line  
Command line syntax: index  
Error return codes  
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Viewing files

This section describes in detail what you see in the EscapeE window, and how to
change it.

EscapeE normally displays a pop-up menu of options on right-clicking the page,
indicated by a tick alongside the 'Autopopup' option.  To turn this feature off for the
duration of the session, click Autopopup.

Tip:  to close a pop-up menu, press the Esc key.

The EscapeE shortcut icon and how to open and size EscapeE; exiting EscapeE:
see Running EscapeE .

EscapeE works with many different file-formats automatically so viewing a file is
easy: see Opening and closing a file .

How EscapeE detects and recognizes the format of files for viewing: see File
format recognition .

How to set up the input file format for non-standard files: see Configuring the
input format .

Setting up format-dependent /INPUT options for experts: see Input options .

How to rotate the page on view: see Rotating the page .

Choosing how much of the page to show in the window: see Choosing the view of
the page .

Zooming in and out and setting a precise scale of view: see Changing the scale of
view .

Specifying the usable area of the page: see Setting the page extent .

Choosing how EscapeE should show an unprintable area: see Viewing the
unprintable area .

How to enable/disable the display of tool hints: see Viewing 'Hints' .

How to find and show data fields and tags in the document: see Viewing data
fields and tags .

How to display font tables and error messages, and view the properties of the
fonts and text: see Viewing font information .

How to view the page details; lines, graphics, images, shading, overlays, macros
and mouse coordinates: see Viewing page information .

How to customize the opening view and zoom options, shift the page contents,
show or hide the unprintable area, change the units of measurement and
suppress blank pages: see Configuring the view .

How to treat unwanted page elements and reduce the output file size: see 
Optimizing the configuration  

Links
Configuring the printer defaults  
File formats list  
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Running EscapeE

To run EscapeE

choose EscapeE from the RedTitan programs in your 'Start' menu, or

double-click an EscapeE shortcut icon on your desktop.

To run EscapeE so that selected file(s) open automatically

choose EscapeE as your preferred program for opening specific files/extensions.
Clicking the file in Windows Explorer will run EscapeE with the selected file open:
see Associated programs .

choose Run from your 'start' menu enter the file path and options on the
command-line; see Run from the command line  

drag and drop a file (or group of files) from Windows Explorer onto the EscapeE
shortcut icon on your desktop. Note that if you have set up automatic file export
with 'View' turned off, the file will simply be exported without coming up on
screen; see Setting automatic export options.  

EscapeE may also be run from a program; see Run from a program.  

The EscapeE window will open at the size specified in the 'Configuration' dialog:  see 
Configuring the view . You may change the size while it is running by clicking one of
the buttons at the top-right of the Title-bar:

 Maximize EscapeE fills the entire screen.

 Minimize hides EscapeE but keeps it open. An EscapeE button is placed on your
Start bar: click this to restore the EscapeE window.

 Restore Down shows EscapeE at a size which you can adjust to fit your
requirements: use the mouse to 'drag and drop' the window border.

The Tool-bar (located below the Title-bar) is split into two parts, one containing
menus and the other with Tool buttons. You may use the mouse to pick up these parts
by their side edges and drag them to another part of the Tool-bar (the height of the
Tool-bar expands/contracts automatically to fit the height of the Tools). This is
particularly useful when you run EscapeE with a narrow window; you may keep all the
Tools on view in the window by placing the menus and buttons on two rows in a
double-height Tool-bar.

To close EscapeE

Choose Exit from the 'File' menu or 

Click the title-bar's  button or 

Choose Close from the title-bar  menu or 

Press Alt F4 keys.

Links
Overview  
Opening and closing a file  
Shortcuts - the easy way to construct a command line
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Opening and closing a file

To view a file

1. Choose Open... from the 'File' menu or 
hold down the Ctrl key and press the O key.

2. Look in the appropriate folder to find the file to be opened.
You may refine your search by only showing specific types of file...
Either choose from the drop-down list:
o Print Files such as .PRN, .LSH, .PCL, .PS, .EPS, .HP, AFP.

o TIFF images shows files with extension .TIF and, for multi-page PCL jobs

converted by EscapeE, extensions .001, .002, etc..
o Plotter files, extension .PLT.

o PDF files in Adobe Portable Document Formats.

o DCX for fax files.

o Control files such as .IDF, .EEC, .CSV, .LOF; see Viewing an IDF

document  and Viewing a data control file .
o EscapeE files: the default, this shows all files with extensions detected

by EscapeE.
o Job configurations for custom .INI, .LOF and .JOB files, see Run custom

jobs .
o All files – shows even those files with non-standard extensions.

or type in a file specification, e.g. *.prt.

3. Click on a file name.

4. Click Open. 
EscapeE opens the file at the first page in the print run.

Alternatively:

Select the file in Windows Explorer, drag and drop it onto the EscapeE shortcut
icon on your desktop: see Running EscapeE.  Or 

if the file has been opened recently, select it from the History list  at the foot
of the 'File' menu.

See also Viewing an IDF document .

To close a file:

Choose Close from the 'File' menu.
See also To close EscapeE .
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 Notes

The file extensions .IDF , .LSH , .PRN , .PCL , .PLT  and .RS2  are set up in
your Windows Registry when EscapeE is installed (if they are not already associated
with another program). You may change an associated program (for example, to make
EscapeE your preferred TIFF image viewer) using Windows Explorer: see Associated
programs .

Print files: these may rely on the default properties of the printer e.g. paper type,
font or line spacing. You may need to set the printer defaults manually in order to
display the file correctly, see Configuring the printer defaults .

AFP files: parameters such as default font and JPEG image DPI found within input
AFP files are honored. If an AFP mask is used in conjunction with a CMYK  image
then the default  ICC  setting will be used to render the image as an RGBA  (Red,
Green, Blue, Alpha) image in order to apply the mask and maintain accurate output
colors. See also Substitute fonts .

 Tip:  EscapeE employs standard Windows features: to see how to use these, consult
your Microsoft ® Windows User's guide. You can use the usual Windows mechanism
for keystrokes: for example, keying-in Alt FO chooses from the 'File' menu and shows
the 'Open' dialog.

Links
About viewing pages  
Running EscapeE  
PDF notes  

File format recognition

Normally, EscapeE is configured  to 'Auto format detection'. It recognizes the input
file format based on the file extension being one of the following: AFP, BMP, DCM,
DCX, DDF, EPS, ESCP, GIF, IDF, IMG, JPG, JPEG, PCC, PCL, PCL6, PCX, PDF, PNG, PPI,
PPO, PRE, PS, RS2, RTF, TIF, TIFF, XL, XML, ZJS.
However, if the extension is not recognized then auto-recognition is attempted, based on
the first few bytes. These formats are recognized in this way: AFP, BMP, DICOM, HP-
GL, PDF, PostScript, Printrex, TIFF, Epson (EscP), RS/2, Zenographics©, PCL XL
(PCL6), and DCX/PCX.

If the format is still not recognized as one of these, it is assumed to be PCL5.

When you know that the file to be viewed is in one of the standard formats but its
extension or opening bytes are non-standard, you may configure  EscapeE to treat
an input file as a specific format.

 Tip:  you may open a file from the command line using /INPUT .

Links
Configuring the input format  
File formats list  
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Configuring the input format

The EscapeE 'Auto format detection' feature enables it to open files in many standard
formats automatically, see File format recognition . If you have a specialist file with,
for example, an unusual extension, you may open it in EscapeE by configuring a
specific format:

1. Choose Configuration from the 'Options' menu, or 
press function key F8 to display the 'General' page of the Configuration dialog.

2. Select a 'Format' from the Input drop-down list:

o Auto format detection (the default: see File format recognition ).

o AFP — IBM Advanced Function Printing format

o BMP — Bitmap

o CANON — Canon  BubbleJet & CAPSL

o DDF — RedTitan Dynamic Document Formatter language

o DICOM — DICOM medical image

o ESCP — Epson printer language

Click Options... to display the Options  for ESCP  dialog.

o FORM — Field generation for a form

Click Options... to display the Options  for FORM  dialog.

o GIF — Graphic Interchange Format

o IDF — Intelligent Document Format

Click Options... to display the Options  for IDF  dialog.

o JPEG — JPEG photo format

o PCC — Lineprinter control codes

Click Options... to display the Options  for PCC  dialog.

o PCC,ROW — Lineprinter 'row number' format

Click Options... to display the Options  for PCC  dialog.

o PCL — HP Printer Control Language

o PCX — PC Paint format or DCX

o PDF — Portable Document Format

o PNG — Portable Network Graphic

o PS — PostScript

o PTRX — Printrex

o RS2 — RedTitan Scripting language

o RTF — Rich Text Format

o STAR — Star POS printer format

o TIFF — Tag Image Format

o XIMG — Xerox IMG

o XL — HP PCL 6

o ZJS — Zenographics format.

3. Click OK.

Links
File format recognition  
Input options  
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Input options

Experts may configure EscapeE to apply specialist input options for reading files in
some formats.
These are set up in dialogs accessed from the Format panel on the General  page of
the Configuration dialog:

1. Select the format (e.g. FORM) from the drop-down Input list then click the
Options... button alongside.

2. The Options...  dialog opens:

o If the chosen format does not support any input options, an 'Information'

dialog displays the message "No options available": click OK.
otherwise 

o Enter the parameter string in the edit box.

Click OK to use this setup for the current task only or 
Click Save to use and retain the setup.

Options... dialog

The Input format Options... dialog contains an edit-box in which experts may enter
a string parameter for modifying the configuration used for viewing files in the
selected format. The name of the input module being configured is shown in the
title-bar (e.g. "Options for RTFORMIN") and if options have been specified on the
command-line they will be shown too.

Specifying an input option parameter sets up a symbol in the [PCLVIEW] section of
the RT.INI  file and is equivalent to appending the parameter to the /INPUT
command. A single option may be set up by simply typing it into the edit box: in
PCC  format, for example, entering ROW sets up the symbol RTPCCIN=ROW,

equivalent to the command line option
ESCAPEE /INPUT PCC,ROW  

To set up more than one option in the edit-box, use a space character to separate
them. In FORM  format, for example, enter
CHECKBOX=145 MINFIELD=100 

to set up the symbol RTFORMIN=CHECKBOX=145 MINFIELD=100.

This is equivalent to
ESCAPEE /INPUT 'FORM,CHECKBOX=145 MINFIELD=100'

on the command line (note that quotes are necessary here to include a "space"
separator in the command).

ESCP input module options

DPI n Horizontal resolution, where n specifies the Dots Per Inch.

STEP n Vertical step between graphic rows, where n is 1, 2 or 3.

FORM input module options

ALL Apply the fields to all pages, not just the current page.

CHECKBOX n Maximum size of a check-box, measured in units of 1/600 inch.

KEEP Save the fields on exit from EscapeE.

MINFIELD n Minimum size of a box to be recognized as a field, measured in 1/600 inch
units.

PAD n  Thickness of padding within the box containing the field, measured in units
of 1/600 inch.
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IDF input module options

DEBUG tag, tag... 

 or

Set debug for specified tags

DEBUG CONDITION, REPEAT, PARSE,
COPY, CSV 

Debug specified operations

PCC input module option

ROW To interpret the characters in the first three columns as decimal numbers
rather than Printer Control Channel  characters. The locations of the data-
fields are given by the 3-digit line-number in columns 1,2,3 and, in column 4,
the number of lines to skip before printing.

Links
File format recognition  
Configuring the input format  

Rotating the page

To rotate the view of the page shown on-screen, select Rotate pages from the View
menu and choose an option from the sub-menu 

Clockwise (90 degrees right)

Anticlockwise (90 degrees left)

Upsidedown (180 degrees)

No rotation (cancels all previous rotations)

The options are cumulative i.e. rotating the page Clockwise once then rotating
Clockwise a second time is the equivalent of clicking once on Upsidedown.

This does not change the orientation of the page in the file. You may, however, export
 the file in the orientation shown to any format other than Subset . If a PCL file is

exported or saved as a Subset, the rotation is not preserved.

 Note

If you would like documents to be opened in a rotated state, use the Viewing page of
the 'Options | Configuration...' dialog. See Configuring the view .

Links
Plotter options  
TIFF images file export  
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Choosing the view of the page

You may choose whether to show the whole of each page in the EscapeE window or
just part of it:

Click View on the menu-bar or 
hold down Ctrl and press L.

o Choose Whole Page or press Ctrl J keys to display the page at a size which

fits completely into the window.

o Choose Page Width or press Ctrl K keys to display the page at a size which

fits to the width of the window. Use the up/down arrow keys to scroll  the
length of the page.

o If the page contains a large amount of white space, choose Printed Region

or press Ctrl M keys to view only the parts of the page with items for
printing.

o Choose Printed Width or press Ctrl W to display only the area of the page

which contains items for printing, fitted to the width of the window. Use the
up/down arrow keys to scroll  the length of the area. If the printing extends
beyond the area of the page on which the printer is capable of printing, the
unprintable parts may be marked by a dotted rectangle – see Viewing the
unprintable area .

See also Configuring the view .

Links
Setting the page extent  
Scrolling the document
Viewing page information
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Changing the scale of view

To enlarge or reduce the scale of view

Click the Zoom In button on the Tool-bar to magnify the size of the page on
screen

Click the Zoom Out button on the Tool-bar to shrink the size of the page on
screen

To set a precise scale of view

Choose a size from the View menu's Zoom  list or 

Click the 'Change magnification' button – shown as a Factor or a 
Percentage – and choose a size option from the drop-down list.
(Scale 6 or 100% displays the page at the best approximation to its actual
printed size.)

You may change between Percentage and Factor view in the Configuration dialog.
You may also set up the actual values of the scaling options that you would like to
make available there too, see Configuring the view .

To zoom in on a specific area

Sweep out the area with the mouse. Select Zoom In from the pop-up menu or
press the F4 key.
To zoom out, press the F5 key or select Zoom Out from the right-click pop-up
menu.

 Tip:  Click the scroll bars or use the arrow keys to scroll the page.

Links
Scrolling the document

Setting the page extent

There are several options for defining the extent of the page area to be regarded as
valid. Select Page extent from the 'View' menu then choose one of these sub-
options 

Printable area The area available for printing on a standard HP  printer i.e.
leaving an unprintable border, 1/6" wide, on all four edges of the paper.

Paper size The full size of the specified paper.

Unlimited Not restricted to a paper size.

Links
Standard paper and envelope sizes  
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Viewing the unprintable area

Most printers are unable to print right up to the edge of the paper. You can choose
how this unprintable area is shown by EscapeE: select Unprintable area from the
'View' menu, then choose an option from the sub-menu 

Crop Does not show anything that falls outside the printable area of the page –
any items outside this are not shown, so the unprintable area is left blank.

Outline the valid region Always shows the limits of the unprintable area,
depicted by a dotted rectangle. If there are items in the unprintable area, these
are also shown.

Outline if not blank Only shows the limits of the unprintable area when there are
items in it (these are also shown).

Viewing 'Hints'

A "Hint" is short message that appears on the screen when the mouse cursor is held
over an item on the EscapeE screen. This message describes the function or content
of the item and is particularly useful for new users. Users who are familiar with
EscapeE however, may be distracted by the Hints, and prefer to turn off the Hints .

To view Hints

1. Choose Show Hints from the 'Help' menu.

2. Click Quick or Slow to set the duration for the hints to be displayed from the
sub-menu. The selected items will be ticked.

3. Place the mouse cursor over objects on the screen to display a Hint for a few
seconds.

To turn off the Hints

1. Choose Show Hints from the 'Help' menu.

2. Click None from the sub-menu.

 Tip:  Hovering the mouse over a field on the page shows the name of that field  as
its Hint. An item placed by a Plugin  shows the fieldname and the Plugin name as its
Hint.
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Viewing data fields and tags

EscapeE may be used to extract data from PCL data-streams and documents; see
About exporting data .

The fields and tags are depicted as rectangular boxes with "sizing handles" at the
corners:

       

The default color for the sizing handles may be entered manually into the
configuration file (RT.INI) or on the command line, see Command line syntax.

To view the position of data fields and tags

Select Show from the 'Fields' menu. From the sub-menu, you may choose to
view 

o All of the fields and tags, or 

o only the fields and tags If found on the page.

See also Defining fields and tags  for check-box options on the Definitions
page of the Field dialog  (Ctrl D).

To display field names and tag names along with their boxes on the page,
select Show from the 'Fields' menu and click Show names from the sub-
menu.

To switch off field and tag viewing, select Show from the 'Fields' menu and
choose None.

 A tick indicates the currently selected option.

 Tip:  Select Show field values or Show field details (Fields menu) to add field
information to the Console notebook's Log: see Logged messages .

To view field and tag definitions

1. Select Edit... from the 'Fields' menu. Field names are listed in the Fields list
pane (usually docked on the right of the Field information pane).

2. Tick the Tree box to set up and show the relationships between fields. The tree
can be expanded/collapsed by clicking on the folder icons. To edit the tree
structure, see Fields list/tree.
To view a sorted list of names instead, uncheck 'Tree'. This makes field-names
easier to find and rename.

3. Click on the field or tag name in the list to display the its definition.

o While a field or tag definition is being displayed it is also depicted on the

page with a red outline.

o If the field is a 'child' (sub-field) of 'parent' field(s) then the parent field(s)

are are indicated by cyan marker  points on the page.

 Tip:  Click the 'back'  and 'forward'  buttons at the foot of the dialog to show
the previous page and next page of the document. Click the left, up, down or right

buttons in the  arrow set to scroll the page.
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Viewing font information

The Font Properties  dialog details font and text information on a specific text string
 in the page on view.

The Font Table  presents information on all fonts available to the document. The
information can be broken into lists showing details of all fonts in a selected category.

1. Select one of these options from the 'Fonts' menu:

o Resident Fonts to view 'Permanently Resident Fonts' table, i.e. fonts that

are resident on the system in the RESIDENT.FIF file.

o Fonts in use to view 'Fonts Used by Current Document' table.

o Downloaded fonts to view 'Download Fonts Used by Current Document'

table.

o Substitute fonts to view 'Default font substitutes' table of any fonts for

which there is a default font set up.

To display substitute fonts specifically set up for the current document,
choose Current font substitutes from the drop-down list.

To view Font Properties

1. Right-click the mouse in the text string  that you would like to examine.

2. Select an option from the pop-up menu:

o Choose Font Properties to display the dialog, or 

o Text Details to log  the details and display the dialog.

3. You may choose to Show selected font in red (see also To highlight a
selected font ); click this option again to switch back to normal rendering of
the page.

4. Click Substitute... to display the 'Font substitutes' dialog: see Setting up a
Font Substitute file .

5. Specialists note: if it is a downloaded bitmap font, there is also a button Add
font to character recognition database which opens EEfonts directly.

The 'Font properties' dialog shows these details of the text string  (if they are
specified in the document file):

Characteristic Example

Typeface 16602

Family Arial

Proportional

ID 0

SymbolSet 19U

Size 10 point

Style 0

Weight 0

A description may also given, e.g. Windows symblolset 10 point regular. This

particularly helpful when a Windows font is loaded and found to have the wrong
weight, style etc.. When a downloaded TrueType font contains characters identified as
belonging to an installed font, the description includes "Recognized as font...".

Square brackets around a Family name indicate that the font is not available.
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It also shows how EscapeE has rendered the Text :

Font type Bitmap 300dpi

Name AR10R

Screen font AR10R Prescaled

PDF substitute Helvetica Size 10

Filename I:\REDTITAN\FONTS\pcldload\13950.RFF

Recognized as
font

Arial~Regular 223 known chars

The details in 'Font properties' are those of the text string shown in the Text box (just
above the dialog's buttons). If there are characters in the string coded as hexadecimal
numbers, these are shown in red to minimize confusion with number characters in the
text itself. For example in this text string, the "dollar" sign has been coded as $24:
"$24100@5%"

To highlight a selected font on the screen

1. Select Show selected font in red from the 'Fonts' menu or 
tick the check-box at the top-right of the 'Font Tables' dialog (see above ).

2. Select the font to be highlighted on the screen view of the page from one of the
font tables.

Red is normally used as the highlight color, but any red text in the document that
uses the selected font will be shown in green on the screen instead.

 When this option is active, a tick is placed beside it in the menu.

To highlight substituted fonts on the screen

Tick Show substituted fonts in red from the 'Fonts' menu to color any text
using a substituted font on the screen.

Red is normally used, but any red text using a substitute font will be colored blue
instead.

Font problems

Click the red  triangle warning button on the Tool-bar to see details in the
Error messages  window of the Console notebook.

See also Troubleshooting.

Links
Font tables
Setting up a Font Substitute file
About symbol sets
Changing font and image libraries
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Viewing page information

To view page details

The status bar at the foot of the window shows the information about pages such as
simplex or duplex, page size, orientation, trays, bins – and for PostScript, even the
color and type of paper . Letter(s) in the right-hand box of the status line indicate
that action(s) which have been specified for fields are active on the current page:
see Setting field actions .

It also shows the position of the mouse, and if an area has been swept out, its
dimensions. The position is measured from the top-left corner of the page. (If you
have scrolled the page, or chosen to view only a printed area  of the page, this
might not be the top-left corner of the window!) For example:

X 1234: 300  Y 567: 400

This gives the current mouse position as 1234 units  from the left edge and 567
units from the top edge of the page; an area has been swept out that is 300 units
wide and 400 units high. If you have set up and selected a custom unit rather than
a standard unit, the diagonal distance swept out 500 is also shown. This feature is
ideal for measuring distances between points on any scale in a convenient unit, be
it a route map in miles or an engineering drawing in millimeters that is on view.

To turn off page details, choose Status from the 'View' menu. To turn the feature
back on, select it again; a tick shows that it is selected.

To view graphic and line details

Right-click the mouse on the graphic then select Graphic Details or Line Details
from the pop-up menu. The details will be displayed in the Log  and (briefly) in
the status bar .

Graphic "image" formats are composed of a mosaic of pixels. A 16-byte MD5 hash
of the graphic (specified by a hexadecimal number) is used as an identifier when
a field searches for a particular graphic. For example:
95 dpi JPEG graphic, size 15 x 19, scaled to 94,119 24 bit
C088D0D6CEB8F22BFED542DFEC9A08040F001300
is a graphic image in JPEG format. The example below typical of other graphic
formats such as BMP:
100 dpi graphic, size 120 x 75, scaled to 720,450 24 bit
605F2BA7214AF2182DB42B4EFE8978ED78004B00
The "dpi" figure (e.g. 100 dpi) is the effective resolution of the image on the page
(not the resolution of the original image before scaling).
Graphic images – but not vector graphics  – may be omitted from the screen
view and from exported files using the 'Ignore' Images  option. 

This is an example of "vector graphics" – a set of lines such as a plotter draws:
$Path 1 #3
Endpath
$Path 2 #260
$Path 1 #3
$Path 2 #260

This is an example a shaded block's details:
Shade 2220 x 600 20%
Shaded areas may be omitted from the screen view and from exported files using
the 'Ignore' Shading  option.

See Optimizing the configuration  and Setting General export options .
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To view overlays or macros

You may choose to view overlays  or macros  or neither.

To show overlays choose Overlays from the 'View' menu. A tick will be placed
alongside the option.

o To turn off overlay viewing, click Overlays again: the tick will be removed.

o To switch to viewing to Macros instead, select Macros from the 'View'

menu: the 'Overlays' tick will disappear and the 'Macros' tick will appear.

To show macros choose Macros from the 'View' menu. A tick will be placed
alongside the option.

o To turn off macros viewing, click Macros again: the tick will be removed.

o To switch to viewing to Overlays instead, select Overlays from the 'View'

menu: the 'Macros' tick will disappear and the 'Overlays' tick will appear.

 Tip:  if a file contains only macros and no normal print data then the Macros
option is engaged automatically.

To switch mouse units

The units in which the mouse coordinates are normally shown is defined in the 
Viewing page of the 'Configuration' dialog. To switch to using different units just
for the current session, choose Mouse Coordinates from the 'View' menu then
select one of these sub-options 

1/300" (300 dpi)
1/600" (600 dpi)
1/720" (decipoints)
Inches 
Cm 
n/600" custom unit (see Configuring the view )

– just as you would if you had changed the units in the Configuration dialog then
selected OK (rather than Save).

 Note

When printing extends beyond the edge of the page, an amber warning  triangle
appears on the Tool-bar. This may be clicked to access the Error messages  page of
the Console notebook directly.

Links
Changing the scale of view
Choosing the view of the page
Viewing data fields and tags
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Configuring the view

The way EscapeE looks and behaves when it is opened is specified in the
'Configuration' dialog, which is divided into several pages. Although you will probably
change the view of the document while you are working on it (as outlined in Choosing
the view of the page  for example), this will not change the configuration.

To set the viewing configuration

1. Choose Configuration from the 'Options' menu, or press function key F8.

2. Click the Viewing tab.

3. Set the Initial window option; choose from

o Minimized to place a vestigial EscapeE on the desktop.

o Normal to allow the window to be sized manually.

o Maximized to fill the screen.

4. Choose the Scale units for specifying the Zoom  options:

o Factor scales the page display in integer steps such that 2 is the biggest, 6

is the actual size etc., or 

o Percent to define the scale for the page as percentages of its true size.

5. Select a Zoom option from the drop-down list. You may choose a page
option:
Whole page, Page width, Printed width, Printed region
or a specific scale  option:
In 'Factor' mode: 2, 4, 6, 8, 12, 18, 24.
In 'Percent' mode: 25, 33, 50, 75, 100, 300.

o To add a customized 'Zoom' option to the list, type in a new percentage or
scale factor then click New.

o To remove a 'Zoom' option from the list, select it then click Delete.

6. Choose the Rotation to be applied to the pages before viewing or conversion.
The angles are measured counter-clockwise:

o 0°  No rotation

o 90°  Rotate a quarter turn to the left.

o 180°  Turn page up-side-down.

o 270°  Equates to rotating the page a quarter turn to the right.

7. If using an HP-GL plotter, tick the Override HP GL rotation box if you need to
swap the drawing direction.

8. Blank pages and pages containing only "space" characters are normally
suppressed, but to show blank pages (to facilitate page counting for example)
select Show blank pages. (This feature can also be configured from the
Printing  page.)
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9. To specify the unit to be used for showing the mouse coordinates and other
measurements choose one of the Dimensions options:

o Cm (Ctrl + 1 keys) or 

o Inches (Ctrl + 2 keys) or 

o 1/300" (Ctrl + 3 keys) or 

o 1/600" (Ctrl + 6 keys) or 

o 1/720" (decipoints) or 

o a custom unit: enter a number  in the edit-box /600" to define your own
unit. For example, entering 3.0 sets up the fraction 3/600 i.e. a unit of

1/200 of an inch. The number remains set up in the edit-box even when
one of the other 'Dimensions' options is selected; it may be changed
simply by entering a different value in the edit-box.
This user-defined unit has an additional feature: when it is in use,
sweeping out a rectangle also shows the diagonal distance swept-out in the
status-bar .

10. To shift the contents of the page (measured in the units selected above):

o Enter the distance Right to shift the page horizontally. Enter a negative
distance to shift the page to the left.

o Enter the distance Down to shift the page vertically. Negative distances
shift the page upwards.

11. Define the limits of Page extent from the options in the drop-down list:

o Printable area  The area available for printing on a standard HP printer i.e.
leaving an unprintable border, 1/6" wide, on all four edges of the paper.

o Paper size  The full size of the specified paper .

o Unlimited  Not restricted by size of paper.

12. To configure the way that the unprintable border is shown (many printers do
not print "edge-to-edge"): select one of these options from the Unprintable
area drop-down box:

o Crop  Does not show anything that falls outside the printable area.

o Outline the valid region  Shows the limits of the printable area using a
dotted rectangle. Items falling outside the printable area are also shown.

o Outline if not blank  Shows the dotted rectangle only if the unprintable
area is not blank.

13. Click Save.
If you have a file open, you will be prompted to reload it. The full re-
configuration will be used the next time that EscapeE is opened.

 Tip:  to change the view just for the current session, for example to change the unit
of measurement, click OK instead of 'Save' (then click Yes if prompted to reload an
open file). See also Viewing page information .

Links
Changing the scale of view
Optimizing the configuration
Viewing data fields and tags  
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Optimizing the configuration

Documents often contain information which is not relevant to the job in hand but take
time, memory and window/page area to display or print. EscapeE can streamline
document viewing and export by excluding  specific types of information which you
set up in the General  page of the Configuration dialog. This is, of course, likely to
change the appearance of the document as shown on-screen and in the output file.

The order in which colored or shaded  areas are added to the page can be an issue
when viewing and printing some documents. This is particularly problematical when
shading has been converted to gray-scale. EscapeE overcomes these difficulties by
means of Ignore  and Keep original element order  options.

Setting the 'Ignore' options

Select Configuration... from the 'Options' menu (or press f8) to open the
'General' page of the 'Configuration options' dialog.
In the Ignore panel:

o Images When this option is selected, any images found in the input

document are not displayed on-screen. (In the case of PDF  files, the
images are skipped by the import module, further improving performance.)
If the file is exported, no images are included in the output file. This
speeds file processing and, if images are overlaid on the text, may make it
easier to read.
Vector graphics are not ignored; see also To view graphic and line details
.

Ticking Images may make big savings in file-sizes but also affects the
view of the file significantly – the caption is italicized to draw attention to
its selection!

o Null clips A "null clip" is a clip region of zero width, typically used to

contain information which the User is not meant to see.
When some scanners create PDFs they put OCR  text in the file as null

clips. You may view this OCR text by ticking the 'Null clips' and 'Images'
Ignore options (though it may not be rendered in the ideal font).

o Shading If you can tolerate the absence of shading, selecting this option

results in smaller file sizes on export (shading does not compress well).
See also To view graphic and line details .

o White areas If the first item(s) on the page are filled white path(s), these

are always ignored as they are likely to have been used to aid the laying-
out of the page rather than as "content". Ticking the 'White areas' option,
however, removes all entirely white characters, lines, filled paths,
rectangles and images from the screen view and the output, wherever they
occur in the document. This usually reduces the size of the output file and
ensures that 'hidden' features do not interfere with the rendering of the
document.

o It is usually best to configure EscapeE with the specialist Kyocera !R!

option deselected. If, however, the data for printing actually contains the
string "!R!", you may treat the characters simply as text by selecting this
option. See also Kyocera Prescribe .

o Selecting PJL commands suppresses the action of any PJL commands

present in the original document on-screen and prevents their export. New
PJL commands constructed from them by EscapeE, however, may be
included in the exported file: see Preamble and PJL options .
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Console notebook

The Console notebook brings together technical information about the document on
view and provides a work-space for coding IDF files.

Click the Information  icon on the Tool-bar.

This displays a window – titled with the full-path of the file on view – containing the
Console notebook with a number of tabbed pages:

Document Properties   Information about the document's size, format, graphic
content etc.

Error messages   How to view error messages and problem warnings.

Logged messages   About viewing the logged messages; how to set up the
information to be shown in the log window.

PJL Comments   About viewing Printer Job Language comments in the
document.

Source code   View and search a PCL or IDF document's source text; modifying
an IDF document's control file.

IDF coding   An IDF tab appears when an Intelligent Document Format control
file is being created/edited. If you have more than one IDF open, extra tabbed
pages are provided and numbered.

 Tip:  The Console notebook may be re-sized by dragging the window's border(s).

Links
IDF documents  
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Document Properties

Select Document properties... from the 'View' menu or 

click the Console notebook button on the Tool-bar

The Properties page of the Notebook  shows the type of document – PCL, PDF etc. –
and the file's size and update date. For some formats such as PDF or TIFF it will
include information such as document creator (if present), for example:
COMMENT Creator: EscapeE Document Processor version 10.42E

It also includes the count of graphics, text strings and drawn paths on the current
page. When a file is opened from the command-line , the options, file and path
entered are also shown.

Error messages

The Errors page of the Console notebook  documents any errors, font problems
and warnings.

When a potential problem is detected, the Errors page is displayed and warning

buttons are placed on the Tool-bar. A red warning  button indicates a problem such

as a missing font  or unknown  PCL command;  an amber  button warns of a less
serious error such as printing going beyond the page bounds .

Click a warning triangle button to display the Errors page of the Console
notebook.

If the problem is one that you can ignore, uncheck the Show check-box to hide the
Errors display for your current session. Clicking a warning button re-displays the
Errors page.

 Tips

 If you are Running EscapeE  in a narrow window, pick up the side edge of the
Tools panel and drag it down and across the Tool-bar so that it fits below the Menu
panel. This will ensure that the buttons will be kept in view.

 When paging through a long document, move the Console notebook to the bottom
right-hand corner of the window. Drag its borders to resize it to fit the unused space:
the Console remains in view but does not obscure the view of the page.

The following topics give more detail on specific errors:

Printing beyond page bounds  
Missing fonts  
Ignored fonts or images  
Poor text appearance  
Unsupported download font format  

See also

HP-GL   
PJL  
PRESCRIBE  
Unsupported printer language  
PDF output file not created  
Unknown/Ignored command  

Handling fonts,  Field problems,  Optimizing the configuration , Problem reporting
 

 Technical notes

Errors found on the RT.INI file are logged in the escapee.log: see  EscapeE

configuration symbols .

A # character in the numeric part of a PCL command is ignored but a warning is
given.
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Logged messages

The Log page of the Console notebook  maintains a record of information
requested by the user, such as print runs, graphics, text and field details and values.

To display the Log select Console Log Window from the 'View' menu.

The information is added to the Log throughout the session, even if the file supplying
the information is closed and another file opened. When an import module outputs

messages to the Log page the amber warning button  is displayed.

The Log is cleared automatically on exit  from EscapeE.
To clear the Log manually mid-session, right-click the Log window then select
Clear Log from the editing and navigation pop-up menu.

The Notebook window may be re-sized by dragging the window border(s). Scroll-
bars are displayed when a page is too big to fit in the window.

Pop-up menu options

Copy (Ctrl C) selected text to the clipboard.
Select All (Ctrl A) selects all the text on the current page.
Save Log to prompt for a file name and save the whole log.
Clear Log to discard the contents of the log.
Hide the contents of the Log page.
Suppress Output to cause all output from the log to be suppressed until
unchecked. 

The log is paginated as it is often verbose, so the pop-up menu also contains
navigation options:

Page Up (Ctrl u) 
Page Down (Ctrl d) 

Go to Start of log 
Go to End of log

The Abort option to end the program is also a convenient method of terminating
excessive output.

Fields information

There are two options from the Fields menu which add information to the Log page:
Show field values field-name and value only, e.g.

Page 2
FIELD1:  non-TXT
FIELD2: 10
FIELD3: 2003/10/05
FIELD5: 03
FIELD6: 3

Tip:  "not this page" is put against any fields where the search  criteria exclude
the current page.
Show field details field-name, field-value, Plugin  and some Actions,  e.g.

Fields:
    FIELD1 <none>:  non-TXT
F   FIELD2 <none>: 10
 O  FIELD3 <none>: 2003/10/05
  L FIELD5 <none> "{_Month}": 03
    FIELD6 tesseract: 3
F start a new file
O omit page
L write a log record
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PJL Comments

The PJL page of the Console notebook  show Printer Job Language  Comments
from the document. For example:
 COMMENT Output written by RTPCLOUT version 7.85 at byte 140
 COMMENT Creator: EscapeE PCL Converter version 10.15 at byte 199

These are normally the strings copied from Comments in the original PCL document's
Preamble. Specialists may, however, construct Comments based on data-values
found in the file's fields: see Setting the fields file options .

1. Click the Console notebook button on the Tool-bar or 
select Document properties... from the 'View' menu.

2. The Console notebook is displayed: select the PJL tab.

You may configure EscapeE to propagate PJL Comments through to a document on
export to PCL , PostScript , PDF  and PDF/A  formats.
 Tip:  You may remove unwanted PJL from the output by ticking Do not use PJL

commands: see Preamble and PJL options .

Links
PCL document file export  
Preamble and PJL options  
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Source code

Click the Console notebook button on the Tool-bar and select the Source tab or
 
select Source... from the 'View' menu or 
key-in Ctrl S.

The Source page of the Console notebook  displays a searchable listing of the source
code for a PCL  or IDF  document shown in the EscapeE window – a boon for PCL
specialists and IDF enthusiasts.

PCL tools

The Source files  for a PCL document are usually many pages long: options are
provided so that only the information relevant to the task are shown.

1. Choose how much of the file you would like to be on show:

o This page shows the current page only.

o Up to here shows all the pages up to and including the current page.

o Whole file shows all the pages in the file.

2. Check the information to be displayed from the Options:

o Omit graphics and character downloads: the default, or 

o Omit text and binary data: to show just the commands, or 

o Show all, including binary: to show everything, including binary data

such as graphics in hex.

Check Show command usage statistics as well to append a
summary showing the number of times a command is used.

3. Aids to finding and copying source information may be accessed by right-clicking
the code window to show the pop-up menu:

o Copy  (or press Ctrl Ins)

o Select all  (Ctrl A)

o Find  (F3) to display the Find dialog.

You may search all of the code (the default) or just a selected (highlighted)
segment of code for text  or by line number .
Tip:  clicking the Top button sets the current location of the cursor to the

first character of the first line, deselecting any highlighted segment of
code.

Modifying an IDF page layout

An existing IDF document may be modified using the 'Source' page's IDF tools
and also by using 'drag and drop':

1. Open  an existing IDF document in the EscapeE window.

2. Sweep out an area containing the item (or group of items) to be moved.

3. Hold down the Ctrl key, click-down and drag the item to its new position then
release the mouse button (the item shown in red).
Behind the scenes, EscapeE generates the control file needed to create the
altered document.

4. Display  the Source page of the Console notebook to see the control file that
generated the original document listed.

5. Click Modified IDF: the control file needed to generate the altered document is
shown. This modified document may be saved with the original document's
name or as a new document with a new name, see below .
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IDF tools

An existing IDF file may be altered by editing the code shown in the Source page of
the Console notebook. Existing source code may also be selected and copied to new
IDF files.

You may select parts of the code by holding the mouse-button down while sweeping
over the statements. In addition, there are some frequently-used short-cuts for
finding and selecting statements:

Right-click the Source code window to show the pop-up editing options:

o Select all  (or Ctrl A)

o Select current <FILE  (or Ctrl F)

Use to highlight a file which is defined as a block of statements:
<FILE>
...
</FILE> 

(rather than as a single line <FILE.../> tag).

o Select current <PAGE  (or Ctrl Enter or Ctrl J) 

to highlight the block of statements
<PAGE>
...
</PAGE> 

for the page of the document on view in the EscapeE window.

o Select next page  (or Ctrl Page down or Ctrl N) 

to highlight the block of statements for the page that follows after the one
on view.

o Find  (or F3) 

to display the 'Find' dialog.
You may search all of the code (the default) or just a selected (highlighted)
segment of code for text  or by line number .
Tip:  clicking the Top button sets the current location of the cursor to the

first character of the first line, deselecting any highlighted segment of
code.

o Copy  (or press Ctrl Ins)

Modified IDF displays the source code for the edited version of the document.

Original IDF displays the source code for the original document, i.e. the
existing saved document, before editing.

Click Save to update the original file with the current modifications.

Click Save as... to make a new IDF file.

Click Help to display the Help file. If the mouse was last clicked in a tag , the
Help file opens with the topic related to that element  on view.

See also Editing an IDF document .

Tip:  clicking on an element tag in the window then clicking Help displays the Help
topic for that element.
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To find text
1. Display the 'Find' dialog: click the Find... button or 

choose Find from the right-click pop-up menu or 
press F3 key.

2. Enter the string into the Find edit-box or,
if you have made previous searches, choose one from the drop-down list.

3. These check-boxes may ticked to narrow the search:
o Case sensitive 

o Whole words only 

o Wildcards * and ? 

o Selected text only 

4. To replace the "found" string, enter the new replacement string in the Replace
with box. Clear the box to delete the "found" string.

5. Click:
o Find to highlight the first instance in the code window or 

o  Replace or Replace All.

6. The 'Find' dialog closes to show the found string highlighted in the code window
and a vestigial search panel added above the Source tools.
o A warning note sounds and the dialog remains open when the string is not

found.
Tip:  hovering the mouse over the search panel shows a hint  containing

the 'Find' string.
7. You may now choose to click:

o New Search to display the 'Find' dialog again.

o Find next to repeat the search.

o Replace to change "found" string to the "new" string.

o & Next to repeat the search and replace the string.

o All to change all instances of the "found" string to the "new" string.

Tip:  you may undo "find and replace" action(s) by displaying the 'Find' dialog and
clicking Undo.

To go to a line

1. Display the 'Find' dialog by clicking the Find... button or 
choosing Find from the right-click pop-up menu or 
pressing the F3 key.
The current location ('Line' and 'Column') of the cursor is shown above the edit
box.

2. Enter the line-number into the Find edit-box or,
if you have made previous searches, choose one from the drop-down list.

3. Click 'Go to' Line button.
The code window adjusts its display to show the part of the code containing the
specified line. The 'Find' dialog remains open.
o To make it easy to return to this line again in future searches, you may

annotate the line number:
Click Remember line and enter a string into the 'Description' box, then
click OK.

 Tip:  Ctrl G may be used to call the Find Text  (Go to page...) dialog for selecting
the appropriate block of IDF statements for a page instead.

Links
IDF coding  
Editing an IDF document  
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IDF coding

An IDF page is added to the Console notebook  when an IDF control file is being
created  or edited . Several IDF files may be worked on at the same time, so the
page-tab's text includes a number, e.g. IDF 1, IDF 2 etc.. 'IDF' appears on the

EscapeE menu-bar whenever there are IDF page(s) open in the Console notebook.

Select New  New IDF File from the 'File' menu or 
Click Ctrl I.

When an IDF coding page is opened for a new IDF control file, EscapeE creates a
vestigial file in it:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF ENCODING="UTF-8" UNITS="Inches" NAME="*" BOUNDS="PRINTABLE">
<PAGE>
</PAGE>
</IDF>

If there is an area selected on a document currently on view then it is put into the
control file as a clip region . Further clips may be added from any document on
view: simply open  the next document and select a clip, then click IDF on the
menu-bar to display the Console notebook again. For details, see Creating an IDF
document .

Code may be copied and pasted from other IDF pages in the Console notebook – see 
Editing an IDF document , or it may be entered directly from the keyboard – see IDF
syntax  section. A number of special features are provided for commonly occurring
tasks: see IDF editor options , pop-up menu  and IDF tools .

IDF tools

These tools are provided on the tool-bar (above the code window) of the IDF coding
page of the Console notebook:

Save to save the code to the current IDF file.
Save as... to save the code as a new IDF file (see Editing an IDF document ).
Options... to see more IDF editor options .
New page to start a new page at the cursor position (see also Creating an IDF
document ).
Find... to display the Find dialog and search the code for a text string  or line
number .
Close to close the IDF file. If the code has been edited since the file was last
saved, you will be prompted to choose whether to save it or not.
To view the document generated by the code running in:
o the current EscapeE window – click Show or 

o a separate EscapeE window – click in new EscapeE.

(See also To edit an IDF document .)
Help displays the Help file. Clicking on an element tag in the code then clicking
'Help' displays the topic related to that element.

See also Hot keys .

 Tip:  clicking in the EscapeE window outside the Console notebook hides it. Clicking
IDF on the EscapeE menu-bar re-displays that IDF coding page of the Console
notebook again.

Links
IDF documents  
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Navigating around a document

This section details how to find your way around a document displayed in EscapeE,
use bookmarks and make searches.

How to display the next part/page of a document using the mouse and keyboard:
see Scrolling the document .

How to find and match text and search through pages and data fields: see 
Searching for text .

How to find a particular numbered page: see Searching for a page .

How to set up and find bookmarks: see Using bookmarks .

Scrolling the document

There are several ways of scrolling through the document:

With the mouse

Click to move to the first page in the job.

Click to move to the previous page.

Click to move to the next page.

Click to move to the last page in the job. Note that this action can be
stopped by clicking the Cancel  button on the Tool-bar. (This button only
appears while EscapeE is busy scrolling through to the end: you may not
see it if the document is short.)

Click in the scroll bar to jump straight to the next part of the page or click
the scroll buttons to step through the page incrementally.

On the keyboard

If you use the PageDown key on your keyboard, EscapeE brings the next piece of
text into view. Thus, if you are viewing a whole page, it will show the next page,
but, if you are viewing only part of a page, it will show the rest of the page until it
reaches the bottom of the page. After this it will go on to the top of the next page.
This is useful if you are using 'View Page Width' scale. Similarly, the PageUp key
scrolls up.
If you use the Arrow keys on your keyboard, the page scrolls incrementally.
Pressing the Ctrl and N keys displays the next page (forwards); pressing Ctrl B
displays the previous page (Backwards).

From the 'View' menu

Select Next Page to display the following page.
Select Previous Page to display the preceding page.

When the 'Fields' dialog is open

There are also buttons at the foot of the Field dialog  (Ctrl D):

Click the forward  arrow to display the following page, click the backward  arrow
to display the previous page. These serve to page through the document without
losing focus on the field definitions. Similarly, there are buttons to scroll the page 

 to the left or right, up or down.
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Searching for text

You may search the text and data fields in a document for specific strings:

1. Click the Find  button on the Tool-bar  or 
choose Find Text... from the 'Edit' menu or 
hold down the Ctrl key and press the F key. 

2. The 'Find text' dialog opens: type the text to be searched for into the Text to
find edit-box.

o If you have searched for the same string before in the current session, you

will see it listed in the drop-down box: clicking on it enters the string into the
edit-box.

3. Select Match case if you wish the search to match the case of the text exactly as
you have typed it in. For example, if you type Bank and select 'Match case', the

search will not find bank or BANK.

4. Select Match whole words only if you wish to ensure that sections of words are
not found. For example, if you type count and leave this unselected, the search

will locate accountant as well as count.

5. You may opt to search among specific data fields only: select

o Search defined fields only or 

o Search selected fields only 

(See Defining fields and tags .)

6. You may choose to restrict the search to just part of the job: select

o Search single page only  i.e. the page currently on view or 

o Stop at page number and enter the number of the page at which the search

task terminates.

7. Click First to find the first instance of the text in the document, no matter which
page is currently on view.

o If the text is found, EscapeE displays the page containing the string with a

red box marking its first character and closes the dialog.

o If the whole job is searched but the text cannot be found, the window

displays the first page of the document and "String not found" appears
briefly in the status bar .

8. To search for the next instance of the text, starting from the page on view:

o press key F3 or 

o select Find next from the right-click pop-up menu or 

o re-open  the 'Find text' dialog and click Next.

9. To continue searching from this point

o for the same text again, repeat the step above. Or 

o open the 'Find text' dialog to enter a new Text to Find search string. Click

Next.

 Tip:  when no more instances of the text can be found, the last page of the task
will be on view. To re-display the last instance of 'found' text instead, tick 
Restore position if fail check-box.
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 Notes

Pages "found" are listed in the drop-down box for the duration of the session so that
you can return to them quickly. You may also annotate them as bookmarks which may
be saved for the next session: see Using bookmarks .

The EscapeE text search is fast – the number of the page being searched changes so
quickly that the current page number shown on the dialog may only be updated in
increments of 50 pages! A red progress indicator on the status bar shows the current
search position through the document.

Searching for a page

You may search the document for a specific numbered page and display it in the 
EscapeE window.

1. Choose Go to Page... from the 'Edit' menu or 

click on the page number/arrow  shown on the Tool-bar and select Go to
page... or 

click the 'Find'  button on the Tool-bar or 
press Ctrl G keys.

2. Type the page's number in the Go to page/bookmark edit-box.

o If you only need to find one particular page, tick Close after search check-

box. Unchecked, the dialog remains open for setting up further searches.

3. Press Enter (Return) key or 
click Go to.

4. The page is displayed in the EscapeE window and the its page-number is added
to the drop-down list.

o If you have not opted to 'Close after search', the 'Find Text' dialog remains

open so that further searches for page numbers, bookmarks  or text  may
be made.

When you're done, click Cancel or 

click  to close the dialog.

 Tip:  if you have already searched for the page-number in the current session, you
may return to it by selecting it from the drop-down list.

 Note

EscapeE enables you to view and search the code which generated a PCL or IDF
document as well as the document itself: see Source code .

Links
Scrolling the document
Searching for text  
Using bookmarks  
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Using bookmarks

To assign a bookmark

1. Display the page you wish to bookmark and choose Set Bookmark... from the
'Edit' menu, or 

click on the page number/arrow  shown on the Tool-bar and select Set
Bookmark....

2. The 'New Bookmark' dialog opens, showing the number of the page on view in
its edit-box. Type in the new Bookmark name.
The name is added to the drop-down list for the current session.

3. If you wish to retain the Bookmark names for the next session, tick Remember
Bookmarks. (These will be saved in the current field definitions file.)

4. Click OK.

To find a bookmark

1. Select Find Text... or Go to Page... from the 'Edit' menu. Or 

click the 'Find'  button on the Tool-bar.

2. Scroll down the Go to page/bookmark drop-down list and select a bookmark.

3. The selected page is displayed in the EscapeE window.
The dialog remains open so you may select other bookmarks or page numbers

 to view or enter text  to find.

4. To close the dialog, click its Cancel or 'Exit'  buttons.

Links
Searching for text
Searching for a page
Navigating to a page
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Font set-up

This section covers font issues from installation, configuration and substitution to
technical details of PCL syntax and font attributes.

How to install soft fonts and font packs and download fonts; how to add/remove
fonts from the library: see Installing fonts .

How to install Windows OpenType fonts (.OTF and .TTF files) and change
typeface: see Installing TrueType and OpenType fonts .

How to change the Resident font library folder, Macro library folder and FDL
library: see Changing font and image libraries .

How to change the default font: see Configuring the default font .

Setting up the source symbol set and how to output in a different symbol set:
see About symbol sets .

About character codes and using EEfonts  to set up a database of characters for
exporting to plain text: see Character codes .

How to assign character codes to unrecognized or wrongly coded selected
characters: see Assigning character codes .

How to view the attributes, identification numbers and substitutes for fonts: see 
Font tables .

About 'font selection sequences' used to specify fonts for a printer: see PCL font
selection sequences .

About the use of typeface, weight, style and size characteristics of a document's
fonts as search-tags for data-fields; see Using font attributes as tags .

Description of how fonts may be substituted: see Substitute fonts .

Setting up a Font Substitute file .

Selecting Substitute fonts .

Syntax of a font substitute file .

Wildcards in font substitution .
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Installing fonts

To print a document containing text (not just images of text), the printer must have
access to the font file of every font used in it. These font files may be OpenType fonts

 provided by Windows, individual fonts or font packs  from RedTitan  or
downloaded with the document for installation in the Resident Font Library .

To install soft fonts and font packs

1. Select Install Soft Fonts... or Install Font Pack... from the 'File' or 'Fonts'
menus.

2. Click Browse to locate the folder where the fonts are stored. A table  of
'Likely font files' (such as .RFF) or 'Font packs' (.FIF) are shown.

3. Click to select a font or 
sweep out to select a range of fonts or 
use Select All from the (right-click) pop-up menu.

o To view the characteristics of a font, select it and click Details.

4. Click Add.

To install download fonts in the Resident Font Library

1. Open  the file containing the fonts in PCL download format. (See note  if
adding download OpenType fonts.)

2. Select Save downloaded fonts in the library from the 'File' menu.

o If there are no down-loadable fonts in the file, an information dialog with

the message "No fonts saved" will be displayed: just click OK to end the
installation process.

3. If a download font matches one that has been installed in the Resident font
library already, a dialog will ask you to confirm that it is OK to overwrite it.

o Click Yes or 

o No; this displays your regular 'Save As' dialog. Enter a File name e.g.

DF1.rff then click Save.

This step is repeated for each download font where an identical font is already
installed.
The Same reply to all similar questions check-box is provided to save time
for those jobs containing many fonts which may be treated alike.

4. The 'Installing fonts' dialog will ask you whether to install all the fonts.

o Click Yes: the ID is used as the stem of the file name. Or 

o No to display the 'Save As' dialog. Enter a File name then click Save.

5. The Fonts table  is shown: click OK close it.

To add fonts to font library

1. Select Library folders... from the 'Options' menu.

2. Click Browse to locate the folder where the fonts are stored.

3. Click Show Fonts.
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4. Click to select a font or 
sweep out to select a range of fonts or 
click Select All from the right-click pop-up menu.

o To view the characteristics of a font, select it and click Details.

5. Click Add.
The selected RFF or HP soft fonts are added to the list of 'Resident fonts' in the
RESIDENT.FIF file.

 Tip:  click the Remove button to safely remove fonts from a list  without deleting
them from your system.

Links
Viewing font information  
Font tables  
Changing font and image libraries  
Setting up a Font Substitute file  

Installing TrueType and OpenType fonts

OpenType fonts may be in 'Compact Font' format .OTF  or 'TrueType' format .TTF
(though they are all often referred to as TrueType fonts). They will be installed under 
Windows  only when needed and so to be available for future use, they must not be
deleted.

There are two methods of installing TTF and OTF fonts:

From Windows
Installs any of the available Windows OpenType fonts under EscapeE.

1. Select Install TrueType Fonts...  From Windows on the 'Fonts' menu.

2. Select a Font family from the list of names.

3. Select a font Style from the list.

4. Select/enter a point Size for the font: you will see a sample of text in the
chosen font in the panel below. Note that the selected point size merely affects
the size of the sample – the font will be scalable to any size.

5. If you would like to show a different piece of Sample Text in the font, choose
one from the drop-down list.

6. You may try choosing different font family, style and/or size attributes until you
find the font you require.

7. With the font that you would like to install selected, click Add.

8. If there is no default typeface (in the PCLT table) in the TrueType file, the
typeface dialog will be displayed; enter the typeface number then click OK.

9. Repeat selection of family, style and size attributes steps for each font you
would like to Add.

10. Click Finished.
The Resident font details are displayed for you to see.
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From File 
To install OpenType fonts from TTF and OTF files not currently installed as Windows
fonts.

1. Select Install TrueType Fonts  From File... on the 'Fonts' menu. 

2. You may need to click Browse to locate the folder where the fonts are stored
before the appropriate font-table of 'Likely font files' (extension .TTF or .OTF) is
shown.

3. Click to select a font or 
sweep out to select a range of fonts or 
choose Select All from the right-click pop-up menu.

4. To view the font characteristics, select a font and click Details from the menu-
bar.

5. Click Add.
 Tip:  you may click Remove to safely remove fonts from the list without

deleting the files.

Adding downloaded TrueType and OpenType fonts to the Resident Font
Library

Note that while downloaded OpenType TTF and OTF fonts can be added to the
Resident Font Library, it is not usually appropriate.

This is because the TTF and OTF fonts downloaded with a document usually contain
only those characters needed to output that document. Consequently a font
downloaded from one document cannot be relied upon to provide all of the
characters required for a different document.

1. Open the Font table for downloaded fonts by selecting Downloaded Fonts
from the 'Fonts' menu.

2. Highlight the (first) font to be added.

o To add a block of fonts, hold down the Shift key and click the last font in

the block: this highlights all the fonts in the block.

3. Click Add.

Changing the typeface

In order to match the typeface that was requested in the PCL file, any OpenType fonts
that you install must be assigned an appropriate typeface. You may change the
typeface for any resident fonts by displaying the resident fonts , selecting them
then:

right clicking and choosing Change typeface from the pop-up menu: see Font
tables .

Links
Font tables  
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Changing font and image libraries

Libraries for fonts, images etc. are set up in the 'Font Library Search List' dialog:

Select Library folders... from the 'Options' menu.

Resident font library

Enter a new path in the Resident font library edit-box, or 
click Browse... to select a new path.
Example C:\REDTITAN\PCLFONTS\HP4\ 

The Resident font library folder stores:

Any bitmapped fonts added to the library; these are converted to RedTitan Format
Fonts (RFFs ).

A default font substitution  file DEFAULT.SUB.

The RESIDENT.FIF file, containing the list of the resident fonts.

To change to a different file name:

1.Enter a File name in the edit-box.

2.Tick the Enable check-box to use the named file or 
deselect the check-box to retain the 'File name' but disable its current use.

Resident macro library

The Resident macro library folder stores any saved macros .

Enter a new path in the Resident macro library edit-box, or 
click Browse... to select a new path.
Example C:\REDTITAN\FONTS\MACROS 

Character recognition database

The Character recognition database folder specifies the location of a RedTitan
database (see Character codes ).

Enter the new file and path in the Character recognition database edit-box,
or 

Click Setup to run EEfonts and add a new font to the database.

The default file name TTlib.rtk is used if the file name is omitted, e.g.

C:\REDTITAN\EEFONTS\TTlib.rtk 
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Current FDL library

The Current FDL library box lists the folders which RedTitan Page Designer  scans
to find the resources it needs to produce its FDL forms . On export  to FDL, a
'Download font folder' and a 'Download graphic folder' are specifically created for
storing fonts and graphic images. To reset these folders:

Enter a new path in the Download font folder edit-box, or click Browse... to
select a new path.
Example C:\REDTITAN\FONTS\PCLDLOAD 

Enter a new path in the Download graphic folder edit-box, or click Browse...
to select a new path.
Example C:\REDTITAN\FONTS\IMAGES 

and ensure that they are located in the 'Current FDL library' search list.

 Tip:  click Show Fonts to view the Resident fonts  table.

Links
Handling fonts
Viewing font information
Installing fonts

Configuring the default font

To set up the default font

1. Select Configuration... from the Options menu (or press f8) then select the
Printer tab.

2. Click the  button (beside the 'Font select' edit box).

3. Select the font Family from the drop-down list.
o If you need a bolder font but there is none available in your chosen font

family, EscapeE can simulate a bolder font by thickening the pen strokes:
tick Bold.

4. Enter, or use the spin-arrows to select, a Point size from the panel.

5. Click Accept, then OK to close the Configuration dialog.

Alternatively, specialists may set up an appropriate font selection sequence  for the
default font on the command line using /SELECT .
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About symbol sets

If you wish to extract readable text from a PCL file, it is essential that symbol sets are
specified correctly. EscapeE interprets the characters in the original document using
the symbol set defined on the General  page of the Configuration dialog. Note that
changing the 'Source Type' will set up this symbol set automatically:

Source Type Typical symbolset

Windows driver HP3 – the character codes are adjusted by
3 so that a "D" in the file is translated to
"A", etc.

RedTitan DDF (PrePrinter) none – no translation is required.

RedTitan Datastream Converter 9700

Other Custom PCL output usually requires no
translation but a few drivers require
symbol set HP-1(adds 1 to each code).

There are some printers which make the task of specifying the correct symbol set
more onerous by creating their own ad hoc character codes. To resolve these issues,
the RedTitan EEfonts program enables you to set up a custom character recognition
database from EscapeE, see Character codes .

To change the symbolset

1. Choose Configuration... from the Options menu.
The multi-page Configuration dialog opens with the General page on view.

2. Select a 'Source Type' from the drop-down list (see above ).

3. Select/enter a suitable 'Symbol set' from the editable drop-down list.

4. Click OK; you will be prompted to reload the file.

When EscapeE extracts and outputs text, it can be set up to use a different
symbolset. You may choose to use the standard Windows character codes (19U),
Unicode, or leave it Unchanged.

To output text using a different symbolset

1. Choose Configuration... from the Options menu.
The multi-page Configuration dialog opens with the General page on view.

2. Click Text options....

3. Choose a suitable Symbol set.

4. Click OK; you will be prompted to reload the file.

 Tip:  You may change parameters on other pages of the Configuration dialog
without closing the dialog. Just click Apply before you switch to another page,
otherwise your changes on the Configuration page will be ignored.

 Notes

Changing the symbol set may affect any data-fields and tags set up previously. See 
Field Problems .

EscapeE may be set to recognize the symbolset automatically by selecting <Auto>

from the 'symbol set' list. This feature may be requested on the command line using
the option /SYMSET *
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Character codes

Character codes do not always map directly to a standard symbol set  and so plain
text extracted from a document may not match the characters in the original
document.
Sometimes this is because the font has been downloaded by the type of printer driver
that generates arbitrary character codes. In this case, use the RedTitan EEfonts
program to set up a character recognition database so that EscapeE can do the text
conversion.

Select Set up database for character recognition from the EscapeE 'Fonts'
menu.

See also  Code tables.
If there are just a few errant characters extracted from a document, it may be
because the original document used some non-standard character codes that EscapeE
has not recognized. In this situation you can assign appropriate character codes
directly: see Assigning character codes .

Links
About symbol sets  
Assigning character codes  
TXT export options  

Assigning character codes

The RedTitan EEfonts program is normally used to set up a character recognition
database when an entire font is not recognized. When you just need to recode a few
characters, however, you may do this directly in the EscapeE window:

1. Open  the original document and right-click on the first character to be assigned
a new code.

2. Select Character recognition... (if all characters in the document are recognized
this option is grayed-out).

3. You may enter a Name for this font in the database to be used for identifying
converted codes in the database as belonging to a particular font then click OK.
Or click Ignore.
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4. The 'Character mapping' dialog opens, showing the code currently assigned as a
hexadecimal number. (The name, ID number and TTlib number for the Font are
also given.)

o Type the new hex code to be assigned to the character in the left-hand 

Translated code box. The new character will be shown in the right-hand
'Translated code' box.

o Click Next Unknown if there are unrecognized characters on the page: the

dialog shows the current code of the next unrecognized character on the page.
Type in the new code then press Enter.

Repeat until the dialog reports that there are "No more on the page".

o Click Next if there are characters with codes to be reassigned on the page.

The dialog shows the current code of the next character on the page.

If the code for this character is wrong, type in the new code then press 
Enter. Click Next to step on to the next character on the page.
If the code for this character is correct, click Next to step on to the next
character on the page.

Repeat as appropriate until all characters on the page are coded correctly.

5. When you have finished assigning characters you may

o click OK to close the dialog and accept all the assignments made while it was

open or 
o click Cancel to close the dialog; any assignments made while it was open will

be ignored.

A new character code must be assigned to one instance of each unrecognized
character in each font used by any text that you would like to extract.
Suppose, for example, that you to need change a dollar sign to a euro sign in an
invoice. If the 'prices' were listed using 10pt Courier but 'totals' in 14pt Arial bold, a
dollar character must be assigned in both fonts to extract 'prices' and 'totals' data in
plain text.

Font tables

Comprehensive lists of fonts and information about them may be viewed. The fonts
may be shown all together in one table or split into separate several tables, grouped
into categories .

To open a table

Select Fonts in use, Downloaded Fonts, Resident fonts or Substitute
fonts from the 'Fonts' menu.

Once a table is open you may switch to viewing other font tables by choosing from
the drop-down list of categories. Each row in these tables contains the details  of
one font:

Resident fonts
Fonts in use
Downloaded fonts
Current font substitutes
Default font substitutes

These table categories show lists of filenames:
Likely font files
Font packs
All files

Select a filename then click Details to fill in that font's details .
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Font details

Name  e.g. Courier New, Arial, EETMP5614225.TTF. When a TrueType font is

downloaded, this field will be set to the TrueType font file name (maximum
name length of 63 characters).

SymbolSet e.g. 19U: see About symbol sets .

Size e.g. 12cpi for a fixed-pitch bitmap font, 10pt for a proportional bitmap font or

scaleable for TrueType and OpenType ® fonts.

Spacing e.g. Proportional.

Weight e.g. bold.

Style e.g. italic.

Typeface e.g. 3: see Using font attributes as tags .

ID e.g. 2. When present in your input file, these identification numbers are

allocated to downloaded fonts by some documents so that the font can be
identified using a single unique number rather than by specifying all the
font attributes.

Selection sequence e.g. (s0p0s0b3T: see Syntax of a font substitute file .

Substitution e.g. 9.5pt.

PDF Substitute font e.g. Helvetica-Oblique. A double quote " indicates that it is

the same as the screen font.

Screen font e.g. Arial.

Conversion symbolset e.g. HP3: see Syntax of a font substitute file .

Comments e.g. EETMP5614225.TTF font Verdana Regular.

An * denotes that it is a Substitute font ; you can change the substitute

font by clicking Substitute. Note that the Portable Document Format has its
own preferences for font-matching, e.g. PDF uses 'Helvetica' in place of
'Arial'.
When an oblique (rather than italic) font style is used, the angle of slant
applied is given.

# e.g. 26. The number of elements currently using this font on the current and

previous page (if any).

Header e.g. 21503179515.

Start e.g. 0.

End e.g. -1. 

Note that the 'Default font substitutes' and 'Current font substitutes' font tables
show attributes that match the original font in green and those that do not match
in red, e.g.:

Weight Style

regular oblique 
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To edit font details

1. Click on any item in the list to select it.

o Hold down the Shift key and click another item in the list to select a group

of items.

o To select all items, click Select All button or right-click and choose Select

all fonts.

2. Selected items are highlighted on a light blue background: right-click to open
the pop-up menu, then choose from these options:

o Show font details when viewing 'Likely font files', 'Font packs' and 'All

files' tables: see Viewing font information .

o Add to resident library: see also Installing fonts .

o Remove from resident library without deleting file from the system: see

also Installing fonts .

o Change Style: enter the new style value, e.g. 1 (Italic). See also see

Using font attributes as tags .

o Change substitute font to open 'Font substitutes' dialog: see Setting up

a Font Substitute file .

o Change Symbolset: enter the new symbolset ID, e.g. 10U then click Save

font. See also About symbolsets .

o Change typeface: enter the new typeface number, e.g. 3 (Courier) then

click Save font. See also Using font attributes as tags .

o Change weight: enter the new weight number, e.g. -3 (light) then click

Save font. See also Using font attributes as tags .

o Save list to open the 'Save As' dialog and copy the table text to a new file:

enter a 'File name' for the new file e.g. MyFonts.txt then click Save.

o Show font sample: any bitmap samples are shown by EscapeE but

scalable fonts are sampled by the FONTEDIT  program if it is found in the
EscapeE software folder (rather than by a font viewing program in your
Windows system).

o Add font to character recognition database: this is an option to enable

experts to include fonts that they know to be sound in the TTLIB database
– see EEfonts.

3. Highlighted font(s) in the Resident, Default font substitute, Current font
substitute or Font pack lists can be deleted from the list (but not your system)
by clicking the Remove button.

 Tip:  To allow fonts to be substituted, tick Enable substitutions box; see also
Setting General export options .

Links
Viewing font information  
Installing fonts
Changing font and image libraries  
Handling fonts  
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PCL font selection sequences

Printers use "font selection sequences" to set up their fonts. In EscapeE, Users select
appropriate fonts from font tables  and dialogs  – the sequences are constructed
automatically.

Technical notes
In the PCL language, a font is selected either by its characteristics  or, if it is a
downloaded font, by a numeric ID  that was assigned when it was downloaded.
Many documents, however, specify their fonts by name. RedTitan products (e.g. DDF

, DSC ) manage 'named' fonts using the alphanumeric ID command:
Escape &n#WFontstring

where string is the name and # is the byte count of Fontstring. For example
Esc &n9WFontArial

This is particularly useful when a document uses library fonts only, see PCL export
options . Using this mechanism, EscapeE can uniquely identify matching fonts in its
library, independent of the printer (printers ignore the command).

Where standard character names occur in AFP input, Unicode values are assigned
automatically.

Selection by ID
The command is 
Escape (<id>X 
where <id> is a number in the range 0 to 32767. 

Selection by characteristics
The command is of the form 
Escape (s<prop>p<pointsize>v<pitch>h<style>s<weight>b<typeface>T 

where:

<prop> is 1 if proportional, 0 if fixed pitch;

<pointsize> can have up to two decimal places and specifies the height in points;

<pitch> can have up to two decimal places and specifies the pitch in characters
per inch (CPI);

<style> integers, e.g. is 1 for italic, where 0 is a regular upright style: see list ;

<weight> is in the range -7 to +7, where 0 = normal: see list ;

<typeface> is the name of any RFF  or TrueType  font currently installed or your
system or 
a 12-bit value with a manufacturer code in the higher bits. For example,
Courier would be '3'; when the code for Compugraphic (the supplier of the
resident fonts on an HP printer) is added, the resulting code would be 4099.
See list .

It is not compulsory to specify all the above characteristics, in which case the
sequence should be terminated on an UPPER CASE letter. The sequence is shown in
the font list , with any unmatched characteristics shown in red. For example:
(s0p0s0b3T

The sequences above are described in terms of the primary font, and the secondary
font uses similar syntax – but with right bracket instead of left bracket e.g.
Escape )10U

The 'shift out' (hex 0E) character then selects the secondary font, and 'shift in' (hex
0F) the primary.

Links
Fonts used by EscapeE  
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Using font attributes as tags

You may set up search tags  so that data-fields may be recognized by particular
characteristics of a font, see Characteristic matching , below. For example, you
might locate a field for a "product number" by searching for tag text with a barcode
symbolset, or a "cost" field which is in a bold font.
Specialists will recognize these characteristics as PCL-style font attributes.

Characteristic matching

PCL fonts are selected by matching the requested characteristic with the same
characteristic in the available fonts. Characteristics are selected using the order
below:

1. Symbol set .

2. Spacing: 0 = fixed, 1 = proportional
3. Pitch: size in 'characters per inch'.
4. Height: size in 'points' (1/72 inch).
5. Style .
6. Stroke weight .
7. Typeface .

For more information please see https://www.pclviewer.com/resources/
font_selection.html.

Symbol set

For example:

0E Roman Extension code page 1050

0Y 3 of 9 barcode

4U Roman-9

8M Math-8

10U PC-8 code page 437

12N Latin/Greek code page 28597

14G PC-8 Greek Alternate code page 437-G

Style

0upright (normal) 2oblique (slanted).

1 italic 5 compressed italic

4 condensed 24expanded

32outline 64 inline

128 shadowed 160outline shadowed

Weight

0 standard (normal)

3bold -3 light

7maximum (black) -7minimum
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Typeface

0 Lineprinter

3Courier 4099

4Helvetica 24580

5Times 4101

 52Univers 4148

Links
Commonly used fonts  431
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Substitute fonts

Setting up your own 'substitute' fonts to replace those supplied in the original
document is normally a job for experts, but you may avoid much of the technical
detail using an EscapeE ".SUB" Font Substitute file.

Matching font attributes to set up a Font Substitute file; renaming substitute
fonts: see Setting up a Font Substitute file .

Choosing the substitute fonts for viewing on-screen and printing in PDF and PS
formats: see Selecting substitute fonts .

Syntax of a font substitute file  describes .SUB files and their keywords.

About Wildcards in font substitution  with examples of /SUBST and /SUBSTDEF
options.

Using the original PCL fonts in a PDF, for example, may not be desirable since
incorporating the font in the PDF may make it quite large, particularly in the case of
bitmap fonts. You may use standard Adobe  fonts or any of your Windows  fonts for
substitution, but note that Windows fonts will only work on systems that also have
these fonts. These substitutions will be used when exporting to Postscript or PCL  as
well as PDF.

PCL note

When a PCL file is opened, EscapeE searches for its substitution file using the
following order of priority:

i. the file specified  by the /SUBST  option. If the SUBST symbol has not been
set, then:

ii. a file with the same name as the input file but with extension .SUB. If the .SUB
file cannot be found:

iii. the file specified  by the SUBSTDEF symbol in the PCLVIEW section of the INI
file. If this symbol has not been set, then

iv. a file called DEFAULT.SUB in the same folder as the input file is used.

For example, if the calling line was
escapee /SUBST *.sub /SUBSTDEF c:\escapee\default.sub

or the equivalent definitions had been configured previously then if a file xxx.pcl is

opened, EscapeE will try for a file xxx.sub and if that does not exist, use file c:

\escapee\default.sub. Note that if the path is omitted from either specification

then EscapeE will look in the folder of the PCL file. Hence the command
escapee /SUBST default.sub /SUBSTDEF c:\escapee\default.sub

would look for a file called default.sub in the folder of the PCL file, and failing that

revert to the one in folder c:\escapee.

More complex possibilities include partial wild cards e.g.
/SUBST ??def.sub

which would use the first two characters of the PCL file name to construct a font
substitute file name, so a file xxx.pcl would use xxdef.sub
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AFP note

If fonts are not included in an AFP datastream, you may set up substitute TrueType
fonts to be used in place of any given original coded font name. Create a file named 
afpsubstitutefonts.txt in the same directory as the RT.INI  file using the

syntax:

CodedFontName,SubstituteTruetypeName,size
where size is specified in units of 1/100 point.

Optionally, this may be followed by:
,B for Bold or 

,I for Italic.

Comments must be preceded by a semicolon.
For example:
  X1H210AC,Arial,1000
  X1H2106C,Arial,600 ;6 point 
  X1H410BC,Arial,1100,B ;11 point bold 
  C0HE09I0.T1HEL500,Arial,900,I ;9 point Italic

Links
Viewing font information  

Setting up a Font Substitute file

1. Open the 'Font substitutes' dialog by:

o Right-clicking the mouse on the piece of text and selecting Font Properties

from the pop-up menu; click Substitute.... Or 

o Select Substitute Fonts... from the Fonts menu. Select a font  from the

list then click Edit. Or 

o If you have any other Font table  open already:

select a font then click Substitute, or 

right-click a font then select Change substitute font from the pop-up
menu .

2. Set up the Match criterion: tick the attribute(s) of the font(s) in the input
document that identify which font(s) are to be substituted, see Select attributes

3. The current substitute Screen font along with its Style and Weight are shown in

the 'Substitute' panel. To change these, click the arrow  button: see Selecting
substitute fonts .
A sample of the chosen font is shown in the panel below: see Sample text .

4. If a substitute PDF font for printing PDF or PostScript output has been set up
already, it's name is shown in the edit box.

o To set up a new font or choose a different font, click the arrow  button to

display the 'Fonts' dialog: see Selecting substitute fonts .
On closing the 'Fonts' dialog, the 'Font substitutes' dialog shows the name of
the chosen font with a tick to indicate that it is selected.

o You may assign a different name to the chosen font by editing the 'PDF font'

box. This is the name that the document will use to call the font; it does not
change the name of the source font shown in the Fonts  dialog and Font
tables .
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5. Choose whether to make the updates to:

o a custom Specific Font Substitute file or 

o a Default Font Substitute file.

6. Click OK to save the setup to the Current Font Substitute file or 
click Save as... and set up a new .SUB file then click Save.

Select attributes

The 'Match' panel shows the attributes supplied for the selected font, e.g.

Attribute Value
Typeface 16901
Name Times New Roman
SymbolSet 19U
Size 16 point
Style 1
Weight 0

If you would like to set up a substitute for a range of fonts, deselect the check-
box(es) of corresponding attribute(s). The Number of matched fonts shows how
many of the fonts in the current document will be affected by the substitution. You
may notice that this number increases as more of the fonts in the document
conform to the criterion. For example, if just a size of 8 point were specified, then

the substitute font would be used for any 8-point font in the document.

Sample text

A window shows a sample of text in the selected  substitute screen font. You may
change:

the Scale at which the sample text is shown in the window: use the spin
arrows to adjust the apparent size.

the Sample text shown in the window: select a string from the drop-down list.

If the characters shown in the sample text are not the same as those you have
chosen to be displayed, you may have an inappropriate symbol set selected: try
choosing another from the Conversion drop-down list.

o It is sometimes necessary to change the 'Source Type' to set up the correct

symbol set: try Windows driver or other from the General  page of the
Configuration dialog (F8): see About symbol sets .

If you need further help, contact the RedTitan support team: help@redtitan.com.

Links
Font tables  
Selecting substitute fonts
Syntax of a font substitute file  
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Selecting substitute fonts

The 'Fonts' dialog is used to choose font(s) for use in place of any font matching the
criterion  set up in the Font Substitutes  dialog. You may set up the different fonts
for printing  and on-screen  or the same  font.

To set up a substitute screen font

1. Click the 'Screen font'  button on the Font substitutes  dialog to display the
'Fonts' dialog.

2. Choose TrueType to use outline fonts  installed in the Windows library or
Other.

3. Select the Font family and Style for the new substitute screen font.

4. Enter/Select a point Size.

5. You can check the appearance of the selected font in the Sample window at the
foot of the dialog.

o  to change the characters on view, choose from the drop-down list of 

Sample text strings.

6. Click OK to close the 'Fonts' dialog.
The Font substitutes  dialog will show the name of the font with a tick to
indicate that it is selected.

To set up PDF and PS substitute fonts

To set up the same substitute font for both screen and PDF/PS use, set up the
substitute screen font  then tick Same as screen font. Otherwise:

1. Click the 'PDF font'  button to display the 'Fonts' dialog.

2. Choose TrueType to use outline fonts  installed in the Windows library or
Acrobat Standard to use the core PDF fonts, located elsewhere on your
system.

3. Select the Font family and Style for the new substitute screen font.

4. Enter/Select a point Size.

5. Check the appearance of the selected font in the Sample window.

o To change the characters on view, select from the drop-down list of 

Sample text strings.

6. Click OK to close the 'Fonts' dialog.

7. The selected font's name is entered into the PDF font box on the Font
substitutes  dialog. For convenience, you may edit the name shown in this
box without changing the actual font name selected in the 'Fonts' dialog.

PCL note

The PCL box allows characteristics to be specified which are only relevant to PCL.
These are by given in the form of a PCL selection string  or part of a PCL selection
string. For example, a symbol set such as (8U or a non-standard style or weight

like (s4B. The selection sequence is used when trying to match against the EscapeE

 library fonts  (and is also used if exporting to PCL ).

 Tip:  if Fonts  dialog is displayed overlapping the Font substitute  dialog, you can
drag the Fonts dialog away by its title-bar. You may then be able to view the Font
substitutes sample window  at the same time, for ease of comparison.

Links
Syntax of a font substitute file  
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Syntax of a font substitute file

A Font Substitute file  (.SUB) consists of a number of sections, each section

specifying the criteria for matching requested fonts to substitute fonts.

Each section starts with the keyword RTFONTSUBST. Any text following RTFONTSUBST on

this line is treated as a comment.

This line is followed by a number of lines each consisting of a keyword  and a string.
The string must be enclosed in quotes if it contains any spaces. You may use wildcard
font names in this string, e.g. *bold would select all fonts with names ending in 'bold'

and *new* in the font name would select all fonts with names such as 'Times New
Roman', 'Courier New' etc.. See Wildcards in font substitution .

Keywords

MATCH 'fontname' where fontname may be wild-carded with * or ? for matching

against the name of a downloaded font.

SELECT 'sel' where sel is a selection sequence defining the characteristics to be

matched. The syntax is as for the PCL font selection but with no escape
character e.g. (10U (s1p0s0B. The 10U in this example is the symbol set; for

a description of the other parameters see PCL Font Selection Sequences .

NAME 'fontname' specified the substitute font name to be used in a PDF (or in
PostScript output). 

SUBST 'sel' specifies the selection sequence to be used for PCL output.

TTNAME 'fontname' specifies the TrueType font to be used on the screen.

CONV 'symbolset' specifies the symbol set  to be used for character code
conversion when extracting text. This could be null (no conversion), HP3 for a

Windows driver or perhaps EBCDIC or -29 in some cases.

HEAD 'MD5string' specifies the MD5 signature of the font

This is an example of a typical section in a font substitute file (labelled with the
comment Arial):

RTFONTSUBST Arial
MATCH: 'Arial'
SELECT (s1p0s0B
SUBST (s16602T
NAME: 'Helvetica'
TTNAME: 'Arial'
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Wildcards in font substitution

There are two command-line options which allow the name of a file containing font
substitutions to be given: /SUBST  specifies the file to be used in the current run,

whilst /SUBSTDEF  allows a default file to be specified for use when no /SUBST is

given. These commands can contain wildcards; for example the command
ESCAPEE /SUBSTDEF *.sub

would look for files with the same stem as the data file but extension .sub and in the
same directory as the data file. 

Simple substitute lists can be set up from the Font Substitutes  dialog or from the
'Font tables' .

Example
A typical substitution file for use with Datastream Converter (which preserves the
Xerox font names in the PCL file) might contain
RTFONTSUBST Kosmos
MATCH: 'RK1*'
NAME: 'Helvetica'
RTFONTSUBST Kosmos Bold
MATCH: 'RK2*'
NAME: 'Helvetica-Bold'
RTFONTSUBST Titan
MATCH: 'R??TI?'
NAME: 'Courier'
RTFONTSUBST Titan Bold
MATCH: 'R??TB?'
NAME: 'Courier-Bold'

The above file specifies that fonts with names beginning with RK1 will be substituted

by Helvetica in any PDF or PostScript output. Names such as R01TIP, R10TIL etc.

will be substituted by Courier and R01TBP, R10TBL etc. will be substituted by Courier

Bold. Substitutions are saved in a file with extension .SUB.

Instead of (or as well as) the NAME parameter, one can specify a selection sequence

that must be matched e.g.
RTFONTSUBST
SELECT: esc '(19U' esc '(s0p3T' NAME: 'Courier'

Any fixed-pitch typeface 3 (Courier) font in 19U symbol set will be matched by this
specification.

Comments (i.e. anything after RTFONTSUBST on the first line of a section) are

optional.

N.B. the wildcard tests are applied sequentially, so the order may be important.

Links
Substitute fonts  
Wildcards and filenames  
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Save and copy

In addition to viewing and transforming files, EscapeE can generate new ancillary
files, see topics below, and create composite documents using its Copy & Add
selection to IDF feature, see IDF documents  section.

How to create a fresh PCL file using parts of an original file: see Saving pages to a
PCL file.  

How to change the layout of a page: see Rearranging page contents.  

How to save an image found on the page; how to copy all or part of the text on a
page to clipboard: see Copying page contents.

Specifying measurements for extracted text copied to clipboard: see Extracted
text options.

How to save macros and create new macros, to use macros from the command
line: see Saving macros.

How to generate XSL, CSS and HTM style sheets for XML data: see Creating XML
stylesheets.  

Saving pages to a PCL file

The Save subset... command may be used instead of the Export... command with
the Format set to Subset; the options are the same in either case.

To save pages to a PCL file

1. From the File menu, choose

o Save Subset... or

o Export... then select Subset as the Format.

2. Set up the Page number range of the pages in the job which you want to
export, see Selecting page ranges.

3. If Do not overwrite files is ticked, EscapeE adds a number to the new output
file name if there is an existing file of the same name already present – see 
Overwriting files.

4. With Subset already set as the Format, a wild-carded  filename (with
extension .PCL) and folder are supplied. To specify a different filename or
extension, type in the new name. To select a different folder to store the file,
use the Browse button.

5. Tick the Force monochrome check-box if required.

6. Tick Run the associated program after creating the file if you would like
EscapeE to open the file immediately using your preferred program (EscapeE is
the obvious program of choice). See also Associated programs .

7. Choose the Fonts to be downloaded:

o fonts from the input file, or

o Any used library fonts to include any library fonts required by the
document.

8. Click OK.
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Notes

You can adjust the font download options when saving/exporting a subset. Normally
EscapeE assumes that all download fonts are needed and so 'fonts from the input
file' is selected. You may wish to deselect this, for example, when you are in the
middle of a print run and the fonts have already been downloaded to the printer.
This will save download time.

If the file is shown in a rotated state, the rotation  is ignored when it is saved or
exported as a Subset.

 Tip:  PCL files that have been repeatedly edited and updated often accumulate
redundant code and unnecessary font downloads. By running such a PCL source file
through HP  PCL Export  instead you can reprocess the file and produce tidy,
efficient code again.

Links
Saving macros

Rearranging page contents

The layout of a page may be changed by sweeping-out 'clip-area' fields then using the
mouse to drag-and-drop them to a new part of the page.

1. Define an area on the page containing the text, images, drawn paths etc. to be
moved: hold the left mouse button down, drag out the area then release the
mouse button.

2. The swept area is shown outlined in red. Hold down the Ctrl key and click down in
the area: the outline changes to blue.

Tip: you may rearrange the page contents without changing the original
document by holding-down the Shift key as well as the Ctrl key.

3. Drag the area to its new position on the page and release the mouse button; any
features recognized by EscapeE within the area are dragged along by the same
distances.

4. Normally the area is defined as a field in the page on view only; to define the
same area as fields in every page of the document instead:

4.1. Open the 'Field' dialog and display the area's field definition .

4.2. Deselect This page only option.

 Notes

Behind the scenes, EscapeE uses the MoveText  plugin to relocate the clip-areas. If
you have enabled the plugin then the new layout will be preserved; if it is 
disabled, the change will be temporary until the page is reloaded.

 Tip:  In addition to rearranging the areas on the current page, you may add areas
copied from other pages – see Creating an IDF document .

Links
Copying page contents  
Using plugins  
Moving and sizing fields and tags  
Composite document wizard  
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Copying page contents

You may copy an entire page as a single image, see Printing pages as images , or
individual images found on a page, see below . You may copy all  of the text on a
page, or just a part  of the text. The text is placed in the clipboard ready for pasting
elsewhere; see also Extracted text options .

To save an image

An image on a page can be simply saved as a TIFF or PNG file:

1. Right click on the graphic and select Save graphic from the pop-up menu.

2. A standard file setup dialog opens, headed 'Graphic' along with the 'width x
height' of the image in pixels. Enter a File name for the new image.

3. Choose TIFF or PNG as the image format.

4. Click Save.

To copy some of the text on a page

First you must select the piece of text to be copied: selected text is shown in a
rectangular box with transparent sizing handles, for example 

Use the mouse to sweep over the piece of text for copying. Then:

o Choose Copy from the pop-up menu or 

o Choose Copy from the 'Edit' menu.

Similarly, you may copy the whole page by choosing Select all from the 'Edit' menu
instead of sweeping-out an area, but there are more efficient ways: see To copy all
of the text on a page  below.

To copy all of the text on a page

When there is no text selected, all the text on the page may be copied to the
clipboard, even if only part of the page is on view in the EscapeE window.

Choose Copy Page from the 'Edit' menu or 

key-in Ctrl Alt C or 

right click on the page and choose Copy Page from the pop-up menu.

 Tip:  to create a new document from parts selected from existing documents, try
using the IDF  Copy & Add selection to IDF feature: see Creating an IDF
document .

Links
Saving pages to a PCL file  
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Extracted text options

There are some specialist options which you may configure for text extracted and 
copied  to clipboard.

1. Select Configuration... from the Options menu or 
Press F8.

2. The Configuration dialog appears with the General page displayed: click Text
options....

3. In the 'Text extraction' section, you may choose to:

o Define the inter-line spacing to be used when outputting the extracted text.

Enter a number in the Line height box: units are set up on the 'Viewing'
page – see Configuring the view . If the box is left blank then the vertical
spacing is taken from the font of the text found in the original document.

o Define the minimum vertical difference between the baselines of two words

for them to be deemed on different lines.
Enter a value in the Minimum line height box.

o Define the top of the character cell as the vertical reference point rather than

the baseline.
Tick Align using top of cell. This may be advisable when the baseline
reference changes mid-string, e.g. for superscript characters.

o Define the minimum horizontal distance between two characters for it to be

deemed a word break.
Enter a value in the Minimum space width box. If the gap is more than this
value then one or more spaces will be inserted in the extracted text. The
default size is 33% of the 'Space width'.

o To ignore downloaded space character's width and use the cell width instead,

tick Space width = cell width.

o To ignore downloaded character widths and use widths calculated to fit the

raster instead, select Calculate character widths.

4. Click OK.

Links
Saving pages to a PCL file  
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Saving macros

EscapeE not only enables you to save  any macros  which have been downloaded
with a PCL document, but also to create  new macros from a page of the document.
These are placed directly into the Resident macros library, emulating a printer's
filestore. Page(s) may also be exported  as .MCR or .PCL files to other locations.

Saving existing macros

To save any macros found in a file:

select Save downloaded macros in the library from the 'File' menu.

Message(s) will be logged  will confirm that the macro has been created. EscapeE
stores the macro in the Resident macro library as a file named xxx.MCR where xxx is

the macro number  – no conventional output stream will be produced.

Creating macros

In most cases the best way to create a new macro is to export the page(s) to be
saved in .PCL  format: see PCL export options . The resulting output will be
completely rewritten in a style that uses mainly HPGL. For cases where the original
PCL is straightforward and does not rely on previously downloaded fonts, palettes
etc. there is another mechanism which merely copies the original PCL of the page
with the appropriate start macro command at the beginning and an end macro
command at the end. There are two ways to invoke this – either 

Select Save page as macro... from the 'File' menu. Enter a number  for the
macro in the File name box then click Save.
The Console window will confirm that the macro has been created, e.g.
Saving page as macro 123
Creating C:\REDTITAN\FONTS\MACROS\123.mcr
1 page

Or, to save a single page as a .MCR  file:

1. Select Export... from the 'File' menu.

2. Select As a macro format.

3. Enter a File name and its path.

4. Enter a Macro identification number.

5. Click Save.

 Notes

If you attempt to Save page as macro when the source file already contains a
macro, you will be prompted to export  in PCL format and define the macro
number in the PCL options  dialog.

The command line option /MACRO  exports the macro and sets the PCL  macro
option to Permanent. E.g.
escapee test.prn /macro 123

A batch file may be used to create a PCL macro from a non-PCL file by specifying a
subsequent /HP  option.

100 446

100

100

63

446

167 169

446

446

167

169

384 169

384



101Save and copy

 Technical notes

When the macro is opened in EscapeE, its identification number is shown on the Tool-
bar . It may be invoked in a command such as 
{escape}&f123Y{escape}&f3X

To include it in the Resident macro library it would need to be copied to the
appropriate folder with the name 123.mcr.

This is the search order used for finding the folder in which Macros are stored:

1. A /MACROS  option on the command line or in the [PCLVIEW]  section of the

RT.INI file.

2. The RTPCLMACROS  environment symbol in the [REDTITAN]  section.

3. A folder named MACROS in the 'library root folder'.
The 'library root folder' is determined as follows:

a. From the RTLIBROOT  symbol. If it does not exist, then

b. if an "RTFDL" symbol specifying a folder with subfolder \* is found then that

folder would be used. For example:
RTFDLLIB=D:\REDTITAN\PRINTERS';D:\REDTITAN\FONTS\*\

yields folder D:\REDTITAN. 

c. Failing that the folder given by INSTALLROOTDIR  with sub-folder MACROS is

used.

Links
Export formats

Creating XML stylesheets

When EscapeE is used to Export data fields to XML , you may opt to output the
stylesheets which organize the data as well.

In the Export  dialog (Ctrl E, Format XML data fields), tick Create XSL, CSS
and HTM files option. Three extra files are generated: for example, if the stem of
the output filename is OUTPUT, then: 

o OUTPUT.XSL is an XSL stylesheet defining the fields;

o OUTPUT.CSS is a cascading stylesheet defining the positions of the fields on

the page, based on the top-left corner of the area being searched for the
original field;

o OUTPUT.HTM is an HTML file which ties these files together with the XML file

and uses a navigation-bar supplied by EENAVBAR.HTM. Both of these HTML

files are independent of the data and are copied from EEDATA.HTM and

EENAVBAR.HTM in the RedTitan Software folder if they do not exist already.

Links
Exporting data fields to XML
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Printing pages

EscapeE can output documents suitable for printing on a wide range of printers, from
small desktop models to large, network-connected production printers.

How to send pages to a printer or a file: see Printing .

Converting pages to images for printing; scaling and cropping pages for printing:
see Page imaging, scaling and cropping .

EscapeE can rotate, scale and order pages automatically to create Booklets and 2-
ups .

How to change the default printer; notes on printer-drivers and printer
configuration instructions: see Printer Setup .

How to set up EscapeE to print the output you want on the printer that you will
actually use: see Configuring the printer defaults .

Associating paper tray numbers and descriptions: see Media definitions .

How to configure Simplex and duplex printing options .

Setting up pens and rotated graphics to configure EscapeE to emulate a plotter:
see Plotter options .

Using EscapeE instead of the Windows printer-drivers for PCL, PDF, PS and XPS:
see Direct printing .

Links
Export files  
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Printing

You may send output to a file or a printer from the EscapeE 'Printing' dialog using the
Windows driver, see below . Alternatively you may output directly to a printer
without using the Windows driver: see Direct printing .
To set up the printer to be used by default, see Printer Setup . To set up the default
configuration for printers, see Configuring the output printer's defaults .

1. To show the 'Printing' dialog:

o Choose Print... from the 'File' menu or 

o hold down the Ctrl key and press P.

2. The preview panel displays a scaled image of the 'side' of paper it is configured to
print. This is usually one 'page' but when a '2-up' or 'Booklet' option is selected
, a pair of pages is shown.

o If the file uses more than one side of paper you may display their previews

using the spin-box at its top-left corner.

3. Select the Page number range that defines which pages are to be printed (see
also Selecting page ranges ).

4. Enter the number of Copies of each selected page to be printed.

o Tick Collate to print one copy of each page in sequence then repeat, instead

of printing all copies of the first sheet then all copies of the second sheet etc.
(if the printer allows).

See also Configuring the printer defaults .

5. If you choose to Print to file instead of a printer, a new edit box is shown
containing a default File name. You may key-in a new name or use the
Browse... button to set up a path in the usual way.

6. Tick Print as an image if appropriate: see Printing pages as images .

7. If the content is too big to fit on the page you may tick Scale to fit and/or Crop
as required: see Page imaging, scaling and cropping .

8. Instead of printing one page per side of paper, you may opt to print the file 2-up
or as a folded-page Booklet; see Booklets and 2-ups . You must also set up a
paper-size:

o When A3 paper is to be used for printing two pages per side, tick the A3

check-box; otherwise 

o click Setup... and select a paper-size  from your standard Printer Setup

list.

9. Select a Printer from the drop-down list. This should be the printer that will be
used unless you have ticked Print to file  – in which case, select a type of printer
that would set up appropriate format parameters for the output file.

o To change the default printer  and its settings, click Setup....

104

115

107

109

104

129

110

105

105

106

432 107

104

107



105Printing pages

10. The source PCL tray number specified for the document is shown in the spin-box
with its designated output Printer tray described alongside: see also Media
definitions .

o To use a different combination of trays, click the spin-box arrows and/or

choose another printer tray from the drop-down box.

Tick Override PCL tray to feed all media from that tray.

To keep this combination for next time, click Save.

o Alternatively, you may print the document using different media and also

switch between trays during the print-run, see Setting field actions .
Choose Automatically select for the 'Printer Tray' and clear the Override
PCL tray check-box.

11. You may tick Use printer parameters for paper and orientation to allow the
paper size, orientation and simplex/duplexing specified in the input file to be
overridden by the Printer configuration .

12. The Duplex override box is normally blank but if an override is in force the plex
is shown in maroon. It is important to check that an appropriate option is set up here, this is
the last plex instruction to be applied before the document is printed. See Simplex and
Duplex options .

13. Click OK.
If you have chosen to 'Print to file', the Log  will show the number of pages sent
and the file name, when the file is complete.

 Tip:  To see the part of the page on which some printers cannot print, select one of
the Unprintable area  options from the 'View' menu.

Links
Printer Setup  
Configuring the printer defaults
Direct printing  

Page imaging, scaling and cropping

Printing pages as images

If you do not need to 'proof-print' the pages, but just want to print what is shown
on the screen, then it may be appropriate to print the pages as images even when
they contain text. It enables prints to be made on printers which have unhelpful
font-handling characteristics. Color artifacts created when ClearType  text is used
are eliminated, ensuring consistency of output, whatever printer and resolution are
used.

This usually results in larger files, but if the pages use many different fonts or bulky
fonts (e.g. Chinese), the resulting files may actually be smaller.

Tick Print as an image when Printing .

Scaled printing

Most printers cannot print over an entire page, so always leave the edges of the
pages blank. The size of this "unprintable area" varies from printer to printer, so
that a page which prints perfectly on one printer may be cropped on another. To
cope with this, EscapeE has a scaling feature to ensure that the printing fits in the
"printable area" of your printer.

Tick Scale to fit when Printing .
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To scale and rotate pages for side-by-side page printing see Booklets and 2-ups
features.

Cropping images

Cropping removes the plain white margins from the image before it is printed.

If Scale to fit  option is also selected, the unprintable area of the page effectively
forms a margin – thus allowing the non-white part of the image to occupy as much
of the printable area as possible.

Tick Crop when Printing .

To Print to file, see Printing .

Link
Changing the scale of view  
Booklets and 2-ups  
Copying page contents  

Booklets and 2-ups

The Booklet  and 2-up  features enable you to print a pair of pages on each side of
a sheet of paper rather than one. EscapeE rotates each page and scales it down to fit
half of the sheet automatically; the order in which the pages are arranged on the
sheet depends on the feature selected (see Printing ).

2-up

In a 2-up simplex job, odd-numbered pages are printed on the left-hand side of the
sheet and even-numbered pages are printed on the right-hand side. The pairs of
pages are in numerical order, as in this 6-page example:

  

Sheets may be cut in half to produce single page half-size sheets or left whole to
show, for example, a double-page spread of a table too wide for a single page.

Booklet

In a Booklet, pages are usually printed in duplex with a pair of pages on each side. If
the paper size selected for the destination printer were A4, for example, then up to
four  'pages' re-sized to A5 (portrait) could be printed on each (landscape) sheet. The
pages are paired in an order such that you just need to gather the printed sheets
together and fold the sheaf of paper in half. For example, these 12-pages may be
folded together like a newspaper:

  

In the special case of a two-page booklet, both pages would be printed beside each
other on one side of a single sheet (in effect, 'simplex').

See also On the back  option ('Action' page of the Field dialog).

Links
Printing
Printer Setup  
Configuring the printer defaults
Standard paper and envelope sizes  
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Printer Setup

To print pages, the printer to be used is selected from a drop-down list on the 
EscapeE Printing  dialog. When the Printing dialog opens, the Printer initially displays
the name of the default  printer.

To change the default printer

1. Choose Printer Setup... from the 'File' menu
or 
if you are about to print and have the Printing  dialog open already, click
Setup... button.

2. The standard Windows 'Print Setup' dialog opens. Select the printer to be used
by default: you may either 

o Choose a Name from the drop-down list of printers which may be attached

to your computer or  

o Click the Network... button then navigate to a printer on your network.

3. The other parameters and options presented in the dialog (for example, paper
size, source and orientation) depend on the printer chosen. Set these up as
appropriate.

4. Click OK.

Further options may be set up in the 'Printer' page of the 'Configuration' dialog:
see Configuring the printer defaults .

 Notes

Some of the parameters which a printer is to use on a print-run can be set up in more
than one place. They may occur, for example, in the original input (e.g. PCL, PS )
file, in the 'Printing' and 'Print Setup' dialogs and the 'Printer' Configuration.

 Most (well-behaved) printer-drivers take in-file printer instructions in their stride.
Consequently, the following printing parameters are normally taken from the input-
files, not the 'Print Setup' dialog:

Paper
Orientation
Input tray
Output bin
Simplex/Duplex

You may, however, override these input-file specified parameters in the Printer
configuration :

Input tray
Output bin
Simplex/Duplex

In addition, these input-file specified parameters:

Paper
Orientation
Simplex/Duplex

may be overridden in the Printing  dialog (tick 'Use printer parameters for paper and
orientation').
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These parameters are also taken from the Printing dialog:
From/To page numbers
Copies
Collation

(The number of 'Copies' may be specified on the command line instead, using the /

COPIES  option).

When the following parameters are not specified in the input file, they are supplied
with the default values set up in the Printer configuration :

Paper type
Orientation

 Some printer-drivers, however, are not so well-behaved. Consequently the paper
type, duplexing and bin selection that you have applied in the Printer Setup dialog will
be used throughout the print-run. If the original input file redefines these parameters
during the print-run then the printer-driver ignores them. The command-line option
for this is /DRIVERDEFAULTS .

If your printer supports PCL, PDF, Postscript or XPS formats you may avoid such
printer-driver problems by using the EscapeE Direct printing  option.

Configuring the printer defaults

N.B. This applies to viewing and all formats.

Your original source document was intended to be sent to a particular type of printer
(such as HP -PCL  or Adobe PS ); EscapeE interprets the instructions in this
document and represents it on your screen instead. The document file usually
contains all the instructions necessary for the pages to be printed, but if they are
absent, e.g. in a raw text file, the printer resorts to using 'default' parameters, and
EscapeE is configured to cope with this. Experts using specialist systems may,
however, have altered these defaults; in this case EscapeE must also be reconfigured
to match:

Configuring the emulation

1. Choose Configuration... from the 'Options' menu (or press F8) then select the
Printer tab.

2. Specify how page-breaks in the document are determined:

o If emulating a printer, select a Paper size from the drop-down list. You may

choose:

a standard paper size : the measurements will be entered in the
width and height boxes automatically (select inches or centimeters as
you prefer). Or 

CUSTOM and enter the 'width X height' (in inches or centimeters)

alongside. To retain  the CUSTOM set-up for future use, remember to
click Save instead of 'OK' on closing the dialog. Or 

AUTO to use the paper-size specified in the document.

o For a PCL or Epson file to emulate a line-printer:

set the page length as the number of lines per page and 

select the line ending symbols from the drop-down list. (Try looking
in the printer's menus, or print its 'test page' for this information.)

o When emulating a plotter, each file defines a single 'page' and so these

page-break defaults are ignored – see note  below.
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3. If the printer is required to start in HP-GL mode, i.e. to emulate a plotter rather
than a printer, tick the Plotter check-box.

o Click Plotter options... to configure plotter-specific options: see Plotter

options .

4. If you are emulating an Epson dot matrix printer, select its resolution from one
of these "dots-per-inch" values:

o 60 (default)

o 72 

o 80 

o 200 

5. If you are emulating a spot color printer, choose an ink color from the drop-
down list (Red, Green, Blue, Cyan, Magenta, Yellow). A sample of the selected
color is shown alongside.
Otherwise select <None> to set the color sample to black. (The default is to
leave the box blank).

6. If the emulated printer is capable of printing to the edge of the paper, tick the 
Edge to edge printing.

7. Set up a default font selection sequence, e.g.
^(19U^(s0p12vsb3T

o enter the string in the Font select edit-box or 

o click the  button to display the Font panel: see Configuring the default

font .

8. Click the Save button to retain these settings after you close the program.
Alternatively, click OK to use them for the current session only.

Emulation notes

If the file is known to be from a plotter then there is no need to set up a default
paper size – the page is made big enough (maximum coordinate value is
8,388,607) to encompass the whole area of the plot. (The file is deemed to be from
a plotter if the file extension is .PLT  or .HPG  or it starts with a plotter command
rather than PCL  or if the 'Plotter ' box has been checked.)

For images, you may override print file setting for paper size so that, for
example, a series of TIFFs read via a Control file  can be forced to fit a particular
paper size.
The document invokes custom paper size using {escape}&l101A.

Configuring the output printer's defaults

The printer which you use to print your document may not be the same as the
original document was created to use, so you may need to set up some default
parameters relating to your chosen output printer:

1. Choose Configuration... from the 'Options' menu (or F8) then select the
Printer tab.

2. If your printer allows an alphanumeric ID to be associated with a specific tray,
click the Add media button. You will be repeatedly prompted first for the name
and then for the tray number to be assigned to it, see Media definitions .
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3. Select the orientation of the document: Portrait or Landscape.

o To use the default orientation even if a default was specified in the original
document, tick Override print file setting.

o A page may contain text in portrait or landscape orientations. EscapeE has
an automatic orientation feature to determine whether the text is in the
same orientation as the page. If the text would be in the "wrong"
orientation, it uses rotated characters instead so that the text is oriented
appropriately. If the page contains some text in portrait and some text in
landscape orientations, this feature determines which orientation most of
the text is in and matches this to the orientation of the page.
Tick Auto to engage this feature.

4. Enter the number of the 'Input tray' that the printer should use by default, in
case the tray number was not specified in the original document.

o To use the default input tray even if a default was specified in the original
document, tick Override print file setting. If the input paper tray box is
left blank, the Windows printer driver's configuration setting will be used:
see Printer Setup .

5. Enter the number of the Output bin  that the printer should use by default, in
case the bin number was not specified in the original document.

o Tick Override print file setting if you would like the default output bin to
be used even if a default was specified in the original document. If the
output bin box is left blank, the Windows printer driver's configuration
setting will be used: see Printer Setup .

6. The Duplex override box is displayed when exporting in PCL , PDF  and
PostScript  formats. The box is normally blank but if an override is in force
then the plex option is shown (in maroon) – see Simplex and duplex options .

7. In duplex  printing, you need to keep track of whether a page is on the 'front'
or the 'back' of a sheet. A tick in Show blank pages check-box ensures that all
pages – even blank pages – are taken into account rather than suppressed. See
also Configuring the view .

8. Click the Save button to retain these settings after you close the program.
Alternatively, click OK to use them for the current session.

Multiple copies

When printing a document, you may edit the number of copies and switch collation
option for that run on the Printing  dialog.

When exporting PCL  or PostScript  output or printing directly , you can specify
that multiple copies be made in a single run by default:

1. Choose Configuration... from the 'Options' menu (or press F8) then select the
Printer tab. 

2. Enter the number of copies of each page to be printed in the Copies edit-box.

o Tick Collated check-box to print one of each page in a multi-page

document before starting the next copy (e.g. for duplex printing). Collating
copies may result in file which is many times bigger than an uncollated file.

o When one side of each sheet in the document is blank, you may save print-

time by de-selecting 'Collated': all copies of the first page are printed before
starting to print the copies of the next page and so on to the end of the
document.

 Tip:  Some defaults, e.g. Spot color, Special media, Copies can also be specified on
the command line: see Command line syntax Printer configuration options  table.
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Media definitions

Media trays may be identified by number, name or attribute, depending on the
printer's language and sophistication. See PCL export options , AFP export options ,
PS export options  for detail on configuring for specific formats. See Setting field
actions  if the print-run requires different trays and/or bins to be selected during the
run.

A PCL file will specify the media that it expects the whole document to be printed on
as a type number (see PCL tray numbers ). Selecting Print... from the File menu
runs the Windows printer-driver; this needs to engage a tray on whichever output 
Printer has been selected. This is specified using a different type number (see
Windows driver numbers ). A PostScript file, on the other hand, will provide a list of
paper attributes and expect to find a matching tray; it can all get very complicated.
Configuring a media definition  creates an association between human-readable
tray-descriptions and tray-numbers, simplifying the printing set-up.

Adding Media definitions

1. Choose Configuration... from the 'Options' menu (or press F8) then select the
Printer tab.

2. Click Add media: the 'PCL media' dialog is displayed.

3. Enter a Media name for one of the input trays in the edit-box then click OK.
(The name may be made up of letters, numbers or combination of letters and
numbers, depending on the printer.)
The dialog now shows an edit-box captioned Tray number for the named tray:
enter the number to be assigned to the specified tray name then click OK.
The 'PCL media' dialog switches back to showing an edit-box for a new 'Media
name' to be defined. Either:

o Define a name for another tray and assign it a number as before, or 

o Click Cancel to terminate media set-up.

Editing a tray definition

If a tray has been defined already, its number will be entered in the Tray number
for...  edit-box automatically. You may:

Click OK to retain the definition or 

To change it, edit the number then click OK or 

Clear the edit-box then click OK to delete the definition.

See also Direct printing .

Links
Tray and bin numbers  
Standard paper and envelope sizes  
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Simplex and duplex options

Some printers can only print on one side of the paper while others can print on both
sides and may even be capable of switching from one 'plex' mode to the other in the
same print-run. EscapeE provides a comprehensive range of options and overrides so
that you may configure the best print setup for outputting your document.

When a document does not specify whether a page is to be printed in simplex or
duplex mode, EscapeE applies the mode set up in the Configuration dialog:

1. Choose Configuration... from the 'Options' menu (or press F8) then select the
Printer tab.

2. Select an option from 'Duplex output' panel: your choice may depend on the
capabilities/limitations of your printer.

o Simplex 

The page is printed on one side of a sheet of paper; the other side is not used
by the printer. See also Simulated simplex  below.

o Duplex - short edge binding 

Can print on both sides of the paper, flipping on the short edge.

o Duplex - long edge binding 

Can print on both sides of the paper, flipping on the long edge

o Default

No plex is specified. In practice this undefined state is capable of printing in
duplex; the mode actually used is set at the printer.

Overrides are provided so that you may also control those pages where the plex mode
is specified but you would like to change their set up:

To ignore the original document's print-mode, tick Override print file setting.

Use Simulated simplex  options when printing a mixed-mode document on a
printer that cannot switch mode efficiently:

o Tick Simulate simplex using duplex (long) to flip on the long edge or 

o Tick Simulate simplex using duplex (short) to flip on the short edge.

Simulated simplex

Some jobs contain simplex pages and duplex pages – for example, a duplex manual
with a simplex title (banner) page. These jobs must be printed on a duplex printer
in a duplex  mode. If your selected printer cannot switch quickly between simplex
and duplex during a print run, EscapeE may be configured to simulate the switch by
inserting a blank page on the reverse of any page specified as simplex. There are
separate options for documents bound on the long-edge (i.e. portrait or tumble
landscape) and short-edge (i.e. landscape or tumble portrait).

There is an additional EscapeE override feature that enables further plex options to be
set before the document is output. This feature only applies when Printing  or
exporting to PCL , PDF  and PostScript  formats: it has the last word on the plex state
of each page, overriding any other settings configured.
The override may be set up from the command-line or from an output dialog: see 
Duplex override  below.
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Duplex override

The drop-down list of Duplex override options may be seen on the Printing
dialog and on the Configuration  and Export  dialogs when exporting in PCL ,
PDF  and PostScript  formats. This box is normally blank: this indicates that
there are no duplex-overrides in force so that the plex mode specified in the source
file is applied. When a duplex-override is in force then the option is shown in the
box and colored maroon to remind you of the alteration to the plex mode.

Simplex Prints on one side of the paper only.
Equivalent to Simplex with Override print file setting ticked
or /OUTPLEX N  on the command-line.

All –> Long edge All pages in a long-edge binding document are duplex with
simulated simplex pages.
/OUTPLEX L 

All –> Short edge All pages in a short-edge binding document are duplex, with
simulated simplex pages.
/OUTPLEX S

Duplex –> long
edge

Document contains duplex and simplex pages: blank back
pages are added to the simplex pages to simulate a fully
duplex document; long-edge binding is used.
/OUTPLEX DL

Duplex –> short
edge

Document contains duplex and simplex pages: blank back
pages are added to simplex pages to simulate a fully duplex
document; short-edge binding is used.
/OUTPLEX DS

No plex Any plex specification that may have been supplied by the
source file is removed from the output file, enabling you to
print it in the plex mode that you set at the printer.
/OUTPLEX U

As in the file Use this to reset to the normal state, i.e. with the box blank, so
no duplex overrides in force and the plex mode specified in the
source file applied.
/OUTPLEX

Links
Printing  
Configuring the printer defaults  
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Plotter options

There are some configuration options that only apply when a plotter (rather than a
PCL printer) is emulated.

Emulating a plotter

1. Select the Printer page of the Configuration dialog (press f8 or click
Configuration... from the Options menu).

2. Click Plotter options....

3. Tick Rotate graphics if embedded graphics for the document are to be rotated.

4. Tick Exchange width & height if necessary: see Note  below.

5. Specify the color palette: either 

o Tick Monochrome (2 pen) palette, or 

o Set up the configuration of each of the Pens: enter – or use the spin

arrows to select – the number of a pen to be defined, then:

To change the pen's color (shown in a square alongside the pen-
number), click Color. Choose a new-pen color from the standard color
selector dialog.

Enter the Width of the pen, in mm.
(You can click Reset to clear all pen set-up alterations.)

6. Pen-drawn colored lines are normally opaque. To treat colored lines as
transparent instead, tick Merge colors when drawing: the colors will merge
together where lines cross.

7. If the pen-drawn elements of a document are only simple horizontal or vertical
lines, you may tick Use rectangles for orthogonal lines. This feature draws
lines using rectangles rather than a pen of a defined width, which is more
efficient as pen shape and line-join characteristics can be ignored.

8. Click Apply to accept the changes and return to the Printer page of the
Configuration dialog.

 Tip:  If you need to cancel the dialog and have made changes to the set-up of pens,
remember to Reset the pens then click Cancel.

 Note

Some plotters were not designed to take sheets of paper like office printers and these
may use "rotated" coordinate systems (i.e. the width and height of the paper are
interchanged) instead.

Links
About printing
Printing  
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Direct printing

In some cases there are options such as tray selection which cannot be done when
outputting using the Windows driver. The EscapeE 'Direct print' facility overcomes
this problem by generating the printer commands as if it were exporting to the
requisite format. In this mode, it is essential that the correct format has been
previously selected in the Configuration dialog. If the 'Direct print' option is grayed-
out, the wrong output format has been selected – see notes  below.

Direct printing in PCL, PDF, PS or XPS

1. Choose Direct print... from the 'File' menu.

2. In the 'Select page number range' panel, specify whether to print:

o This page – just the page on view or 

o the Whole file or 

o  a range of pages from Start to End: see Selecting page ranges .

3. Select the Format for the document from the drop-down list; click the format-
specific options button to configure further options.

4. Choose a Printer from the drop-down list; click Setup... to configure  its
parameters.

5. If the document contains color and the printer can only print in black and
white, tick the Force monochrome check-box.

6. Select a PCL tray number  from the spin-box.

o For PS, enter/select the name  of the Printer tray to be associated with

the numbered tray.

7. Check whether a Duplex override is in force - see Simplex and duplex options

8. To save the setup for later use, click Save.

9. Click OK.
The document is processed and sent directly to the printer. See also To change
the default printer .

Configuration notes

The Configuration dialog may be viewed by selecting Configuration... from the
'Options' menu or pressing the f8 key.

On the General page of the Configuration  dialog, choose PCL document,
PDF document, Postscript level2, Postscript level3 or XPS document as
the 'Output Format'.

o For PCL format, click the Options button. Depending on the printer, it may

be necessary to:

clear the Printer supports scalable image check-box

tick the LIDIL (graphics only) printer check-box.

Links
Printing  
Printer Setup  
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Convert pages to other formats

EscapeE is not only a "PCL to PDF" and "PDF to PCL" file converter. This section briefly
describes all the formats which EscapeE can manage and gives an overview of the
general features of file conversion. (For detailed export instructions, see Export files
section.)

The format-by-format guide to the features of the formats in which EscapeE can
export files: see Export formats  

Matching the format to the task: see Choosing an export format

The general procedure for exporting files: see Exporting files manually  

The set up and use of configuration options for export (source, driver, symbol set
etc.): see Setting General export options  

How to engage – and how to turn off – automatic file export; the 'clock' icon: see 
Exporting files automatically

How to set up automatic export options; renaming or deleting input files, naming
output files; using 'drag and drop', 'shortcut' icons and LPR output: see Setting
automatic export options .

How to set up which page(s) from a file to export: see Selecting page ranges  

Generating unique output file names to avoid overwriting existing files: see 
Overwriting files  

About Port names and numbers for TCP/IP input; Host names and IP addresses
for LPR output: see Setting TCP/IP options  

About options for treating text as graphics and combining strings to improve text-
searching: see Text options .

For information on screen, printed and fax image issues, see: Image resolution

Description of compression options for exporting documents: Image compression
 

Options for converting colored images into 'black and white' or 'gray scale': 
Monochrome conversion  

Smoothing options  for scaling-down images to best effect

About the use of dot shading patterns and solid gray-scale in EscapeE: see 
Shading options  

How to associate a file format with a program so that EscapeE can open files
directly on export: see Associated programs  

The use of 'wild-cards' when naming files: see Filenames and wildcards
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Export formats

EscapeE can export your original documents in many different formats:

FDL form

Converting a PCL job to 'Forms Description Language' means that you can open
pages in RedTitan Page Designer , edit them and output them for virtually any
printer.

FDL export >

PostScript file

Output is generated in Adobe  'PostScript' printer language without using any
Windows  printer driver and is suitable for level 2 and level 3  printers.

PostScript export >

PDF file

Output is generated in Adobe  'Portable Document Format'. Pages can be viewed
directly with a browser, creating documents that can be searched for text strings.
Iteractive "AcroForms" may be created. For security, passwords may be specified or
the files may be signed and/or encrypted.

PDF export >

PDF/A file

This is Adobe  Portable Document Format for Archiving documents. Its documents
can be viewed with a browser and text strings searched for, like regular PDFs. The
feature that sets it apart from PDFs is that it is self-contained; any fonts used in the
document are included in the file. PDF/A files may be secured with a digital
signature.

PDF/A export >

HTML files

The document can be output as a file written in HyperText Mark-up Language ,
suitable for display by a web browser.

HTML export >  

HTML files may be created as a single file that contains all the resources packaged
as a Multipart/Related MIME  document, extension MHT .

MHT export >

HTML files may also be output in HTML5  format suitable for reading by the
RedTitan UberEd  program, where they may be edited and new documents
created.

HTML5 export >

HP PCL file

Using the HP PCL format for exporting a file will reprocess the file, even though it
was imported as a Printer Control Language file. This is useful for consolidating files
that have been heavily modified.

PCL export >

Using the Subset  export format enables you to extract part of a PCL print job
without reprocessing. This is useful, for example, when you have a paper wreck in
the middle of a PCL print run and wish to reprint just part of the job.
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IDF

Exports RedTitan Intelligent Document Format documents. The coding for this
format is readily intelligible to English speakers, ideal for editing and creating new
documents from existing documents and resources.

IDF export >

IPDS

Exports an Intelligent Printer Data Stream suitable for IBM  IPDS printers. Pages
may be rendered as exact images or as text/image composites for speed.
Note:  the module to export in IPDS protocol must be specially installed; contact
help@redtitan.com for more information.

IPDS export >

XPS

Exports in Microsoft open architecture XML Paper Specification – a zipped file of XML
pages, fonts, images in native format etc. for printing or viewing on screen.

XPS export  >

AFP image

Exports an AFP datastream rendering each page as an image for printing on IBM
systems that support Advanced Function Printing. Note that this does not allow you
to edit the file or use the text search facility.

AFP export >

DCX/PCX images

DCX fax file format is supported for both input and output. This format is used by
some fax systems – it uses the PCX format for the images. EscapeE can handle up
to 1023 pages.

DCX/PCX export >

DICOM images

Exports one-file-per-page in Digital Imaging and Communications in Medicine
format used for medical imaging. Each DICOM  file contains an image and a data-
set of information related to the image. The group/element values may be extracted
to set up the DICOM Element Tags  that make up the data-set.

DICOM export >
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EMF images

An Enhanced MetaFile object stores a vector image as a list of settings and drawing
commands. It may be used to provide images for printing or viewing on-screen.

EMF export >

IMG image

IMG export produces a datastream in Variable blocked format for feeding directly to
a channel-attached Xerox  centralized DJDE/Metacode printer. The Xerox IMG
(Barr)  format is used where the printer has a Barr  spooler interface attached.
These formats enable documents from standard word processing software to be
output as a PCL file and then converted by EscapeE for printing identically on a
Metacode printer. Both formats make use of PP.JSL supplied.

IMG export >

JPEG image

JPEG images use a "lossy" compression method developed by the Joint
Photographic Experts Group: it is well-suited to reproduce real-world photographs.
It is not recommended for graphic art, however, as JPEG compression losses result
in poorer image quality: for example, straight lines typically lose their crispness.

JPEG export >

PNG image

Portable Network Graphic: a useful web-compatible image format that can be
displayed in browsers and avoids the royalty issue associated with GIF format.

PNG export >

TIFF image(s) 

Tagged Image File Format is principally used as an archive format for viewing in
EscapeE and in COLD (Computer Output on Laser Disc) systems. It creates an exact
image of a page. A single file may contain more than one image.

TIFF export >

Windows BMP

This is a bulky format typically used by painting-type programs representing MS
 Windows  bitmap files.

BMP export >
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Rich text RTF

Extracts selected contents of a document to Microsoft Rich Text Format . Editable
in word-processors.

RTF export >

Plain text TXT

Exports pages from the document to plain text , allowing you to create documents
which can be easily edited with any text editor. You may also export just the Data
fields to Plain Text  and paste them into any other application.

TXT export >

CSV fields

Data fields can be exported in CSV  format. You may choose to export all the fields
in the document or just selected fields.

CSV export >

XML fields

Data fields can be exported in XML . You may choose to export all the fields in the
document or just selected fields. The extra files necessary to create style sheets can
also be generated.

XML export >

Macros

Macros  in the document itself may be extracted and exported. The macros created
can be used to overlay on selected pages using the Field mechanism – see PCL
export options  and Setting field actions.

A range of pages may be saved as a macro .

'No output' note

On major print jobs, specialists sometimes find it useful to process the job prior to
printing. This produces no output, but does call on Plugins etc. and gather
statistics (e.g. on paper use, for accounting purposes).

See Exporting files manually  and command-line option /PROCESS .

Links 
Exporting files automatically  
Export files
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Choosing an export format

Choosing the format in which to output a specific file depends on how the file is to be
used. For example, JPEG is good for photographs and TXT for text, but if you need to
output a medical file (which may contain images and text) then only DICOM will do.

The following table matches function to format:

Task Suitable Formats

Exporting to images AFP  
BMP, PNG  
DCX/PCX  
IMG , IMG Barr format  
JPEG  
PDF , PDF/A  
TIFF

Exporting medical file DICOM

Exporting to Page Designer FDL

Exporting the document EMF  
HTML , HTML5 , MIME-encoded HTML  
IDF  
IPDS *
PCL  
PDF , PDF/A  
PS level2, PS level3  
RTF  
XPS

Exporting data fields CSV , TXT , XML  
IDF , RTF  

Extracting text IDF , RTF , TXT  

Extracting part of original document IDF  
Macro  
RTF  
Subset  

Archiving DICOM  
PDF , PDF/A  
TIFF
TXT  
XPS

Printing (MS Windows) Print

Production printing AFP  
PCL  
PS level2, PS level3  
IPDS *
IMG

Web publishing HTML , HTML5 , MIME-encoded HTML  
PDF , PDF/A  
PNG

*if you have the IPDS option installed 
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Exporting files manually

You can convert files from one format to another simply by exporting  them.

To export files

1. Open the file  containing the pages that you wish to export, then:

o choose Export... from the 'File' menu, or 

o Hold down the Ctrl key and press the E key.

2. Specify the pages to be exported in the Page number range panel: see
Selecting page ranges .
If page numbering has been configured, Page 1 number will be shown: see
Creating page numbers .

3. Tick Do not overwrite files to add a number to the new output file name if
there is an existing file of the same name already present. Deselect if you want
same-named files to be overwritten, for example when re-exporting a file with
changed options. See also Overwriting files .

4. If the default Format shown is inappropriate, select the format you need to use
from the drop-down list (see also Choosing an export format ).

o A new button – Save format – will be placed on the dialog. You may make

the newly selected format the default by clicking it.

5. A File name (with suitable extension) and folder are supplied. To set up a
different name or extension, type in the new name (wild-cards  may be used).
To select a different folder to store the file, click the Browse button.

o Alternatively, some formats are suitable for LPR output: tick to switch the

file-name's edit-box to 'LPR output via TCP/IP'.
See Setting TCP/IP options .

6. Many formats enable you to set up further options: click the options... button
to display the appropriate 'Options' page of the Configuration dialog. You may
see some configuration options represented on the Export dialog too, such as:

o Force monochrome: tick the check-box if required, see Image import/

export options.

o When exporting to TIFF file  format, ticking Multi-page TIFFs creates

one file containing all the images rather than several files each containing a
single page image.

o When exporting to EMF image  format, select your preferred 'Resolution'

from the drop-down box: Screen, Printer or Image defaults.

o When exporting to Zerox IMG  format, the Dept edit-box enables you to

specify the accounting department.

o If an LOF composite file is on show in the  EscapeE window, you may tick

Treat as a single file to export the files as a single unit rather than as
separate files, see About control files .

7. For some selected formats, EscapeE can open the new file in the program that
you normally use as soon as the export process is completed: tick Run the
associated program after creating the file (see Associated programs ).
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8. If you have defined data fields on the pages, you may choose to extract 
Selected fields, None or All defined fields simultaneously into Comma
Separated, XML or Plain text format. This outputs a log file with the extension
.LOG (rather than .CSV etc.), see Log file export .

o You may also set up Page Numbers, Bates Page Numbers and/or

Message options: see Setting Log file options .

9. When exporting to PCL , PDF  and PostScript  formats, the Duplex
override box is displayed. This is normally blank, see Simplex and duplex
options  for details.

10. Click OK to close the Export dialog.

o IDF, RTF and HTML5 UberEd export formats only: if the Show fields form

on the 'Options' dialog has been checked, the Fields dialog opens, see IDF
export options , RTF export options .

EscapeE outputs the new document.

Other export formats, such as Windows Metafile, are available. RedTitan also
specializes in customized solutions for database publishing. Contact RedTitan for more
information.

 Tip:  You can do a "dummy run" by choosing No output as the Format . No
document is created but any messages produced by the job run are logged  in the
Console notebook and you may export field contents in a Log file, see Setting Log file
options . This is useful for checking the validity of the input documents, number of
pages in the output document etc..

Links
About exporting pages  
Setting General export options
Exporting files automatically  

Setting General export options

The 'General' page of the Configuration dialog defines the options which apply to
documents whatever their format: see below .

Format-specific configuration 'Options' pages may be displayed by clicking the button
alongside the 'Output' Format box on the General page, or from the Export dialog;
see Exporting files manually .

 Tip:  when a format-specific 'Options' page is on view, clicking any other tab resets
the 'Options' page to 'General'.

To set General Configuration options

1. Choose Configuration... from the 'Options' menu (or press f8) to open the
General page of the 'Configuration options' dialog.

2. In the INI file  section:

o Select RT.INI to use the default configuration or 

o Select *.INI to use a per-file one with the same name as the data file but

with extension .INI.
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3. Under 'Source Type', specify the origin of the PCL file. If you used the 
Windows Driver, the RedTitan Dynamic Document Formatter (the
PrePrinter) or the DataStream Converter to create it, EscapeE can optimize
other configuration settings, e.g. symbolset.

4. Rarely, you may wish EscapeE to convert the character set in the fonts (see 
Handling fonts ). Scroll the Symbol set list to select a suitable option. See
also Notes , below.

5. The 'Ignore' panel contains a number of features for removing unnecessary
components from pages and minimizing file-sizes. See Optimizing the
configuration  for more details:

o Select  Images.

o Select  Shading.

o Select  White areas.

o Select  Null clips.

o Select  PJL commands. See also Preamble and PJL options .

o Kyocera !R! is a specialist option , normally deselected. See also Kyocera

Prescribe .

6. Similarly, in the 'Ignore download fonts' panel:

o You may choose to ignore All fonts which have been downloaded with the

file or 

o If substituted: just those for which substitutes have been given. (Ignored

fonts are not stored.) Or

o If same header. Any downloaded font which has the same ID  and an

identical header to a previously loaded font will be ignored. This avoids
multiple copies of a font being included in the output.

You must also specify which one of the Standard Adobe fonts is to be used:
see PDF export options .

7. In the Fonts  panel:

o If the font characteristics specified by the printer driver are inappropriate,

tick the Calculate download font characteristics box and let EscapeE
provide more fitting values for point size, weight etc..

o To see the details of the fonts in the 'Font substitutes' file, click View...;

see also Font tables .

o To use the fonts in the named 'Font substitutes' file, check Enable.

8. The location of the EE file  containing the field definitions  is shown. It may
be changed by clicking Edit... to open the Field dialog.

o When the default fields file is in use then the location is labeled Default

field definition file, see Setting fields file options .

o When a specific fields file is in use then the location is labeled Field

definition file, see Field definitions file  and Setting fields file options .

9. Select the 'Input' format: this is normally set to Auto format detection but
you may choose a specific format from the drop-down list  instead: see also
File format recognition .
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10. Select the Output 'Format'.

o Further options may be configured for AFP , DICOM , FDL , HTML ,

IDF , IMG , IPDS , JPEG , PCL , PDF , PostScript , RTF , TIFF ,
TXT  and XPS  formats: click Options....

o When exporting to TIFF image  format, a check-box allows you to specify

whether a Multi-page TIFF file or individual single image files are to be
output.

o When No output is selected for making a "dummy run" you may export a

Log file containing its processing data: click Options... to set up the Log
file options .

11. The Duplex override box is only displayed when exporting in PCL , PDF
and PostScript  formats. The box is normally blank but if an override is in
force then the plex option is shown (in maroon) – see Simplex and duplex
options .

12. The current command-line print-option status is set up from the 'Option format'
panel, see Print option flags . Experts may choose whether they prefer to use:

o Numeric (default) or 

o Mnemonic parameters.

13. Click the Save button to retain these settings after you close the program.
Alternatively, click OK to use them for the current session.

14. To create a Shortcut icon which uses all the options you have set, click 
Shortcut...: see Shortcuts - the easy way to construct a command line.
Alternatively, expert users can click the Save as button to save these settings
to a file.

Notes 

It is essential that the correct Symbol set is specified. EscapeE translates characters
from the specified symbol set into the standard Windows set 19U. See About symbol

sets .

Changing the symbolset, either directly or by changing the "source" set up, may
affect any data-fields and tags set up previously. See Field Problems .

If the symbolset is negative and Calculate download font characteristics is
selected then the widths are calculated from the bounding box of the characters.
Professional users may obtain this effect on the command line; for example:
ESCAPEE /SYMSET -29 /CALC Y

There is a shorthand for use on the command line for using the configuration
'filename.ini' (if it exists) and data file 'filename.pcl':
^^* filename.pcl

To ask for a specific INI file on the command line, use a command such as:
escapee ^^c:\temp\newdefs.ini

Links
About exporting pages  
Exporting files manually  
Optimizing the configuration  
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Exporting files automatically

To engage automatic file export 

1. Select Configuration... from the 'Options' menu.

2. Select the Automatic tab.

3. Tick the check every box and enter the checking interval in seconds. See Setting
automatic export options  for more options.

4. Click OK. 
The automatic timer  clock is displayed on the Tool-bar to show that automatic
export is enabled.

To turn off automatic file export

1. Click the timer  clock button on the Tool-bar.

2. A dialog asks if you want to "Continue to scan for more files"; click No.
Automatic file export is turned off and the clock removed from the Tool-bar.

Links
Exporting files manually
Shortcuts - the easy way to construct a command line
Run from the command line  

Setting automatic export options

The automatic export options are set up from the Automatic page of 'Configuration'
dialog; see also Exporting files automatically .

Input files specification

1. Fill in the Input files specification edit box (see Filenames and wildcards
for more information and examples) or leave this box blank if you want all files
to be converted.

2. To engage automatic file export,  tick the Check every box and set the time
interval. A clock icon  will be placed on the Tool-bar to show that file
conversion is operating automatically.
If you would like to see the PCL pages on screen while files are automatically
being created, select View. If you do not turn this on, the status panel will still
show the progress of the conversion.

3. Files are usually processed in order of their update date but you may opt to
process them in the order of their creation date instead by ticking Process
oldest first. (See command line option /FIFO .)

4. After the input files have been processed you may choose to:

o Rename them or 

o Delete them instead: see Notes  below.

5. Set up a 'Drag and Drop' action: when a file or group of files is dropped onto
the EscapeE shortcut icon you may choose to View the file(s) or Export them.
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Output files specification

1. Specify the output filename or folder in the Output file specification edit box:
see Filenames and wildcards  for more information and examples. The output
file will be named automatically and stored in the program folder.

2. Some formats allow LPR output to be selected at this stage; to use TCP/IP input
or LPR output, see Setting TCP/IP options  – the LPR output box will then be
checked.

3. Select Create new folder if necessary if you have specified a folder that does
not yet exist.

4. Check Rename output when complete to defer the naming of the output files
until all processing is finished. This avoids the possibility of creating incomplete
temporary files with the specified output names.

5. If the Do not overwrite files box is checked, a suffix of "#1", "#2" etc. is
added to the filenames.

Setting other automatic options

1. Run the associated program after creating the file to open the file
immediately using the Program specified in the box below, e.g.
C:\REDTITAN\ESCAPEE.EXE

2. RedTitan customers may tick the Check the RedTitan website each month
for updates to EscapeE box to automate updating EscapeE  regularly. See
Note  below.

3. To close the dialog, you may choose to:
Click OK to use them for the current session.
Click the Save button to retain these settings after you close EscapeE. 
Click the Save as button to save these settings to a file.
Click Shortcut... to create a Shortcut icon which uses all the options you have
set: see Shortcuts - the easy way to construct a command line.

 Notes

In timed mode, once EscapeE has used an input file, the default action is to Rename
it by changing the extension to ".BAK". (To change this extension, use the command
line option /RENAME .)
Alternatively, you  may choose to Delete processed input files instead. For timed
mode, this is set up in the ERASE  Configuration symbol : only input files that
have been processed automatically are erased. (Using /ERASE on the command line
supersedes the ERASE configuration symbol.)

To avoid conflict on the INI  file when running in automatic mode (e.g. processing
from a command line scanning a folder), the file history  is not updated.

When EscapeE is part of a system sourced from another manufacturer (rather than as
a stand-alone product from RedTitan ) an OEM  statement in RT.INI suppresses
automatic update checking.

Links
Setting General export options
Exporting files manually  
Run from the command line  
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Selecting page ranges

When exporting pages from a file, you must specify which pages are to be output. In
the 'Page number range' panel of the Export  dialog:

To print the page on current view, select This page.

To print all pages in the file, select Whole file.

To print a particular range of pages, deselect 'This page' and 'Whole file' and enter
the Start page number (the number of the page on view is already entered) and
End page number.

o If you leave 'Start' empty the program prints from the start of the file

o If you leave 'End' empty it prints to the end of the file.

EscapeE may be configured to add page numbers to the exported pages (see
Creating page numbers ). The number of the first page to be exported will then be
shown in Page 1 number box: edit this number as required.

Overwriting files

EscapeE provides two mechanisms for avoiding output files overwriting existing files
on Export .

with Do not overwrite files check-box ticked
If a subsequent file is created which would have the same name as a file in the list, 
EscapeE appends "#1", "#2" etc. to the new file's name automatically. This ensures
that each file name is unique and that no existing files are overwritten.

with the box unchecked 
EscapeE maintains a list of output files that have been created from the most
recently opened file. It appends "1", "2" etc. to the name if it would be the same as
one created earlier in the run (but not considering any pre-existing files). The file
list is cleared when a input new file is opened.

Setting TCP/IP options
EscapeE Professional  editions only

To use TCP/IP input

1. Choose Configuration from the 'Options' menu. 

2. Select the TCP/IP page of the 'Configuration' dialog.

3. Check the Enable TCP/IP input box.

4. Click Port number and supply the number (e.g. 6000) 

or 
click Port name and type in a port name (e.g. ESCAPEE or myport which will be

looked up in the Windows  Services file to find the port number).

5. To create a Shortcut icon which uses all the options you have set, click 
Shortcut... (see Shortcuts - the easy way to construct a command line ).

6. Click OK. 

140

239

140

450

448

367



Convert pages to other formats130

To use LPR output

1. Choose Configuration from the 'Options' menu. 

2. Select the TCP/IP page of the 'Configuration' dialog.

3. Select Enable LPR  output (this is mirrored on the 'Automatic' tab).

4. In the To host box, define the host name or the IP address to which the output
is to be sent e.g. \\mainserver\ourprinter.

5. On large systems, set up the Queue name (e.g. HeadedPaper); a Job name

(e.g. MonthEnd) may be specified too if required.

6. To create a Shortcut icon which uses all the options you have set, click 
Shortcut... (see Shortcuts - the easy way to construct a command line).

 Notes

The 'class' of the file will be the same as the file extension (PDF, XML, etc.).

Specifying the 'host' sets up a symbol (so HOST=xx.xx.xx.xx in the INI file would

define the default host IP address); this would enable LPR output from the command
line e.g.:
ESCAPEE filename /PS /LPR

The /LP_DATASIZE  symbol can be used to tell a printer that the file size is unknown

by setting the value of n to 0, -1 or -2, depending on the printer. (nQ  accepts the

default setting for LP_DATASIZE of 0.)

While the file is being processed the output is stored in a buffer. The LPR connection is
made when the processing is complete (or in the case of a large file, the buffer is full).
This means that the transmission may not start immediately and the line is not kept
waiting.

Links
Exporting files automatically  
Exporting files manually
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Text options

The pages of files in some formats may contain text, images and drawn objects, while
other formats may contain only an image. EscapeE has a number of features for
handling the text so that you can configure it to suit the required task.

The choice of option also affects the size of the exported file. A bitmapped image of a
page of text, for example, is likely to be larger than a file which contains the "real"
text in a font resident on the printer.

Render as a graphic
This produces an accurate image of each page in the file, including its text. The
'text', while readable by people, is merely ink marks to a computer. The content is
not preserved as characters in the file and cannot be searched or processed directly,
but it does eliminate possible font problems.

Checking the Include text as well as the graphic  option available in some formats
(PCL, PDF, PDF/A, PS) does, however, add the textual data to the document in a
computer-usable form. This data, though unseen by the User viewing the page
image, may be searched by the computer.

 Tip:  Optical character recognition techniques may allow characters to be matched
to their shapes in an image of text: see Other plugins .

Render all but text as a graphic
This outputs the page as an accurate image of all the non-text items on the page
with the textual content written on top (see also Keep original element order
below). The text can be read by people and processed by computers.

Include text as well as the graphic
When rendering as graphics  to some formats you may also choose to Include
text as well as the graphic. The textual data is sent along with the page image so
that the computer can search it, but you cannot edit the text directly.

See also Render all but text as graphic .

Keep original element order
EscapeE normally places text (and drawn lines) on top of images to avoid opaque
elements (such as shaded areas) in the images covering the text. You may override
this by selecting the Keep original element order option.

Combine text strings together
When you opt to Combine text strings together, EscapeE assesses the
positioning of the words and attempts to concatenate those likely to be part of a
continuous string.

While this can improve search performance in documents with normal formatting,
the results may sometimes be unsatisfactory in others. (For example, where each
character has been dragged into position manually for visual effect rather than
readability.)

 Tip:  double-byte fonts (e.g. Chinese characters, currency symbols, box-drawing
characters) are rendered as graphics, not text.
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Image resolution

The default input and output resolution of images is set up on the Images page
of the 'Configuration' dialog (F8 key), see Image import/export options .

An Override option enables the initial input resolution to be used throughout a job.

Both the default image resolution and resolution-override apply to images added by 
plugins  as well as to those read from the data-stream.

When you are exporting an image which is expected to be viewed on-screen only, a
resolution of 100x100 will usually suffice, whereas if a laser printer-quality image may
be required, it would be better to select a resolution of 300x300. For archiving
purposes choosing "200" or "150" will allow rough paper copies to be produced at
much reduced file sizes.

You may export your image file at a custom resolution by filling in the 'X-resolution'
and 'Y-resolution' boxes. Values can be from 25 to 600. Note that if the Y-resolution is
left blank, EscapeE will use the same value specified for the X-resolution.

To export a TIFF file intended for faxing, select the appropriate Fax output resolution:

  X   Y

Standard 204   98

Fine 204 196

Super Fine 204 392

Selecting one of these fax options automatically ticks the Force monochrome image
option and shows "Force monochrome set" message in the status bar for a few
seconds.

Links
Image import/export options
TIFF images file export
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Image compression

When you export an image, you can choose whether or not to compress it (see Image
import/export options ). EscapeE is able to use many compression methods  and
there are often several methods available from the drop-down list in the Configuration
dialog (F8) that are appropriate to your chosen export format.

JPEG note

When exporting JPEG images, the compression method set up here is irrelevant.
JPEG files use their own compression method, specially designed for photographs.
EscapeE can apply this to images within PDF  files too: see JPEG compression
options.

Fax note

The CCITT group 3 fax and CCITT group 4 compression methods are suitable for
faxing. When either of these options are selected, the Force monochrome option is
ticked automatically.

Compression methods

CCITT group 3 A simple 1-dimensional (horizontal) compression for
black and white images. 

CCITT group 3 fax For faxing. See also TIFF export options .

CCITT group 4 A 2-dimensional scheme which usually gives more
compact files than CCITT3. It is used for black and
white images and is suitable for faxing.

DocuPrint CCITT Group 4 Encoded as a single monolithic piece of data as
required for Xerox DocuPrint.

LZW For color images.

Packbits For a quicker compression which is not as compact as
LZW or CCITT4.

Run-length Compression option for DICOM image files.

RL4 For compressing AFP color output.

Default To let EscapeE select the most suitable compression
method for the image.

Uncompressed To turn off compression.
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Monochrome conversion

When you export an image you may also choose to convert its colors to 'black and
white' or 'gray scale' in the output document.

1. Select Configuration from the 'Options' menu (function key f8) and click the
Images tab or 
select Export from the 'File' menu (Ctrl E) –  see Image format file export .
Select an image format such as BMP or PNG then click the Image options...
button.

2. Tick Force monochrome.

3. Choose a conversion method from the drop-down list of options:

o Halftone (Default option)

The image is treated as if it were composed of blocks of pixels (block size 4x4
pixels). The average luminosity of each block is matched to a shade of gray
with similar luminosity. Gray shades are actually blocks of black dots on
white – the number and pattern of the dots within each block determining its
overall luminosity.

o Threshold 

This assigns black pixels to colors with a luminosity below the threshold
value, and white to the remainder. Enter a value in the range 1 to 254
(default value is 127, i.e. 50%).

o Adaptive 

The density in each quadrant of the image is computed and the image
adjusted by interpolating between these values. The image is then converted
to a 1-bit image using the specified threshold value .

o Dither A method of error diffusion that takes into account the discrepancy

between the original luminosity of a pixel and the monochrome value that the
default threshold value  of 50% would assign to it. The difference is
propagated to adjacent pixels, resulting in a more randomized scatter of
black and white pixels than basic thresholding.

o Gray 

Converts image to solid gray-scale shades  rather than black-and-white dot
patterns; select also 4-bit or 8-bit Smoothing for output to Monochrome
images .

Links
Image import/export options  
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Smoothing options

EscapeE provides a number of smoothing options for scaling monochrome and colored
images down in size.

Select Configuration from the 'Options' menu (function key f8) and click the
Images tab or 
select Export from the 'File' menu (Ctrl E) –  see Image format file export .
Select an image format such as BMP or PNG then click the Image options...
button.

The 'Smoothing for output to' section contains a pair of panels: one for 'colored
images and the screen' and another for 'monochrome images'. Choose from these
options to set up the most appropriate method for smoothing the output image:

Gray-scale gives the best effect if the output format supports it, but if converting
to 1-bit monochrome it may be preferable to use Simple  or Two-bit .
4-bit gives better results than 8-bit, which is only suitable when images are to
be heavily scaled-down.

Simple scaling is probably somewhat quicker but for images which are scaled
down considerably or have pale areas, it may result in parts of the image
vanishing altogether.

Two-bit scaling guarantees that if a pixel in the resulting scaled image contains
any black then it or its neighbor will be black – and similarly for white.

Links
Image import/export options  

Shading options

Shading options affect the way shaded areas in a PCL file are displayed and output to
all formats.

Originally, the PCL defined several levels of shading which were implemented as dot
patterns on a monochrome PCL printer. Modern color printers can render shading as
true, solid gray color which often gives better results than dot patterns, particularly
when scaled. You may configure EscapeE to use dot-patterns or solid gray shades.

EscapeE Shading options

1. Select the Images page of the Configuration dialog (function key f8): see Image
import/export options.

2. In the 'Shading' panel, choose from:

o Standard: a fairly coarse pattern of dots. This is useful when exporting at
lower resolutions.

o Fine: a fine pattern of dots.

o Gray-scale: solid gray; unlike the dot patterns, this will not be transparent.
Not suitable for simple  (1-bit) monochrome images, it is good for some
types of PDF: see PDF export options  for notes on Keep original element
order

You may opt to 'Ignore' shading: see Optimizing the configuration .
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Associated programs

Many file extensions have a program associated with them: for example .HTM will be

associated with an Internet browser.

It is possible to change the programs 'associated' with a particular file extension. For
example, you may wish to open CSV files with the RedTitan Database Manager
program. To do this from Windows Explorer:

1. Right-click a file with the extension .csv.

2. Select Properties from the pop-up menu.

3. Click Change... from the 'General' page of the dialog.

4. Scroll down the list of programs. Select RTDB (usually located in the 'RedTitan
\Software' folder) then click OK.

5. Click OK.

If the Run the associated program after creating the file box is ticked when a file
is exported , EscapeE will create and export the file then call the associated
program to view or process it. If the option is ticked but there is no associated
program set up for that export format, then if EscapeE can handle the format, it
defaults to opening another copy of EscapeE and showing the file there.

Link
Associated files  

Filenames and wildcards
EscapeE Professional  editions only

When selecting files to export you can use 'wildcards' to specify the Input  and
Output  file names and/or folder. If you have defined  data fields on the pages you
can use these in the file name, see Setting advanced options in field definitions .

Input
Specify the folder to be monitored on the Automatic  page of the Configuration
dialog: e.g.
*.PRN

processes all PRN files instead of LSH.
H:\REPORTS\*.*

processes all files arriving in the 'REPORTS' folder of the H drive.
In automatic mode the input file is either renamed or deleted – see Setting automatic
export options.  The default  is to rename as *.BAK; see /RENAME .

 N.B. if you use a wild-card such as *.* you must opt to have the files deleted,

otherwise if they are merely renamed, they will be processed repeatedly!

Output
When you select an export format, output files are automatically created with a
suitable extension and stored in the specified folder unless you a specify different
extension and folder: e.g.
E:\ARCHIVE\*.DOC

creates files with the 'DOC' extension and places them in the ARCHIVE folder of the E
drive.
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If the output file name would be the same as the input file then the default suffix of
'_out' is added to the output name (except if the /NQ  option is used).

If 'Multi-page TIFFs' has been selected, there may be more than one page image in
each output file; see TIFF images file export.  Normally, EscapeE creates a file for
every page image (data record) in a TIFF job, appending a number to the file name
to distinguish the page images from one another. The default is TEST1.TIF,

TEST2.TIF etc..

Similarly, when creating multiple FDL  pages they are named using the file stem,
e.g. FILE1.FDL, FILE2.FDL.

o To change these file names, use one or more consecutive " characters to indicate

how to construct output file names for the numbering the page image files, e.g.
*.PRN /TIFF /TO *"".TIF

converts an input file called TEST.PRN into

TEST01.TIF, TEST02.TIF ... TEST99.TIF, TEST100.TIF etc.

The position of the string of " characters specifies the position of the page

number in the name and the length of the string determines minimum number of
digits for the page number. If the number requires fewer digits then leading zeros
are inserted but digits are never discarded – they will always be inserted at the
specified point. If there are no " characters, or no output specification is given,

then a multi-page TIFF file is created.
For example, if the command:
ESCAPEE *.PRN /TIFF 5 /TO *"".TIF

found an input file called TEST.PRN it would create files with names TEST01.TIF,

TEST02.TIF ... TEST99.TIF, TEST100.TIF etc. whereas the command:
ESCAPEE *.""" /TIFF 5

would create files with names TEST.001, TEST.002 ... TEST.999, TEST.1000 etc..

A "plus" sign is a valid character for use in file names, but:

o When Page numbering  has been engaged, a + will be replaced by the page

number in the output file name, see About page numbers . For example, if the
output file specification is *+.PDF, the 'Page 1 Number' is 3, the 'Template' is p",

and the input file name is FILE1, an output file named FILE1p3.PDF is exported.

o When exporting in TXT  format, an initial + in the output name appends the

output to an existing file if it exists or creates a new file if not. Thus a single TXT
file may be built up from a series of pages exported from a number of files. For
example, in the export dialog enter the File name:
+summary.TXT 

or on the command line use the /TO  option to define the output name for /TEXT
 file export:

escapee *.lsh /text /to +summary.txt 

EscapeE can be set up to start a new output file whenever a specified field (or tag)
is encountered or when a field changes. The output file name can be derived wholly
or in part from the contents of a field – see Setting advanced options in field
definitions.

If a field has been set up to be used in the output file name you will notice that an =

wildcard has been specified as the Export dialog's File name. This indicates that the
field value will be substituted instead of the first equals sign in the output file
name.
For example, if the file is called TEST.PCL, the field contains ABCD and the export file

name specification is *=.PDF then the output file name will be
TESTABCD.PDF

See also Run from the command line  to specify this on the command line.
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An output file specification can also incorporate parts of fields or special symbols,
see Special fields in composed strings . This is an alternative to the use of special
symbols such as *, + and =, though " is still permitted.

For example, the special field _NAME is the stem of the file name (minus any path or

extension) so you can use parts of the original file name in the output specification
e.g.
C:\OUTPUT\{_NAME:1-8}\{_NAME:9} 

This would use the first 8 characters of the input file name as the output folder, and
the rest of the name as the file name. The special field _PATH is the original folder

name and _EXT the original file extension, should they be needed.

A file name containing fields and/or composite fields is usually evaluated when the
file is created. If, however, the specified field(s) cannot be found because they are
undefined at the start, EscapeE waits till the end of the processing before looking for
the field value(s) again so that the final output file's name can be constructed.

 Note: The output file may also be created using a temporary extension and then
renamed when complete. The temporary extension defaults to .TMP but can be

changed using the /TEMP option – see Command line syntax.

Links
Wildcards in font substitution  
Overwriting files
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Export files

The first pair of topics in this section covers common issues for exporting to image
formats. The topics that follow detail how to export files in each specific format, along
with topics on how to set up the configuration for any special features that they
support. These are set up in auxiliary 'Options' pages, usually accessed via the
'General' page of the Configuration  dialog or an options button on the Export
dialog.
Tip:  When a format-specific 'Options' Configuration page is on view, clicking any

other tab resets the 'Options' page to 'General'.

Export Export options

Image format file export  such as PNG,
BMP

Image import/export options  

AFP image file export  AFP export options  

DCX/PCX fax image file export

DICOM medical image export  DICOM export options  

EMF format file export

FDL forms file export  FDL export options  

HTML file export  

HTML MIME encoded file export

HTML export options  

HTML5 UberEd format export HTML5 UberEd export options  

IDF file export  IDF export options  

Xerox IMG image file export  

Xerox IMG in Barr format file export  

IMG export options  

IPDS file export  IPDS export options  

JPEG image file export  JPEG compression options  

PCL document file export PCL export options

Preamble and PJL options

PDF file export  PDF export options  

Security options for PDF export  

More options for PDF export

PDF/A file export  PDF/A export options  

PostScript file export  PostScript export options  

More options for PS export  

RTF file export  RTF export options  

TIFF images file export  TIFF export options  

Plain TXT file export  TXT export options  

XPS file export  XPS export options  

Links
Save and Copy  
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Image format file export

To export files to image formats such as PNG, BMP

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose the appropriate image format, e.g. PNG images.
A filename (with an appropriate extension, e.g. .PNG) and folder are supplied. To

create a different filename or extension, type in the new name or use wildcards.
To select a different folder to store the file, use the Browse button.

To make the selected image format the default, click Save format.

5. Tick the Force monochrome check-box if 'black and white' or 'gray scale' output
is required. Some compression and resolution options tick this box automatically:
click Image options... to configure these and other Image import/export
options.

6. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program, e.g. Windows
Picture and fax viewer . See Associated programs.

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

8. Click OK to export the pages.

Links
Image import/export options
Handling graphics

Image import/export options

Use the Images page of the 'Configuration' dialog to set up options common to image
formats.

Choose Configuration from the 'Options' menu (function key f8) and click the
Images tab
or 
choose Export from the 'File' menu (Ctrl E) –  see Image format file export .
Select an image format such as BMP or PNG then click the Image options...
button.
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To set options for image import/export

1. Select an appropriate Output resolution; you may choose from several options
optimized for archiving images, faxing etc. or enter a custom resolution. See 
Image resolution.

2. In certain cases when importing images for which the resolution is unspecified, it
may be necessary to change the Input resolution from the default initial value
of 300dpi ( EscapeE accepts resolutions as low as 25 dpi).

o You may force the initial input resolution to be used throughout the job by

ticking Override. This is generally inadvisable unless the resolution of the
images is known to be wrong.

3. Select a compression format  from the drop-down list.

o More compression parameters may be configured when exporting to JPEG

format. They may also be applied to images within IDF, PDF, PDF/A,
PostScript format files. See JPEG compression options .

o In addition to compression, when exporting to TIFF image format, further 

options  may be configured: click TIFF options....

4. To reduce the bulk of the document, you may opt to Omit blank pages.
(Normally the viewing of blank pages on-screen is merely suppressed, see Show
blank pages  option.)

5. Select the 'Image' area of the page to be exported. Choose from:

o Full   Outputs entire page(s): this is the default (equivalent to Select all

option on the 'Edit' menu or pressing Alt A).

o Paper size only   Outputs an area of each page the size of the sheet of

paper.

o Printable region only   Only the area of the page(s) which the printer is

actually able to print on is shown; on many printers this may be several cm
smaller than the full size of the paper.

o Printed region only   Only the area of each page that is actually printed on.

o Selected area only   You can export just part of a page by sweeping out the

area for outputting then choosing this option.

6. A border may be added to the Image by entering the widths of the left, top,
right, and bottom borders in the editable box, in order one after the other,
separated by commas.
If only one width is specified, EscapeE automatically sets all four borders to that
width. If two widths are specified EscapeE automatically sets the left and right
borders to the first width, and the top and bottom borders to the second width.
(Borders are normally set to 0 dots.)

o Select the units as cm, inches or pixels.

7. Set up the Final size for the image:

o Check Scale to to shape the final image to an exact size; enter the width

and height in the boxes.

o Check Trim to to crop the final image to an exact size; enter the width and

height in the boxes.

You may choose to use cm, inches or pixels as the unit of measurement.
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8. A default image Cache size of 10Mb will usually suffice, but this value may be
edited if necessary.

9. When the Use ICC profiles box is checked, any colors expressed in CMYK  will
be converted to RGB  by the RedTitan Color Management System using an ICC
color profile: see the RTcms Help file.
Click the ICC configure... button to display the configuration dialog for RTcms;
select a CMYK profile and the required rendering intent.

o If no profiles are available click the Browse... button to select a profile from

the Windows location
C:\windows\system32\spool\drivers\color.

If no profiles are in this location you can download them from the internet,
search for 'ICC Profiles'.

10. Some formats (e.g. PNG, TIFF) allow the white parts of an image to be treated as
transparent instead of opaque. Select Transparent white check-box for
'transparent' treatment; deselect for 'opaque' treatment. See also Handling
graphics .

11. You may tick the Force monochrome box to convert colors to 'black and white'
or 'gray scale' images (see also Fax note ).
Select a conversion method  from the drop-down list of options:

o Halftone 

o Threshold 

o Adaptive 

o Dither 

o Gray 

12. Select the smoothing options  for 'colored images and the screen' and
'monochrome images' that you would like EscapeE to use when images need to
be scaled down in size:

o Simple 

o Two-bit 

o 4-bit Gray-scale 

o 8-bit Gray-scale 

13. Select a 'Shading' option as appropriate: Standard, Fine or Gray-scale. See
Shading options .

14. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

Links
Image format file export  
More options for PDF export  
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AFP image file export

To export files to IBM AFP images

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose AFP images as the 'Format';

o a wild-carded  filename (with extension .AFP) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o check the LPR output  box: the filename will be supplied automatically.

To make 'AFP images' format the default, click Save format.

5. Click AFP options... button to display the Configuration dialog: see AFP export
options.

6. Tick the Force monochrome check-box if required. See also Image import/
export options.

7. Tick Run the associated program after creating the file if you want EscapeE
to open the file immediately using your preferred program: see Associated
programs.  The default associated program is EscapeE.

8. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

9. Click OK to export the pages.

 Tip:  It is recommended that you trim the image by sweeping out an area of the
page with the mouse and choosing Selected area from the Images  page of the
Configuration dialog.

Links
AFP export options
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AFP export options

Choose AFP images output format from the Options|Configuration dialog (f8)
then click the Options... button on the 'General' page, or 
Choose AFP images format from the File|Export dialog (Ctrl E) – see AFP image
file export  – then click AFP options...

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for AFP export 

1. Set up the FormDef (see Notes  below) by:

o typing in the 'AFP Medium Map' name corresponding to the PCL Simplex
and Duplex trays, or 

o tick Generate formdefs automatically, then enter the number of the tray
that you would like the AFP printer to use alongside each corresponding
PCL tray number cited in the document. (The entry for tray 0 applies in the
case where no PCL tray has been selected.)

2. To set more Image import/export options  select the Image options...
button.

3. To set up the default tray names for your output select the Printer tab from the
Configuration dialog – see Configuring the output printer's defaults .

4. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Notes

AFP systems use a "FormDef" resource to process the datastream which EscapeE can
generate automatically. The default set-up is a one-to-one mapping from the PCL tray
number to the AFP tray number. Alternatively, Users may choose to construct the
FormDef manually using Medium Map names and correlating them with the
appropriate trays and 'plexing'. Note that medium maps have names of up to eight
characters.

It is recommended that you use compression option CCITT group 4 .

Links
AFP image file export
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DCX/PCX fax image file export

To export files to DCX/PCX fax images

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.  Maximum number of pages is 1023.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose DCX fax images as the 'Format';

o a wild-carded  filename (with extension .DCX) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o check the LPR output  box: the filename will be supplied automatically.

To make 'DCX fax images' format the default, click Save format.

5. Tick the Force monochrome check-box if required. Click Image options... to
configure more Image import/export options.  

6. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

7. Click OK to export the pages.

 Tip:  For optimum viewing of PCX images with resolutions other than 300 dpi, users
may wish to create pre-scaled fonts at the correct resolution using RedTitan Font
Rasteriser.

Links
Image import/export options
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DICOM medical image export

To export files to DICOM format

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose DICOM images as the 'Format'.
A File name and path are supplied.

o A \ terminates the filename if 'Build a DICOM directory' option has been

selected.

o If 'Build a DICOM directory' option has not been selected, the file name will

be given extension .DCM.

You may use the Browse button to set up a new path.

To make 'DICOM images' format the default, click Save format.

5. Click DICOM options... to set up DICOM-specific configuration options: see
DICOM export options.

6. Tick the Force monochrome check-box if required, see also Image import/
export options .

7. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program: see
Associated programs.  The default associated program is EscapeE.

8. Click OK.

 Notes

A DCM 'image' file not only contains an image but also data pertaining to the image,
see DICOM Element Tags.

Sets of DICOM files are commonly shipped together in a self-contained 'directory':
see DICOM export options .

Links
DICOM export options  
DICOM element tags
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DICOM export options

Choose DICOM images output format from the Options|Configuration dialog (f8)
then click the Options... button on the General page, or 
Choose DICOM images format from the File|Export dialog (Ctrl E) – see DICOM
medical image export  – then click DICOM options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for DICOM export

1. DICOM medical files are usually output as a "directory" folder to facilitate their
distribution via external media (CD ROMs, USB memory sticks, ZIP files etc.).
This is the location of the "directory" file (note the "DIR" appended to the file
name) and the images folder "RTIMAGES". The 'DIR' file contains details of each
of the pages of the original file; the images file(s) are placed in the RTIMAGES
folder.

o When Build a DICOM directory is ticked, the 'File name' path specified in

the Export dialog defines the location of the directory folder containing the
directory file and its RTIMAGES folder.

o De-selecting 'Build a DICOM directory' outputs a basic DCM file, suitable for

use with a DICOM viewer (such as EscapeE) on your own local system.

Select Compressed to request run-length data compression of DCM
images. (Not all viewing software supports this, and it is deprecated if a
directory is being created.)

2. Some viewers are unable display the '1-bit' (black-and-white) images typically
produced by older equipment. If your original image was '1-bit', select Convert
1-bit images to 8-bit and EscapeE will do the transformation for you. This does,
however, increase the file size.

3. To accept this set-up of options:

o click Apply. Or, 

o click Image options... and configure further options: see Image import/

export options .

 Tip:  blank pages may be ignored by deselecting Show blank pages option in the
Printer  or Viewing  pages of the Configuration dialog.

Links
DICOM medical image export  
DICOM element tags
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EMF format file export

To export files to Enhanced MetaFile format

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose EMF Enhanced Metafile as the 'Format'.
A filename (with extension .EMF) and folder are supplied.

o To create a different filename or extension, type in the new name (wild-cards

 may be used).

o To select a different folder to store the file, use the Browse button.

To make 'EMF Enhanced MetaFile format' the default, click Save format.

5. Tick the Force monochrome check-box if required. Click Image options... to
configure more Image import/export options.

6. Choose the appropriate 'Resolution' from the drop-down box: Screen, Printer or
Image defaults.

7. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program, e.g. Windows
Picture and fax viewer. See Associated programs.

8. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

9. Click OK to export the pages.

Links
Image import/export options
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FDL form file export

To export files to FDL forms

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose FDL forms as the 'Format'.
A filename (with extension .FDL) and folder are supplied.

o To create a different filename or extension, type in the new name or use 

wild-cards .

o To select a different folder to store the file, use the Browse button.

To make 'FDL forms' format the default, click Save format.

5. Tick the Force monochrome check-box if required. Click FDL options... to
configure FDL export options.

6. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program, e.g.
RedTitan Page Designer . See Associated programs.

7. Click OK to export the pages.

 Notes

When generating FDL forms it may be necessary to save fonts and images. A folder is
created to contain any download fonts saved during FDL form generation (usually
\RedTitan\FONTS\PCLDLOAD). For fonts a name is made based on the font name,
point size etc, and a check is made to see if it is the same as a previously encountered
font to avoid duplicates. Because some drivers only download the characters they
need, the downloaded characters may be merged into an existing font if it has the
same characteristics and shares some characters with the new font and there are no
discrepancies. Images are given names based on hashing the image data and stored
in the IMAGES sub-directory of the library root directory (usually \RedTitan\FONTS
\IMAGES). Each image is only saved once, so before saving the image a check is also
made to see if it exists already. To save fonts and images in specific library paths see 
Changing font and image libraries .

To avoid problems when you are reusing the form, you can set EscapeE to recalculate
the characteristics of download fonts. See Setting General export options .

Links
FDL export options
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FDL export options

Choose FDL forms output format from the Options|Configuration dialog (f8) then
click the Options... button on the 'General' page, or 
Choose FDL forms format from the File|Export dialog (Ctrl E) – see FDL form file
export  – then click Options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for FDL export 

1. Select Render as graphic or select Render all but text as graphic: see notes
 below.

2. Set the resolution for line drawing and images and for text positioning: 600dpi
or 300dpi.

3. Select the format for any image(s) needed to output the document: RIF ,
TIFF  or PNG  (the default).

4. Select Generate flowed text in FDL forms if you wish to make changes to
the form later.

5. To import data tags, select from the 'Data tagging' options:

o MS Word  suitable 'Field delimiter' characters for the Start and End of

fields will be entered automatically.

o Other enter the Field delimiter characters Start and End edit boxes.

o Select None to clear any previous settings.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Notes

If you are going to edit an FDL form using Page Designer  you can combine the text
into flowed paragraphs with spaces in between: choose Generate flowed text in
FDL forms above .

If your PCL file contains tagged data, for example as created by Microsoft Word, you
can import the data names into the FDL form: see Data tagging  above.

Links
FDL form file export
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HTML document file export

Files can be exported in standard HTML  format to create a WEB page for the
Internet – see below  – as MIME -encoded HTML to include resources (see HTML
MIME encoded file export ) and HTML5 (see HTML5 UberEd format export ).

To export files to HyperText Mark-up Language

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose HTML document - WEB page as the 'Format'

o a wild-carded  filename (with extension .HTM) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button.
Note that if you enter the location of a folder on your web server here, the

file will be directly available to the Internet.
Or 

o check the LPR output  box: the filename will be supplied automatically.

To make the HTML document format the default, click Save format.

5. Tick the Force monochrome checkbox if required. Click HTML options... to
configure more HTML export options.

6. Tick Run the associated program after creating the file if you want 
EscapeE to open the file immediately using your preferred program, e.g. Internet
Explorer . See Associated programs.

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

8. Click OK to export the pages.

 Notes

The document is output as a file written in HyperText Mark-up Language, suitable for
display by a web browser. There is an option  to output the document as XHTML i.e.
the HTML is written using XML , so all elements start and end in a standardized way.
Documents typically require other resources e.g. images; these must be stored in
separate files, potentially in a different folder. See also HTML MIME encoded file export

To print HTML documents created by EscapeE and containing vertical lines, ensure
that "Print background colors and images" from the "Printing" section of the Internet
Explorer "Tools|Internet options...|Advanced" dialog is selected.
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HTML MIME encoded file export

As with 'HTML document - WEB page ' export, 'HTML MIME-encoded' creates files
that can be opened by web browsers. In this MHT  format, however, a single file is
created that contains all the resources packaged as a Multipart/Related MIME
document.

To export files to MIME-encoded HTML

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages which you want to export, see
Selecting page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose HTML MIME-encoded as the 'Format';

o a wild-carded  filename (with extension .MHT) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or

o check the LPR output  box; the filename will be supplied automatically.

To make 'HTML MIME-encoded' format the default, click Save format.

5. Tick the Force monochrome check-box if required. Click HTML options... to
configure more HTML export options.

6. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program, e.g. Internet
Explorer . See Associated programs.

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

8. Click OK to export the pages.

 Notes

If a local file path is specified then this will be used as a place to store the results
temporarily during the construction of the output. The addition of an appropriate
header giving sender and recipients would make the output suitable for Emailing.

Links
HTML export options
HTML document file export
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HTML export options

The configuration options for 'HTML document – WEB page ' and 'HTML MIME
encoded file export ' are common to both formats, see below . (If exporting to
HTML5 UberEd format , see HTML5 UberEd export options  instead.)

Choose an HTML output format from the Options|Configuration dialog (f8) then
click the HTML options... button on the 'General' page, or 
Choose an HTML format from the File|Export dialog (Ctrl E) then click HTML
options....

Click Apply to accept the 'options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for HTML export

1. Select save in XML format for XHTML only if normal HTML is inappropriate.

2. To export the document in HTML containing a single graphic image per page,
choose render as graphic; element options (see below) do not apply.

3. Set up the file prefix  to be used for creating the resource files. (If left blank
the output filename will be used as the prefix.) Numbers will be appended to
the names so that each resource file is uniquely identified.

4. Set up the local file path  to be used for storing the resource files. If left blank
the resources will stored in the same location as the output file.

5. Set up the URI path  for use when the page is referenced via the Internet.

6. Click Apply to set up these options and return to the 'General' page.

7. Select Printer page of the 'Configuration' dialog to set the printer defaults.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or Click the Save
button to retain these settings after you close the program.

Element options

To store text as longer phrases (to improve searching) select combine text
strings together.

To combine the non-text (graphic) elements into a single graphic image of each
page while retaining the text elements, choose render all but text as graphic. 

Selecting always use standard fonts ensures that fonts are never rendered as
bitmaps. De-select this option if the document contains non-standard fonts, for
example to allow logos coded as characters to be rendered as bitmaps.

Select keep original element order if the document has ordered opaque
elements (e.g. shading) to overwrite text or lines.
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 Notes

An HTML document consists of a sequence of elements: text, lines, shading, images
etc. EscapeE enables you to choose whether to output the pages as individual
elements or as a single PNG image or as a combination of text and a single PNG
image.

The elements in the document are placed at absolute positions and will be ordered so
that 'solid' elements (e.g. graphics) occur before 'open' elements (e.g. text). This
ensures that text cannot be obscured by opaque elements. You may override this
feature by selecting the Keep original element order option.

If the fonts defined in the original PCL document are not also in the browser's
resources, substitute fonts will be used. If this noticeably affects the appearance of
the document, you may opt to output an image of the document instead.

The Local file prefix can be set up as a prefix to the resource files being created. The
actual filenames used will be made by concatenating this prefix with the resource
name. File locations may be specified as 'relative' or 'absolute'. The URI prefix should
be the corresponding web URI for the directory path of the filename.

Links
HTML document file export
HTML MIME encoded file export
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HTML5 UberEd format export

Files exported in this HTML5  format are readable by the UberEd  program for
creating and editing multi-page documents.

To export files to HTML5

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose HTML5 UberEd format from the drop-down list.

o a wild-carded  filename (with extension .HTML) and folder are supplied.

To create a different filename or extension, type in the new name. To select
a different folder to store the file, use the Browse button.
Note that if you enter the location of a folder on your web server here, the

file will be directly available to the Internet.
Or 

o check the LPR output  box: the filename will be supplied automatically.

To make 'HTML5 UberEd format' the default, click Save format.

5. Tick the Force monochrome check-box if required. Click Options... to
configure more HTM5 UberEdL export options.

6. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program e.g. UberEd

. See Associated programs.

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)
XML
Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

8. Click OK to export the pages.

HTML5 UberEd export options

Choose HTML5 UberEd format as the 'Output' format from the Options|
Configuration dialog (f8) then click the Options... button on the 'General' page,
or 
Choose HTML5 UberEd format from the File|Export dialog (Ctrl E) – see HTML5
UberEd format export  – then click Options... 

Click OK to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.
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To set options for HTML5 UberEd export 

1. Set up the fields in 'Field definitions' panel:

o Use existing fields  Tick to extract items based on the existing fields and

their Type  e.g. 'Text aligned right'.

o Delete existing fields  Click to remove all existing field definitions (e.g.

when enabling EscapeE to define the fields automatically ). Confirmation is
required before this action is carried out.

o Define fields automatically  Tick to create new fields encompassing the

items found on the current page. These field 'Types' may be recognized and
set up automatically:
'Text aligned right',
'Text justified'
'Text centered'
'Graphic'.
If the Type of a field area is unspecified, anything in the area will be rendered
as a 'Graphic' for export.

o Use same fields on each page  Tick this if the document contains many

similar pages which need to be treated alike.
The default is for this option to be deselected, so any fields generated
automatically are defined for the current page only.

o Show Fields form  When this option is ticked The Field dialog  is opened

to show the definitions of the fields created on each page. This enables you
to edit  any definitions before the page is output.
Click OK to step to the next page's field definitions. When the fields for the
last page are displayed, clicking OK closes the Field dialog.

2. In the 'Options' panel:

o Show lines  Tick to include fields for representing any lines or drawn paths

on the page.

o Show graphics  Tick to include fields for representing any graphics on the

page.

o Use same options for each page  Tick this if the document contains many

similar pages which need to be treated alike: this dialog will not be shown for
subsequent pages.

3. Set up distances, measured in 1/600 inch units, in the 'Alignment and spacing'
panel:

o X difference to be vertically aligned 

Lines which end within this distance may be treated as 'Text aligned right'. It
is the maximum difference between x coordinates for two lines, e.g. 3.

o Flowed text

Line breaks will not be preserved.

4. Click OK to complete the export or 
click Cancel to abort the export and return to the document on display in the
EscapeE window.

 Note

Any JPEG-compressed images will be saved as JPEGs on export to HTML5. See also
JPEG compression options .
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IDF file export

A file for export to Intelligent Document Format  may comprise whole-page
impositions of an existing document and/or a number of clipped areas and/or a series
of IDF statements  entered manually. This is an invaluable feature when re-
purposing existing documents.

To export files to IDF

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose IDF Intelligent Document Format from the drop-down list of formats;

o a wild-carded  filename (with extension .IDF) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o check the LPR output  box; the filename will be supplied automatically.

5. To make the IDF format the default, click Save format.

6. Click Options... to set up IDF-specific configuration options: see IDF export
options .

7. Tick the Force monochrome checkbox if required.

8. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

9. To open the new file immediately in EscapeE, tick Run the associated program
after creating the file.

10. Click OK; if 'Show Fields form' has been configured, the Field dialog opens: see
IDF export options .

IDF export options

Choose IDF Intelligent Document Format output format from the Options|
Configuration dialog (f8) then click the Options... button on the 'General' page, or 
Choose IDF Intelligent Document Format from the File|Export dialog (Ctrl E) – see
IDF file export  – then click Options... 

Click OK to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or the Export dialog.
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To set options for IDF export 

1. Set up the fields in 'Field definitions' panel:

o Use existing fields  Tick to extract items based on the existing fields and

their Type  e.g. 'Text aligned right'.

o Delete existing fields  Click to remove all existing field definitions (e.g.

when enabling EscapeE to define the fields automatically ). Confirmation is
required before this action is carried out.

o Define fields automatically  Tick to create new fields encompassing the

items found on the current page. These field 'Types' may be recognized and
set up automatically:
'Text aligned right',
'Text justified'
'Text centered'
'Graphic'.
If the Type of a field area is unspecified, anything in the area will be rendered
as a 'Graphic' for export.

o Use same fields on each page  Tick this if the document contains many

similar pages which need to be treated alike.
The default is for this option to be deselected, so any fields generated
automatically are defined for the current page only.

o Show Fields form  When this option is ticked The Field dialog  is opened

to show the definitions of the fields created on each page. This enables you
to edit  any definitions before the page is output.
Click OK to step to the next page's field definitions. When the fields for the
last page are displayed, clicking OK closes the Field dialog.
See also Editing an IDF document .

2. In the 'Options' panel:

o Show lines  Tick to include fields for representing any lines or drawn paths

on the page.

o Show graphics  Tick to include fields for representing any graphics on the

page.

o Use same options for each page  Tick this if the document contains many

similar pages which need to be treated alike: this dialog will not be shown for
subsequent pages.

3. Set up distances, measured in 1/600 inch units, in the 'Alignment and spacing'
panel:

o X difference to be vertically aligned 

Lines which end within this distance may be treated as 'Text aligned right'. It
is the maximum difference between x coordinates for two lines, e.g. 3.

o Flowed text

Line breaks will not be preserved.

4. Click OK to complete the export or 
click Cancel to abort the export and return to the document on display in the
EscapeE window.

 Note

Any JPEG-compressed images will be saved as JPEGs on export to IDF. See also JPEG
compression options .
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IMG image file export

To export files to Xerox IMG images

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose IMG images (Xerox) as the 'Format'.
A filename (with extension .MET) and folder are supplied.

o To create a different filename or extension, type in the new name or use

wildcards .

o To select a different folder to store the file, use the Browse button.

To make 'IMG images (Xerox)' format the default, click Save format.

5. To set up input tray options, click Xerox options...: see IMG export options.

6. Tick the Force monochrome checkbox if required. See also Image import/
export options .

7. Enter the accounting department in the Dept box if required.

8. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program: see
Associated programs .

9. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

10. Click OK to export the pages.

 Notes

IMG export produces a datastream in Variable blocked format for feeding directly to a
channel-attached Xerox centralized DJDE/Metacode printer. (The Xerox IMG in Barr
format  is used where the printer has a Barr  spooler interface attached.) These
formats enable documents from standard word processing software to be output as a
PCL file and then converted by EscapeE for printing identically on a Metacode printer.
Both formats make use of PP.JSL supplied.

Input trays can be configured to correspond to the PCL input tray numbers. It is then
possible to set up a field definition which forces a particular type of page to feed from
the desired tray. See IMG export options.
The Dept option allows you to specify the accounting department to use. Contact
RedTitan if you require more help with using this option.
Creating an image does not allow you to edit the file or use the text search facility.
Use the FDL export  if you wish to create an editable version.
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IMG in Barr format file export

To export files to Xerox IMG images in Barr format

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose IMG (Xerox, Barr) as the 'Format'.
A filename (with extension .MET) and folder are supplied. To create a different
filename or extension, type in the new name or use wildcards.  To select a
different folder to store the file, use the Browse button.

To make 'IMG (Xerox, Barr)' format the default, click Save format.

5. To set up input-tray options, click Xerox options...: see IMG export options.

6. Enter the accounting department in the Dept box if required.

7. Tick the Force monochrome checkbox if required. See also Image import/
export options.  

8. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program: see
Associated programs .

9. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

10. Click OK to export the pages.

 Notes

IMG export produces a datastream in Variable blocked format for feeding directly to a
channel-attached Xerox centralized DJDE/Metacode printer. This Xerox IMG (Barr)
format is used where the printer has a Barr  spooler interface attached. These
formats enable documents from standard word processing software to be output as a
PCL file and then converted by EscapeE for printing identically on a Metacode printer.
Both formats make use of PP.JSL supplied.
Input trays can be configured to correspond to the PCL input tray numbers. It is then
possible to set up a field definition which forces a particular type of page to feed from
the desired tray. See IMG export options.
The Dept option allows you to specify the accounting department to use. Contact
RedTitan if you require more help with using this option.
Creating an image does not allow you to edit the file or use the text search facility.
Use FDL form file export  if you wish to create an editable version.
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IMG export options

The configuration options for 'IMG images (Xerox)' and 'IMG images (Xerox, Barr)' are
common to both formats.

Choose an IMG images output format from the Options|Configuration dialog (f8)
then click the Options... button on the 'General' page, or 
Choose an IMG images format from the File|Export dialog (Ctrl E) – see
Exporting files to IMG images , IMG in Barr format file export.  Then click
Xerox options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for Xerox IMG export 

1. Configure the input trays to correspond to the PCL input tray numbers, e.g:
Tray 1   MAIN

Tray 2   AUX

The entry for tray 0 applies in the case where no PCL tray has been selected.

2. Click Apply 
or 
to set further options (resolution, size etc.) click Image options... (see Image
import/export options ).

3. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Tip:  You may set up a field definition to force a particular type of page to feed from
the desired tray – see Setting field actions .

Links
IMG image file export  
Exporting files to IMG in Barr format 
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IPDS file export
Only installed on specialist systems.

To export files to IBM IPDS

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose IPDS as the 'Format'.
Enter a filename (with extension .IPD) or use wildcards.  To select a different
folder to store the file, use the Browse button.

5. Tick the Force monochrome checkbox if required.
Click IPDS options... to configure more IPDS export options.

6. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

7. Click OK.

Links
IPDS export options
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IPDS export options

Choose IPDS output format from the Options|Configuration dialog (f8) then click
the Options... button on the 'General' page, or 
Choose IPDS options format from the File|Export dialog (Ctrl E) – see IPDS file
export  – then click Options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for IPDS export 

1. If you would like to reduce the document size select use data compression.

2. If you would like to store text as longer phrases (to improve searching) select 
combine text strings together.

3. Select render as graphic or select render all but text as graphic or neither
of these options: see notes below.

4. Select keep original element order if the document has ordered elements
which may overwrite text or lines.

5. Enter the number of the input tray on the PCL printer (or use the spin-box)
and the number of the input tray to be used by the IPDS printer instead. Do
this for each tray used in the document.

6. Enter the number of the output bin on the PCL printer (or use the spin-box)
and the number of the output bin to be used by the IPDS printer instead. Do
this for each bin used in the document.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Notes

The module to export in IBM  IPDS protocol must be specially installed; contact
help@redtitan.com for more information.

IPDS printers can use their own built-in mechanisms to generate the text, drawing
and image elements of a document from a relatively small file of IPDS instructions.
Different printers, however, may render the document differently from the original. 
EscapeE copes with this by offering three options. If it is imperative that the document
is reproduced exactly, ticking the 'Render as graphic' box will remove any uncertainty
in the faithfulness of the output, at the expense of a much bigger file. Ticking the
'Render all but text as graphic' option will ensure that only the graphic elements are
reproduced exactly, so the output file is of intermediate size. If the file is essentially a
simple text document rather than a piece of artwork, you may leave both of these
options blank and rely on the IPDS printer's mechanisms.

Links
IPDS file export  
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JPEG image file export

To export files to JPEG image format

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose JPEG images as the 'Format'.
A filename (with extension .JPG) and folder are supplied. To create a different
filename or extension, type in the new name or use wildcards.  To select a
different folder to store the file, use the Browse button.

To make 'JPEG images' the default format, click Save format.

5. To set up resolution and size options, click Image options...: see Image import/
export options .

6. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program, e.g. Photo
Gallery. See Associated programs.

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Click Log file... to set up configuration options: see Log File export.

8. Click OK to export the pages.

 Tip:  To output the smallest file for the quality of image required, edit the JPEG
compression parameters: see JPEG compression options .

 Note

JPEG is designed for real-world pictures for which it gives good results, but for line-art
or solid color, TIFF  or PNG  format may be preferable: see Export formats .

JPEG compression options

The JPEG compression method was devised for storing real-world photographs as
digital images. It reduces file-sizes considerably but information on color and
luminance may be lost. Consequently, JPEG compression may not be the best choice
for detailed images with sharp lines.

To configure EscapeE to get the best JPEG image at the smallest file-size, see
Compression parameters  below.

You may choose to apply JPEG compression to image(s) found in PDF, PDF/A ,
PostScript , IDF  and HTML5  documents, while applying a different compression
method to the rest of the document: see JPEG images in other documents  below.
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Compression parameters

Experts may customize the values of the parameters used for applying JPEG
compression to an image (see also command line option /JPEGOPTS ). Note that this
set-up is also used when exporting to PDF, PDF/A , PostScript  and IDF .

1. Choose Configuration... from the 'Options' menu (or press f8) to open the
General  page of the 'Configuration options' dialog.

2. Select JPEG images Output Format then click the Options... button alongside to
show the JPEG Options page.

3. Tick the Low resolution color check-box to effectively average the color (rather
than the luminance) of a number of pixels, yielding a smaller number of "bigger"
color pixels. This results in smaller images with some loss of quality – sharp
edges may appear fuzzy and colors smeared out, but this is usually acceptable for
photographs.

4. Enter/select a value for image Quantisation quality:
100 for minimal degradation, but bigger files than

000 for heavily quantized (i.e. highly compressed but low quality) images.

Intermediate values may be used to vary the degree of quantization; the default
value used is 50.

5. Tick the Coarse color quantisation check-box to allow the color to be rounded
to fewer levels (fewer than the luminance values), again yielding smaller images
with some loss of quality. This may be acceptable for graphic art using limited
palettes.

6. Click Apply.

JPEG images in other documents

1. Choose Configuration... from the 'Options' menu (or press f8) to open the
General  page of the 'Configuration options' dialog.

2. Select PDF images Output Format then click the Options... button alongside
to show the PDF Options page.

3. Click More....

o To apply JPEG compression to any JPEG images found in the document,

tick if it was a JPEG. Alternatively,

o set up a benchmark to determine whether JPEG compression is to be used

or not. Enter/select a value for Use JPEG for images from the drop-down
box:

Always  always use JPEG compression for all images (100)

Never  never use JPEG compression for any image (0)

If appropriate  and set up an intermediate value to bias the set-up
towards or against choosing JPEG compression; EscapeE defaults to
using a value of 50.

 Tip:  you can check whether an image in the document on view was sourced from a
file in JPEG format by looking for "JPEG" in the image's Graphic details .

Links
JPEG image file export  
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PCL document file export

To export files to HP PCL

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose PCL document as the 'Format';

o a wild-carded  filename (with extension .PCL) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o check the LPR output  box; the filename will be supplied automatically.

To make 'PCL document' format the default, click Save format.

5. Tick the Force monochrome check-box if required. Click PCL options... to
configure PCL export options .

6. The Duplex override box is normally blank but if an override is already in force
then the plex option is shown (in maroon as a warning). You may choose an
option from the drop-down list, see Simplex and duplex options .

7. Tick Run the associated program after creating the file if you would like to
open the file immediately, using your preferred program ( EscapeE is an
obvious choice). See Associated programs  for instructions.

8. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

9. Click OK.

 Tip:  If you have opted to create macro(s)  from the page(s), a Macro box is
shown on the dialog: enter the number  for the (first) macro, see PCL export
options . To revert to exporting PCL rather than macros (and remove the 'Macro'
box from the dialog), clear the Permanent and Temporary 'Save as a macro'
boxes, see PCL export options .
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 Notes

PCL files that have been repeatedly edited and updated often accumulate redundant
code and unnecessary font downloads. By running such a PCL source file through PCL
'Export' you can reprocess the file and produce tidy, efficient code again. If you need
to copy the PCL code without reprocessing, choose Subset as the export format – see
Saving pages to a PCL file .

EscapeE output always orders the elements in the document so that 'solid' elements
(e.g. graphics) occur before 'open' elements (e.g. text). This ensures that modern
color printers (which use patterns of colored and white dots to render shaded areas),
always place text and drawn lines on top of any opaque elements. You may override
this feature by selecting the Keep original element order option.

As with PS and PDF export, compression, string combination and graphic/graphic
with text options are available.

Each page in a document may be used to create a new macro  using the Export 'PCL
document' format. See To set options for PCL export .

Links
Saving pages to a PCL file  
PCL export options  

PCL export options

Choose PCL document output format from the Options|Configuration dialog (f8)
then click the Options... button on the 'General' page, or 
Choose PCL document format from the File|Export dialog (Ctrl E) – see PCL
document file export  – then click PCL options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for PCL export

1. Select Use data compression when exporting to modern printers; adaptive
compression methods reduce the size of files containing images.

2. You may reduce the size of the file by choosing:

o to Render all but text as graphic, which retains the 'text' features (e.g.

search).

o You may reduce the size of the file further by choosing to Render as

graphic instead.

In addition, you may now choose to Include text as well as the
graphic; this would use least memory of all.

See Notes  below.

3. If you would like to store text as longer phrases (to improve searching) select 
Combine text strings together.

4. It is usually best to select Include TrueType fonts unless you are using a
printer that does not support TrueType fonts. If this is not selected then
bitmapped fonts will be used, which in some cases may result in a smaller
output file depending on the point sizes used.

96

446

168

96

168

167

170



169Export files

5. If you have set up substitute fonts in the 'Fonts | Substitute Fonts...' dialog,
you may Use standard fonts if substitute font given. 

o Select Always to always use standard fonts i.e. so that only fonts from the

library are used and no fonts are downloaded. 

6. Select Save fonts separately in file if required (see Notes  below). You may
enter a filename in the edit-box below or simply use the *.hp default.

7. Select LIDIL (graphics only) printer if exporting to a host-based  printer.

8. Tick the Omit blank pages option if appropriate – for example when exporting
a document which is to be viewed on screen (not printed) from a duplex
original.

9. Select Keep original element order if the document has ordered opaque
elements (e.g. shading) to overwrite text or lines.

10. Select Printer supports scalable images unless you are using an old printer
that cannot handle scaled graphics.

11. These PJL options are provided for PCL specialists:

o Export PJL comments check-box: see PJL Comments .

o The Do not use PJL commands check-box to remove unwanted PJL from

the output if the printer is not strictly PCL compatible. See also Preamble
and PJL options: Notes .

o Edit-boxes to set up a PJL prefix and PJL separator: see PCL field prefix

.

o An editing window for entering a Preamble: see Preamble .

12. Set the resolution for line drawing and images and for text positioning: 600dpi
or 300dpi.

13. To enable macro(s) to be created from the PCL, enter the macro number
(EscapeE initially defaults to 100) then choose:

o Permanent – macro retained from one job to the next, or 

o Temporary – macro deleted from printer at the end of the current job.

Setting either of these options causes the LIDIL (graphics-only) printer  box
to be checked, thus ensuring that the macro is exported as a graphic. The
macro number  is also displayed on the PCL export  dialog.

14. To use a different Input tray from that specified in the original document, use
the spin box to set up the original tray number and enter the new tray number
in the box alongside.

15. To use a different Output bin from that specified in the original document, use
the spin box to set up the original bin number and enter the new bin number in
the box alongside.

16. The Duplex override box is normally blank but if an override is already in force
then the plex option is shown (in maroon as a warning). You may choose an
option from the drop-down list, see Simplex and duplex options .

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.
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Notes

A PCL file may be rendered as a graphic only or as a graphic with text. The 'graphic
only' option will produce an accurate image from the file, including an image of the
text, but cannot be used for extracting text for further processing. Exporting the file
as 'graphic with text' retains the text features and consumes less memory.

Creating macros using PCL export outputs a totally new PCL file using mainly HP-GL
commands. Ticking render as graphic eliminates possible font problems.

On large production printers, it may be more efficient to download all the fonts
needed for a complex task at the start of a run, rather than loading them one page at
a time. It then does not matter if the output pages are re-ordered e.g. if the pages
are sorted by postal address instead of by surname. Ticking Save fonts separately
in file creates such a file and assigns each font in it a unique "ID". This reduces the
size of the page files while ensuring that each page can access the fonts it needs
when the task is sent to the printer. See also Handling fonts , /FONTFILE .

Links
PCL document file export
Saving pages to a PCL file

Preamble and PJL options

One or more lines of information at the start of a file are usually sent to a printer
before it starts to print a page. These prepare the printer so that it is set up ready to
print the page. For HP-compatible printers, this code is in "PJL " and known as the
'Preamble'. For Xerox printers, the code uses "XRX" commands. EscapeE can
propagate PJL and XRX code as a Preamble  when exporting to PCL , PostScript ,
PDF  and PDF/A  formats.
Most users need not know about these technicalities, but EscapeE enables experts to
create specialist data-fields from these lines of code. See PJL prefix  and Special
fields in composed strings .

Preamble

The Preamble is made up of lines of code which may be commands for the printer to
execute and/or Comments . Comments are there to aid the Operator and are
ignored by the printer. You may view a document's comments on the PJL  page of
the Console notebook.
The total number of characters in each line of the preamble must not exceed 255
but the Composite field  syntax can be used to build up longer strings or to copy
information from the input.
If a PCL file's preamble strings do not begin with an 'Escape' character it is assumed
to be PJL. EscapeE outputs an "enter PJL" sequence and begins each preamble line
with:

@PJL

ending the preamble with:

@PJL ENTER LANGUAGE=PCL.

See also the two corresponding command-line options:
/PCLPREAMBLE  and /PSPREAMBLE .
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PJL Comments

Any PJL Comments  found in the input document's Preamble  can be passed to a
document on export to some formats:

PCL : Choose PCL document output format from the General page of the
Configuration dialog (f8) then click the Options... button.

o Tick Export PJL comments.

PDF , PDF/A : Choose PDF document or PDF/A document as the output
format (from the General page of the Configuration dialog) then click the 
Options... button.

o Tick Export PJL comments.

PostScript: Choose a Postscript output format from the General page of the
Configuration dialog (f8) then click the Options... button.

o Click More... button and select an 'Include PJL comments' format option:

XML or Plain text. See More options for PS export .

Up to 26 of these Comments (and also the JOB and JOBATTR commands) from the
original file may be associated with each page. They are output as Plain text or as
XML-style strings, labeled alphabetically. A typical line in a PDF might be:
% <RT A='COMMENT &34;HEADER PCL&34;' B='COMMENT &34;Driver version
02.03&34;'/>

(Note that the UNICODE hex code 34 is used to output the double quote character.)

Or in Plain text:
% COMMENT "HEADER PCL" % COMMENT "Driver version : 02.03"

Comments may be specified on the command line using /COMMENTS  option.

 Tip:  a PJL command of the form

@PJL COMMENT REDTITAN DIR xxxx

will cause the special field  {_RT} to have the value xxxx.

 Notes

When the 'Ignore' PJL commands option (on the General  page of the Configuration
dialog) is ticked, any PJL commands found in the input file are stored but cannot be
exported. They may, however, be used to provide values for fields using the prefix
mechanism. In general usage, this specialist feature can be safely ignored.
If the Ignore PJL commands check-box is cleared, PJL commands found in the input
file are stored and will be included in the exported file. PJL commands constructed
using the prefix  mechanism may also be exported.

There is an option to remove unwanted PJL from the output file – for example, when
outputting to a printer which is not strictly PCL compatible. Display the Configuration
dialog's 'PCL document' options page (see PCL export options ) and tick Do not use
PJL commands.

Links
PJL Comments  
Special fields in composed strings  
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PDF document file export

To export files to PDF

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose PDF document as the 'Format';
o a wild-carded  filename (with extension .PDF) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or

o check the LPR output  box; the filename will be supplied automatically.

To make 'PDF document' format the default, click Save format.

5. Click PDF options... to display the Configuration dialog and set up PDF export
options.

6. Tick the Force monochrome check-box if required.

7. The Duplex override box is normally blank but if an override is in force then
the plex option is shown (in maroon) – see Simplex and duplex options .

8. Tick Run the associated program after creating the file if you want 
EscapeE to open the file immediately using your preferred program, e.g. Adobe

Acrobat  or EscapeE. See Associated programs.

9. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)
XML
Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

10. Click OK to export the pages.

 Tip:  When viewing the PDF output in Adobe Acrobat, you may need to turn off the
smoothing options. These may be found on the 'Preferences' dialog in the Acrobat
'Edit' menu.
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 Notes

Documents exported as PDFs can be viewed directly with a browser and may be
searched for text strings. The fonts required to display the document are often
included with the PDF file, but this can make the file very large. To reduce the file-
size, PDF files may include references to external fonts instead – unlike PDF/A
document files.  This is helpful when the referenced fonts are installed on users'
systems already: see PDF export options.  If you are not happy with the appearance
of fonts in the output file, please contact RedTitan for more help with fonts.

If you are using EscapeE to view a PDF file which includes referenced fonts that are
not available on your system, EscapeE uses the fonts which best match the requested
fonts' properties from the fonts which are available. Thus, while the major attributes
of a font's style will be honored, minor features may differ and so the display will not
be an exact image of the original document. For example, if an italic font with a
custom underline has been requested, the font used will be italic but the default plain
solid underscore will be used for the underline. A message detailing the attributes of
the fonts requested and used will be placed on the Error messages  page of the
Console notebook when this happens. See also Setting up a Font Substitute file .

By default, EscapeE will use substitute fonts for any printer-resident fonts (e.g.
Courier, CG Times and Univers) and any downloaded fonts will be converted to bitmap
fonts and included in the PDF. These defaults can be changed – see PDF export
options.  You can opt to create a 'Table of Contents' from selected fields, or from
tags: for example, special font definitions.

Fields may be defined to enable the export of unfilled PDF forms using a number of
special options: buttons, borders, check-boxes, editable boxes, lists. See Special
fields for PDF export.  

There are two methods of generating PDF files with security restrictions. The original
method used two passwords: one to allow full ownership access including changing
the security options, the other for general users: see PDF export options . The
alternative method uses "public" and "private" keys to digitally sign and/or encrypt
the document: see Security options for PDF export .

There are command line options which enable the PDF document summary elements
Title, Description, Author, and Keywords to be defined: see PDF document summary.

There are command line options for setting up preferences regarding the display of a
PDF document: see PDF viewer preferences.

Links
PDF export options  
PDF/A document file export
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PDF export options

Choose PDF document output format from the Options|Configuration dialog (f8)
then click the Options... button on the 'General' page, or 
Choose PDF document format from the File|Export dialog Ctrl E) – see PDF
document file export  – then click PDF options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for PDF export 

1. In the 'PDF options' panel:

o By default Use data compression is ticked so that output files are

compressed. To export files uncompressed instead, clear the box. See also 
More options for PDF export.

o Select Combine text strings together to store text as longer phrases to

improve searching, see Text options .

o Include TrueType fonts is usually selected to embed any TrueType font,

downloaded in the original PCL file, in the exported PDF file. See Notes
below.

o The Omit blank pages option may be ticked as required – for example

when exporting a document which is to be viewed on screen (not printed)
from a duplex original.

o Normally, each element on the original page (text, image, shades, drawn

lines etc.) is placed individually on the PDF page.
Alternatively, you may choose to consolidate some or all of the elements:

Render all but text as graphic or 

Render as graphic. You may also opt to Include text as well as the
graphic: see Text options .

2. To reduce the size of the exported PDF file, you may choose to substitute fonts
in the original document and 'Use standard Adobe fonts' instead. (See also
General Ignore download font options .)

o If you choose to replace bitmap fonts, TrueType fonts or always, ensure

that such fonts in the document are using the Windows character set,
otherwise characters may be wrongly attributed. See also About symbol
sets .

o Selecting if substitute font given option will only omit the download font

if it is recognized as having a known substitute, so is more reliable: see
also Substitute fonts.

3. To restrict the capabilities for general users select one of the 'Do not allow'
options:

o Printing

o Changing the document

o Adding or changing notes and form fields

o Selecting text and graphics.

172

177

131

175

131

125

81

89



175Export files

4. To generate PDFs with restricted access you may either:

o Enter one password to Open the document and enter another password

to enable administrators to change Security options.
Warning: curly brackets, { and }, will be interpreted as introducing a field

name (see Special fields in composed strings ), so to incorporate these
characters in the password you must substitute the two character
sequences _{ and _} respectively.

Or:

o Click Security options button and set up a signing certificate profile and/

or recipient list: see Security options for PDF export .

5. Set the 'Resolution' for line drawing and images and for text positioning: 
300dpi or 600dpi (default).

6. Keep original element order is selected by default. Depending on the way
opaque and transparent elements (e.g. shading) have been layered in a
document, however, it may be advisable to select graphic elements first: see
Text options .

7. Tick Export PJL comments to include any PJL comments  and JOB
commands in the output.

8. If the document contains embedded TrueType fonts, you may opt to Subset
TrueType fonts, see Notes  below.

9. To assemble a list of fields to be used as a 'Table of Contents' for the document,
click the Contents... button: see PDF Table of Contents .

10. Click the More... button to set further PDF options; see More options for PDF
export.

11. The Duplex override box is normally blank but if an override option is in force
it is shown in maroon, see Simplex and duplex options .

12. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Notes

Double-byte fonts, such as currency symbols, Chinese characters and box-drawing
characters, are rendered as graphics.

When exporting to PDF, Include TrueType fonts  that have been downloaded in the
original PCL file is selected by default. If this box is not checked then such fonts are
converted to bitmap fonts. Using TrueType (i.e. scalable outline) fonts usually results
in better appearance than bitmapped fonts, but may have adverse effects on the file
size if only a few characters from a font are used. Checking Subset TrueType fonts
may reduce file-sizes considerably in such cases: only the characters actually used in
the document are embedded, rather than all of them. For example, a document in
English containing an Ω character would not need to export the entire Greek alphabet.
The corresponding command line option is /TTSUBSET .

There is a command-line option to specify the password for PDF input independent of
the one for output: see /PDFREADPASS .

Links
Special fields for PDF export  
PDF document file export
More options for PDF export
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Security options for PDF export

For greater security than the standard password  protection measures can provide
for keeping PDF files safe, you may set up a Signing certificate  and/or an Encryption
certificate . You may also sign  PDF/A documents. Digitally signed documents may
be Time-stamped  and given authorization protection too, if required.

To access the digital security options

1. Select PDF document or PDF/A document format from the File|Export dialog
(Ctrl E) – see PDF  or PDF/A  document file export.

2. Click PDF options... to open the PDF configuration dialog.

3. Click Security options to display the digital security page.

Signing a document

When a document has been digitally 'signed', recipients trying to open a PDF or PDF/A
file may check whether it has been altered since it was signed and also how
trustworthy the signature is.

The signature consists of a 'digest' of the document and a 'Signing certificate' file
or profile . The signing certificate requires an associated 'Private key' and the
authority of the signature.

Private keys (.PFX files) are installed on the PC and Windows keeps them safe for
you in its own certificate-store.

A trustworthy signature is a chain of referees linking back to a 'Root Signature':
self-signed documents must be treated with caution!

See also your Email Tools Options Security settings.

 Font note: When exporting to PDF format, there are options  to use Adobe fonts
rather than downloading the original fonts used when the document was created
(as PDF/A  does). These are useful for reducing the size of a PDF file, but if your
document contains uncommon characters it may be best to deselect them. This
forces the document to include your original font, so you can be sure that the
characters in the exported document are always the same as those in the original.
(For example, currency and maths symbols – if present at all – may not conform to
a standard symbolset.)

1. Display the digital security options page as above .

2. Select a Signing certificate profile  from the drop-down list.
Alternatively, to cancel a previously selected certificate, select <None> instead.

3. Click OK to close the 'Configuration' dialog or 
click Apply to return to 'PDF options' page.

The digest will be created and the resulting signature applied to the whole PDF
document when it is exported.

Encrypting a document

PDF (but not PDF/A) files may be 'encrypted' so that only specified recipients may
view the document.

To encrypt a PDF document you use a .CER, .P7B or Security profile  'Encrypting
certificate'. Encrypting certificates employ the 'Public keys' of one or more
recipients.
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1. Display the digital security options page as above .

2. Select a suitable 'Encryption' option:

o 40-bit (RC4 encryption, used before 1999)

o 128-bit (RC4 encryption, superseding '40-bit')

o 128-bit AES (more secure than RC4 encryption but not as fast).

3. Specify the Recipient list  {public keys}:

o Browse to or 

o Select from the drop-down list.

4. Click OK to close the 'Configuration' dialog or 
click Apply to return to 'PDF options' page.

About Security profiles

Certificates are organized very securely by your PC and it is usually inconvenient to
enter simply a filename and full path. This is often the case when encrypting a
document containing many Public keys so that the same PDF may be exported to a
number of recipients. User-friendly RedTitan 'Security Profiles', however, may be
constructed to contain all the certificate information and keys necessary – just select
one from the drop-down list.

To set up a Signing certificate profile or Recipient list, click Manage certificates
on the digital security  page. The RedTitan EEcerts  Certificate management
program will open. See EEcerts Help for more details.

About Time-stamping

"Time-stamps" are used to pin-down documents and their contents to a precise and
verifiable moment. A digest of the time-stamped document is created for you by a
'Time Stamping Authority' via a 'Trusted Third Party'.

To Time-stamp a document, click Manage certificates on the digital security
page. The RedTitan EEcerts  Certificate management program will open. See
EEcerts Help for more details.

More options for PDF export

Click the More... button on the PDF options page of 'Configuration' dialog (see
PDF export options , PDF/A export options ).

If a file is to be compressed, standard data compression methods which reduce the
file's size without losing information are usually applied to the entire document (see 
PDF export options , PDF/A export options ). When exporting to PDF formats,
however, you may choose to treat the images in the document differently, see JPEG
compression options . JPEG is good for compressing color images, but unsuitable for
monochrome images.

Gray-scale  is best for scaling-down 1-bit images.

PDF documents have no need of "finishing" information (such as which media trays to
use) because they are intended for use on-screen. Finishing information may,
nonetheless, be included in a PDF document: see Solimar ® finishing, below .
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Gray-scale options

Converting to gray-scale is of most benefit for scaling down 1-bit real-world images,
see Monochrome conversion . Though "lossy", it can reproduce something close to an
original gray-scaled image, compressed by half-toning or dithering.

by 4 to 4-bit gray generally gives the best appearance. However, if the image is
to be scaled down heavily, then:
by 8 to 8-bit gray resolution produces a smaller file but a coarser appearance.

Image trimming

1. Select an Image option:
Paper size only  The image is trimmed to the size of the selected paper.
Printed region only  White space is removed to leave the smallest rectangle
which will contain all the printing.
Printable region only  The image is trimmed to the area of the page which a
PCL printer would print on.
Selected area only  Outputs the area that has been swept out. If an area has
not been swept out, the first field found is used to define the area. If neither an
area nor a field can be found, the default ("Full", see below) is used.
Full  The default. The whole page is output, including any items which fall outside
the area of the page.

2. If you would like to add a Border around the trimmed image, key-in the width of
the Left, Top, Right, Bottom borders and select the appropriate units: Cm,
Inches or Pixels. For example, 1,3,1,3 adds 1 unit to the sides and 3 units to

the top and bottom of the image.

3. Click Apply.

Override options

If the document needs to be printed a specific size using Adobe Acrobat , tick
Unscaled printing. This ensures that the document will not be "scaled to fit" by
default and so the dimensional accuracy of the printed document will be
maintained.

If you have set up a Table of Contents  it will be generated when the document
is exported to PDF or PDF/A. To override this, tick Do not make a Table of
Contents check-box.

The preferred compression mode for monochrome document export is usually 
CCITT4  and so the Permit CCITT4 compression check-box is ticked by
default. You may disallow CCITT4 compression by de-selecting this option
(although it is unusual for PDF readers not to cope with CCITT4 compression).

Solimar finishing

On Solimar systems, finishing instructions are carried on the "front" (i.e. odd-
numbered) page of each sheet of paper. To set up the media instructions for Solimar
finishing, select an option from the drop-down list:

Use tray numbers as specified in the original file.

Use PCL trays Specify a PCL tray number by clicking the View trays button then
editing the spin box value.

Use Postscript trays To view/edit tray set-ups, click View trays button; see
PostScript export options .

Use trays appropriate to input format To view/edit tray set-ups, click View
trays button.

 Tip:  You can avoid processing images in a PDF document by ticking the 'Ignore'
Images  option on the 'General' page of the Configuration dialog. No images will be
shown when the file is viewed or included in files exported to PDF.
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PDF/A document file export

To export files to PDF/A

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose PDF/A document as the 'Format';

o a wild-carded  filename (with extension .PDF) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o check the LPR output  box; the filename will be supplied automatically.

To make 'PDF/A document' format the default, click Save format.

5. Click PDF options... to display the Configuration dialog and set up PDF/A
export options.

6. Tick the Force monochrome check-box if required.

7. You may choose a Duplex override  option from the drop-down list:

o Simplex  force simplex

o Long edge  force duplex, long edge binding

o Short edge  force duplex, short edge binding

o No plex  do not specify any plex in the output file

o As in the file  use the option specified in the input file.

8. Tick Run the associated program after creating the file if you want 
EscapeE to open the file immediately using your preferred program, e.g. Adobe
Acrobat  or EscapeE. See Associated programs.

9. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)
XML
Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

10. Click OK to export the pages.
 Tip:  When viewing the PDF output in Adobe Acrobat, you may need to turn off

the smoothing options. These may be found on the 'Preferences' dialog in the
Acrobat 'Edit' menu.

 Notes

PDF/A is an unencrypted archive format that can be viewed with a browser and creates
documents which can be searched for text strings. The fonts required to display the
documents are always included with PDF/A files, and this can make the files very
large. See PDF/A export options.
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PDF/A export options

Choose PDF/A document output format from the Options|Configuration dialog
(f8) then click the Options... button on the 'General' page, or 
Choose PDF/A document format from the File|Export dialog (Ctrl E) – see PDF/
A document file export  – then click PDF options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for PDF/A export 

1. In 'PDF options' panel:

o Tick Use data compression to compress output files, or clear the box to
export files uncompressed. See also JPEG compression options .

o Select Combine text strings together to store text as longer phrases to
improve searching, see Text options .

o You may choose to Render all but text as graphic or Render as graphic,
(and optionally, Include text as well as the graphic too): see Text
options .

o Select include TrueType fonts to include any TrueType font, downloaded
in the original PCL file, in the exported PDF file. Using TrueType (i.e.
scalable outline) fonts usually results in better appearance than bitmapped
fonts, but may have adverse effects on the file size if only a few characters
from a font are used. If this box is not checked then by default such fonts
are converted to bitmap fonts.

o The omit blank pages option may be ticked as required, for example
when exporting a document which is to be viewed on screen (not printed)
from a duplex original.

2. To restrict the capabilities for general users select one of the 'Do not allow'
options:

o Printing

o Changing the document

o Adding or changing notes and form fields

o Selecting text and graphics.

3. Set the 'Resolution' for line drawing and images and for text positioning: 
300dpi or 600dpi.

4. To digitally sign a PDF/A document, click Security options...: see Security
options for PDF export .

5. Depending on the way opaque and transparent elements have been layered in a
document (e.g. shading), it may be advisable to select graphic elements first
or keep original element order; see also Text options .

6. Tick Export PJL comments to include any PJL comments  and JOB
commands in the output.

7. To assemble a list of fields to be used as a 'Table of Contents' for the document,
click the Contents... button: see PDF Table of Contents .
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8. Click the More... button to set further PDF/A options; see More options for PDF
export .

9. The Duplex override box is normally blank but if an override option is in force
it is shown in maroon, see Simplex and duplex options .

10. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Notes

Double-byte fonts, such as currency symbols, Chinese characters and box-drawing
characters, are rendered as graphics.

Security options enable PDF/A documents to be digitally signed using Certificates
but not or encrypted or password protected (unlike PDF documents).
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PostScript file export

To export files to PostScript

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose PostScript level 2 or PostScript level 3 as the 'Format'.
o A wild-carded  filename (with extension .PS) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button or

o Check the LPR output  box; the filename will be supplied automatically.

To make the selected PostScript format the default, click Save format.

5. Tick the Force monochrome check-box if required. Click PostScript
options... to configure more options for export.

6. The Duplex override box is normally blank but if an override option is in force
it is shown in maroon, see Simplex and duplex options .

7. Tick Run the associated program after creating the file if you want 
EscapeE to open the file immediately using your preferred program: see
Associated programs.  The default associated program is EscapeE.

8. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:
o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)
XML
Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

9. Click OK to export the pages.

 Notes

EscapeE directly generates output for PostScript level 2 or 3 printers  without using
any Windows printer driver.

There is an option to use data compression : this usually reduces the size of the
output files, though it makes them slower to generate. See also JPEG compression
options .

The tray/bin selection specified in the PCL data can be overridden on the command
line: see options /TRAY  and /BIN .
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PostScript export options

The configuration options for 'Postscript level 2' or 'Postscript level 3' are common to
both formats.

Choose a Postscript output format from the Options|Configuration dialog (f8)
then click the Options... button on the 'General' page, or 
Choose a Postscript format from the File|Export dialog (Ctrl E) – see PostScript
file export  – then click Postscript options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for PostScript export

1. If you would like to reduce the document size, select Use data compression.
EscapeE applies a suitable compression method (e.g. Flate) to the document.
You may also opt to apply JPEG compression to any images in the document,
see JPEG compression options .

2. If you would like to store text as longer phrases (to improve searching) select 
Combine text strings together, see Text options .

3. You may choose to:

o Render as graphic 

o Render all but text as graphic, and also

Include text as well as graphic 

See Text options .

4. Select Include TrueType fonts to include any TrueType font downloaded in
the original PCL file in the exported PDF file. Using TrueType (i.e. scalable
outline) fonts usually results in better appearance than bitmapped fonts, but
may have adverse effects on the file size if only a few characters from a font are
used. If this box is not checked then by default such fonts are converted to
bitmap fonts.
Very big documents and forms often use a large proportion of the characters in
a font; in these cases, efficiency may be improved by selecting Load fonts
first, particularly if your driver builds up the font incrementally page by page
(e.g. MS Windows). It is best to de-select this option for short documents or
those with large fonts (e.g. Chinese) which take a long time to load.

5. To reduce the size of the exported PostScript file, you may specify when to
substitute fonts in the original document with Standard Adobe  fonts.

o If you choose to use substitute fonts Instead of bitmap fonts, Instead

of downloaded TrueType fonts or Always, ensure that such fonts in the
document are using the Windows character set , otherwise characters
may be wrongly attributed.

o The If substitute font given option will only omit the download font if it

is recognized as having a known substitute, so is more reliable: see also 
Substitute fonts.

6. Set the Resolution for line drawing and images and for text positioning:
600dpi or 300dpi.
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7. Assign each of the numbered PCL Output Bins used by the document a
PostScript name. PostScript bin names may be letters, numbers or a mixture of
both.

8. Assign each of the numbered PCL Input Trays used by the document a
PostScript Name or number. (The entry for tray 0 applies in the case where no

PCL tray has been selected.) You may select a standard paper  Size from the
drop-down box or leave this blank and fill in the paper Height and Width (in
inches) yourself.
When exporting to a 'production' printer, it is useful to specify the Weight (in
grams), Color and Media-Type attributes as well.
If exporting to a smaller printer which uses numbered trays, just give the tray a
number instead of a name (and leave the other attributes blank).
See also Notes  below.

o To remove a tray definition from the list, click Delete.

o To remove all the tray definitions from the list, click Delete all.

9. Select Keep original element order if the document has ordered opaque
elements (e.g. shading) to overwrite text or lines.

10. The Omit blank pages option may be ticked as required – for example when
exporting a document which is to be viewed on screen (not printed) from a
duplex original.

11. Further options may be set up from other pages of the Configuration dialog:

o Click More... to set up Jog offsetting, stapling and PJL comments options:

see More options for PS export .

o There is a specialist option for setting-up a "Preamble" (see Preamble and

PJL options ). Click Preamble... to open an edit pane and enter the code
required.

o Select Printer tab to set the printer defaults ; see also Technical notes

below.

12. The Duplex override box is normally blank but if an override option is in force
it is shown in maroon, see Simplex and duplex options .

13. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

Notes

PostScript files include a DSC (Document Structuring Convention) header which
specifies the input trays and output bins to be used when the document is printed.
The trays may be identified by index number or by attributes (media size, color,
type, weight). When EscapeE reads a PS file, it uses the information in the DSC
header to assign existing PCL tray names to the specified trays (see step 7 above).
If no match can be found for a specified tray, EscapeE creates a new one
automatically. For example, a tray identified by attributes might be named 
PSTRAY12, whereas a tray identified by index number might be named 12. The

numbers may not correspond to the physical layout of trays so check the printer's
.PPD file (or use 'TRAYS.PS', obtainable from RedTitan) to ensure that the correct
tray is selected in the 'Configuration' dialog.
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The output is sent to a bin that has a number and a name. Note that the names
may be longer than eight characters, may contain spaces and are case-sensitive.
For production printers the output document must be created with a PostScript DSC
header. This must specify the attributes of the paper stock – the size, weight, color
and type of the paper associated with each named tray. A document will not
normally be printed until all its specified media requirements are met – be careful
not to set up a long list of trays that result in a media list that cannot be actually
configured on the printer. If different documents require different tray
configurations then you should save each separately and only apply them to the
appropriate one.

Technical notes

The tray/bin selection specified in the PCL data can be overridden using /TRAY

and /BIN . Note that this is still the PCL tray/bin number so it may be necessary to

define the equivalent Postscript tray/bin using the 'Configuration' dialog. Select the
'Printer' tab to set up the default tray and bin – see Configuring the printer defaults

.

Xerox -made PostScript printer files begin with several lines of "XRX" commands,
in addition to the DSC header. When EscapeE reads such files, any lines which start
with %XRX commands are stored in a field named RT_XRX. (These commands are

used to define job characteristics such as accounting, stapling, trays, duplexing
etc.)

Links
PostScript file export  

More options for PS export

Click More... on the PostScript options page of the Configurations dialog (f8):
see PostScript export options.

Click Apply to return to the PostScript options page of the Configuration dialog.

Jog offsetting and stapling

Print runs of large documents are often broken down into 'sets'. A set is assumed to
start at the next front page following the end of a set or when explicitly specified by
a field:

Define a field with the Action 'start a new set' (see Setting field actions ) to
break the document into sets.

Sets may be 'jog offset', i.e. sets of pages are stacked alternately a finger-width to
the left or right in a printer's output bin. This makes it easier to pick up each set
separately from a bin.

To engage jog offset action, select Jog offsetting.

Some printers can also staple a set of pages together.

To engage stapling, just select Stapling.
The Staple command and Staple details edit boxes are normally left blank,
but custom settings (typically printer-specific) may be entered by specialists.
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Include PJL comments

PJL Comments  found in a document which is to be output in PostScript format
may be included in either one of two forms:

XML, e.g.
% <RT A='COMMENT &34;HEADER PCL&34;' B='COMMENT &34;Driver version
02.03&34;'/>

or 

Plain text, e.g.
% COMMENT "HEADER PCL" % COMMENT "Driver version : 02.03"

See also Preamble and PJL options , command line option /COMMENTS  and
specialist feature Setting the fields file options .
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RTF file export

A series of whole pages or parts of pages from one or more files may be exported to
create a new document in Rich Text Format .

To export files to Rich Text Format

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose RTF Rich Text Format from the drop-down list of formats;

o a wild-carded  filename (with extension .RTF) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o check the LPR output  box; the filename will be supplied automatically.

To make RTF format the default, click Save format.

5. Tick the Force monochrome check-box if required.

6. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program, e.g. WordPad

®: see Associated programs .

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

8. Click OK; if 'Show Fields form' has been configured, the Field dialog opens: see
RTF export options .

Links
RTF export options  
IDF file export  
TXT file export  

RTF export options

When converting to Rich Text Format, you may choose whether to export everything 
EscapeE recognizes on the page or just selected parts. The items for export are clip-
area fields : these may be fields already set up in the original document or new
fields. You may opt to let EscapeE define fields for extraction automatically for each
item it finds on the page.
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To set options for RTF export

1. Set up the fields in 'Field definitions' panel:

o Use existing fields  Tick to extract items based on the existing fields and

their type e.g. 'Text aligned right'.

o Delete existing fields  Click to remove all existing field definitions (e.g.

when enabling EscapeE to define the fields automatically ). Confirmation is
required before this action is carried out.

o Define fields automatically  Tick to create new fields encompassing the

items found on the current page. These field 'Types' may be recognized and
set up automatically:
'Text aligned right',
'Text justified'
'Text centered'
'Graphic'.
If the Type of a field area is unspecified, anything in the area will be rendered
as a 'Graphic' for export.

o Use same fields on each page  Tick this if the document contains many

similar pages which need to be treated alike.
The default is for this option to be deselected, so any fields generated
automatically are defined for the current page only.

o Show Fields form  When this option is ticked The Field dialog  is opened

to show the definitions of the fields created on each page. This enables you
to edit  any definitions before the page is output.
Click OK to step to the next page's field definitions. When the fields for the
last page are displayed, clicking OK closes the Field dialog.

2. In the 'Options' panel:

o Show lines  Tick to include fields for representing any lines or drawn paths

on the page.

o Show graphics  Tick to include fields for representing any graphics on the

page.

o Use same options for each page  Tick this if the document contains many

similar pages which need to be treated alike: this dialog will not be shown for
subsequent pages.

3. Enter distances, measured in 1/600 inch units, in the 'Alignment and spacing'
panel. This "fine-tuning" aids the elimination of rounding-errors etc. and ensures
crisp and accurate rendering of the document.

o X difference to be vertically aligned

Lines which end within this distance may be treated as 'Text aligned right'. It
is the maximum difference between x coordinates for two lines, e.g. 3.

o Flowed text

Line breaks will not be preserved.

4. Click OK to complete the export or 
Cancel to return to the document on display in the EscapeE window.

Links
RTF file export  
Defining fields and tags  
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TIFF images file export

To export files to TIFF images

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose TIFF images as the 'Format'.

o A wild-carded  filename (with extension .TIF) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button or 

o Check the LPR output  box; the filename will be supplied automatically.

To make 'TIFF images' format the default, click Save format.

5. Select Multi-page TIFFs to create a single file containing multiple pages.
Deselect to generate one single-page file for each page in the job. See also
Setting advanced options in field definitions  for how to use field names as the
page names.

6. Tick the Force monochrome check-box if required.

7. Click Image options... to configure more Image import/export options .

8. Tick Run the associated program after creating the file if you would like 
EscapeE to open the file immediately using your preferred program e.g. 
RTIMAGE . See Associated programs.

9. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

10. Click OK to export the pages.

 Tip:  For optimum viewing of TIFF files with resolutions other than 300 dpi users
may wish to create pre-scaled fonts at the correct resolution using RedTitan Font
Rasteriser. 
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 Notes

A special feature of TIFF images is that the format allows more than one image to be
stored in a single file, see above . 

You may set up 'bit reversal', 'end of line' markers etc. to satisfy fax protocol. The
orientation and rotation of the output images can be configured. An image may sent
as a single strip of data, e.g. for PostScript printers. See TIFF export options .

You may export just part of the printed region by sweeping out an area of the page
with the cursor and choosing Selected area from the Images page of the
Configuration dialog. If you choose 'Selected area' and no area has been marked out
(e.g. when converting in batch mode) then the area where data fields are marked is
exported. See Image import/export options .

A title for the document may be defined on the command-line: see /TITLE .

Links
TIFF export options  
Image import/export options  

TIFF export options

In addition to the image options set up on the Images page of the Configuration
dialog – see Image import/export options  – there are some TIFF format-specific
options.

Display the General page of the Configuration dialog (from the 'Options' menu or
press f8).
Choose output format TIFF images then click the Options... button.
Or 
Display the Export dialog ('File' menu or ctrl E).
Choose format TIFF images and click the Options... button to display the
Images page of the Configuration dialog.
Then click TIFF options... button.

Click Apply to resume display of the 'General' page or 
'Images' page of the Configuration dialog.

To set options for TIFF images

1. Set up the 'TIFF Rotation on export' as:
either rotated through 0, 90, 180, 270 degrees counter-clockwise,
or force Portrait or Landscape orientation.

o You may tick Set rotation to zero in output file to store the rotated TIFF

as the normal non-rotated image.

See Notes  below.

2. Select a Compression format: see Image compression .

3. Choose fax options as required:
Bit reversed  the data bits are sent least significant bit first.
EOLs  'End Of Line' markers are added at the start of each line.
Byte-aligned  any partial bytes at the end of a line are filled with zeros. 

4. Choose Single strip if you wish to output the image as a contiguous chunk of
data.

5. Click Apply to accept the changes and return to the General options page.
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 Notes

You may rotate  images so that they match page orientation and look the right way
up.
The time taken to print an image increases if the printer needs to rotate it. EscapeE
can speed up printing by rotating the image and resetting its rotation parameter 
before sending it to the printer.

It can be useful to load TIFFs directly on a Xerox DocuPrint  and then call them up in
PostScript. For example, for a portrait page use the 270  degree option. For faxing
you should choose Portrait  to rotate all pages to Portrait orientation regardless of
their original orientation.

The original TIFF specification recommended that the data be divided into strips but
you may configure EscapeE to output the image as a single  contiguous chunk of
data instead. This is useful for simplistic programs or for direct access via PostScript
on a printer such as a Xerox DocuPrint™.

EscapeE can cope with reading CCITT3 Fax TIFFs even when the byte-aligned EOLs
mode is wrongly specified but when exporting with CCITT group 3 fax  compression
the default setup is recommended: tick the EOLs, Byte-aligned  and Single-strip
check-boxes.

Links
Image import/export options
TIFF images file export  
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TXT file export

  'Plain text ' TXT files are convenient to edit and readily exported to another format.
The primary use for TXT export is, however, for outputting data extracted from the file
when the document itself is being exported to a different format, see Exporting plain
TeXT data fields . You may export an entire document or page(s) from a document
as a file in plain text format. Pages from a number of documents can be assembled
into the same TXT file, see Filenames and wildcards .

To export files to plain text

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose Plain Text as the 'Format'.

o A wild-carded filename (with extension .TXT) and folder are supplied. To
create a different filename or extension, type in the new name. The Browse
button may be used to select a different folder in which to store the file.
To assemble pages from a number of documents into the same TXT use the +
notation: see Filenames and wildcards .
or 

o Check the LPR output  box; the filename will be supplied automatically.

To make 'Plain text' format the default, click Save format.

5. Click Options... to configure more TXT export options.

6. Tick Run the associated program after creating the file if you want EscapeE
to open the file immediately using your preferred program, e.g. Microsoft Notepad.
See Associated programs .

7. Select All text in the 'Fields to be output' panel.

8. Tick Page Numbers to add page numbers to the output file: see Creating page
numbers  to set up the page numbering Template.

9. Click OK to export the pages.

Links
TXT export options  
RTF file export
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TXT export options

Choose Plain text output format from the Options|Configuration dialog (f8) then
click the Options... button on the 'General' page, or 
choose Plain text format from the File|Export dialog Ctrl E) – see TXT file export

. Then click Options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for plain text export/extraction

1. In the 'Space Fill for Text Export' section, to fill fixed pitch text with spaces you
may set up the options:

o Left align or Right align

o Space width: type in the width (in current units) of the column to be

filled.

2. In the 'Text extraction' section, you may choose to:

o Define the inter-line spacing to be used when outputting the extracted

text. Enter a number in the Line height box (units are set up on the
'Viewing' page – see Configuring the view ). If this box left blank then
the vertical spacing is taken from the font of the text found in the original
document.

o Define the maximum vertical difference between the baselines of two words

for them to be deemed on the same line: enter a value in the Maximum
same line Y difference box.

o To define the minimum horizontal distance between two characters for it to

be deemed a word break: enter a value in the Minimum space width box.
If the gap is more than this value then one or more spaces will be inserted
in the extracted text. The default size is 70% of the 'Space width'.

o To ignore downloaded space character's width and use the cell width

instead, tick Space width = cell width.

o To ignore downloaded character widths and use widths calculated to fit the

raster instead, select Calculate character widths.

o To use the top of the character cell as the vertical reference point rather

than the baseline, check Align using top of cell. This may be advisable
when the baseline reference changes mid-string, as is sometimes the case,
for example, with superscript characters.

o When sweeping out areas for fields and clips, if any part of a character's

shape is included in the area then that text is normally selected too.
Ticking Criterion is text baseline rather than text extent when
selecting changes this to only include text when the baseline of a
character is in the swept area.

3. Ensure a suitable Symbol set is chosen to output the text; choose from
Windows (19U), 16-bit Unicode, UTF8 Unicode, or Unchanged (i.e. same
as input file). See also About Symbol sets.
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4. To use the character recognition database to convert the text back to a readable
form from files where arbitrary character encodings have been used, select 
Assign character codes using the TTLIB database: see EEfonts Help.

o Use converted codes when exporting. Using the character codes  as

translated by EEfonts means that the text in such a file, exported to PDF or
PCL, is searchable. See also Note  below.

o Select Use glyph number if character is unrecognized to perform

character code assignment using the glyph IDs in a download TrueType
font.

o Tick Manually review pages with unconverted codes to find any

character codes which have not been assigned because the characters were
not in the database.

 Page through the file by clicking on the 'Next page' button on the
toolbar. Or 

 for PCL or Postscript files, click the 'Last page' button on the toolbar.
When a page is encountered that has unconverted code, the Character
conversion dialog is invoked to allow them to be assigned the correct code.

5. Pure TXT format documents consist only of lines of text, so if you export a
multi-page document as plain text, the pagination is normally lost. You may opt
to retain the page structure instead by selecting Insert a Form Feed for each
page.

6. The underlining of text may be ignored by ticking Ignore underlining. This is
the default; clear check-box to retain underlining instead.

7. Click OK.

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

 Note

Some printer drivers use arbitrary character codes when downloading fonts, so that
any text extracted directly from the PCL file would not be readable. By using EEfonts
to set up a character recognition database, EscapeE  is able to convert the characters
back into usable text, see Assign character codes using TTLIB database . On export
to PCL or PDF, ticking Use converted codes when exporting  enables such files to be
read and their text searched. Problems could arise if there are any character codes in
these files which are not present in the database. Ticking Use glyph number if
character is unrecognized  assigns the IDs of the glyphs in downloaded TrueType
fonts to such characters.

Links
Exporting files to plain TeXT
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XPS document file export

The XML Paper Specification – XPS  – is the default output format for Windows
Vista.

To export files to XPS

1. Choose Export... from the 'File' menu or 
press Ctrl E keys.

2. Set up the Page number range of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files: see Overwriting files.

4. Choose XPS document as the 'Format'.

o A wildcarded  filename (with extension .XPS) and folder are supplied. To

create a different filename or extension, type in the new name. To select a
different folder to store the file, use the Browse button. Or 

o Check the LPR output  box; the filename will be supplied automatically.

To make 'XPS document' format the default, click Save format.

5. Tick the Force monochrome checkbox if required. Click XPS options... to 
configure more XPS export options.

6. Choose a Duplexing option from the drop-down list:

o Simplex  force simplex

o Long edge  force duplex, long edge binding

o Short edge  force duplex, short edge binding

o No plex  do not specify any plex in the output file

o As in the file  use the option specified in the input file.

7. If you have defined data fields on the pages, EscapeE can create a .LOG file

automatically:

o select the Fields to be logged: see Log file export.

o Set the Log format:

Comma separated (default)

XML

Plain text

o Further Log file options may be set up from the 'Log File' page of the

Configuration dialog: click Log file....

8. Click OK to export the pages.

Links
XPS export options
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XPS export options

Choose XPS document output format from the Options|Configuration dialog (f8)
then click the Options... button on the 'General' page, or 
choose XPS document format from the File|Export dialog (Ctrl E) – see XPS
document file export . Then click XPS options... 

Click Apply to accept the 'Options' page configuration.
EscapeE resumes displaying the 'General' page or 

the Export dialog.

To set options for XPS export

1. Select Use data compression to use Flate  compression to reduce the
document size.

2. Select Combine text strings together to store text as longer phrases to
improve searching, see Text options .

3. There are options to render as graphic and render all but text as graphic, see
Text options .

4. The Omit blank pages option may be ticked as required, for example when
exporting a document which is to be viewed on screen (not printed) from a
duplex original.

5. Select Keep original element order if the document has ordered opaque
elements (e.g. shading) to overwrite text or lines, see also Text options .

6. Click OK. 

In addition, when you have finished setting up the options, you may also choose to
create a Shortcut icon that uses all the options you have set by clicking Shortcut...
(see Shortcuts - the easy way to construct a command line ) or click the Save
button to retain these settings after you close the program.

Links
XPS document file export
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Extract data

This section describes how to extract and manipulate data from documents and data-
streams.

Notes on using The Field dialog  

How to set up data fields and tags, adding tagged text and tips on viewing: see 
Defining fields and tags

How to select, enable/disable and delete existing fields and tags; using the Field
Definitions dialog to change the location and content of data fields and tags: see 
Editing fields and tags

How to move and resize existing data fields and tags using the mouse and
keyboard: see Moving and sizing fields and tags

How to set up text or graphics search tags, search criteria and field-end options:
see Setting search tag options

Specifying when and how a field may be used, forcing 'front' and 'back' pages,
overlays, trays and resetting the sheet count; new files, log-files, fields-files and
sets: see Setting field actions

How to include field names in file or page names, specify when a field may be
used, printer options and fixed-pitch export options: see Setting advanced
options in field definitions

Defining a hierarchy of fields and tags so that some are dependent on the
processing of others; combining fields: see Fields list/tree

About ".EE" files; setting up and changing EE files: see Field definitions files

How to make field values persistent, select an EE file for reuse and set up a
banner page; the specialist PJL field prefix feature: see Setting fields file options

 

Troubleshooting common data extraction problems – tags not found,
inappropriate symbol sets, unexpected box characters: see Field problems

How to make buttons and boxes on PDF forms: see Special fields for PDF export

Using command-line options to set up Author, Title, Subject and Keywords for a
PDF document: see PDF document summary

How to create and edit a TOC for a PDF document: see PDF Table Of Contents

Defining the screen view of PDF documents using the command-line: see PDF
Viewer preferences

Setting up DICOM field names for exporting data to DICOM Element Tags  

How to include information on the presentation of the data output to XML, e.g.
fonts, images and style-sheets: see Outputting to XML  

About types of field for export to AFP, PDF and XML: see Field TYPE attribute .

About EscapeE plugins for document editing: see Using plugins  

How to attach a plugin to a field: see Calling plugins  

Editing plugin configuration: see Reconfiguring plugins  

Using AddText plugin to add or delete text: see AddText plugin  

About MoveText, AddImage, AddFile, Blankout, BarCodes, BC39Reader, QRCodeReader,
DMatrix, Tesseract, Rocr, OCRust, Evaluate and Script plugins: see Other plugins  
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The Field dialog

To display the 'Field' dialog:

Select Edit... from the Fields menu or 
Hold down Ctrl and press the D key.

The Field dialog is used to set up fields and tags for the data. It consists of a Control
panel , the Fields list/tree  window and seven tabbed pages .

 Tabbed pages

 Click the tab left/right buttons at the top of the window to
scroll the tabs to the left or right.

Definitions Defining fields and tags

Searching Setting search tag options

Action Setting field actions

Advanced Setting advanced options in field definitions  

File Setting fields file options

PDF Special fields for PDF export

XML Outputting to XML

Control panel

The panel below the tabbed pages contains several controls beside the standard OK,
Cancel and Help buttons. These enable you to control the view of the document in
the main window, without closing the Field dialog.

Click the back/forward buttons to show the previous/next
page of the document.

Click the left, up, down or right buttons in the arrow set to
scroll the page.

 Tree Click to switch between 'list' and 'tree' views: see Fields list/
tree .

Refresh When you have edited fields , click to re-evaluate the fields
and update the document.

Delete To remove the selected field from the document.

Links
About fields and tags  
Defining fields and tags  
Editing fields and tags  
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Defining fields and tags

A field's position may be defined relative to the top-left corner of the page (see To
define a field , below) or in relation to another field – known as a "tag" – instead
(see To set up tags , below).

Alternatively, it is possible to set up a field definition manually by selecting New...
from the 'Fields' menu and keying in the details on the Definitions page of the Field
dialog . It is also possible to convert the field into a tag by filling in the Searching
page of the 'Field' dialog as well: see Setting search tag options

An AddText  field may be attached to a tag  and used, for example, to fill in a
form.

The field name definitions are saved in a file with the extension .EE and the same

stem name as the input file. You can rename this file in the File page: see Setting
fields file options .

To define a field

1. Display the Field dialog  and with the 'Definitions' page on view:

o Right-click on the page and select New Field... from the pop-up menu.

Enter the new field's From left and From top coordinates, and its
Height and Width dimensions in the edit boxes.

o Or sweep over a piece of text on a page to mark-out the new field's area,

then right-click and select New Field... from the pop-up menu.

The selected area's coordinates and dimensions are entered in the
dialog automatically.

2. Use the default Field name (FIELD1, FIELD2, etc.)
or click DICOM name... and set up a DICOM tag – see DICOM Element Tags  
or type in a new name.
The field names are listed either on the right of the field definition page or
below it. If the Tree option is selected, this list shows the hierarchy of fields
and their related tags, otherwise it is an alphabetical list of fields: see Fields
list/tree.

3. Non-specialists are advised to select Any content for the field TYPE  from the
drop-down list.
EscapeE is often able to detect when field values do not correspond to the

selected type: if this happens the caption "Type" will be shown in red and an
'invalid data' warning given.

4. To make a field relative to a tag, select the appropriate field from the 
Reference Field drop-down list.
Alternatively, you can drag the field name in the 'tree view' and place it under
the name of its parent field.

5. If you need to set up a 'composite ' field, tick Composite to access the set-
up panel: see Defining a composite field .

6. The field is enabled by default, but you may "switch off" the field by de-selecting
the Enabled check-box: see To disable a field or tag .
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7. Further options may be defined for the field on the set-up window's other
pages:

o Searching  see Setting search tag options  and To set up tags  below.

o Action  see Setting field actions .

o Advanced  see Setting advanced options in field definitions .

o File  see Setting fields file options .

o PDF  see Special fields for PDF export .

o XML  see Outputting to XML .

8. Click OK.

You may also use EscapeE to define composite fields : these can comprise a
combination of other fields' values, simple text or access pre-defined special fields .

A composite field is treated just like any other field, so may be included in a CSV or
XML file or used as a file name. It can be manipulated by a plugin  such as Barcode
or displayed using AddText  by leaving the added text field blank.

To depict all fields and tags on the page displayed in the EscapeE window, tick
Show fields. To depict only the fields and tags that have been found on the
current page, tick If found instead.

o To show the field-names and tag-names along with their areas, tick Show

names as well.

o Click Remember to keep this set-up.

See also Viewing data fields and tags .

If an Action for the field has been set up and found true, the Found circle is
colored cyan  to indicate that the action will occur: see Setting field actions .

To set up tags

1. Right-click on the piece of text or graphic or sweep out an area of a graphic to
select just part of it.

2. Select New Tag...  from the pop-up menu then choose from the following sub-
options:

o Any graphic...  To search for any kind of graphic, line, drawn path or
shade in this area.

o This size graphic...  To find a graphic, line, drawn path or shade with
matching width and height.

o Graphic of this width  To find a graphic, line (typically vertical), drawn
path or shade with matching width.

o Graphic of this height  To find a graphic, line (typically horizontal), drawn
path or shade with matching height.

o Part of a graphic  To find a graphic, line, drawn path or shade with
matching elements.

o Any text...  Any text in the area of the field.

o This text...  The text under the mouse or within the selected area (the
default).

o Tagged text...  To use the selected text as a tag for defining a new
AddText  field: see Adding Tagged text  below.

o Any mark  To find any kind of mark, graphic or text occurring in the field.

205 201

208

210

213

217

224

244

247

227

228

52

208

228 202



Extract data202

3. The Definitions page of the Field dialog  is displayed, showing details of the
new tag. Use the default name (TAG1, TAG2, etc.) or type in a new name for
the tag in the Field box. See also Editing fields and tags .

4. Select Searching tab; here you can define how to find a field and how to find
the end of the field: see Setting search tag options.

5. Click OK.
Repeat  these steps to set up more tags. For convenience, the chosen sub-
option  is moved to the top of the pop-up menu, e.g. "New Tag This size
graphic...".

 Note

If there is more than item on the page at the chosen position, a dialog will prompt
you to 'Choose which item' from a list, e.g.

Graphic 1750 x 1175

Graphic 1745 x 1170

Adding Tagged text

Tags may be used to add text to a document if/when a tag's Search options  are
met.

1. Right-click on the piece of text or graphic or sweep out an area of a graphic to
select just part of it.

2. Select New Tag...  and choose the Tagged text... sub-option.

3. The Fields dialog opens with the Searching page on view: edit this as
appropriate to set up the tag, see Setting search tag options .

4. Click OK: the AddText  configuration dialog is displayed.

5. Enter the text string to be added to the document. Set up the font, position and
rotation for the string. See To add new text in the Plugins Help.

6. Click OK.

 Tips

 Configure the symbolset before defining data fields and tags, see About symbolsets
.

 Choose appropriate units from 'View' menu's Mouse coordinates sub-options, see
To switch mouse units .

 A field's size and position may be redefined using the Field dialog, see Editing fields
and tags , or by dragging it's box/sizing handles on the page, see Viewing data
fields and tags .

 Fields can be reordered by dragging the names in the 'tree view' window, see Fields
list/tree.  

Links
About fields and tags  
About exporting data  
Editing fields and tags  
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Editing fields and tags

Existing fields and tags may be selected  and edited ; to create new fields and tags
from scratch, see Defining fields and tags  instead.

To select a field for editing

With the document open :

press Ctrl D to open the Field dialog  then select it from the list/tree
window or 

Right-click on the field and use the options from the menu which pops up
automatically or 

Left-click on the field, then use options from the Fields menu.

To step from the currently selected field to another:

Hold down:
 
then click:

Alt 

Tab 

down arrow or Selects next field

Alt 

Shift 

up arrow or 

Tab

Selects previous field

Alt left arrow Selects parent field

Alt right arrow Selects first child field

To redefine field and tag properties

1. Right-click on a field on the page and select Edit Field... 
or
Select Edit... from the 'Fields' menu
or
Press Ctrl D keys.

2. The Field dialog  is displayed: select the Definitions tab. (The Definitions tab
is the first on the left – if it is not visible, scroll  left to bring the tab into
view.) To rename the field, type the new name in the Field edit box.

3. To edit the coordinates of the top-left corner of the field, its width or height,
click in the appropriate edit box and enter the new values. Double-click an edit
box to select and redefine that value for all selected fields.

4. Use the Fields list/tree window to change the field's relationships to other fields
and tags and to add a child field. See Tree view .
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5. Further options may be redefined for the field on the set-up window's other
pages:

o Searching  see Setting search tag options .

o Action  see Setting field actions .

o Advanced  see Setting advanced options in field definitions .

o File  see Setting fields file options .

o PDF  see Special fields for PDF export .

o XML  see Outputting to XML .

6. Click OK.

In the event that a job changes and a field is no longer required, you may disable
the field until you need it again or delete  it altogether.

To disable a field or tag

Right-click on it and select Disable field... or 

Display the 'Field Definitions' dialog (Ctrl D) then de-select the Enabled check-
box for that field.

If the job changes back, the field can be reinstated simply by:

Right-clicking on it and selecting Enable field... 

To delete a field or tag

1. Right-click on the field or tag on the document page and select Edit Field... 
or
Select Edit... from the 'Fields' menu
or
Press Ctrl D keys.

2. Click the Delete button at the foot of the Field dialog .

3. Click OK.

 Tips

 Select Show>All from the 'Fields' menu to view the position of fields and tags on
the page, see Viewing data fields and tags .

 When you are editing fields in the 'Field' dialog, clicking the Refresh button will re-
evaluate the fields and update the page view without closing the dialog.

 You can set up a font (family, size, style, effects, color and language group) for
displaying the tags' search strings by clicking Font... (Field Definitions  page). This
may be useful when you are searching for text in an unfamiliar symbolset.

 When the dialog has been edited, the OK button is highlighted: this indicates that a
press on the Enter key is equivalent to a click on the OK button.

Links
Viewing data fields and tags
The Field dialog  
Defining fields and tags  
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Moving and sizing fields and tags

The exact size and position of a data field or tag may be redefined using the 'Field
Definitions' dialog (see Editing fields and tags ) but it is often more convenient to
adjust the coordinates by eye using the mouse and keyboard.

To redefine coordinates

This is a quick and easy way of changing the size and position of existing fields and
tags.

1. Place the mouse pointer over the sizing handle  at the corner of the field or
tag to be redefined; it will change to a double-headed arrow.

2. Hold the left mouse button down and drag the sizing-handle: the edge(s) of the
field/tag will move to track the motion. When the corner looks to be in the right
place, release the button to set the new coordinates.

3. Repeat with other corners as necessary.

Moving fields or tags

This method is good for making fine adjustments to the position of existing fields
and tags.

1. Select Show none from the Fields menu.

2. Select Fields|Edit... or 
press Ctrl D keys to display the Definitions  page of the Field dialog.

3. Select the field to be moved from the Fields list,  then click OK. The Field
Definitions dialog closes to show the document with the chosen field outlined
in red.

4. Hold down the ctrl key and press the arrow keys to shift the field in the
direction of the arrow. The field will move one pixel at a time – you may need
to zoom in  (press F4) to see the effect.

Links
Editing fields and tags
Fields list  

Setting Search tag options

To set tag options

1. Select Edit... from the 'Fields' menu (Ctrl D) and click on the field you wish to
edit in the Fields list.
or 
Right-click on a field on the page and select Edit Field... 

2. Click the Searching tab.

3. Ensure that the appropriate Tag string is selected from the drop down list
(see Notes  below). The corresponding Tag type (Text, Graphic or Part of a
graphic) is set automatically.
This is only used when its Match box is checked.
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4. Select from the options:

o Multiple occurrences allowed

A field may occur more than once per page.

o Subfields may precede the tag

Sub-fields may occur earlier on the page than the tag itself e.g. on the
preceding line.

o Tag entirely in the field

Tick if the whole of the tag must be found within the field; clear this box if
the string must start within the field but can extend beyond it.

o Front page only

Only searches for the field on the 'front' sides of the paper, usually odd-
numbered (right-hand) pages.

o Back page only

Only searches for the field on the 'back' sides of the of paper, usually even-
numbered (left-hand) pages.

5. Specialists may use font characteristic(s) to recognize fields. In the Required
font characteristics section, enter any of these values for matching: Symbol
set , Size , Style , Weight , Typeface , and tick the Match box(es)
alongside.

To set field end options

1. Select Edit... from the 'Fields' menu (Ctrl D) and click on the field you wish to
edit in the Fields list.
or
Right-click on a field on the page and select Edit Field...

2. Click the Searching tab.

3. To define how the end of a field is detected, select from the options in the Field
Ends at section:

o New tag

Field ends when another tag found.

o End of page

Field terminated by end of page.

o Blank line

Field ends when a blank line is encountered.

4. Type in the values for:

o After Columns

Maximum width of the field in characters.

o After Rows

Maximum height of fields in rows.

5. Starting page:  enter the number of the page on which to start the search.

6. Repeat every:  enter the number of pages to be counted till the next search is
started. Note: if you enter a number that is bigger than the number of pages
(after the starting page) in the document, only one multi-page set will be
created.

7. Repeat for other fields.

8. Click OK.
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Notes

When text is used as a search tag, the whole of the text block (as defined by the
PCL file) is displayed in the 'Tag string' box. (If you are setting up a tag manually,
you must enter the text here yourself – see Defining fields and tags .) If there is
variable data in the text block, click in the Tag string box and edit the text to
remove it.
If 'Match' is checked but the string is null then a match will occur if any text
whatever is found in the designated area (subject to any font characteristics that
are being checked).

Vector graphic  paths and bitmapped graphics  may be used as search tags.
When a "whole" graphic is used, a unique 40 character hex string is assigned to it
(this includes any white borders that are part of an image) and displayed here; it
should not be edited.
If you are setting up the tag manually, you can right-click on a graphic and choose
Graphic details to see the 40 character string that you need to enter in the Tag
string box.
When searching for This size of graphic, the string takes the form of
"width X height", e.g. 200X100 for a graphic that is 200 pixels wide by 100 high.

When searching for Any graphic, the 'Tag string' box must be cleared but the
'Match' check-box beside it must be ticked.

When only part of a graphic is used as a search tag, white edges within the swept
rectangle are trimmed off before its hex string is calculated. Only one graphic in the
area can be recognized and any text in the area is also ignored. When searching for 
Any mark, 'Part of a graphic' is specified with a null 'Tag string' and 'Match'
checked.

See Examples|Search tags.

Tips

 Select Show from the 'Fields' menu to view the position of fields and tags on the
page, see Viewing data fields and tags .

 If a barcode is used as a tag, the tag type may be text or graphic: it depends on
the system which created it.

 You can set up a font (family, size, style, effects, color and language group) for
displaying the tags' search strings by clicking Font... (Field Definitions  page).
This may be useful when you are searching for text in an unfamiliar symbolset.

Links
Defining fields and tags
About exporting data  
Field Problems
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Setting field Actions

1. Select Edit... from the 'Fields' menu (Ctrl D) and click on the field you wish to
edit in the Fields list.
or
Right-click on a field on the page and select Edit Field... 

2. Click the Action tab and set up the 'Action' condition:

o Each time field found  The Action occurs every time the field is found, or

o When field changes  The Action occurs only when the contents of the field

change (not meaningful for tags, as they are set up to search for occurrences
of the same text string). The sub-fields of Composite fields  will only be
exported if the contents of their parent field have changed, or 

o When field absent  The Action occurs only when the field is not detected.

This is only useful if a search criterion such as a tag or font characteristic is
specified, or the field is a sub-field of a field with such a criterion.

3. When a field is found, specify the page on which the Action should occur:

o This page 

o Next page 

o Next sheet 

4. Tick the boxes to:

o Start a new file  Creates a new output file each time an Action condition is

met. See also Filenames and wildcards.
o Start a new log file each time an Action condition is met (instead of

accumulating all log entries in a single log file).
o Start a new set used when jog offsetting or stapling has been requested for

a PS printer. A new set is started, automatically ending the current set (if
there is one). See More options for PS export .

o End set  Ends a jog offsetting or stapling set on a PS printer. (This does not

need to be specified if there are no sheets between this set and the next –
'Start a new set' ends the current set automatically). See More options for PS
export .

o Use another fields file  When an Action condition is met, the value of the

field supplies the name of a field definitions file (the default extension is .EE
and the default folder is that of the current field definitions file). The "new"
field definitions file is loaded and applied immediately, up to once per page.

o Reset sheet count  Set the sheets of paper count back to zero; see Special

fields in composed strings .
o Reset page count  Set the page count back to zero.

o Force front page Feeds a new sheet ready to print on the 'front' side if the

Action condition is met, for example when switching to a different paper tray,
see below .

o Force back page Feeds a new sheet ready to print on the 'back' side if the

Action condition is met, for example when switching to a different paper tray,
see below .

o New back page moves print position to the next 'back' page if the Action

condition is met. If the current print position is already on a 'back' page a
new sheet will be fed even though its 'front' page will be left blank. The new
back page will be blank unless this field (or another on the 'front' page) adds
something with a Plugin  using the 'On the back' option, see below .

o Omit page  Omits the current page from the output.
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5. When requested by Log file options , a log record can be written for any page on
which the field is found: tick Write log record.

6. When the Action condition is met, you may force the printer to use:

o Tray  Enter an input tray number. This is useful for cases where colored

paper is required for a header or trailer page.

o Bin  Enter an output bin number.

o Overlay number  A tag can be linked to an overlay. Type the macro number

 in the box and select whether that overlay is to be turned 'on' or 'off' when
it recognizes the selected tag.

7. You may call a 'plugin' when the Action condition is met, for example, to add a
Bar-code to the sheet. Select one of the Call Plugin options from the drop-down
list (a brief description of the selected plugin will be shown in the status bar for a
few seconds). This list will depend on which plugins are installed on your system,
see Using plugins .

o An image or text may be added to the back of the target page: tick the On

the back check-box. This forces duplex printing even on simplex jobs (long-
edge binding if portrait and short-edge binding if landscape).
Note that the Booklet  option on the 'Printing' dialog reorders the pages, so
should not be used when using 'On the back' option.

8. Click OK.

 Tips

 When an Action condition has been met, the Found circle on the Definitions  page
for that field turns cyan .

 A number of Actions specified by fields on the current page are indicated by these
letters at the right-hand end of the status bar  and in the Log  when Show field
details is selected.
B new Back page 

F start a new File 

L write Log record 

O Omit page 

R Reset sheet count 

S start a new Set

Links
Defining fields and tags  
Setting advanced options in field definitions  
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Setting Advanced options in field definitions

To set advanced options

1. Select Edit... from the 'Fields' menu (Ctrl D) and click on the field you wish to
edit in the Fields list/tree.  Or 
Right-click on a field on the page and select Edit field... 

2. Click the Advanced tab.

3. Tick the boxes to:

o Omit from output  The data for this field will be omitted from the output.

Any other actions (such as processing sub-field or causing a new file to be
started) will still occur.

o This field starts a new XML level  If this tag is the parent of any sub-fields

then these sub-fields are contained within this field in the resultant XML,
otherwise they are on the same level as their parent.

4. Use this field

o in the file name  If you opt to split the file into sections, the field name is

used as part of the file name. For example, if the file is called TEST.PCL the

field contains ABCD and the output specification is *=.PDF then the output file

name will be TESTABCD.PDF. See also Filenames and wildcards .

o in the page name  To use the field name when creating multi-page TIFF

image files (i.e. when 'Multi-page TIFFs' is selected in the Export options,
see TIFF images file export ).

5. Click OK.

To set fixed-pitch text export options

1. Select Edit... from the 'Fields' menu (Ctrl D) and click on the field you wish to
edit in the Fields list.
or
Right-click on a field on the page and select Edit field...

2. Click the Advanced tab.

3. Set up a space-filling option:

o Trim  Removes leading or trailing spaces from the extracted field data.

o Align – Left  Uses spaces to fill out the extracted field data to the column

width so that the text is aligned to the left.

o Align – Right  Uses spaces to fill out the extracted field data to the column

width so that the text is aligned to the right.

o Spacing  Type in the width of the column to be filled by aligned text,

measured in the units set up in the Configuration dialog (default unit is
1/300 inch).

4. Click OK.

 Tip:  Select Show from the 'Fields' menu to view the position of fields and tags on
the page, see Viewing data fields and tags .
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Fields list/tree

Fields are listed in a window of the Field dialog , usually on the right-hand side of
the window containing the tabbed field set-up pages (see also docking, below ). The
field-names can be shown as a simple list in alphabetical order (convenient for finding
and editing ) or in Tree  view.

Tree view

Tree view not only shows the order in which fields are output (for example, for CSV
export) but also how the fields relate to each other. When a field or tag depends
on another field or tag it is regarded as a "child" of its "parent" field or tag. Parent
field and tags are denoted by a folder icon which may be "opened" to display its
children or "closed" to conceal them. Clicking a field, tag or parent name selects
it; right-clicking opens a pop-up menu .

To show the contents of a parent folder, double-click its folder icon or 
select Expand from the pop-up menu.

To hide the contents of a parent folder, double-click its folder icon or 
select Collapse from the pop-up menu.

To make a field or tag dependent on another (parent) field or tag, click down on
the  (child's) name and drag it onto the parent name. The parent folder  icon
replaces the field  or tag  icon when the mouse button is released.

To 'promote' an existing field or tag out of a parent folder, click down on the
field  or tag  icon and drag it onto the icon of the field or tag that it should
follow. (If all the child fields/tags have been promoted out of a parent folder,
the parent icon reverts to its native field  or tag  icon.)

To delete a field, tag, or parent folder and its sub-fields, press Delete key or 
select Delete from the pop-up menu.
A warning dialog appears when deleting parent folders: click

o Yes to delete the folder and its sub-fields or 

o No to cancel the command. To delete the parent field or tag but not its

sub-fields, move the sub-fields out of the folder first.

Pop-up menu options

Right-clicking a field or tag selects it and displays the pop-up menu:

Move up or Ctrl U: steps the selected field or tag up the list.

Move down or Ctrl D: steps the selected field or tag down the list.

New field or Ctrl N: creates a new field as a child of the clicked field; see also
To define a field .

Combine with next field or Ctrl C: expands the selected field, tag or parent to
encompass and override the next field, tag or parent in the list at the same
level or lower.

Combine selected fields: all selected fields are combined into the selected
field which is highest in the list/tree.

o To select a group of fields, click in the highest field to be selected then hold

down the Shift key and click the lowest field to be selected.

o To add a field to the current selected file(s), hold down the Ctrl key and

click the field to be added.
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To move the list/tree window

The list/tree window may be docked on the right of the tabbed-pages window or
below it.

1. Use the mouse to drag the border of the dialog so that it is big enough to hold
the list/tree window in its new position.

2. Click the mouse button down in the list/tree window (without selecting a field or
tag), drag the window to the new location then release the mouse button.

3. Adjust the dialog border(s) for best fit.

Links
The Field dialog  

Field definitions files

When you mark up text on pages, the field definitions are saved in a file with the
same name as the input file and the extension .EE. This can be imported into another

print file and used to extract the text at the same positions on the page.

The previous version of any .EE field definition file is saved as .~EE for backup

purposes.

Locating .EE files

When a file is opened, EscapeE searches for the field definitions file specified by:

the /FIELDS  option.
If the FIELDS symbol has not been set (and the Always use these definitions
option has not been ticked either), then EscapeE continues to search for:

i. a field definitions file with the same name as the input file but with
extension ".EE".
If this .EE file cannot be found it then searches for:

ii. the field definitions file specified  by the /FIELDDEF  symbol in the
PCLVIEW  section of the INI file.
If this symbol has not been set, then:

iii. a field definitions file called DEFAULT.EE  in the same folder as the input
file is used.

 Tip:  The field definitions file can be specified explicitly on the command line, e.g.
ESCAPEE DATA.PCL/FIELDS MYFIELDS.EE

To save the field definitions file

1. Select Edit... from the Fields menu or 
hold down Ctrl and press D key.

2. The Field dialog  opens: click the File tab.

3. If you wish to change the name under which the definitions are saved, you can
type a new name in the Field Definition File box.

4. Click Save.

 Tip:  You can save changes automatically when you exit from EscapeE or close the
data file or load a new set of definitions. Tick Always or Ask to Save definitions
on close or exit.
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Setting fields File options

The .EE file containing the field name definitions are usually saved in a file with the
same stem name as the input file, see Field definitions files . To apply an existing
.EE file instead:

1. Select Edit... from the Fields menu or press Ctrl D keys.

2. The Field dialog  opens: click the File tab.

3. Type the full path of the .EE field definition file in the Field Definition File edit-
box then press Enter. Or 
click Browse and select an .EE file (you may need to change drive/folder).

o If you wish to view the fields  and their coordinates, click the Definitions

tab.

4. You may save the field definitions file under a new name: click Save as... to
display the standard 'Save As' dialog. Enter a new name then click Save.

5. You may opt to Always use these definitions by ticking the check-box.

6. Click OK.

Default field definitions file

1. Select Edit... from the Fields menu or press Ctrl D keys.

2. The Field dialog  opens: click the File tab.

3. Type the full path of the .EE field definition file in the 'Default Field Definition
File' edit-box then press Enter. Or 
click Browse and select an .EE file (you may need to change drive/folder).

o If you wish to view the fields  and their coordinates, click the Definitions

tab.

4. You may use this default field definition file rather than a  specific field
definition (see above ): click Apply.

5. Click OK.

Persistence of fields

By default, composite  and regular fields lose their existing values when the field
is not present  on subsequent pages. To change this so that composite fields
maintain their values until they are next encountered:

1. Select Edit... from the Fields menu, or 
click Ctrl D.

2. Click the File tab.

3. Tick Persistent composite fields check-box.

The change will be saved in the field definitions file .
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To set up a header file

A 'header' file will be processed before the main file. It may contain font and macro
definitions used by the main file, or a printable page (e.g. banner page) to be
output ahead of the main file. It may be overridden by /HEADER .

1. Select Edit... from the Fields menu or press Ctrl D keys.

2. The Field dialog  opens: click the File tab.

3. Type the name in the File name of header page box or 
Click Browse and select the header file.

4. Tick Retain PCL state for subsequent pages if the file is to be reused – for
example, when it contains a set of fonts common to numerous other pages. See
also Handling fonts .

5. Click OK.

Fields from comments

This panel is used for a specialist Prefix feature only: in general usage, its edit boxes
can be left blank and safely ignored.

Specialists may make use of PJL Comments , PJL JOB and PJL JOBATTR
commands in a document to create fields and their values.
A field-name is created using a 'prefix' and the string to the left of the separator's
(first) occurrence in the comment. The string from the right of the separator to the
end of the line ('CRLF') provides the field's value.

1. Select Edit... from the Fields menu, or 
click Ctrl D.

2. Click the File tab.

3. In the 'Fields from comments' panel, enter a suitable prefix in:

o the PJL field prefix edit box or 

o in case of HP-GL comments in XML format, the XML field prefix edit box.

To save the XML field prefix in the RT.INI  file, click Save.

4. Enter the separator character in the PJL separator edit-box.
If the separator is not specified then a default separator is assumed and the
command searched to find it.
The first default separator is "colon"; if it is not found then the command is
searched again for the second default separator, "equals". The third default
separator is a "space" character.

5. Click OK.

6. Select PCL document format on the 'General' page of the Configuration dialog
(F8), then click Options....

7. Tick Export PJL comments.
The PJL field separator and PJL field prefix characters are reflected on this
dialog and you may re-set them here if necessary. See also Preamble and PJL
options .

The total length of these prefixed field-names must be no more than 63 characters.
Only alphanumeric characters and underscore may be used in the prefix string. The
field-values may contain any characters which can be represented in the "UTF8"
symbolset. To ensure that these field-names are unique, a number is appended to
any new name that duplicates an existing one.
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Examples

Setting a prefix of PJL_ would mean that a PJL command such as:

@PJL COMMENT NAME=John Smith

would result in a field named PJL_NAME with value John Smith.

For HP-GL comments in XML format, a field is constructed whose name is the XML
tag name prefixed by the XML field prefix and whose value is the attributes. e.g.
<TAGNAME> ATTRIBUTE1=".." .... </TAGNAME>

(To set up a prefix on the command-line, use /PJLPREFIX , to set up a separator,

use /PJLSEPARATOR .)

 Notes
If you load a new fields definitions file when the existing fields have been changed,
you will be prompted to 'Save field definitions' – Yes or No.

The previous version of any .EE field definitions file is saved as .~EE for backup
purposes. The 'Edit' menu has an entry Undo Field Changes which will reload the
.EE file or, if no changes have been made to the current file, it will reload from .~EE
file.

Fields may be used in the compilation of a PDF Table of Contents .

The area defined for a field may be reused as a clip-region in an IDF document .

See also /FIELDS  and /FIELDDEF  Command line options.

 Tip:  Select Show from the 'Fields' menu to view the position of fields and tags on
the page, see Viewing data fields and tags .

Field problems

If you define a field but no data is extracted or the associated action is never carried
out then there are several possible explanations:

Tag not found

 Check that the tag (or at least the start of the search string) is located in the
designated area.

 An inappropriate page range may have been specified in the Searching page of
the Field dialog  (select Fields|Edit... or press Ctrl D keys).

 Incorrect set of font characteristics specified in the Searching page of the Field
dialog.

 The field may be a sub-field of a field that was not found. Note that sub-fields are
assumed to be in a fixed position relative to their parent field.
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Inappropriate symbolset

 Check that the source has not been reconfigured since the field was defined; there
is a drop-down list of source types on the General page of the Configuration
(press f8 key) dialog:

Source Type Typical symbolset

Windows driver HP3 – the character codes are
adjusted by 3 so that a "D" in the file
is translated to "A", etc.

RedTitan DDF (PrePrinter) none – no translation is required.

RedTitan Datastream Converter 9700

Other (none)

 Test the symbolset: define a tagged field by right-clicking on a piece of text and
choosing New tag...; if the symbolset is correct the identical text will appear Tag
string box on in the 'Searching' page.
If it is incorrect, choose a different symbolset in the General page of the
'Configuration' (f8) dialog and try again. For example, custom PCL output (Source
Type set to 'Other') usually requires no translation but a few drivers require symbol
set HP-1 (adds 1 to each code).
You may need to use a character recognition database in some cases: see EEfonts
Help.

Extracted data is mistranslated

 Inappropriate symbolset – see About symbolsets .

Tag names appear as box characters

 Some drivers assign arbitrary codes to the characters as they occur in the
document, so there is no way of calculating the appropriate translation. In these
cases it is worthwhile changing the font used in the original document to be one of
the printer-resident fonts (e.g. CG Times), so that the normal codes will be used.

Links
About fields and tags  
Defining fields and tags  
Setting advanced options in field definitions  
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Special fields for PDF export

EscapeE can be used to create unfilled PDF forms (AcroForms ) from any file it can
read in (see File formats list ). You can set up data fields in your document which
will be rendered as various special "interactive" elements in your final output when
viewed in Acrobat Reader :

1. Right-click on a field on the page and select Edit Field... 
or 
Select Edit... from the 'Fields' menu
or 
Press Ctrl D keys.

2. Select the PDF tab; you may need to scroll the tabs to the right  to bring this
tab into view. The currently selected field will be highlighted in the Fields list/tree

.

3. Choose which type of element the field should be:

Type Options Purpose

Submit button Draw button  
Draw border  

Makes the field area into a region which, when
clicked, sends the completed form to the
specified URL.

1. Select a 'Type of Submit response'
format. Choose from:
o HTML response.

o Adobe FDF response.

o XML response.

2. Enter a URL.

Reset button Draw button  
Draw border  

Makes the field area into a region which, when
clicked, clears any data that has been entered
into the form.

Radio button

 

Checked  
Draw border  

A round button for selecting one option from
several.
Specify where the image of the radio button is
to be placed:

Left of the field area or 
Right of the field area, or 
Center on the field area, starting at the
top-left.

Check box

 

Checked  
Draw border  

A box for switching an option on and off,
independent of other options.
Specify where the image of the check box is
to be placed:

Left of the field area or 
Right of the field area, or 
Center on the field area, starting at the
top-left.

Editable text
field

Draw border  For typing text onto the form.
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List box Drop down  
Editable  
Draw border  

For selecting one item from a panel of many
items.

1. In the 'Choices' section, click Edit... to
display an editable window.

2. Type in the list then click OK.
3. Select the item to be highlighted in the

'Choices' drop-down list when the form is
opened.

Hyperlink Draw border  Makes the field area into a region which, when
clicked, opens another file – the 'target' file.

Enter the URL of the target file.

If the target is a file name with any of these
extensions:
EPS, IDF, LSH, PCL, PDF, PLT, PRN, PS or XML

then EscapeE itself opens the file.
If the target URL starts with:
 escapee:// 

then EscapeE will be used regardless of the
file extension; otherwise the associated
program will be used to open the file. E.g. for 
xxx.htm 

your default browser would be used.

4. Tick Include field in PDF Table of Contents if required. See PDF Table of
Contents .

5. Click OK.

Repeat for all fields to be rendered as special elements; note that untreated fields will
be displayed as Normal on the 'PDF' page of the dialog.

Options

Checked 'Tick' to show this field 'selected' when the form is opened or
reset.

Draw border Draws a border around the area of the form swept out to define
the field.
A border may be added to any special field, but is particularly
useful to surround Combo boxes.

Draw button Places an image of a button on the form.
The top-left corner of the button coincides with the top-left corner
of the field.

Drop down Tick to convert a List box  into a Drop-down box.

Editable Tick to convert Drop-down  List box into a Combo box, enabling
Users to enter text as well as select from the list.
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 Tips:

 When an exported form containing a hyperlink  is opened, you may right-click and
select the open the file in a new window option from a pop-up menu (or press F9
key). For PDFs this will call Acrobat .

 When a radio button  on the form is clicked it becomes selected and all other

radio buttons on the form become deselected.

Links
PDF document file export
Setting advanced options in field definitions
Defining fields and tags

PDF document summary

EscapeE defines these symbols  to contain summary information from the input PDF
file:

_DocAuthor  the name of the document's author.

_DocKeywords  the document's keywords.

_DocSubject  the document's subject.

_DocTitle  the document's title.

_DocProducer  the program that output the document.

_DocCreator  the program that created the original document.

_DocCreationDate  the creation date of document.

_DocUpdateDate  the last update date of document.

These command-line options may be used to construct PDF document summaries:

/PDF-A   the author of the document.

/PDF-K   the list of keywords associated with the document.

/PDF-S   the subject of the document. 

/TITLE   or, for backward compatibility, /PDF-T   the title for the document.

The parameters following these commands are terminated by a space, so when a
parameter itself contains spaces it is necessary to enclose the parameter within quote
characters.

Examples

ESCAPEE c:\nsci\paper1.pcl /PDF/PDF-A 'I. Newton'

ESCAPEE c:\nsci\paper1.pcl /PDF/PDF-K 'force motion mass velocity'

ESCAPEE c:\nsci\paper1.pcl /PDF/PDF-S 'An exact quantitative description
of the motions of bodies'

ESCAPEE c:\nsci\paper1.pcl /PDF/PDF-T "Philosophiae Naturalis Principia
Mathematica"

In the absence of any such options then, if there is a field with the appropriate name,
it is used for that item. For example a field called TITLE could be used to extract the

first line of the document and use it as the title. Any such field will only be used at
the start of each PDF, so must either be a literal field or occur on the first page of the
input file (or of the section if multiple PDFs are created).

Links
Run from the command line
PDF export options  
PDF Viewer preferences
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PDF Table Of Contents

A 'Table of Contents' (TOC) may be created when exporting a file to PDF  or PDF/A
. The strings to be listed in the TOC are supplied by fields selected on the PDF page of
the Fields dialog, see To set up a TOC  below.

Once set up, you may choose whether to include a 'Table of Contents' when the
document is exported, or not: see Switching a TOC on and off  below.

To set up a TOC

1. Select Edit... from the 'Fields' menu or 
press Ctrl D.

2. Select the PDF tab of the Field dialog  (you may need to scroll the tabs to the
right  to bring the tab into view).

3. Click a field in the tree  that you want to put in the TOC then tick Include
field in PDF table of contents.
Repeat for each field that is to be listed in the TOC.

4. Click OK.
See also Switching a TOC on and off , below.

 Tip: You may also set up a TOC via the Configuration dialog (either directly or on
Export ) by means of the Contents... button: see PDF export options .

To edit a TOC

1. In the Field dialog  (Ctrl D), click the PDF tab (you may need to scroll the
tabs to the right  to bring the tab into view).

2. Click a field in the tree  which you want to edit.

3. Select Include field in PDF table of contents to add the field to the TOC
or
Deselect 'Include field in PDF table of contents' to remove it.

4. Click OK.

Switching a TOC on and off

When you export a document in PDF or PDF/A format which has a Table of Contents
already set up , the default is to export the TOC too. To export the document
without the TOC:

1. Select Configuration... from the 'Options' menu or 
press F8.

2. Select PDF document or PDF/A document as the Output Format.

3. Click Options... then More....

4. Select Do not make a Table of Contents.
The TOC set-up is retained but not exported on this occasion.

To revert to exporting the TOC with the PDF (or PDF/A) file: 

1. Select Configuration... from the 'Options' menu or 
press F8.

2. Select PDF document or PDF/A document as the Output Format.

3. Click Options... then More....
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4. Deselect 'Do not make a Table of Contents'.

5. Click OK.

Alternatively you may switch 'Do not make a Table of Contents' on and off via the
Export  dialog: click PDF options... to bring up the Configuration dialog then click
the More... button.

Links
PDF document file export  
PDF export options  
More options for PDF export  
Special fields for PDF export  

PDF Viewer Preferences

The command-line option /PDFPREF  enables users to specify which features of a
PDF reader are to be displayed on the screen.

The Menu-bar, Tool-bars, Navigation-bars, Title-bar and Window may be individually
controlled by setting the /PDFPREF flag bits .

Flag bits

Flagbit value Action Notes

1 Tool-bar hidden. CTRL key shortcuts may still be used.

2 Menu-bar hidden. ALT key shortcuts no longer exist.

4 Navigation-bars hidden;
only the document’s
contents are displayed in
the document window.

Ensure that the page is set to an appropriate
scale otherwise the user may not be able to
view the contents properly.

8 Window sized to fit the
document's first page. 

It would be better to override the default
page magnification with this option because
otherwise it will use the user's default which
could be inappropriate.

16 Window centered on the
screen. 

32 Document title is
displayed rather than the
filename in the title-bar. 

A document title must be specified for this
option to be valid. See PDF document
summary  

64 Full-screen mode: the
entire screen displays
document content only. 

Tool-bars, menus etc. become inaccessible.
The user can escape this state using the ESC
key; the program then adopts the
configuration that would have been used if
this option had not been given.

128 Scale width of the page to
fit the document window.

To "fit page to window", use 128 and 256,
i.e. 384 . 

256 Scale height of the page
to fit the document
window.

To "fit page to window", use 256 and 128,
i.e. 384 . 
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To control several features, add up the appropriate numbers to get the PDFPREF
flagbit value.
Here is an example of the normal appearance of Adobe Acrobat Reader  (shown at
reduced scale):

To hide the tool-bars(1), hide the menu-bar(2) and
center the window(16) you would use:
ESCAPEE /PDFPREF 19

then open  the file and export  it in PDF format
for viewing in Acrobat Reader.
Alternatively, it can be stored in the RT.INI file in
the PCLVIEW section as for example
PDFPREF=19

 Note:

Care should be exercised as you are overriding user-set preferences. You should
consider unexpected consequences since a user who has chosen rather unusual or
extreme defaults may find he cannot view a document at all if the wrong combination
of these settings is used.

 Tip:  If you want to inhibit the user from activities like printing or editing the
document, then you should consider requesting an encrypted PDF but with no
password specified rather than turning off menus etc. with the above options, as the
encrypted option flags are enforced with more certainty.

Links
Command line syntax
Run from the command line
PDF document file export  
PDF export options
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DICOM Element Tags

DICOM medical image files usually contain textual data as well as images. The data
values are attributes of "DICOM Element Tags". A DICOM Element tag combines two
hexadecimal codes, each four characters long. The first is the "group" code, the
second is the "element" code. For example, 00100020 is the Patient's ID, and

00100030 is the Patient's Birth Date.

EscapeE enables you to define data-fields to extract data values from files and map
them to the appropriate Element Tags when the file is exported in DICOM format.
Most 'date' or 'time' values will be converted to DICOM format automatically using the
options set in your system's Control Panel. If alphabetic month names (e.g. 23rd

June 2016 or Jun/23/2016) have been used rather than numbers (e.g. 23/6/16) they

will be converted provided they are in English, French, German, Portuguese or
Spanish and EscapeE's language option  has been set to match.

To set up a DICOM Tag

1. Click and drag the mouse over the data to be extracted.

2. Select New... from the 'Fields' menu,
or 
right-click and select New Field.... 

3. Click the DICOM name... button on the Definitions  page to display the DICOM
fields dialog.

4. Set up the element Tag: select a Group from the drop-down list (e.g. 0010

concerns general information about the Patient) and a Tag name from the drop-
down list (e.g. the Patient's Address is 1040). EscapeE has some features to help

set up these pairings:

o If you are defining a required element tag,  you will find these listed in the
Missing tags panel. Simply choose a name from this list and EscapeE will
construct the Tag.

o If you are defining a frequently used element tag, choose to show only 
Common tags in the 'Tag names' drop-down list instead of the All tags
comprehensive (but tediously long) list.

5. Click OK.
EscapeE names the new field, e.g. DICOM_00101040.

6. Click OK. 
EscapeE uses the named field to enter data into the matching field in the DICOM
output.

Links
DICOM medical image export  
DICOM export options  
Required DICOM tags  
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Outputting to XML

When outputting to XML, EscapeE enables you to export more than just the data
content of the fields. For example, you may specify a style sheet so that you control
the way that the data is presented and set up a path to run the XML using the
program of your choice.

Set up the data fields as usual (see Defining fields and tags ) then:

1. Select Edit... from the Fields menu or 
press Ctrl and D keys.

2. The Field dialog  opens: click the XML tab. You may need to scroll the tabs to
the right  to bring the tab into view.

3. Tick Include XY coordinates to output the locations of the top-left corner of the
fields.

4. Tick Include graphic field data to output any fields of TYPE  "Graphic"; they
will be encoded  as PNG images.

5. Tick Include font information to use font attributes defined in the current
document in the output XML.

6. Tick Include width and height to output the size of the field; see notes
below.

7. To create a margin around text within a field area, enter the size (measured in
1/300 inch) in the Padding edit-box.

8. You may set up a command-line to run the XML to an application program:

o Enter a top-level tag name. If omitted, the default is the stem of the field
definitions file name. E.g.: MYxmlDATA.

o Specify, or Browse... to, the XSL Stylesheet to be used for the output XML.
E.g.: MyStyleSheet.XSL.

o Nominate an associated Program to process XML output. The default is
normally the default browser. E.g. IEXPLORE.EXE.

o Enter any other Program parameters that you require: see Command line
syntax  for descriptions of the options.

9. Click OK.

 Notes

If the field is of TYPE  "Graphic", the width and height of the image is given in
pixels; if the image's resolution does not match that of EscapeE (normally 600dpi),
the SCALE factor that EscapeE has applied to the image is also given. For example, a
1inch square PNG image with a resolution of 100dpi might produce this fragment of
XML:
<FIELD... TYPE="GRA" FILETYPE="PNG" WIDTH="100" HEIGHT="100" SCALE="6">.

In the case of images with no intrinsic resolution (e.g. JPEG), the default resolution is
stored in the image when it is exported to XML.

Links
Exporting data fields to XML
Setting Log file options
Log file export
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Field TYPE attribute

When Defining fields and tags,  the field's 'Type' attribute defaults to Any content.
Other options, used for special purposes, may be chosen from the drop-down List of
field data types .

List of field data types

Option TYPE attribute

Any content ANY

Alphabetic ALPH

Alphanumeric ALNUM

Numeric NUM

Decimal DEC

Currency CUR

DateDMY DMY

DateMDY MDY

DateYMD YMD

Phone TEL

Email EML

URL URL

Graphic GRA

Text TEXT

Text aligned right TEXTR

Text centered TEXTC

Text justified TEXTF

Meta data META
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'Meta data' note

Fields of type Meta data  do not contain data to be printed on the page like most
fields, but information about the page. The information does not affect the printed
appearance but may be used by a post-processor, e.g. for indexing.

Select Meta data from the drop-down List of field data types .

In PDF and AFP documents, EscapeE uses the Meta data field type to specify that
the field is to be included as a 'name, value' pair. AFP  treats the field as a
"TLE" (Tag Logical Element) which will be added as a tag to the start of any page
on which it is found.
In an HTML document, it may supply information such as the document title and
keywords relating to the document content.

'Graphic' note

When exporting a field of type  'Graphic' to XML, you may choose to output the
field as an image in PNG format, see Outputting to XML . The attributes for such a
field are:

TYPE="GRA" ENCODING="BASE64" FILETYPE="PNG" X="x coordinate" Y="y
coordinate"

BITS="color depth" WIDTH="image width" HEIGHT="image height"

 Tip:  Click the buttons at the top of the window to scroll the tabs to the left  (e.g.
to show 'Definitions' page tab) or right  (e.g. to show 'XML' page tab).
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Using plugins

Plugins give EscapeE the ability to modify the appearance and content of documents.
These plugins are included as standard in EscapeE:

AddFile  
AddImage  
AddText  

MoveText  
Evaluate  
Script  

Barcode  
BC39Reader  
QRCodeReader  

Additional plugins are available for purchase – contact sales@redtitan.com:

Tesseract  
OCRust  
Rocr  

DMatrix  BlankOut  

In this section:

Calling plugins  

Reconfiguring plugins  

AddText plugin  

Other plugins  

See Plugins Help for further details.

Links
Calling plugins

Calling plugins

1. Open the document  and set up a field for the plugin to act on, see Defining
field and tags.  

2. Select Edit... from the 'Fields' menu (Ctrl D) and click on the field in the Fields
list/tree .
or
Right-click on the field and select Edit field... 

3. Click the Action tab; select the plugin  from the Call plugin drop-down list.

4. Click Configure.

o Some plugins require further information so a plugin-specific configuration

dialog is displayed, e.g. movetext , addtext , addimage , addfile ,
barcode , tesseract , rocr , evaluate .

o Some plugins use the just the data contained in the field so require no

further configuration e.g. BC39Reader , QRCodeReader .

5. Click OK to close the Fields dialog.
EscapeE enables the plugin: the Enable plugin check-box on the 'Layout' page
of the Field dialog  is ticked and the 'Plugins enabled'  button shown on the
Tool-bar.

Links
Setting field actions  
Reconfiguring plugins  
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Reconfiguring plugins

Once a field has been configured, you may re-open and edit the plugin's Configuration
dialog:

Select Configure field from the right-click pop-up menu or 
with the Field dialog  open, right-click the field in Tree  and select Configure
field... from the pop-up menu.

To enable/disable plugins:
Tick/clear the Enable plugin check-box on the 'Layout' page of the Field dialog or
Click the Plugins button on the Tool-bar:  indicates 'enabled' and  'disabled'.
Select Enable field or Disable field from the right-click pop-up menu.

 Note

If a plugin attempts to modify a PDF document that is marked as not editable  then
the corresponding field is disabled and a warning given.

AddText plugin

The addtext plugin allows new text to be added  to a page in a choice of fonts, colors
and alignments. It may also be used to remove  existing text from a page.

Addtext is the primary EscapeE plugin, and may be accessed directly from the
EscapeE window's pop-up menu:

Add text
1. Open the document  and display the page for the added text. To add text to

an existing field, select it.

2. Right-click on the page then choose Add text (or press Insert key) from the
pop-up menu.

o If an existing field has been selected the addtext dialog opens. If not then:

o If a field on the page has been configured to utilize the addtext plugin, the

addtext dialog is opened showing the field's setup. Otherwise,

o A new field to contain the new text is created automatically and the

addtext dialog is opened.

3. Set up the text string, font, position and rotation: see also To add new text
[Plugins Help].

To disable the addtext field, sweep out the text or click on the field; then select
Delete text from the pop-up menu. See also Delete text  below.

To reinstate the addtext field, click on the field then select Enable field... from
the pop-up menu, or open the Field dialog  (Ctrl D) and tick the Enabled check-
box.

Delete text
If the original page contains text that you would simply like to remove:

1. Sweep out the text for removal.

2. Right-click and choose Delete text.

3. You can make adjustments to the field set-up as necessary – see To define a
field .

Note that only "real" text strings in a 'Delete text' field can be removed, not images
of text.
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Other plugins

In addition to addtext  plugin, these plugins are available as standard:

MoveText

allows existing text to be moved about and/or have its font or color changed
Also facilitates Rearranging page contents  feature.

See movetext [Plugins Help]

AddImage

allows an image (BMP, TIFF, RIF or PCX) to be added to the document. Dynamic
images may be selected using names (or parts of names) extracted from the data

See addimage [Plugins Help]

AddFile

allows a page of a PCL, PDF or PostScript file to be added as an overlay
See addfile [Plugins Help]

Barcodes

allows text to be converted into any of the common barcode formats including 2-D
types

See barcode [Plugins Help] 

BC39Reader

Reads a Code 3 of 9  barcode, converts it into text and uses it as the value of the
field. (No further configuration is required.)

See bc39reader [Plugins Help]

QRCodeReader

QRCodeReader extracts the data from a QR Code 2D  barcode and uses this text as
the value of the field. (Typically an internet URL ; no further configuration is
required.)

See qrcodereader [Plugins Help]

Evaluate

allows field values to be calculated and pages to be set up dependent on field
content using RS/2  programs or expressions

See evaluate [Plugins Help]

Script

enables you to embed Javascript configuration string expressions
See script [Plugins Help]

Appropriate permission codes must be installed for the plugins listed below. They may
be purchased from sales@redtitan.com.

BlankOut

covers the field's area on the page with a rectangular patch of white or black. You
may choose whether any text this may cover is retained or discarded

See blankout [Plugins Help]

DMatrix

Reads a Data Matrix 2D  barcode, converts it into text and uses it as the value of the
field.

See dmatrix [Plugins Help]

Tesseract

An Optical Character Recognition plugin which converts images of characters into
true text using Tesseract open source routines

See tesseract [Plugins Help]
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OCRust

Enables the optical character recognition of dot matrix printer characters
See ocrust [Plugins Help]

Rocr

Use to set up your own database of recognizable character glyphs
See rocr [Plugins Help]

New plugins are regularly being developed and RedTitan can provide custom plugins
to perform specific tasks: contact RedTitan for more information.

Links
Using plugins  
Calling plugins  
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Export data

EscapeE can extract data fields for export to CSV, XML or plain text data-files. Fields
may also be extracted when a document is exported to other formats to output a log
file.

See Exporting data fields  for information about the formats and files for
exporting data; how to select fields for export; exporting PJL comments.

How to export fields to Comma Separated format, and how to extract CSV data
fields when exporting to other formats – log files: see Exporting CSV data fields

How to export fields to plain text, and how to extract text data fields when
exporting to other formats, with notes on symbol sets and character recognition
codes: see Exporting Plain Text data fields

How to export fields to XML and how to extract XML data fields when exporting to
other formats – log files: see Exporting XML data fields  

How to export a document with a log file: see Log file export  

Configuring for log file export – choosing fields to be logged, log format, number
options etc. – log naming notes: see Setting Log file options  

How to set up page numbering schemes for the document: see Creating page
numbers .

The features of the Bates numbering system as implemented by EscapeE: see 
About page numbers .

Exporting data fields

When you have marked up data fields on the pages, you can export the data fields
into a CSV  file or into an XML  file which may be imported into a database or fed
to the RedTitan Dynamic Document Formatter. You may also opt to export the fields as
Plain text . In addition, you may export the fields as a LOG file when exporting a
document, see Log file export .

When outputting XML, you can opt to create XSL and CSS stylesheets too: see 
Creating XML stylesheets .

When exporting a document to PCL, PDF, PDF/A or PostScript formats you may also
choose whether to include PJL comments or not. These may be comments present in
the original file or those created by EscapeE using its 'Prefix' mechanism: see Setting
the fields file options .

To select fields for export

1. Select Edit... from the 'Fields' menu, or 
hold down Ctrl and press D key.

2. In Fields list  view, hold down Ctrl and click the field name or 
In Tree  view, right-click a field name then choose Select for export. This will
select any sub-fields too.
Repeat this step to select all the fields you wish to export.

3. Click OK to close the 'Fields' dialog.

 Tip:  To deselect a field for export right click and choose Unselect for export.
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Exporting CSV data fields

To export fields to CSV

1. If there are fields defined on the page (see Defining fields and tags ):

o choose Export... from the 'File' menu or 

o press Ctrl E keys.

2. Set up the 'Page number range' of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files (see Overwriting files ).

4. Choose Comma separated fields as the 'Format'.

o A default file name (with extension .CSV) is provided. To create a different

filename or extension, type in the new name or use wild-cards.  To select
a different folder to store the file, use the Browse... button. Or

o Check the LPR output  box; the filename will be supplied automatically.

5. Choose whether to Run the associated program after creating the file or
not. See also Associated programs.

6. You may choose to export:

o all the data fields defined in the job: click All defined fields, or

o only some of the data fields:

To set up a new selection of fields, click Select... to display the 'Field
Definitions' window. Right click on a field name in the Fields list  and
choose Select for Export. Repeat for other fields you wish to export;
you may select Unselect for export if you decide not to export a
selected field. Click OK to return to the 'Export' window; the Selected
fields only option is selected automatically.

To export an existing selection of fields, choose Selected fields only
option.

7. Tick Filenames to include the name of the originating input file to the data in
the log file. It will be placed first in the log, in a field named "FILENAME".

8. Tick Page Numbers to include the page number for each record in the log file.
It will be placed in a field named "PAGE". The PAGE field will be inserted
immediately after FILENAME field if the 'Filenames' option is also selected (see 
above ), otherwise it will become the first field.

9. Further options may be set up on the Log File  page of the Configuration
dialog: click Log file....

10. Click OK to export the fields.

To extract CSV data fields when exporting to other formats

If you are exporting to an image or other format, the fields can be extracted
simultaneously into CSV format. In this case the file is not given the extension CSV,
but a .LOG file is created instead. This will contain the filename of the output image if
the Filenames option has been selected.

Choose the export Format and set any options required – see Exporting files
manually  – then select the field logging options: see Log file export .
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Exporting plain TeXT data fields

To export data fields to plain text

1. If there are fields defined on the page (see Defining fields and tags ):

o choose Export... from the 'File' menu or 

o press Ctrl E keys.

2. Set up the 'Page number range' of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files. See Overwriting files.

4. Choose Plain text as the 'Format'.

o A default file name (with extension .TXT) is provided. To create a different

filename or extension, type in the new name or use wild-cards.  To select
a different folder to store the file, use the Browse... button. Or

o Check the LPR output  box; the filename will be supplied automatically.

5. Choose whether to Run the associated program after creating the file or
not. See also Associated programs .

6. You may choose to export:

o all the data fields defined in the job: click All defined fields, or

o only some of the data fields:

To set up a new selection of fields, click Select... to display the 'Field
Definitions' window. Right click on a field name in the Fields list  and
choose Select for Export. Repeat for other fields you wish to export;
you may select Unselect for export if you decide not to export a
selected field. Click OK to return to the 'Export' window; the Selected
fields only option is selected automatically.

To export an existing selection of fields, choose Selected fields only
option.

7. Further options may be set up on the Log File  page of the Configuration
dialog: click Log file....

8. Click OK to export the fields.

Remember that EscapeE must be configured to use the appropriate driver/
symbolset to translate the character codes  correctly: see About Symbol sets .
Character recognition codes may be set up using EEfonts, choose Set up database
for character recognition from the 'Fonts' menu.

To extract text data fields when exporting to other formats

If you are exporting to an image or other format, the fields can be extracted
simultaneously into text format. In this case the file is not given the extension TXT,
but a .LOG file is created instead.

Choose the image or other export Format and set any options required (see 
Exporting files manually ), then select the field logging options – see Log file
export.
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Exporting XML data fields

There must be some fields defined in order to export XML, since only the contents of
fields found on each page will be exported. See Defining fields and tags.

To export data fields to XML

1. Choose Export... from the 'File' menu or press Ctrl E keys.

2. Set up the 'Page number range' of the pages you want to export, see Selecting
page ranges.

3. To avoid a new file overwriting an existing file with the same name, tick Do not
overwrite files. See Overwriting files.

4. Choose XML data fields as the 'Format'. To set further options click XML field
options...: see Outputting to XML.

o A default file name (with extension .XML) is provided. To create a different

filename or extension, type in the new name or use wild-cards.  To select
a different folder to store the file, use the Browse... button. Or

o Check the LPR output  box; the filename will be supplied automatically.

5. Choose whether or not to Create XSL, CSS and HTM files: see Creating XML
stylesheets.

6. Choose whether to Run the associated program after creating the file or
not. See also Associated programs.

7. You may choose to export:

o all the data fields defined in the job: click All defined fields, or

o only some of the data fields:

To set up a new selection of fields, click Select... to display the 'Field
Definitions' window. Right click on a field name in the Fields list  and
choose Select for Export. Repeat for other fields you wish to export;
you may select Unselect for export if you decide not to export a
selected field. Click OK to return to the 'Export' window; the Selected
fields only option is selected automatically.

To export an existing selection of fields, choose Selected fields only
option.

8. Further options may be set up on the Log File  page of the Configuration
dialog: click Log file....

9. Click OK to export the fields.

To extract XML data fields when exporting to other formats

If you are exporting to an image or other format, the fields can be extracted
simultaneously into XML. In this case the file is not given the extension XML, but a
.LOG file is created instead.

Choose the image or other export Format and set any options required (see 
Exporting files manually ) then select the field logging options – see Log file
export.
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Log file export

Instead of exporting a document  and its data  separately, you may generate a log
of a document's fields when exporting the document. The options for exporting a log
are set up on the 'Log file' page of the 'Configuration' dialog, see Setting Log file
options . Some of these settings, however, are reflected in the 'Export' dialog and
you may reset them there:

1. Display the Export dialog and set up the details for document export as usual –
see Exporting files manually .

2. In the 'Fields to be logged' panel, choose:

o All defined fields, or 

o Selected fields only. To edit your selection:

Click the  button to open the Field dialog , right click on a field name
in the list and choose Select for export. (If you need to cancel a
selection, right-click and choose Unselect for export.)
Repeat for all the fields you wish to export.
Click OK to return to the 'Export' window.

3. Choose a 'Log format' (see also Setting Log file options ):

o Comma Separated or 

o Plain text or 

o XML. You may opt to create an XML stylesheet by ticking:

Create XSL, CSS and HTM files.

4. Tick to add these options as required:

o Sheet Numbers see Setting Log file options .

o Page Numbers see Creating page numbers .

o Bates Numbers to the document's pages and the log file. See About page

numbering .

o Filenames includes the file-names of the data-files used in the document,

see Setting Log file options .

o Message if one has been set up, see Setting Log file options .

To switch off log file export:

In the 'Fields to be logged panel' of the Export dialog (see above ), select None.

Links
Exporting data fields  
Exporting files manually  
Setting Log file options  
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Setting Log file options

The names/contents of data-fields can be exported, generating a log file. Options for
the log file are set up in the Log File page of the 'Configuration' dialog, see below .
(Some of these settings are reflected in the 'Export' dialog – see Log file export .)

To set options for the Log file

1. Click the Log File tab of the 'Options|Configuration' dialog (f8).

2. Select the 'Log File Format':

o XML 

You may click XML field options... to refine the choice of XML data-
field options to be logged, see Outputting to XML .

o Plain text; you may also add a:

Text log file message. Type in a string to be output to the log file; it
may contain Special fields in composed strings . Tick Enabled to use
the message. Unselect 'Enabled' to de-select the option without erasing
the message. See also Examples: Command lines .

o Comma separated. By default, the field names are used to create the first

line of a CSV log file. The alternative is to tick the option to:

Omit field names and suppress the output of the first line.

3. In the 'Logged Fields' panel, choose which data fields are to be included:

o all the data-fields defined in the job: click All defined fields, or

o just some of the data-fields. Click Select... to display the 'Field Definitions'

window.

Right click on a field name in the Fields list/tree  and choose Select
for export.

To cancel a selection, right click and choose Unselect for export.

Repeat for all the fields you wish to export.
Click OK to return to the 'Log File' window; the Selected fields option is
selected automatically. See also Viewing data fields and tags .
Alternatively:

o Select None of the data-fields: this switches off log-file export.

4. To show the file-names of the data-files which supply the data for the data-
fields in the document (as well as the actual field-values) in the console log,
tick Filenames.

5. Page numbers, Bates Page Numbers and/or Sheet numbers may be logged.
If the format chosen for the log file is:

o CSV  then the number for each page/sheet exported is recorded in the log

file;

o XML  then a number for each page/sheet exported is recorded in the log

file. This is default option.

o Plain text  then the count (number of pages/sheets exported from this

document in this export) is added to the end of the log file.
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6. Set up 'When to output' items for the Log – either output log entries for:
Every page (the default) or 
When a field specifies it.

o You may opt to output log entries only:

At end of file or 
At end of file + 1 too: see Note  below.

7. Set further options as required:

o Rename log file when finished. See Note  below.

o Create a new log file for each output file. See Note  below.

o Make one new log file entry for each output file; left unchecked, a new

log file entry will be made for each page output instead.

8. Some jobs require a count of the pages in each of a number of repeated sets
within a document: click Count pages (see below ) then click OK.

9. If any errors occur an Error log file may be created along with the file. Setting
up a path and filename in the edit box automatically ticks Enable (default is
ERROR.LOG). See Note  below.

10. Click OK.
Alternatively, you may choose to create a Shortcut icon that uses all the options
you have set by clicking Shortcut... (see Shortcuts - the easy way to construct
a command line ) or click the Save button to retain these settings after you
close the program.

Notes

The output files are constructed using the specified output file name ; numbers
appended so that the default output file-stems are xxxx1, xxxx2 etc.. The log files

take the corresponding file-stems plus the extension .CSV, .XML or .LOG, depending

on the log format  that you have selected.

Rename log file when finished: during processing, the log file bears a temporary
name and is not given its final name until the log file is complete. The temporary
name is given an extension of .CS~, .XM~ or .LO~, indicating that it is still being

created.

Create a new log file for each output file: the output file is split whenever a
specified field (or tag) is encountered or when a field changes. Each log file has a
name corresponding to its output file and field content (even if only one file is
created), unless the input was from TCP/IP , in which case it has a name based on
the first output file name.
For example if the file is called TEST.PCL, the field contains ABCD and the output

specification is *=.PDF then the output file name will be TESTABCD.PDF and the Log

file will be TESTABCD followed by the appropriate extension.

At end of file writes the log entries at the end of the file. At end of file + 1 writes
the log entries as if on a page after the end of file, to simplify page counting. See
also /LOG  command-line option.

The Count pages dialog constructs a prototype RUN command set up with the
options that you have selected, e.g.
EscapeE {ofilename},FILENAME,PAGE /INPUT CSV

An Error log file is only created when there are errors to log. When Enable is ticked
the value of ERRORLOG symbol in the [PCLVIEW] section of RT.INI is set to the
specified file. When 'Enable' is deselected the ERRORLOG value is set to N. See also /

ERRORLOG .
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Creating page numbers

Page numbers, in the position and font of your choice, may be added to pages when
they are exported. They may be simple digits or a combination of text and digits. The 
Bates  numbering feature enables several different files to be output with
consecutive numbers so that they form a set, e.g. for legal documents.

To create page numbers

1. Choose Configuration... from the 'Options' menu or 
press F8 key.

2. Select the Layout tab.

3. In the 'Page numbers' panel:

o In the Template box, either:

Type in the text for the page-number's prefix. If the prefix text
includes an * character then EscapeE will replace the asterisk with the

filename stem. Or 

Leave it blank for no prefix.

o Enter, or use the spin-buttons to set, the minimum  Number of digits a

page-number may display. EscapeE adds one " character to the Template

for each digit required.
The default value is zero, which switches page-numbering off.

For more on setting up a Bates-style number template see About Page numbers

4. Set the Horizontal position of the page-number as a distance , either 

o From left edge of page to the left side of the field or 

o From right edge of page to the right side of the field.

If left blank, page numbering is suppressed.

5. Set the Vertical position similarly: either 

o From top edge of page to the top of the character cells or 

o From bottom edge of page to bottom the of the character cells.

If left blank, page numbering is suppressed.

6. Set the Point size and Font Family for the page-number. If either of these
boxes are left blank, page numbering is suppressed.

7. If Bates page numbering is required:

o Tick Remember number for next time so that the current 'Number for

next page' is used for the next document. This ensures that the pages of
successive documents are consecutive.

o You may click Save number now to reset the stored page number to the

value in the 'Number for next page' box. Note that otherwise the last-used
page-number is only saved if greater than the highest previously used.

8. Click OK to use these setting for the current session. Or 
Click Save to retain these settings after you close the program. Or 
Click Save as to save these settings to a file. Or 
Click Shortcut... to create a Shortcut icon which uses all the options you have
set (see Shortcuts - the easy way to construct a command line ).
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To switch off page numbering

Page numbering is suppressed when any of these boxes are left blank:

Number of digits and/or 

Point size and/or 

Family and/or 

Horizontal position ('From left' and 'From right') and/or 

Vertical position  ('From top' and 'From bottom')

 Notes

When there are more digits in an actual page-number than 'double-quote' characters
in the template, then the length of the page number field on that page is extended to
accommodate the extra digits: the numbers are never truncated. When there are fewer
digits in the page-number than 'double-quote' characters in the template, then one or
more 'zero' characters are added to the page number field to fill out the field to the
required length. See example in About page numbers .
The vertical offsets are distances from the physical page edge to the edge of the
nominal character cell for the font specified, not the font's baseline. This ensures that
there is sufficient space for ascenders and descenders.
If using a Windows printer driver there is an unprintable region of about 0.3" at the
edge of the page: any text which extends even partly into this region is omitted by
the driver.

 Tip:  To change the units in which distances are specified, see Configuring the view
.

Links
About page numbers  
Setting Log file options  

About page numbers

Page numbers can be added to each page of a document when exporting .
EscapeE creates  "Bates" numbers, designed to be unique over a complete set of

documents. They may include a prefix and/or file-name stem in addition to the serial
number.
The syntax for specifying the format of the number is similar to that for file-names :

"   represents one digit of the serial number 
*  represents the original file stem

The maximum length of the page number template is 150 characters.

 Examples

For a PCL file called 'SALES.PRN':

Template Creates numbers
 "" 01, 02, 03, etc.
 Page " Page 1, Page 2,.. Page 10 etc.
 APRIL*""" APRILSALES001, APRILSALES002, etc.

You can also specify a starting page number; that is, the number that would be
assigned to page 1 of the document. If, for example, it is 12345 then if you start

output at page 10 that page will be numbered 12354, so that the numbering is

consistent for any subset. If you select Remember number for next time from the
Layout  page of the Configuration dialog, then on closing the file the page number is
saved (if it is larger than the previous highest number).
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If you want to have two different projects each with its own range of page numbers
then you will need to use different configuration files. The configuration file name can
be specified on the command line  or in a shortcut . Use the Save As button on the
Configuration dialog to create such a file, and a shortcut to it.
To specify the starting page number on the command line use the /NEXTPAGE
option e.g.
ESCAPEE myfile.pcl /TIFF /NEXTPAGE 12345

You may opt to Save number now so that the stored page number is reset to the
value in the Number for next page  box next to it. Note that otherwise the last-used
page number is only saved if greater than the highest previously used. 
On the command line, a negative value of /NEXTPAGE ensures that the page number
is not saved for the next document and that the number is adjusted by any offset in
the /PAGE  option. For example the command:
escapee myfile.pcl /print /page 4-5 /nextpage -1 /pnum 'Page " of subset'

would print pages 4 to 5, numbering page 4 of the document as "Page 1 of subset"
and page 5 as "Page 2 of subset". 
Page numbers can be incorporated into the output file's name. When a "plus" sign is
included in the output file name specified in the Export  dialog, it is converted to the
page number in the output filename. For example, the set-up:

Output file specification: *+.PDF

Page1 number: 3

Number template: p"

Input filename: FILE1

This set-up creates an output file named FILE1p3.PDF with pages numbered and

starting at 3. To output the file without printing the number on each page, select a

null font or clear the font point size or the horizontal or vertical position fields in the
Configuration dialog's Layout  page.

Links
Creating page numbers  
Setting Log file options  
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Composite fields

This section describes how to build composite fields for particular functions. The first
four topics detail how to set up composite fields using EscapeE dialogs. These are
followed by topics which document the syntax used in composite fields (see also 
Composite fields syntax summary  in the Reference  section).

How to build a composite field, with example: see Defining a composite field

See More on defining composite fields  to set up composite fields using the Field
dialog's Composite field wizard.

Embedding fields in composed strings and pre-defined 'symbols': see Special
fields in composed strings  

Use of arithmetic and logic operators when assigning field-values: see Composite
field expressions  

About field attributes  bottom, height, left, length, right, top, width, x and y;

extracting sub-strings from fields: see Partial fields

Using := to set up numeric and string field-values: see Defining field values  

Using + prefix to set up Counters: see Numerical conditions

Using + prefix to define values dependent on whether a string is found or not:

see String conditions

Using = prefix and += prefix to define page-dependent field values: see Page

conditions

Eliciting data from the User: see User input data fields  
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Defining a composite field

Usually, fields are used to insert the whole field value by enclosing the field name in
curly brackets e.g. Dear {name}. Sometimes, however, you may need to insert just

part of a field's value or to use a particular value in certain circumstances. The
composite field feature enables you to set up new fields based on modifications of
other fields and/or conditions.

To define a composite field

1. Select New... from the 'Fields' menu to display the Definitions  page of the
'Fields' dialog.

2. Enter a name for the field in the Field box then click Refresh.

3. Click the Composite check box to display the "Value" edit box.

4. Enter the composite field definition in the Value box using one of these
methods:

o Select a string from the drop-down list of ready-made 'Components'. The
list contains the names of all the fields currently in the document plus
many commonly used composite symbols such as _day, _side: see Special

fields in composed strings . Or 

o Click the More... button to open the  Composite field wizard  and let 
EscapeE generate the syntax for a more complicated definition from its
setup.

o edit the Value box directly from the keyboard – see Composite field syntax
summary  for an overview of the syntax.

Value strings are enclosed in curly brackets to mark them as symbols rather
than pieces of text.

5. Select the Action tab to specify what EscapeE is to do (start a new set, force a
back page etc.): see Setting field actions . When an action criterion is met,
the "Action" box is shown ticked.

6. Click OK.

Example

The value: 
File {_name} page {_page} Inv: {invnum}

would result in a composite field such as:
File TEST page 2 Inv: 073102

 Note

A leading underscore character is used to distinguish predefined fields  from any
defined by the user, but may be omitted if there are no user-defined fields with
conflicting names.

Links
More on defining composite fields  
Special fields in composed strings  
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More on defining composite fields

A complicated composite field can be set up in the Value box on the 'Definitions' page
of Field dialog, see Defining a composite field . You may key-in the definition directly
(see Composite field syntax summary ) or click More... to display the Composite
field wizard. EscapeE will construct the definition from details set up in the wizard,
see below

Composite field wizard

A complex composite field may comprise several conditions. These conditions can
be set up, one at a time, in the Composite field wizard then coded and concatenated
by EscapeE when the Add button is clicked.

1. Open the wizard by clicking More... on the Definitions  page of the Field
dialog.

2. Choose one of the Components from the drop-down list of fields already
present in the document and Special composite symbols .

3. Set the 'Condition' for the field to be output; choose from:

o Always

o If field found – On selection, additional edit boxes are displayed for

setting up a String condition .
Either enter a string Value for:

when field is Found, and/or 

when field is Not found.

Or set up a Counter , see below.

o If field changed – On selection, additional edit boxes are displayed for

setting up a Page condition .
Either enter a string Value for:

when field is Unchanged, and/or 

when field is Changed.

Or set up a Counter , see below.

4. You may extract just part  of the Component field's value, rather than the
whole field's value. In the 'Extract sub-field' panel:

o specify the column position of the first character to be extracted in the 

Starting column box.

Click From start to count columns from the left or 

click From end to count columns from the right.

o Set up the place at which to stop extracting characters:

You may specify an Ending column if counting from left, or 

Specify width as a Number of columns or 

Specify Terminators – any character that may indicate the end of the
piece of data, e.g. comma.

o A sub-string may be found within a field: specify the [number] of the

Word. 

o A line may be found within a multi-line field: specify the [number] of the

Line.
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5. Click Add then repeat steps above  to build up the entire composed field
definition.

o Arithmetic expressions may be inserted in Value as necessary directly from

the keyboard: see Composite field expressions.  

6. When the composed field definition (shown in 'Value' box) is complete, click 
Done.

Counter setup

When Field found  or Field changed  conditions have been selected, the wizard
displays a panel of options. Ticking a Counter check-box on this panel sets up a
count of the number of occurrences of the condition.

1. Set up the type of counter by ticking the Counter check-box alongside the
appropriate option:

o Search for the field and increment the count if the field is

Found or 

Not found or 

o Check the field and increment the count if the field value is

Changed or 

Unchanged.

2. Enter, or use the arrows on the spin-box to set up, the "width" of the counter:

o specify the minimum number of digits to be used for the counter or 

o tick 0 check-box to create a fixed-length counter. Specify the number of

digits to be used: it will be filled-out using leading zeroes.

3. Enter the number at which the count is to Start.

4. Enter the number at which the count ends and resets in the Limit box.

5. In the Reset box, enter the number at which the count is to restart when the
Limit  has been reached.

See also Numerical conditions .

To assign a value

To simply assign a constant known value to a new composite field:

1. Select the field name from the drop-down list of Components.

2. Enter the value that the field is to take in the Value box.

3. Click Assignment.

4. Click Done then OK.

See also Defining field values .

 Tip:  If you re-open the Field dialog  to show the Definitions  page for a
composite field, its code is shown in the 'Value' box and its evaluated result is shown
below its 'Field' name.

Links
Numerical conditions  
String conditions  
Page conditions
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Special fields in composed strings

A composed string (such as used in a composite field,  an output file specification or
a PDF password ) can contain embedded field names enclosed in curly brackets e.g.
Dear {name}. The value of the field is substituted at the time of invoking the string

e.g. when constructing an output file name. As well as the user-defined fields there
are certain special ones:

Special composite symbols

_{ An opening curly bracket.

_} A closing curly bracket.

_back Value is BACK if on a back page or null if not a back page. Related

item: _front .

_bates The 'bates' page number as defined in the Layout  page of the
'Configuration' dialog. Related item: _page .

_bin The current output bin number. Related item: _tray .

_CR Carriage Return (character 13 decimal, 0D hex). Related items: 
_CRLF  _LF .

_CRLF Carriage Return & Line Feed (0D0A hex). Related items: _CR ,
_LF .

_day Today's day number (1-31). Related item: _month .

_DocAuthor The name of person who created the document, extracted from a 
PDF  input file.

_DocCreationDate The date that the document was created, extracted from the PDF
input file.

_DocCreator The name of the program that created the original document
extracted from the PDF input file.

_DocKeywords Keywords for the document, extracted from the PDF input file.

_DocProducer The name of the program which output the document, extracted
from the PDF input file.

_DocSubject The subject of the document, extracted from the PDF input file.

_DocTitle The document title, extracted from the PDF input file.

_DocUpdateDate The most recent update date of document, extracted from the PDF
input file.

_ext Same as _Iext , see below.

_filename Same as _Ifilename , see below.

_filenum The current file number within a list of files being processed.

_filepages The number of pages in a current input file. Valid only for input
formats  such as PDF , TIFF  or DCX  where the number of
pages can be easily determined.

_FirstPageInSet The page number of the first page in the current set. It is updated
when a field defines the start or end of a set. Related items: 
_numSetPages , _page , _SetPages .

_front Value is FRONT if on a front page, otherwise null. Related item:

_back .

_GMT Same as _UTC , see below.

_hour Time in hours. Related items: _minute , _second .

_id Unique numeric ID; used to construct the default output file
name: {_title}{id}
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_Iext The original (Input) file extension, including the 'dot'. Related
item: _Oext .

_Ifilename The full Input file name. Related item: _Ofilename .

_IgnoredImages A count of the number of images that were ignored by ticking the 
General Configuration  option 'Ignore images' .

_Iname The file name stem of the original (Input) file. Related items: 
_Oname , _Mname .

_Ipath The full path of the original (Input) file. Related items: _Opath ,
_Mpath .

_LF Line Feed (character 10 decimal, 0D hex). Related items: _CR ,
_CRLF .

_local Subsequent times are 'local'; the default time is specified in 
Universal Coordinated Time .

_media The media  type of the current page. Related item: _paper .

_Mext The Main file extension. Related items: _Mname , _Mpath .

_minute Time in minutes. Related items: _hour , _second .

_Mname For a List Of Files  this is the Main (LOF) file name; note that
_Iname  is the current Input file name, see above. Related
items: _Mext , _Mpath .

_month Today's month number (1-12). Related item: _day .

_Mpath For a List Of Files  this is the full path of the Main (LOF) file;
note that _Ipath  is the current Input file's full path, see above.
Related items: _Mext , _Mname .

_name Same as _Iname , see above.

_numPages When using /FROM  to read a CSV Control file,  _numPages

obtains the number of pages in the current file segment. Related
items: _numSetPages , _page .

_numSetPages Calculates the number of pages in the current set (i.e. from the
field marking the start  of the current set to the field marking
the end  of the current set). Related items: _FirstPageInSet
 _numPages , _numSetSheets .

_numSetSheets Number of sheets in the current set. Related items:
_numSetPages , _sheets .

_Oext The Output file extension, including the 'dot'. Related item: _Iext
.

_Ofilename The full Output file name. Related item: _Ifilename .

_Oname The file name stem of the Output file. Related item: _Iname .

_Opath The full path of the Output file. Related item: _Ipath .

_orient The orientation of the page.

_page The current page number. Related items: _bates ,
_numSetPages , _sheets , _sides .

_paper The name of the paper used for the page e.g. LETTER. Related

items: _media , _sheets .

_path Same as _Ipath , see above.

_plugins The folder containing the plugins .

_RT This is defined by the value from the @PJL COMMENT REDTITAN
DIR value. See also Preamble and PJL options .

_RTid Returns the RedTitan PC ID .

_RTini The full path (including the file name) of the RT.INI  file.
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_second Time in seconds. Related items: _minute , _hour .

_SetPages The number of pages in the current set . Related items:
_FirstPageInSet .

_sheets The number of pieces of paper that have been output. Related
items: _page , _side .

_side or _sides The current side number starting at 1. Related items: _page ,
_sheets .

_TempDir The Windows® temporary folder (terminated by backslash) e.g. 
C:\Users\<username>\AppData\Local\Temp\ 

_title The job title; used to construct the default output file name:
{_title}{_id}

_tray The current input tray number. Related item: _bin .

_UTC Subsequent times are in Universal Coordinated Time. Related
item: _local .

_year Today's year number. Related item: _month .

All these special 'symbols' start with the "underscore" character, followed by
characters that may be in upper, lower or mixed case. The underscore characters are
to distinguish predefined fields from those defined by the user, but may be omitted if
there are no user-defined fields with conflicting names.

PJL note

Special fields beginning {PJL_ can be used to extract data from PJL commands. For

example,
{PJL_OUTPAPER}

could be used to search for a command such as
@PJL SET OUTPAPER LETTER

and extract the OUTPAPER parameter (LETTER in this case).

Similarly, the composite field {PJL_JOB} will yield the name of the job.

See also PJL Comments  and Preambles and PJL options .

Examples

{_GMT}{_day}/{_month}/{_year} is a Greenwich Mean Time date in European

format.

{_Local}{_Month}/{_Day}/{_Year} is a local date in U.S.A. format.

{_local}{_hour}:{_minute}:{_second} is a local time.

See also Examples: Command lines .

Links
Partial fields  
Filenames and wildcards  
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Composite field expressions

Numeric expressions

In a composed string, if the field can contain a numeric field-value then you may use
an arithmetic expression in place of a field-name. These operators may be used:

+  to add 

-  to subtract 

*  to multiply 

/  to divide (rounding towards zero) 

\  to provide the remainder after division (the mod function) 

and use round brackets () to contain intermediate calculations. 

Examples:

{pagenum\2}

to check whether the current page number supplied by a field named pagenum is odd

(when remainder is 1) or even (remainder is 0).

{field1*(field2-field3)+1}

where field1, field2 and field3 all supply numeric values.

Logic expressions

Fields yielding integer values may use these bit-wise logical operators :

&  AND 

|  OR 

¬  NOT  

Any composite field that contains only Boolean expressions such as field.found  and
field.valid , or such expressions combined using Boolean logical operators, is
considered to be a Boolean field. If they have no search tag then such boolean fields
are considered to be found when their value is "True" (-1) and any specified actions

will occur accordingly. The field type is shown as Boolean in the Fields properties.

Examples:

{field1.found&field2.found}

The result is True if both field1 and field2 are found, in which case the value of the

composite field would be -1.

If only one of the fields or neither are found the result would be False (0).

{field1.found|field2.found}

The result is True if either field1 or field2 or both fields are found, in which case the

value of the composite field would be -1.

It would be False (0) if neither field1 nor field2 is found.

{field1.found&¬field2.found}

The result is True if field1 is found and field2 is not found, in which case the value of

the composite field would be -1.
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{field1&7}

ANDing field1 with binary 111 gives the bottom three bits of the value and so acts as

a 3-bit "mask".
Note that field1 must have a integer value, otherwise an error will be given.

Links
Defining a composite field  
Partial fields  
Bit-wise logic  

Partial fields

{fieldname.size}
Extracts an attribute of a field's position and size, or length in characters.

The field and tag parameters (as set up in the Fields dialog – see Defining fields and
tags ) may be used in composite field expressions. These size attributes (in units

defined in the Viewing  page of the Configuration dialog) are:

left, right, top, bottom position of field's boundaries.

width, height size of field

x, y coordinates at which tag is found.

length the number of characters found.

For example, if the value of the field named title is "Miss", then the composite

field
{title.length}

gives the number of characters in title, i.e. "4". Arithmetic operators  may be

used in composite field definitions, for example
{fielda:fieldy.length+2:3}

extracts 3 characters from fielda starting at the column position given by the
number of characters in fieldy plus two characters.
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{fieldname:range}
Extracts a range of character(s) from a named field. There are several ways of
specifying the range

{fieldx:n}
{fieldx:-n}
The name of the field may be followed by a colon and a number specifying the
position of the first character to be extracted from the field. If a positive number
is given, the first character is found by counting from the left. For example, if the
field value is ABCD,EFGH then:
{field:6}

extracts the field value from character 6 onwards, omitting the first 5 characters: 
EFGH.

If a negative number is given, the first character is found by counting from the
right. For example:
{field:-4}

extracts only the last 4 characters of the field: EFGH.

{fieldx:n:r}
{fieldx:-n:r}
The syntax may be followed by a further colon and the number of characters to be
extracted, for example
{field:4:3}

extracts 3 characters starting at the 4th character from the left: D,E and
{field:-4:3}

extracts 3 characters starting at the 4th character from the right: EFG.

{fieldx:n-m}
Alternatively, the range may be given by a hyphen and an end character position
number. Use positive position numbers to counting from the left and negative
numbers to count from the right, e.g.
{field:4-6}

extracts 3 characters ranging from the 4th to the 6th characters from the left: 
D,E.

{fieldx:n:'separator_characters'}
Another option is to specify the range using a further colon and separator
character(s) as a quoted string (i.e. between a pair of single or double quotes).
For example
{field:1:',;'}

extracts from character 1 up to the first comma or semi-colon: ABCD.

{field[n]}
Extracts the "nth" sub-string from a field. 

The sub-strings must be separated by space character(s). To extract a sub-string
which itself includes space character(s), the sub-string must be enclosed in a pair of
single or double quotes. For example, if a field named PERSON contained the value
Mr "John Smith" 1234

then
{person[1]} would be Mr

{person[2]} would be John Smith

{person[3]} would be 1234 
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{field[#n]}
Extracts the "nth" line from a multi-line field. 

For example, if ADDRESS were a 4-line field generated by the OCR plugin then

{ADDRESS[#2]} 

would be the second line of the address.

See also More on defining composite fields .

Boolean field properties

{field.found}
Yields -1 (True) if the field was found on the current page; otherwise it yields 0

(False).

{field.valid}
Yields -1  (True) if the field value is valid according to its specified type  (numeric,

dateDMY etc.); otherwise it yields 0 (False).

See also Composite field expressions .

 Note

A composite field (i.e. one defined in terms of other fields) retains its value even if it
uses a sub-field of a tag which does not occur on the current page. See also Setting
fields file options .

Links
Defining a composite field  
Composite field expressions  
More on defining composite fields  
Special fields in composed strings

Defining field values

{fieldname:=value}

Assigns a value to the named field; see also More on defining composite fields .

If the named field does not exist, it will be created. The value can include fields and
expressions, see Special fields in composed strings  and Composite field
expressions.  

Examples
{newfield:=0}
{delta:={field1-field2}}
{next:={_page+1}}

Note that the last example assigns the numeric value of {_page}  plus 1, i.e if _page

is 23, next field value is set to 24. This example, however, assigns a string value:

{sum:={_page}+1}

i.e. if _page is 23, next field value is set to the string "23+1".
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Numerical conditions
The + syntax should be used in preference to the obsolete ? form.

{+fieldname=['found'],['not_found']
[[,initial_value],limit[,reset_value]]}

The + condition field syntax, when given numerical values, may be used to set up a

number of counting functions. Full nesting of conditional field expressions is
supported, e.g.
{field1*field2}
{field1*2-field2}
{field1}{field2}

etc. as long as they resolve to a number.

{+fieldname=found,,[initial_value][,limit[,reset_value]]}
A counter that is incremented when a named field is found.

found, An integer specifying the number of characters to be used for
a counter. If found value starts with a zero then leading zeros

are inserted to make up the width, otherwise spaces are used.
If the counter exceeds the specified width then it is not
truncated and all digits are shown.

Alternatively, a number of # characters would specify that

number of characters be used for a counter.

, This denotes a null value for the unused not_found parameter.

initial_value

(optional)

The initial value used when the field is first evaluated,
regardless of whether counting occurs or not.
Omitting this parameter sets a null starting value.

,limit

(optional)

This is an integer value which specifies an ultimate value for a
counter, after which the counter resets.

,reset_value

(optional)

The integer value to which the counter resets after the limit

has been reached.
If reset_value is omitted it defaults to initial_value. If

initial_value is omitted it defaults to zero.

For example:

{+points=02,,03,12,01}

Initially, composite field is set to the value 03. Each time the field named "points"
is found, the composite field value is incremented by 01 until it reaches the value
12. The next time "points" is found, the composite field value is reset to 01.
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{+fieldname=,not_found[,
[initial_value],limit[,reset_value]]}
A counter that is incremented when a named field is not found.

, This shows that the (redundant) found parameter has been

skipped and default value – null – set.

not_found An integer specifying the number of characters to be used for
a counter. If not_found value starts with a zero then leading

zeros are inserted to make up the width, otherwise spaces are
used. If the counter exceeds the specified width then it is not
truncated and all digits are shown.

Alternatively, a number of # characters would specify that

number of characters be used for a counter.

,initial_value

(optional)

The initial value used when the field is first evaluated,
regardless of whether counting occurs or not.
Omitting this parameter sets a null starting value.

,limit

(optional)

This is an optional integer value which specifies an ultimate
value for a counter, after which the counter resets to 
initial_value.

,reset_value

(optional)

The integer value to which the counter resets after the limit

has been reached.
If reset_value is omitted it defaults to initial_value. If

initial_value is omitted it defaults to zero.

For example:

{+debit=,2,0} or
{+debit=,##,0}

Initially, composite field returns the value 0. Each time the field named "debit" is
not found, the composite field value is incremented by 1.

{+fieldname=found}
A simple construct for counting found fields, where the initial value is null.

found An integer specifying the number of characters to be used for
a counter.

Alternatively, a number of # characters would specify that

number of characters be used for a counter.

 For example:

{+count=1} or
{+count=#}

The composite field value starts null. Then each time the field named "count" is
found, the composite field value is incremented by 1.
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Obsolete syntax:

{fieldname=digits[,initial_value[,limit]]}
This initializes and increments a counter: use +fieldname  syntax above instead.

fieldname= The composite value must include a field name followed by an
equals sign.

digits Specifies how many characters wide the 'counter' field should
be. It may be an integer or a string of # characters.

,initial_value

(optional)

The value that the counter starts counting from. Default value
is zero.

,limit

(optional)

Ultimate value that the counter can reach before resetting to
initial_value.

When the specified field is encountered for the first time, the counter is set to 
initial_value, or 0 if that is not specified. Subsequently, if the field exists the

counter is incremented until it reaches the limit (if any), when it is reset to the
initial value.

If digits parameter value is an integer and starts with a zero then leading zeros

are inserted to make up the width, otherwise spaces are used. If digits parameter

value is a number 'n' of # characters, then the width is specified as n characters.

If the counter exceeds the specified width then it is not truncated and all digits are
shown.

Examples: 
Invoice {page1=1,1} 

This specification would have the value "Invoice 1" the first time field page1 was
found, and the number would increment each time field page1 was found.
Set{page1=02,0,99} 

This specification would start at "Set00" and go up to "Set99" before resetting to
"Set00".

To truncate the counter another composite field may be used. For example, you
might use:
{countfield:-4}

to take the last 4 digits of countfield.

See also More on defining composite fields .

Links
String conditions  
Examples|Composite fields
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String conditions
The + syntax should be used in preference to the obsolete ? form.

The + prefix is a versatile condition field syntax which may be used with integer

parameters (see Numerical conditions ) or with strings. A string condition may be
applied to a pre-defined symbols (see Special fields in composed strings ) as well as
User-defined fields. Full nesting is supported, so the 'found' and 'not_found'
parameters may themselves consist of another field expression or conditional field,
provided that they resolve to a string.

{+fieldname=['found'],['not_found']}
The string value of this composite field depends on whether a field is found or not.

found This is a string and must be enclosed within a pair of quote
characters. It is the value that the composite field returns if 
fieldname is found.

not_found This string, in quotes, is the value that the composite field
returns if fieldname is not found.

 See also Examples: Composite fields

Obsolete syntax:

{?fieldname=['true_value'][,'false_value']}
This expression determines whether or not a field value is present in a data-field:
superseded by +fieldname  syntax above.

?fieldname= Must start with a question mark followed by a field name and
an equals sign.

true_value

(optional)

The value assigned if a value exists for the named field. If 
true_value is a single 'word', it need not be in quotes.

Default value is T  if true_value parameter value is omitted

from the expression.

false_value

(optional)

The value assigned if a value for the named field does not
exist. If false_value is a single 'word' quotes may be omitted.

Default value is F  if false_value parameter value is omitted

from the expression.

See also {?fieldname} below.

{?fieldname} 
To just return the default values T if the field value exists or F if it doesn't, it is
sufficient simply to precede the field name by a question mark. Use +fieldname
syntax instead.

See also More on defining composite fields .

Links 
Numerical conditions  
Examples|Composite fields
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Page conditions

{=fieldname}
generates a null value if named field is not found on the current page.

Using {fieldname} just returns the most recently defined value for the named field.

Using the = syntax enables a composite field to be defined which automatically

resets its value to an empty string each time a page is started.

For example, if only one of FIELD1 or FIELD2 occurs on the current page then

{=FIELD1}{=FIELD2}

will contain the value of whichever field occurs.

{+=fieldname=['same_value'][,'different_value']}
This redefines the value of the named field, dependent on whether the field-value is
the same as the previous page, or different.

+=fieldname= Must start with += followed by a field name and an equals

sign.

same_value

(optional)

The value assigned if the named field's value is the same as
on the previous page – unchanged.
If omitted, the value is not redefined.

different_value

(optional)

The value assigned if the named field's value is the different
from the previous page – changed.
If omitted, the value is not redefined.

When the same_value/different_value parameters are single 'words' they need not
be in quotes, but note that # characters that are not in quotes indicate a 'Counter':
see Numerical conditions .

{?=fieldname=['same_value'][,'different_value']} 
This is equivalent to the +=fieldname  syntax above.

See also More on defining composite fields .

User input data fields

{"question"}

This construct displays a dialog with the question text as its caption and prompts the

User for an 'answer'. The answering value entered by a User in response will be stored
as the required field value: see also Defining a composite field .
The default is to prompt once per file. Alternatively, to prompt for every page, check 
when field changes in the Action  page of the Field dialog.

Example 
{"Please enter your postal code"}
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Data Control files

The control files described in this section supply the data for creating composite
documents. (To create a composite document using Intelligent Document Format,
see IDF documents  and IDF wizards .)

About Control files  describes how LOF (and CSV) files may be used to set up
composite documents.

How to display a data control file in EscapeE and how to view the composite
document: see Viewing a data control file .

How to build an LOF control file automatically or from the keyboard: see Creating
a data control file .

How to edit an LOF control file or save as a template for editing; CSV note: see 
Editing a data control file .

About .EE files for control files  describes the fields, records and FILENAME
pertaining to field definitions files.

How to create a field definitions file: see Creating the .EE file .

About Control files
EscapeE Professional  editions only

A control file that is used to provide the data for assembling into a composite
document may be a simple text list  or a CSV  file. An IDF document is, strictly
speaking, a control file too. However an IDF document 'control file' also contains code
for creating a document as well as data, so it is treated differently. See Editing an IDF
document .

Text control files (.LOF)

A "text" control file is basically a list of files: see Creating an LOF control file . Each
line of the file starts with the name (and path if the documents are not all in the
same folder) of one of the component documents. The filename may be a wild-
carded file specification; filenames must be enclosed in single quotes if they contain
spaces. By default, EscapeE will create a field definition file with the same filestem
automatically if none already exists. For complex composite documents, however,
you may find it convenient to set up separate field definition files for some of the
component files: see LOF details.

CSV control files (.CSV)

If the control file has extension .CSV or begins with a double-quote character it is
assumed to be a set of field definitions in comma-separated form: see Editing a
data control file .
The first record must contain the field names for the data found in subsequent
records.
Each subsequent record must contain the information required for EscapeE to
construct the filename of one component document. By default it will use the first
CSV datafield as the source of the filenames, but by using a field definitions file it is
possible to use the special composite field definition named FILENAME to construct it

from other field values. The fixed values for fields defined in the CSV file may be
used in other fields and with plugins, for example, to add text or barcodes: see Using
Plugins .
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Viewing a data control file
EscapeE Professional  editions only

1. Select File on the menu-bar then:

o Click Open..., select the control file and click the Open button or 

o if the file has been displayed recently, select the file from the History list .

Control files are indicated by ^ character.

2. The control file is displayed in the Text-editor  window.

Displaying the composite document

1. Open  the control file as above.

2. Click Show on the Text-editor window's menu-bar to display the first page of the
composite document in the EscapeE window. Or 
Double-click a file named in the Text-editor's window to display that file in the
EscapeE window. (Any options set up in associated EE  and/or INI  files will be
applied.)

3. You may page through the document using the navigation  buttons on
EscapeE's menu-bar as usual. The name of the original component file used to
create each page is shown in the EscapeE title-bar.
In addition to exporting a page on display in the normal way, you may export the
whole composite file by ticking the Treat as a single file check-box on the
Export  dialog.

 Tip:  if the composite document is on display in the EscapeE window, selecting
View control file from the 'View' menu opens another window in which the Text-
editor displays the control file.

Links
About Control files  
Creating a Control file  
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Creating a data control file
EscapeE Professional  editions only

LOF ("List Of Files") data control files may be built automatically , or from the
keyboard  in the Text editor  window.

Creating an LOF control file automatically

1. Open  a file to be included in the new LOF.

2. Select Remember file from the 'File' menu: the 'Name of new control file'
dialog is displayed.

3. Set up the new File name (with extension .LOF) then click Save.

EscapeE creates a new LOF file and adds the "remembered" filename to it,
along with its fields file (and any specified INI file). The Text editor window
opens to show the LOF file's contents.

4. To add another file to the LOF file: open  the next file in the EscapeE window
then select Remember file from the 'File' menu. The new file's path is
appended to the LOF file shown in the Text editor window.
Repeat until all the files have been added to the LOF.
Double-clicking the name of the file in the list will load it with the specified
options (for example, /PDF  option would export the file directly, in PDF
format).

5. Select Save from the Text editor window's 'File' menu. Name the file, with
extension ".LOF".

Creating an LOF control file manually

1. Highlight New... in the 'File' menu and select  New list of files from its sub-
menu.

2. Enter the File name in the 'Name of new control file' dialog.

3. Select List of files (LOF) from the 'Save as type' drop-down list, then click
Save.
The Text-editor  is displayed, with :\ESCAPEE  entered on the first line of its

window.

4. Type in the names and paths of the files to be included in the control file, one
file per line. If these files have associated files (such as .EE, .INI), add those
too. Or 
Select Add files... from the text-editor's 'File' menu to display the standard
'Open' dialog. You may:

o Click on a file to add it to the control file's list. Or 

o Add a block of files by clicking on the first file in the block then, holding

down the Shift key, clicking on the last file in the block.

o Add additional files to the selection by holding down the Control key and

clicking each file separately.

Click Open.

5. To insert the contents of a file, click Load...: select the file then click Open.

6. Click Save then close the LOF window:
o Click the Text-editor window's title-bar  button or 

o Choose Close from the Text-editor window's title-bar  menu or 

o Press Alt F4 keys.

See also Example .LOF file  
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Editing a data control file

EscapeE Professional  editions only

 Open  the LOF file then:
o Edit the list shown in the Text-editor window directly from the keyboard or 

o Use the file as a template for a new LOF file:

Select Save As... from the Text-editor's 'File' menu to create a new LOF
file. Name the new LOF file then click Save.
Edit its code in the Text-editor window.

Text-editor features

Show  Click to display the document in the EscapeE window, see Viewing a data
control file .

Search  Click to find text  or go to a specific line-number .

x  y  Current location of cursor: character position (x), line number (y).

File options

Add files...  

Save  

Load...  

Save As... see above .

Edit options

Undo Ctrl Z

Cut Ctrl Del

Copy Ctrl Ins

Paste Shift Ins

Select All Ctrl A

Checkpoint Ctrl B

Restore Ctrl R

Paste from file...

CSV note

Expert users will realize that the Text-editor window provides all the functionality
necessary to construct CSV data control files  as well as LOF files:

Replace the first line with fieldnames separated by a character such as a comma,
semicolon or tab.

Enter the data, one record per line. Use the same separator character between
each data-value in a record.

If a string-value contains separator character(s) or space(s), the whole string-
value must be enclosed within a pair of quote characters. Single or double quotes
may be used, as long as the opening quote character is the same as the closing
quote character.

Save the file with .CSV as the extension.

See also LOF details .
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About .EE files for data control files
EscapeE Professional  editions only

The ".EE" (field definitions) file is supplied with field names found in the first record of
the associated data control file. Using EscapeE's composite field  mechanism, field
definitions may be constructed to compute filenames from the fixed data values in
subsequent records in the control file. The named files are assembled into the
composite document. 

If no FILENAME has been supplied in the first record of the control file, EscapeE uses

any .EE file it finds with the same file-stem as the control file. If a field definition file
in that name cannot be found, EscapeE creates a new field definition file automatically
and names it with the control file's file-stem. It is by this means that a control file
consisting of a simple list of files may be used to construct a composite document, the
User remaining unaware of the underlying .EE file.

Links
Field definitions files
About Control files

Creating the .EE file
EscapeE Professional  editions only

1. Select Edit from the 'Fields' menu
or 
press Ctrl D.

2. Check the composite box on the Definitions  page of the Field dialog.

3. Enter FILENAME in the field box.

4. Enter the fieldname – enclosed in curly brackets – of the data to be found in the
control file, and associated options using the usual notation: see Special fields in
composed strings.  

5. On the File  page of the dialog, enter the name for the field definition file and
click Save.

6. Click OK.

Links
About .EE files for data contol files
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IDF documents
EscapeE Professional  editions only

IDF quick start

Create new files from clippings:

1. Sweep out an area of a page to copy and click Copy & Add selection to IDF.
Repeat for each clip.

2. Save the file in IDF format.

The IDF file may then be viewed , printed  or edited . You may also export it in
another format .

'Intelligent Document Format' is the RedTitan document description language
interchange format designed to enable users to edit existing documents in a variety of
formats. EscapeE wizards write the code to create new documents in IDF: see IDF
wizards  section.

How to assemble a new composite document using copies clipped from other
documents. Extracts may be parts of a page, whole pages or whole files: see 
Creating an IDF document .

How to open an IDF file as a document for display and as a control file: see 
Viewing an IDF document .

How to open an IDF file as a control file for editing: see Editing an IDF document
.

Setting up IDF editor options : full-width clip selection, retaining a clip's
position and using relative paths.

IDF editing tips  contains hints about editing text, clip regions, file
specifications and page-breaks in the code; finding your way around elements,
tags and attributes.

Viewing an IDF document
EscapeE Professional  editions only

Once you have created  an IDF document, you may use EscapeE to view  it, edit
it and/or export  it into other formats.
You may run an IDF file just by opening it in EscapeE. EscapeE interprets the file and
displays the first page of the document in its window. Once the file is running, you
may open the Console notebook  and display the code that generated the page(s).

To view an IDF document

Choose Open... from the EscapeE 'File' menu, select the IDF file and click Open.
Or 

if you have opened the document recently, select it from the History list  at the
foot of the 'File' menu.
Note that although IDF files act as control files , there is no ^ character

preceding the file's name in the list. EscapeE will show the composed document
in its window. To see the IDF code too, see below .
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To view the IDF control file

1. Open the IDF file as above .

2. Select View source... from the 'View' menu or 
Press Ctrl S keys.
The IDF code for the document is displayed in the Source code window of the
Console notebook: see Source code .

Creating an IDF document

EscapeE Professional  editions only

Highlight New... on the 'File' menu and select  New IDF file 
or 
press Ctrl I keys.

The Console notebook  is opened with a new "IDF" page on view containing the code
to make a vestigial IDF document. This code may be constructed directly from the
keyboard (see Editing an IDF document ) or by assembling "clips" copied from other
"component" files:

1. Click Open... from the EscapeE 'File' menu to display  a component file and
navigate  to a page for copying.

o To clip whole pages, right-click in the page and choose one of these options

from the 'pop-up' menu:

Add whole page to IDF. Or 

Add as two sections to IDF to create two separate clips from the
whole page. The elements are split at the current cursor position and the
clips are placed on the page one after the other.
Although this looks the same as the 'Add whole page to IDF' option
above, it creates an ideal starting point for editing just part of the code
for the page. Or 

Add whole file to IDF.

o To clip part of the page instead, start by using the mouse to sweep out the

area of the page to be copied. Then right-click on the page to display a pop-up
menu and choose one of these options:

Copy & Add selection to IDF places the elements found in the selected
area as a single block clip.

Add selection as paragraphs to IDF and enter the size of the gap to
be made between one paragraph and the next below it, measured in
inches. Click OK.

2. EscapeE adds the IDF code for the component to the IDF window.
Repeat the step above  for each clip, page and file to be included in the IDF file,
opening new component files when necessary.

3. To start another page in the new document click New page...: EscapeE inserts a
page-break at the cursor position in the code.

4. Click Save from the IDF tool-bar to open the standard 'Save As' dialog and set up
the File name as usual.

5. When you're done, click Close from the IDF tool-bar.
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You may edit IDF documents – adding, removing, rotating, changing text, glyphs etc.
– see Editing an IDF document .

If a component document contains fields, you may use the areas defined for the fields
as clip regions in an IDF document: see Using fields as clip regions .

See also Composite document wizard .

Links
About Composite documents and IDF  
Editing an IDF document  

Editing an IDF document

EscapeE Professional  editions only

Existing IDF documents can be used like templates and re-purposed, without
changing the original documents. The control file which built the IDF document can
be edited  in the IDF coding  page of Console notebook. An area defined as a field

 may be treated as a clip region and copied to an IDF document.

To edit an IDF document

1. Open the document in the EscapeE window and its control file in the Source
page of the Console notebook, see Viewing an IDF document .

2. Click Save as... from the Source code window's tool-bar . Enter a new name
for the file and click Save.

3. You now have a copy of the original IDF document's code open in an IDF page
of the Console. You may:

o add more clips using the Copy & Add to IDF  feature and field clips using

Copy clip to control file . And/or 

o edit the code from the keyboard.

Programmers: see IDF syntax .
Non-programmers: see IDF editing tips .

4. Click Save from the IDF tool-bar.

5. When you've finished editing, click Close on the IDF tool-bar.
The IDF document remains on-view in the EscapeE window.

There are hints to help novice Users get started in IDF editing tips ; dip into the
IDF  when you need to add a new feature (see Elements  and Attributes , Notes

 and Samples ).

Using fields as clip regions

1. Open the document in the EscapeE window and its control file in the Source
page of the Console notebook, see Viewing an IDF document .

2. Open  the component file then display the definition of the field for copying in
the Field dialog .

3. Click Copy clip to control file button then OK to close the 'Field' dialog.
The field's area is added as a clip to the IDF document (the component file is
unaffected).
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Hot-keys

Hold dow
n: 

then click:

Ctrl A Select All.

Ctrl B Sets a checkpoint in the file which may be restored .

Ctrl 
Ctrl 

C or 
Ins 

Copy to clipboard; see also cut , paste .

Ctrl F Select IDF statements for the current file (if defined as a
block).

Ctrl G Call the Go to page  dialog.

Ctrl 
Ctrl 

J or 
Enter 

Select block of IDF statements for the current page; see
also next page .

Ctrl 
Ctrl 

N or 
PageDown 

Move to Next page/select its statement; see also current
page .

Ctrl R Undo editing to Restore file to its checkpoint  state.

Ctrl 
Shift 

V or 
Ins 

Paste from clipboard; see also copy , cut .

Ctrl 
Ctrl 

Shift 

X or 
Del or 
Del 

Cut to clipboard; see also copy , paste .

Ctrl Y delete line.

Ctrl 
Alt 

Z or 
Back 

undo last update.

Navigation keys

left arrow go one character left.

right arrow go one character right.

up arrow go up one line.

down arrow go down one line.

Ctrl left arrow go to previous word

Ctrl right arrow go to next word

Home go to start of line

End go to end of line

PageUp go to previous page

PageDown go to next page

Ctrl 
Ctrl 

PageUp or 
Home 

go to start of document

Ctrl 
Ctrl 

PageDown or 
End 

go to end of document

 Tip:  To open a file specified in the code shown in the IDF editor, just double-click on
its text string (any options found in an associated INI  file are applied). If the file is
on display already, the appropriate clip-region (found in associated EE  file) is shown
outlined in red.

Links
IDF editor options  
Creating an IDF document  
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IDF editor options

EscapeE Professional  editions only

Click Options... on the IDF coding  page of the Console notebook to see more
options for creating /editing  an IDF document.

Select all (or Ctrl A) 
Selects all the code on that IDF page of the Console notebook.

Copy (or Ctrl C or Ctrl Ins) 
Copies selected code to clipboard.

Relative paths 
When checked, any file path which is the same as that of the IDF file itself is
omitted.
For example, an IDF file c:\Invoices\2016\JanSummary.idf containing a clip

from the file c:\Invoices\2016\January1.pdf would code it with the relative

path
FILENAME="January1.pdf" 

instead of the full path
FILENAME="c:\Invoices\2016\January1.pdf" 

Keep coordinates 
To place clips at the same position in the new document as they were in the
component document, select this option then choose a clip option, see Creating

an IDF document . (A tick  beside 'Keep coordinates' indicates that this
"keep" mode is already engaged.)
When this option is deselected, the first clip is placed at the top of the container
(Y="0") and subsequent clips are located just below the previous clip (Y="Y

+0.05").

See also Positioning and sizing .

Full width select 
This expands any clipped areas to the full width of the page when adding them to
the document (useful if re-paginating a document by moving items between
pages).

Tip:  If you have selected a narrow clip area but EscapeE has clipped the whole line
instead, deselect Full width select from the text editor's Options  menu.

Links
Creating an IDF document  
Editing an IDF document  
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IDF editing tips

EscapeE Professional  editions only

The code shown in the IDF coding  window can be edited from your keyboard; if
you're not a programmer, here are some tips...

To search for text

To look for a particular string of characters in the code, click Search on the Menu-
bar. This displays the 'Find' dialog – see To find text .

To update text

Sweep-out the text  to be changed and type in the new.

Old text <TEXT>5 Regius Court,
Penn,
High Wycombe</TEXT> 

New text <TEXT>Aston Court
Kingsmead Business Park
Frederick Place
High Wycombe</TEXT>

To change a file

Sweep-out the text-string specifying the filename and/or path and type in the new
filename and/or path.

Old file <FILE FILENAME="c:\Reports\2015\Winter.pcl" />

New file <FILE FILENAME="c:\Reports\2016\Spring.pcl" />

Elements

An IDF document is built from a series of individual "parts" placed on its page(s).
These parts (known as "elements") need to be tagged according to their purpose –
to add a piece of text or a logo from a file etc.. Elements are easily recognized by
their start and end tags .
See IDF elements  for descriptions of what each element can do.

Tags

"Tags" signal the opening and closing of an element .

For example , the tag <TEXT>  opens a TEXT element and the tag </TEXT>

 closes it. The text that is actually put on the page is entered between the tags.

Some elements are composed of a single self-contained tag. See, for example, the
FILE  element above : the tag starts with < and ends with />.

Attributes

"Attributes" can be added to the 'start' tags of elements  to override the default
set up for that element.

For example, you could specify that the color of the text is to be red by adding 
COLOR="RED" to the start tag of a <TEXT> element.

Default color <TEXT>5 Regius Court,
Penn,
High Wycombe</TEXT> 

Specific color <TEXT COLOR="RED">5 Regius Court,
Penn,
High Wycombe</TEXT> 

See IDF attributes  for a list of available attributes and click on an attribute name
for details on the values (e.g. what pen color ) which each attribute may take.
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Clips

Clicking Copy & Add to IDF adds a clip region as attributes  to an element
(see Creating an IDF document ).
In the example below, a clip region 9.01 inches wide and 2.34 inches high is copied
from page 12 of the 'Tables.pdf' file. The position of the top-left corner of the clip
region in the original file is 3.45 inches from the left and 6.78 inches down from the
top-left corner of the page. It is placed 0.5 inch below the current coordinates X, Y
in the IDF container  element.
To change the location of the clip region to a fixed position instead, enter absolute
values for the 'X' and 'Y' attributes:

Relative
position

<FILE FILENAME="c:\Reports\2015\Tables.pdf" PAGE="12" UNITS="Inches" CLIPX="3.45"
CLIPY="6.78" CLIPWIDTH="9.01" CLIPHEIGHT="2.34" X="X" Y="Y+0.5"/>

Absolute
position

<FILE FILENAME="c:\Reports\2015\Tables.pdf" PAGE="12" UNITS="Inches" CLIPX="3.45"
CLIPY="6.78" CLIPWIDTH="9.01" CLIPHEIGHT="2.34" X="5.67" Y="8.9"/>

Page breaks

PAGE elements  are used to assemble the clip(s)  into separate pages of the IDF
document. The <PAGE> tag opens a new page, and the </PAGE> tag closes it.

1. To split an existing page into two pages, move the cursor to the end of the last
element required to be in the current page.

2. Press Enter then key-in </PAGE> to close the current page.

3. Press Enter again then key-in <PAGE> tag to open a new page.

In this example, a page-break is inserted between the second and third clips.

 One PAGE
element

containing
three CLIPs

<PAGE>
<FILE FILENAME="Report.pdf" PAGE= "2" CLIP="0.93,1.74,7.455,6.63" X="0"
Y="Y+0.05"/>
<FILE FILENAME="Report.pdf" PAGE= "5" CLIP="0.81,1.14,7.545,3.735" X="0"
Y="Y+0.05"/>
<FILE FILENAME="Report.pdf" PAGE= "5" CLIP="0.855,5.94,7.425,9.51" X="0"
Y="Y+0.05"/>
</PAGE>

New PAGE
element

created to
contain third

CLIP

<PAGE>
<FILE FILENAME="Report.pdf" PAGE= "2" CLIP="0.93,1.74,7.455,6.63" X="0"
Y="Y+0.05"/>
<FILE FILENAME="Report.pdf" PAGE= "5" CLIP="0.81,1.14,7.545,3.735" X="0"
Y="Y+0.05"/>
</PAGE> 
<PAGE> 
<FILE FILENAME="Report.pdf" PAGE= "5" CLIP="0.855,5.94,7.425,9.51" X="0"
Y="Y+0.05"/>
</PAGE>

To join two adjacent pages, just delete the <PAGE> and </PAGE> lines which formed

the page-break.

Give it a try

1. Click New IDF file on the 'File' menu to open a new IDF page into the Console
notebook.

2. Copy and paste the code from one of the Sample IDF scripts  over the
existing default text (it's OK to lose the formatting, only the plain text need be
extracted).

3. Click Show in EscapeE to check what it does then try editing its code.
EscapeE can spot some types of coding errors and warn you of the problem when
the IDF document is opened, e.g.
missing > after end tag  at line 4
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IDF syntax

IDF is a means of describing the structure of a composite document to the EscapeE
print file conversion resources system. A complete document can be assembled from a
number of fragments in any of the supported EscapeE formats. EscapeE wizards
write the code for their documents in IDF.

XML 1.0 notation  is used to describe document content. IDF uses a simple tree
structure where each branch is a tag or an array of tags. Leading and trailing
"whitespace" in body text is removed. The intrinsic space character entity &nbsp; may

be used to preserve "whitespace" in these positions.

See Notes on IDF syntax  for details on positioning, sizing and drawing; about
text and data fields in IDF.

The pieces of material which go to make up the page(s) of an IDF document are
known as "elements". There are a variety of elements, each suited to a different
function, e.g. writing text, extracting clippings from files. See IDF elements  for
their descriptions.

IDF attributes  describes the parameters set up in the elements, such as
position or color. There is no significance in the ordering of attributes. Where
appropriate, the attributes of container elements are used as defaults for nested
elements; nesting may be up to 8 levels deep.

Example scripts demonstrating the use of IDF are given in the Sample IDF scripts
 section.
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Notes on IDF syntax

 This section contains explanatory topics on:

Positioning and sizing  About units, cursor position, horizontal and vertical
distances, width, height, alignment, stacking and containers. Use of arithmetic
expressions and special symbols. Defining fields and bounds.

Notes on drawing  Repositioning the "pen". Drawing straight (Polyline) and
curved (Bezier) lines. Placing ellipse and filled or open rectangular shapes.

Notes on text  About formatting pages; applying default fonts and pagination to
"plain text".

Using data fields  How to prompt users for data, include data values in
attributes, use processing instructions to place data and apply conditions to
groups.
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Positioning and sizing

The position  of an item is given relative to the origin (the top-left corner) of the
'container' (e.g. GROUP) it is in. The size  of an item defaults to the dimensions of
the container.

The default unit in IDF is 1/600th of an inch: to change it, see UNITS  attribute.

Positioning

To specify a horizontal distance of an element from the left side of its container, use
the LEFT  (or X ) attribute.

To specify a vertical distance of an element down from the top of its container, use the
TOP  (or Y ) attribute.

To specify that the current cursor position (i.e. as left by the previous piece of text or
bottom-right corner of the previous group) is used, set X="X" or Y="Y". This is useful

for stacking elements such that they are placed one after the other on the page (e.g.
in a row, column or table).

To force an element to the edge of its container, use the ALIGN  attribute. Text may
be justified or be baseline aligned too.

Sizing

Use WIDTH  and HEIGHT  attributes to specify the size of an item: the values can
be full arithmetic expressions including brackets. You may also use the following
special symbols:

_PRINTABLE gives the printable area of the page. e.g. _PRINTABLE.LEFT is the

leftmost printable point.

_PAGE gives the full page dimensions e.g. _PAGE.WIDTH is the width of the paper.

Alternatively, an element's size may be supplied by a FIELD element . A FIELD
element may originate from an existing EscapeE field definitions (".EE") file or from
an IDF statement: see DEFINE  attribute. A field sourced from an EscapeE .EE file
may be resized using the BOUNDS  attribute.

Examples
<PAGE BOUNDS="_PRINTABLE">

sets the page-boundaries to the printable area of the page.
<FILE FILENAME="Logo1.tif" LEFT = "WIDTH/2"/>

would be used to position the file Logo1.tif on the right of a two-up page.

 Tip:  usually, a leading underscore is used to distinguish special fields from user-
defined fields. If there is no user-defined field with the same name then the
underscore may omitted.
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Notes on drawing

IDF may be used to draw lines  and shapes  on the page. Furthermore, EscapeE
may use the rectangular area occupied by a drawn path as a field tag (see 'To set up
tags' topic).

Lines may be made up of one or more straight  segments, curved  segments or a
sequence of straight and curved segments. To position the pen at the start of a new
line, use the Move element  <M>.

To draw a straight line to another point, simply define that position as a Polyline
element  <P>.

To draw a curved line to another point, however, three pairs of coordinates must be
defined so that a "Bezier" curve may be calculated. The first two points are not
positioned on the curve itself: they are "control" points which bend the line so that it
passes through the third pair of coordinates: see Bezier element  <B>.

The SHAPE  attribute may be used to construct regular shapes (BOX, ELLIPSE and
filled RECTANGLE) from the dimensions of the element (GROUP , PAGE  etc.) that
contains it.

Notes on text

When a file contains "text", i.e. strings of characters, the way in which the text is
formatted, details of font, style, page breaks etc. are generally specified in that file.
Thus pages from files in most formats may be added to an IDF document using the
FILENAME  attribute in a FILE element .

Files in 'plain text' format (extension typically .TXT) do not include this formatting

information. Furthermore, plain text files are not paginated: each line of text is
allocated a line number instead. EscapeE can treat plain text files as PCL, thereby
applying default formatting and pagination for you: just set FILETYPE="PCL".
To add text as a plain text file however, you must set  FILETYPE="TEXT" , include
formatting information (e.g. FONT, ALIGN), and if the text is likely to run onto another
page, set PAGE="NEXT" .

Alternatively, text from a plain text file can be placed in a document using the TEXT
element . Specify a FILENAME; formatting details will be taken from the TEXT tag –
or if undefined there, from the tag of its parent container element.

When adding a short piece of text (just a few lines, no page breaks) to a document, it
may be more convenient to insert the text directly into the IDF code using the TEXT
element  rather than via a file.

A single line of text (no page or line breaks) can be added to a document using the 
STRING  attribute of a TEXT element .
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Using data fields

To use data values in IDF attribute values, enclose the data fieldname in braces
(curly brackets), for example
FILENAME = "C:\MyFiles\{field1}.pcl"

To prompt a user to provide data for a field, place double quotes within the braces,
e.g.:
<FIELD DEFINE="YES" NAME="MyInFile" STRING='{"Input file name"}'/>

See Double page sample script .

To place data within the body text of an IDF document, use the processing
instruction 
<?EE fieldname?> 

See Element GROUP sample script  and REPEAT  attribute.

To make the processing of items dependent on the value of a data field, place the
items in a GROUP  and set up a CONDITION .

To enable the value of an attribute in an INCLUDE  GROUP  contained within
another GROUP to be changed, DEFINE  a temporary field.
See Element DEFINE sample script .
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IDF elements

These element tags are defined:

IDF  – mandatory root element,

in which the following element tags may occur:

DDF  – to insert Dynamic Document Formatter code into the IDF script

DEFINE  – to create a temporary field for propagating attributes

EXECUTE  – a program to be called to supply data

FIELD  – a type of group which invokes an EscapeE field and is positioned
relative to it

FILE  – displays the contents of a page of a file

GROUP  – encapsulate (and re-use) a group of items

INCLUDE  – incorporates a named GROUP or IDF or EE field-definitions file

INFO  – for placing comments in an IDF script

PAGE  – a type of group which defines a physical side of a page of output

RS2  – for placing RS/2 code in an IDF script.

SIGNATURE  – a digital signature

TEXT  – a text string caption; formatting can be applied using <?FORMAT?>
instruction

plus the drawing element tags:

B  – points for defining a Bezier curve

M  – Moves the drawing cursor

P  – points defining a Polyline.

Technical note

You may include 'non-IDF' XML statements in an IDF file by using a tag with a colon
to denote the change of name-space. E.g.:
<RS2:TEXT>

The content of these elements will be ignored by RTIDFIN.DLL.

Links:
IDF attributes  
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Element Bezier

The element "B" is used to define any point of a Bezier curve. 

To draw a Bezier curve, first define a starting point. The next two points are 'control
points'; these points are not positioned on the line but are used to guide the curve to
the next defined point, which is positioned on the line. Continue to define groups of
three points (i.e. 2 off-line control points + 1 on-line position point) until the line is
drawn.

If the starting-point is omitted then the group origin is used.
If the start and end-points are both omitted then the group origin is used for both.

Drawing elements sample script

Attributes 

X  Y  

Links: 
Element Polyline  
Element Move  
Notes on drawing  

Element DDF

The DDF element inserts a RedTitan Dynamic Document Formatter script in the IDF code.
Attributes

ALIGN  

COLOUR  
or COLOR

FIELD  

FILENAME

FILL  

FONT  

FONTSIZE  (scaled
by current SCALEY )

LEFT  

PAD  
or PADDING

PADBOTTOM

PADLEFT  

PADRIGHT  

PADTOP  

POINTSIZE  

ROTATE  

STRING  

STYLE  

SYMBOLSET

TOP  

WEIGHT  

Links:
Element RS2  
Element TEXT  

Element DEFINE

The DEFINE element creates a "temporary" field, i.e. a field which is not saved in an
".EE" field definitions file. Elements usually inherit their default settings from the
attributes of their containing element. When a GROUP is INCLUDEd  within another
GROUP , however, only ROTATE , X  and Y  attribute values are inherited. Other
attribute values may, in effect, be propagated to an included group by defining a
temporary field to provide a value for the included group.

Element DEFINE sample script

Attributes:

DEFINE  FIELDFLAGS  NAME  STRING  

Links:
Element GROUP  
Element INCLUDE  
DEFINE  
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Element EXECUTE

EXECUTE builds a command line which runs a program.

The program – an EscapeE 'Plugin' or other external 'DLL' or 'EXE' program – is
specified in the PLUGIN  attribute, for example
<EXECUTE PLUGIN = "FRED.EXE" />

Further options may be added to the command line using the PARAM  attribute. For
example
<EXECUTE PLUGIN = "IDFPLUGIN" PARAM="OPTION1 OPTION2">
Here are the results:
</EXECUTE>

The EXECUTE command creates a temporary file (with a name such as 
EETMP12345678) in which it can store the contents, including any sub-tags. (In the

example above, the body text Here are the results.) This command-line is then

executed, calling IDFPLUGIN program:
IDFPLUGIN EETMP12345678.XML OPTION1 OPTION2

The files must reside in the EscapeE plugins folder. 

If ENCODING  is set to BASE64 (for binary data) and there are no sub-tags then the
body text is decoded as base 64; otherwise it is written as it appears.

Attributes 

PARAM  PLUGIN  

Element FIELD

A type of group which specifies a position and display area. The area may be used by
other elements e.g. PAGE , or as a "clip region" – see CLIP  attribute. Fields can be
defined in terms of other fields (including any special ones such as the time) or a
value obtained by prompting the user; see Double page sample script . 

If the named field has not been defined already in an associated .EE fields file, the
area's coordinates are constructed from the IDF position attributes. If the named field 
is defined in the .EE fields file, the display's coordinates may be taken from the 
EscapeE field instead: see DEFINE  attribute.

Element FIELD sample script

Attributes:

DEFINE  FIELDFLAGS  NAME  STRING  
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Element FILE

FILE is a type of group that normally displays a PAGE  of a file specified by the
FILENAME  attribute. Sections of a page may also be incorporated by adding
attributes to define a "clip region": see CLIP  attribute. The file format may be PCL,
PDF, PostScript, Epson ESCP, DCX, PCX, BMP, DICOM, IMG, JPEG, PNG, TIFF, TXT etc.
as well as IDF. The default format for files with non-standard extensions is PCL. See 
FILETYPE

Files in any of these formats except TXT  provide text-formatting details within the
file. In a PCL file, however, PAPER , TRAY , BIN  or PLEX  attributes can be
specified in the FILE tag to override these settings.

TXT format lacks pagination and text-formatting details (see Notes on text ), so
formatting attributes (FONT , FONTSIZE  etc.) should be supplied by the IDF code.
In the FILE tag, set FILETYPE  attribute to "TEXT"; do not specify a PAGE  number,
but use PAGE="NEXT"  (see also REPEAT ).

To encapsulate binary data (for example from an image file) "in-line" rather than as
an external file, use ENCODING = "BASE64" .

If an IDF script contains an empty FILE element:
<FILE />

then on opening, EscapeE displays the 'Input file name' dialog so that you may
choose which FILENAME to use. Alternatively, you may supply the missing FILENAME
on the command line, e.g.:
ESCAPEE c:\Catalogs\Spring.idf,Special4

This is a convenient method of customizing a document without editing its IDF code
directly.

 Tip

EscapeE can treat plain text files as PCL, thereby applying default formatting and
pagination for you: just set FILETYPE="PCL" instead of FILETYPE="TEXT".

Examples
<FILE FILENAME = "FRED2.PCL" PAGE="4"/>
<FILE FILENAME = "PHONE1.CSV" SEPARATOR=":"/>
<FILE FILENAME="Revisions.txt" FILETYPE="TEXT" FONT="Times New Roman"
POINTSIZE="7" PAGE="NEXT"/>

Element FILE sample script

Attributes

ALIGN  

BIN  

BOUNDS  

CLIP  

CLIPHEIGHT  

CLIPSTEPX  

CLIPSTEPY  

CLIPWIDTH  

CLIPX  

CLIPY  

COLOUR  
or COLOR  

ENCODING  

FILENAME  

FILETYPE  

FILL  

FONT  

FONTSIZE  

HEIGHT  

IMAGERES  

LEFT  

MONOCHROME

ORIENT  

PAGE  

PAPER  

PLEX  

POINTSIZE  

ROTATE  

SCALE  

SCALEX  

SCALEY  

SEPARATOR  

SIDE  

STYLE  

TOP  

TRANSPARENT  

TRIM  

UNITS  

WEIGHT  

WIDTH  

Links:
Element TEXT  
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Element GROUP

Encapsulates a number of items so that they may be treated as a single unit.
Conditions may be applied to the group: only if conditions are 'true' will the group be
processed (see CONDITION  attribute). 

Groups may contain, or be contained by, INCLUDE  elements and PAGE  elements.

Any attributes of the group become the defaults for items within the group. Note that
an included element only passes the group's ROTATE , X  and Y  attributes to the
objects within it.

Groups can be nested up to 8 levels deep.

Element GROUP sample script  
The INDEX parameter is used when setting up an IDF file to display a Table of
Contents. It specifies a title for each PAGE  to be shown in the Table of Contents.
When a title shown in the Table of Contents is clicked,  EscapeE displays the
corresponding PAGE. Groups using INDEX parameters can be nested so that titles
may be shown within folders; double-click to open/close a folder – see INDEX attribute

.

A named GROUP specifying CACHE="YES" will create an overlay which can be invoked
by an INCLUDE element specifying the GROUPNAME for the group. This group's tag
may also specify a transparency value: see ALPHA attribute .

Attributes

ALPHA  

BGCOLOUR  
or BGCOLOR

BIN  

BLANKLINES  

BOUNDS  

CACHE  

CLIP  

CLIPHEIGHT

CLIPSTEPX

CLIPSTEPY  

CLIPWIDTH

CLIPX  

CLIPY  

COLOUR  
or COLOR

CONDITION

FILL  

FONT  

FONTSIZE

HEIGHT  

INDEX  

LEFT  

LINEEND  

LINEJOIN  

LINESTYLE  

MONOCHROME

NAME  

ORIENT  

PAPER  

PLEX  

POINTSIZE

PREFIX  

REPEAT  

ROTATE  

SCALE  

SCALEX  

SCALEY  

SHAPE  

SIDE  

STEPX  

STEPY  

STYLE  

THICKNESS

TOP  

TRANSPARENT

TRAY  

UNITS  

WEIGHT  

WIDTH  
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Element IDF

This is the top-level tag encapsulating the whole file. All of the other elements – B,
 DDF,  EXECUTE,  FIELD,  FILE,  GROUP,  INCLUDE,  INFO,  M,  P,
 PAGE,  RS2,  SIGNATURE,  TEXT  – are used within it. You may even use the
INCLUDE element to nest another IDF file inside it!

The <IDF> tag does not have attributes per se, but provides a convenient site for
setting up default attributes for the whole document. For example, the attributes
common to any GROUPs defined in the script such as PAPER  and FONT . It may
also contain the FILENAME  of a 'global' file.

 Command-line tips

Instead of specifying a global file myfile1.pcl in the IDF tag of c:\myscripts

\myscriptfile1.idf file:

<IDF FILENAME="myfile1.pcl">

you may specify it on the command-line:
ESCAPEE c:\myscripts\myfile1.pcl /USING c:\myscripts\myscriptfile1.idf

For backwards compatibility, a comma by inserted between the IDF file's name and
the global file's name:
ESCAPEE c:\myscripts\myscriptfile1.idf,myfile1.pcl

has the same effect.

Element IDF sample script
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Element INCLUDE

The INCLUDE element is used to incorporate named groups and IDF, CSV or EE files.
For example,
<INCLUDE GROUPNAME = "para2"/>

incorporates an existing group with the name of 'para2'.

Files can be INCLUDEd within a PAGE  container if the file itself supplies no more
than one page. You may, however, incorporate one page selected from a multi-page file
within a PAGE container by employing the REPEAT  attribute. To incorporate several
pages from a multi-page file directly, the INCLUDE statement must be located outside
any PAGE container.

INCLUDE may be used to invoke an overlay by specifying a named GROUP and setting
the CACHE  attribute to "YES". (Overlays are used for efficiency when an object is
used more than once in the document.) For example:
<INCLUDE GROUPNAME = "overlay1" CACHE = "YES"/>

The ALPHA  attribute may be specified for an overlay, either in the INCLUDE tag or
its GROUP tag. This makes all the pixels translucent to the specified percentage, from
0 (completely transparent) to 100 (opaque).

You may use an "empty" INCLUDE element to create a customized document and yet
leave the IDF file unchanged:
<INCLUDE />

When the IDF file is opened, EscapeE displays the 'Input file name' dialog: select the
FILENAME to be INCLUDEd. If you open the IDF file from the command-line, you may
add the missing FILENAME instead e.g.:
ESCAPEE c:\Catalogs\Summer.idf,Special7

When an INCLUDE element is placed within a GROUP , included objects do not
inherit any properties from that group other than supplying the X,Y position  and
rotation  to be applied to the object.
When an INCLUDE statement does not specify a GROUPNAME  or FILENAME (i.e.
<INCLUDE/>), IDF uses the group or file specified in its parent container.

The file type is determined by the extension of a named file:
.IDF is another Intelligent Document Format file

.EE  is a set of EscapeE field definitions

.CSV is a comma-separated data file with field names in record 1. The data values are

assigned to the specified fields.
Element INCLUDE sample script  

Attributes

ALPHA  

BIN  

BOUNDS  

CACHE  

CLIP  

CLIPHEIGHT  

CLIPSTEPX  

CLIPSTEPY  

CLIPWIDTH  

CLIPX  

CLIPY  

COLOUR  
or COLOR  

FILL  

FONT  

FONTSIZE  

GROUPNAME  

HEIGHT  

LEFT  

NAME  

PAPER  

PLEX  

POINTSIZE  

PREFIX  

ROTATE  

SCALE  

SCALEX  

SCALEY  

SHAPE  

SIDE  

STEPX  

STEPY  

STYLE  

THICKNESS  

TOP  

TRANSPARENT  

TRAY  

UNITS  

WEIGHT  

WIDTH  
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Element INFO

The INFO element is used for including information in the script which EscapeE must
not process.

This information may be a simple comment for the benefit of programmers such as
<INFO>***part one starts here***</INFO>

or information for an external program to process, e.g.
<INFO>
FIELD1
FIELD3
FIELD6
</INFO>

The 'information' must not contain any tags.

INFO element sample script

Element Move

The "Move" element, M, is used to move the "pen" to a new drawing position before
starting to draw a line.

Drawing elements sample script

Attributes 

X  Y  

Links: 
Element Bezier  
Element Polyline  
Notes on drawing  
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Element PAGE

A container which defines a physical side of a page of output.

PAGE and IDF  elements cannot be placed directly into a PAGE element, but they
may be incorporated using an INCLUDE  element.
All of the remaining elements – B,  DDF,  EXECUTE,  FIELD,  FILE,  GROUP,
 INCLUDE,  INFO,  M,  P,  RS2,  SIGNATURE,  TEXT  – are allowed in the
PAGE container.

Any attributes of the PAGE become the defaults for items defined within it. 

Element IDF sample script  

Element GROUP sample script  

Element INCLUDE sample script  

Attributes 

BGCOLOUR  
or BGCOLOR

BIN   

BLANKLINES  

BOUNDS  

CLIP  

CLIPHEIGHT  

CLIPSTEPX  

CLIPSTEPY  

CLIPWIDTH  

CLIPX  

CLIPY  

COLOUR  
or COLOR  

FILL  

FONT  

FONTSIZE  

HEIGHT  

LEFT  

LINEEND  

LINEJOIN  

LINESTYLE  

MONOCHROME

NAME  

ORIENT  

PAPER  

PLEX  

POINTSIZE  

PREFIX  

REPEAT  

ROTATE  

SCALE  

SCALEX  

SCALEY  

SHAPE  

SIDE  

STEPX  

STEPY  

STYLE  

THICKNESS  

TOP  

TRANSPARENT  

TRAY  

TRIM  

UNITS  

WEIGHT  

WIDTH  

Links: 
PAGE  

Element Polyline

The "Polyline" element, P, is used to define a point to which a straight-line segment is
drawn. The starting point for the first segment of a Polyline may be given by a Move
element or the origin of the containing group. Subsequent segments use the previous
Polyline element as their starting point.

Drawing elements sample script

Attributes 

X  Y  

Links: 
Element Bezier  
Element Move  
LINESTYLE  
Notes on drawing  
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Element RS2

An RS2 element inserts RS/2 code in an IDF script. It may be used, for example, to
compute a field value or to draw items on the page. 

Attributes

ALIGN  

COLOUR  
or COLOR

FIELD  

FILENAME

FILL  

FONT  

FONTSIZE  (scaled
by current SCALEY )

LEFT  

PAD  
or PADDING

PADBOTTOM

PADLEFT  

PADRIGHT  

PADTOP  

POINTSIZE  

ROTATE  

STRING  

STYLE  

SYMBOLSET

TOP  

WEIGHT  

Links:

Element DDF  
Element TEXT  

Element SIGNATURE

SIGNATURE adds a digital signature: this is a security feature that EscapeE can add
to make PDF documents tamper-proof, and enables signatures to be validated. (See
Security options for PDF export topic.)

Digital signatures need the certificate name and a serial number;  they may also
include a description. E.g.
<SIGNATURE CERTIFICATE="DGF LLC" SERIAL="7C 56 05 3F 88 42 13 88 45 95 4A
2B 03 C7 56 47 " DESCRIPTION="Test file">
[digital signature encoded in base 64]
</SIGNATURE>

IDF helps with setting these up: check the "Sign" box when creating the IDF file.

Attributes

CERTIFICATE DESCRIPTION LOCATION SERIAL
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Element TEXT

The TEXT element is used to place text on a PAGE . A short line of text can be placed
directly in the text tag using the STRING attribute:
<TEXT STRING="text"/>
To place several lines of text, enclose the block of text in a pair of tags:
<TEXT> text
block...</TEXT> 

To place the textual content of a plain text file, use:
<TEXT FILENAME="filename"/>

The attributes listed below are used to set up the formatting. If, however, you just
need to emphasize an odd word or two in a block of otherwise plain text, the
<?FORMAT?> instruction  is often the simplest method.

 See also Notes on TEXT .

Element TEXT sample script  

Element FILE sample script  

Attributes

ALIGN  

BLANKLINES  

COLOUR  
or COLOR

FIELD  

FILENAME  

FILL   

FONT  

FONTSIZE  (scaled
by current SCALEY )

LEFT  

PAD  
or PADDING

PADBOTTOM

PADLEFT  

PADRIGHT  

PADTOP  

POINTSIZE  

ROTATE  

STRING  

STYLE  

SYMBOLSET

TOP  

WEIGHT  

Links:

FORMAT instruction  
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<?FORMAT?> instruction

The <?FORMAT?> instruction is a convenient means of applying 'spot' formatting to a
short string of text, which is itself nested within a larger block of plain text in a 
<TEXT> element.  

<?FORMAT options?>

where options are:

 FONT fontname

The fontname is the name of the Typeface family: if this includes spaces then the
name must be enclosed in quotes, e.g. "Courier New".

 WEIGHT weight 

You may use any integer from 7 to -7 for the value weight. There are also some

permitted string values for frequently-used weights:

string # description
-7 ultra thin
-6 extra thin 
-5 thin 
-4 extra light 

LIGHT -3 light
-2 demi light
-1 semi light

REGULAR  0 medium
(default) 

 1 semi bold
 2 demi bold

BOLD  3 bold
 4 extra bold
 5 black
 6 extra black

BLACK  7 ultra black

 STYLE style

where style may take these integer or string values:

# string
0 UPRIGHT

1 ITALIC

OBLIQUE

 POINTSIZE number

The commonly used shorthand alternatives POINT and PT are also acceptable in

place of POINTSIZE – in fact a number by itself is sufficient. (The same cannot be

said of WEIGHT and STYLE, which may also take numeric values.)

Mail-merge sample script  

Links:
Element TEXT  
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IDF attributes

A

ALIGN  

ALPHA  

B

BASEFILE  

BGCOLOR  

BIN  

BLANKLINES  

BORDERCOLOUR  or
BORDERCOLOR  

BORDERS  

BORDERSTYLE  

BORDERWIDTH  

BOUNDS  

C

CACHE  

CERTIFICATE  

CLIP  

CLIPHEIGHT  

CLIPSTEPX  

CLIPSTEPY  

CLIPWIDTH  

CLIPX  

CLIPY  

COLOR  or
COLOUR  

CONDITION  

 D

DEBUG  

DEFINE  

DESCRIPTION  

E

ENCODING  

F

FIELD  

FIELDFLAGS  

FILENAME  

FILETYPE  

FILL  

FONT  

FONTSIZE  

G

GROUPNAME  

H

HEIGHT  

I

IMAGERES  

INDEX  

JKL

LEFT  

LINEEND  

LINEJOIN  

LINESTYLE

LOCATION  

 M

MONOCHROME  

N

NAME  

O

ORIENT  

P

PAD  or
PADDING  

PADBOTTOM  

PADLEFT  

PADRIGHT  

PADTOP  

PAGE  

PAPER  

PARAM  

PLEX  

PLUGIN  

POINTSIZE  

PREFIX  

QR

REPEAT  

ROTATE  

S

SCALE  

SCALEX  

SCALEY  

SEPARATOR  

SERIAL  

SHAPE  

SIDE  

STEPX  

STEPY  

STRING  

STYLE  

SYMBOLSET  

T

THICKNESS  

TOP  

TRANSPARENT  

TRAY  

TRIM  

TYPEFACE  

UV

UNITS  

VSPACE  

W

WEIGHT  

WIDTH  

XYZ

X  

Y  

Links:
IDF elements  
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ALIGN

ALIGN overrides the default LEFT, TOP (and BASELINE for text) positioning of items. 

To specify a horizontal or vertical alignment only, use:

ALIGN="value"

where value can be: 

LEFT 
RIGHT 
TOP 
BOTTOM 

CENTRE or CENTER (horizontally only) 

BASELINE (for textual items only) 

JUSTIFY (for textual items only) 

For example, ALIGN="centre" places the item centrally with its top at the TOP

position, unless the item is text; in this case the text's baseline is aligned with the 
TOP position. 

To specify a horizontal and vertical alignment, separate the two values with a comma:

ALIGN="value,value"

horizontal vertical

LEFT

RIGHT

CENTRE or CENTER

JUSTIFY (for textual items only)

TOP

BOTTOM

CENTRE or CENTER 

In addition, you may specify BASELINE for textual items. This uses the leftmost point

of the text's baseline to position the item instead of the top-left corner of the item.

Note that when ALIGN is used in conjunction with ROTATE,  ALIGN is applied before
ROTATE.

Element TEXT sample script  

ROTATE sample script  

Links:
Element TEXT  

ALPHA

ALPHA is a translucency value that may be assigned in an INCLUDE  element, or a
named GROUP  within the INCLUDE tag, when used in to make an overlay by
specifying CACHE="YES" .

ALPHA="percentage"

where percentage is a real number from 0 (transparent) to 100.00 (opaque). E.g.:
<INCLUDE GROUPNAME = "mutedoverlay" CACHE="YES" ALPHA="33.33"/>

Links:
TRANSPARENT  
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BASEFILE

BASEFILE="filestem.pdf"

BASEFILE is an attribute of the IDF  element which specifies a PDF file on which a

new PDF, modified by the IDF script, is to be based.

INFO element sample script  

Links:
Element IDF  

BGCOLOR

Flood-fills the containing GROUP  or PAGE  element with the specified
"background" color. Elements which print in the same area as the GROUP will be
overprinted if they occur before the GROUP in the IDF; if they occur after the GROUP
then they will overprint the background color.

BGCOLOR="r,g,b" 
where each of the 3 values (red, green, blue) is in the range '0' to '100' percent, or 

BGCOLOR="colname"
where 'colname' takes one of these values:

CYAN MAGENTA YELLOW BLACK

RED GREEN BLUE WHITE

Alternative spellings: 

BGCOLOUR="r,g,b" 
BGCOLOUR="colname"

 Tip:  to fill a SHAPE  or TEXT  with colour use FILL .

COLOR sample script  

Links: 
BORDERCOLOR  
COLOR  
FILL  
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BIN

BIN="n"

Used to specify the output bin number instead of using the bin set up on the printer.

Typical output bin numbers:

0 Automatic

1 Upper

2 Lower (rear)

Links: 
TRAY  

BLANKLINES

BLANKLINES = "YES"
Honours empty lines in the text, and spaces down by the Vertical Motion Index (the
default).

BLANKLINES = "NO"
Blank lines of text are omitted.

Element GROUP sample script  

Mail-merge sample script  

Links: 
Element TEXT  
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BORDERCOLOR

Sets the color of a border around an element: see BORDERS .

BORDERCOLOR="r,g,b" 
where each of the 3 values (red, green, blue) is in the range '0' to '100' percent,

or 
BORDERCOLOR="colname"
where 'colname' takes one of these values:

CYAN MAGENTA YELLOW BLACK

RED GREEN BLUE WHITE

Alternative spellings: 

BORDERCOLOUR="r,g,b" 
BORDERCOLOUR="colname" 

To specify the color of the ink used to draw a colored SHAPE , Bezier , Polyline  or
TEXT , use COLOR .

COLOR sample script  

Links: 
COLOR  

BORDERS

BORDERS = "L,T,R,B"

Places a border around all four sides (Left, Top, Right and Bottom) of an element with
defined boundaries such as a FIELD , GROUP , PAGE , or TEXT . If LEFT , TOP

, HEIGHT  and WIDTH  attributes are not defined in the element itself, they will
be inherited from its parent element.

The ordering of the values L, T, R and B does not matter.

Omitting value(s) omits the corresponding side(s) of the border, for example
BORDERS="B,T"

places lines at the bottom and top of the item; there are no lines at the sides of the
item joining the top and bottom lines.

Borders are drawn as if using an imaginary 'pen'. The thickness of the border-pen is
defined by the BORDERWIDTH  attribute. The outer edge of the border lies on the
boundary but does not extend beyond it; i.e. the border is drawn entirely within the
area occupied by the element.

The shape of the 'pen' is defined by the LINEJOIN  attribute. In the example above,
where there are no joins, LINEEND  parameter may be used to specify the shape of
the pen instead (if LINEEND and LINEJOIN are both defined for a border, LINEJOIN
takes precedence).

The style of the border-lines is defined by the BORDERSTYLE  attribute, and the
color by the BORDERCOLOR  attribute.

COLOR sample script  

Links:
BORDERWIDTH  
BORDERSTYLE  
BORDERCOLOR  
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BORDERSTYLE

BORDERSTYLE="style" 

Sets the type of line used to draw BORDERS  around an element, where style may

take one of these values:

SOLID A continuous line, a BORDERWIDTH  wide.

BROKEN A line of dashes (3xBORDERWIDTH) long spaced a BORDERWIDTH
apart. Dashes are a BORDERWIDTH wide.

Synonym: DASHED.

DOTTED A line of dots.
The dots are round or square, depending on the value of LINEJOIN  or
LINEEND  attribute.
The diameter of round dots is equal to the BORDERWIDTH value. The
square dots are a BORDERWIDTH wide/high.
The distance between one dot and the next is the BORDERWIDTH value.

COLOR sample script  

Links: 
BORDERS  
BORDERCOLOR  
BORDERWIDTH  
LINEEND  
LINEJOIN  
LINESTYLE  

BORDERWIDTH

BORDERWIDTH="width"

Width of line used to draw BORDERS  around an element, e.g. 
BORDERWIDTH="60"

sets their width to 0.1" when default UNITS  (1"/600) are used,

or

BORDERWIDTH="width units"

to set the width and units of a border to be used specifically for that element. For
example: 
BORDERWIDTH="2 mm"

sets that element's border to a width of 2mm, even when other units have been set
up elsewhere.

COLOR sample script  

Links:
BORDERS  
BORDERCOLOR  
BORDERSTYLE  
THICKNESS  
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BOUNDS

BOUNDS="fieldname" 

Sets the boundaries for a group. It is derived from a named EscapeE field

or, when there are no commas separating the values:

BOUNDS="left,top,right,bottom" (deprecated). 

Alternatively, the boundaries may be supplied by the _PAGE and _PRINTABLE symbols,

e.g.
BOUNDS="_PRINTABLE"

 Tip:  a leading underscore is used to distinguish special symbols from user-defined
fields. If there is no user-defined field with the same name then the underscore may
omitted, e.g. BOUNDS="PRINTABLE".

Element FILE sample script  

Element GROUP sample script

Links:
Positioning and sizing  
Element GROUP  
Element PAGE  
Element FILE  
HEIGHT  
WIDTH  

CACHE

CACHE = "YES"

An attribute of INCLUDE , or of a GROUP  or IDF file within an including element.
Enables the object to be read once and stored on printers such as PostScript and PDF
(i.e. it creates an "overlay"). When an object is invoked repeatedly, it is more efficient
to reuse an overlay than to reread the object.

Element GROUP sample script

Links:
ALPHA  
GROUPNAME  

CERTIFICATE

This is the security certificate name for a digital signature, e.g.

CERTIFICATE="DGF LLC"

See SIGNATURE element .
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CLIP

The area defined by a CLIP attribute is copied from a file and inserted into the IDF
document.

CLIP="fieldname" 

or 

CLIP="left,top,right,bottom" (deprecated). 

If there are no commas, then the parameter is assumed to be a fieldname whose
boundaries are used to set up the 'clip region', see Element FIELD  and Element
DEFINE .

The top left corner of the resulting area is positioned at the LEFT  (or X ) and TOP
 (or Y ) position.

 Tip:  the clip may be positioned relative to the original position of the CLIP. E.g.
CLIPX="CLIP.LEFT + 50"
CLIPY="CLIP.TOP + 150"
X="CLIP.RIGHT + 100"
X="CLIP.BOTTOM" + 200

Links:
CLIPHEIGHT , CLIPWIDTH  
CLIPSTEPX , CLIPSTEPY  
CLIPX , CLIPY  
UNITS

CLIPHEIGHT

CLIPHEIGHT="clipheight"

Specifies the height of a 'clip region' in the default units, e.g.
CLIPHEIGHT="1200"

sets position to 2" using default of 1"/600.

Alternatively:

CLIPHEIGHT="clipheight units"

Height of the clip region in specified units, e.g.
CLIPHEIGHT="2 in"

sets position to 2", whatever units have been set up for use elsewhere.

INFO element sample script  

Links:
UNITS  

CLIPSTEPX

CLIPSTEPX="distance"

Steps the horizontal position of a 'clip-region' by the specified amount for each sub-
item.

Links: 
CLIPSTEPY  
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CLIPSTEPY

CLIPSTEPY="distance"

Steps the vertical position of a 'clip-region' by the specified amount for each sub-
item.

Links: 
UNITS

CLIPWIDTH

CLIPWIDTH="clipwidth"

Width of the 'clip region', e.g. 
CLIPWIDTH="1200"

sets width to 2" in default units

or

CLIPWIDTH="clipwidth units"

E.g. 
CLIPWIDTH="2 in"

sets width to 2", whatever units have been set up elsewhere.

INFO element sample script  

Links: 
CLIPHEIGHT  
UNITS

CLIPX

CLIPX="x"

Horizontal offset of a 'clip region', relative to the start of group, e.g.
CLIPX="60"

sets position to 1/10 inch when UNITS  is 1/600 inch (default value).

Alternatively, an expression referring to the clip's position may be used, e.g.
CLIPX="CLIP.LEFT + 450" 

Links: 
CLIPY  
CLIP  

CLIPY

CLIPY="y"

Vertical offset of the 'clip region', relative to the start of group e.g.
CLIPY="600"

Sets position to 1inch (using default UNITS ).

Alternatively, an expression referring to the clip's position may be used, e.g.
CLIPY="CLIP.TOP + 300" 
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COLOR

Sets the color for drawing lines, shapes or text. (To color a border around an element,
use BORDERCOLOR .)

COLOR="r,g,b" 
where each of the 3 values (red, green, blue) is in the range '0' to '100' percent,

or 

COLOR="colname"
where 'colname' takes one of these values:

CYAN MAGENTA YELLOW BLACK

RED GREEN BLUE WHITE

Alternative spellings: 

COLOUR="r,g,b" 
COLOUR="colname" 

To place the line, shape or text on a colored background, use FILL .

COLOR sample script  

Element TEXT sample script  

Links: 
BGCOLOR  
BORDERCOLOR  
FILL  
MONOCHROME  
TRANSPARENT

CONDITION

Specifies the case(s) which must (all) be valid in order to process a GROUP . 

CONDITION="String Operator String"

where Operator is one of:

= equal > greater than >= greater than or equal

<> not equal < less than <= less than or equal

and String can include:

quoted strings

fields 

For example:
CONDITION = "{FIELD1}='First'"

The comparison is case-sensitive.

Links:
Element GROUP  
FIELD
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DEBUG

When dealing with a complex document, it may prove useful to check the progress of
its composition. The attribute:

DEBUG="string"

will place a warning button on the toolbar; click this to display the "string" in the

Console Log if the enclosing tag has been processed. 

TRIM sample script  

DEFINE

An optional attribute which can be used for specifying the source of the position and
size coordinates for a FIELD  or temporary field (see Element DEFINE ).

DEFINE="yes"

Field coordinates are fixed at the position attributes given in the IDF element  tag.
For backward compatibility, the shorthand for
FIELD DEFINE="YES"
is
DEFINE

DEFINE="no"

Field coordinates are taken from an existing field in an EE field-definitions file, and
will change if the field is changed using EscapeE. 

DEFINE="auto"

If the field exists already, coordinates are taken from the EE field-definitions file (like
"No") but if the field does not exist in an EE file, the field is defined using the IDF
position attributes (like "Yes").

 Command-line tips

DEFINE field=value

The value may be numbers, characters or a filename.

You may declare a field in the IDF file e.g.
<INCLUDE FILENAME="Brochure{part}.pdf" />

and supply the value on the command-line e.g.
ESCAPEE c:\CustomerRecords\MailBrochure.idf /DEFINE part=Fruit1

The equivalent IDF statement would be:
FILENAME="BrochureFruit1.pdf"

Element FIELD sample script  

Double page sample script  

Links:
Element DEFINE  
Element FIELD  
FIELD  
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DESCRIPTION

DESCRIPTION="text"

This optional attribute allows a description of the document to be added to the
document when creating a digital signature for security purposes. E.g.
DESCRIPTION="Test file"

See Element SIGNATURE .

ENCODING

ENCODING="BASE64" 

This attribute is used in FILE  or IDF  elements to allow binary data to be placed in
the IDF document. This is a convenient means of including binary, non-text data such
as images, "in-line" rather than as separate files.

When ENCODING is set, any body text found in the element will be converted from
the base64 (in which the binary data is encoded) and processed according to the 
FILETYPE . If it is not set, the characters in the body text will used literally – which
in the case of binary data, would be meaningless.

XML note

IDF scripts commonly start with an XML instruction for which the default encoding is
UTF-8.

INFO element sample script  

FIELD

FIELD="fieldname"

The FIELD attribute uses the value of the named field (whereas the FIELD  element
specifies a field's location), for example:
<TEXT FIELD="Field3" LEFT= "2" TOP="7" WIDTH="1" HEIGHT="1" COLOUR="RED"/>

uses the value of Field3 as its text string.

Note that processing instructions embedded in text may also use field values like this:
<TEXT LEFT= "2" TOP="7" WIDTH="1" HEIGHT="1" COLOUR="RED">
Here is <?EE Field3?> in some text
</TEXT>

Fields may be used when setting up criteria for processing "conditional" groups: see 
Element GROUP .

FIELDFLAGS

FIELDFLAGS="type,method,border"

The FIELDFLAGS attribute defines a clickable field on a PDF form (corresponding to
the PDF options set up in the EscapeE Field dialog). It can take up to three
arguments, separated by commas.

The first parameter defines the type of field. The second, where appropriate, defines
the method. The third parameter, BORDER, is used when a border is required around
any of these types of field.
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type method border Description

CHECKBOX CHECKED

CENTRE (or CENTER)
RIGHT

BORDER A checkbox: checked,
centered vertically or with
the button on the right of the
caption.

COMBO EDIT BORDER A drop-down list/editable
drop-down list.

LINK BORDER Hyperlink.

LIST BORDER A list of options.

RADIO CHECKED

CENTRE (or CENTER)
RIGHT

BORDER A radio button: checked,
centered vertically or with
the button on the right of the
caption.

RESET BORDER Reset button.

SEND FDF
XML

BORDER Submits the form. (No button
is drawn.)

SUBMIT FDF
XML

BORDER Submits the form.
A "Submit" button is drawn.

TEXT BORDER An editable text field.

FILENAME

FILENAME="filename.extension" 

This attribute supplies an external filename and format for an element, e.g. FILE  or
TEXT . If it is placed in the IDF  element it is in effect the 'global default' for the
document: any element calling on this file need only specify which PAGE  is to be
used.

If the path of the named file is the same as the IDF file, it may be omitted ("relative"
path) e.g.:
<FILE FILENAME = "FRED2.PCL" PAGE="4"/>

Otherwise use the full path  ("absolute" path) e.g.:
<FILE FILENAME = "c:\ARTICLES\FRED2.PCL" PAGE="4"/>

If the format is not obvious from the file extension (such as ESCP, JPG, TIF, DCM,

BMP, DCX, PCX, PNG, RTF, IDF, IMG), EscapeE can also identify and process PDF,

PostScript, PCL XL, DICOM, JPEG and Epson (Esc-P) files automatically, even when a
non-specific extension such as PRN is used.

Alternatively, the format may be specified in the FILETYPE  attribute.

Element IDF sample script  

Element INCLUDE sample script  

Double page sample script  

Links: 
Element INCLUDE  
Element TEXT  
NAME  
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FILETYPE

If the format of a specified FILE  is not recognizable either explicitly (by its
extension) or implicitly (by its content), specify its FILETYPE in the FILE tag itself:

FILETYPE="ext"

where ext may take one of three values:
PCL
CSV
TEXT

For example, a file output by printer with extension PRN could be placed in an IDF

document using
<FILE FILENAME = "FRED2.PRN" FILETYPE = "PCL" PAGE="4"/>

Plain text files – which usually have extension ".TXT" – are normally specified as 
FILETYPE="TEXT". Due to the lack of page-breaks in TXT files, however, it is

sometimes useful to specify FILETYPE="PCL" instead: see Notes on text .

The default file-type for unrecognized files is PCL5.

Element FILE sample script  

MONOCHROME sample script  

Links:
FILENAME

FILL

FILL="r,g,b" 

The color for filled areas, where each of the three values (red, green, blue) must be in
the range 0 to 100 percent,

or 

FILL="colname"
where 'colname' takes one of these values:

CYAN MAGENTA YELLOW BLACK

RED GREEN BLUE WHITE

or NONE to turn off filling. 

FILL may be used in TEXT elements  to place the text on a colored background. The
filled area will be a rectangle just sufficient to underlie normal characters. PADDING
may be used to extend the area. ROTATE  may be applied too, though while the
resulting IDF document will print correctly, some systems will be unable to display it
properly on screen.

COLOR sample script  

Element TEXT sample script  

 Tip:  to flood-fill a GROUP  or an entire PAGE , use BGCOLOR .

Links: 
BGCOLOR  
BORDERCOLOR  
COLOR  
TRANSPARENT  
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FONT

FONT="fontname[,weight,style]" 

Specifies the font-family name, optionally followed by a weight and/or style for plain
text  e.g. 
"Times New Roman,bold,italic"

Alternatively, the font's style and weight may be given by the STYLE  and WEIGHT
attributes.

Element FILE sample script  

Element GROUP sample script

Links:
FONTSIZE  
POINTSIZE  
Element TEXT  
Element GROUP  
Element PAGE  
Element FILE  

FONTSIZE

FONTSIZE="n units"

A way of specifying a font size and units for plain text . 

INCHES (or IN) 
MM 
CM 

POINTS (or PT) 

E.g.
FONTSIZE="10 pt"

Unlike POINTSIZE , it is scaled according to the current SCALE  factor. If

FONTSIZE="n"

is used to specify a font size, the UNITS  will be applied e.g. FONTSIZE="12"

Element INCLUDE sample script  

Element TEXT sample script  

GROUPNAME

Once a GROUP  has been defined and named in an IDF document, it may be used in

subsequent INCLUDE  elements using this attribute:

GROUPNAME="name"

E.g.:
GROUPNAME = "3rdQuarter"

Links:
NAME  
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HEIGHT

HEIGHT="height"

Height of an item, e.g. 
HEIGHT="1200"

sets height of item to 2" when 1"/600 units (the default) used.

or

HEIGHT="height units"

Height of an item, e.g. 
HEIGHT="2 in"

sets height of item to 2", whatever units have been set up elsewhere. 

Drawing elements sample script  

Element TEXT sample script  

Links: 
WIDTH  
UNITS  
Positioning and sizing  
BOUNDS  
PAGE  
VSPACE  
X,Y  

IMAGERES

The IMAGERES attribute may be used to specify the resolution of images accessed
using the FILE  element in Dots Per Inch. Used like this:

IMAGERES="dpi"

the resolution defined in IMAGERES is only used when the image file specifies the
resolution as 0 or does not specify the resolution at all. For example,
IMAGERES = "100"

is a useful default for most printers. Alternatively, use

IMAGERES="-dpi"

to override resolutions specified in image files and force the IMAGERES value. E.g.
IMAGERES = "-96"

gives good results for viewing an image on-screen.

Links: 
Element FILE  

332

331

325

323

276

297

312

324

325

282

282



307IDF syntax

INDEX

INDEX="title"

An attribute of the GROUP element  which specifies a title to be used for indexing a
PAGE .
If no PAGE parameter is specified the current input page number is used. Multiple
nesting levels are allowed.

INDEX sample script

Links
Element GROUP  
Element INCLUDE  
Element PAGE  
PAGE  

LEFT

LEFT="distance"

Horizontal position of the element's "origin" relative to the "origin" of an enclosing
container element. The origin for most items is their top-left corner but for unALIGNed

 TEXT  it is the leftmost point of the first character's baseline.

The default UNIT  is 1/600 inch, so:
LEFT="600"

would set the horizontal position to 1" inside the container's left boundary. If a 'unit'
value is appended to the offset value, the current unit value is overridden for that
item, e.g.
LEFT="12CM"

See also TOP  and X .

Drawing elements sample script  

Double page sample script

Links: 
Positioning and sizing  
ALIGN  
TOP  
WIDTH  
X,Y  
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LINEEND

LINEEND="pen"

The (imaginary) 'pen' used to draw any Polylines  and Bezier curves  is, by default,
flat; its size is specified using the THICKNESS  attribute. The line starts and finishes
at the specified X,Y positions. The LINEEND attribute applies terminals to the ends of
a line, as if it had been drawn by a square or round pen. See also BORDERS .

The LINEEND pen can take one of two values:

SQUARE Lines are drawn with a square pen one THICKNESS  wide and
high. The centre of the pen starts and finishes at the defined
locations, so that each end of the line appears lengthened by half
a thickness.

ROUND These lines are drawn with a round pen of one THICKNESS
diameter. The centre of the pen starts and finishes at the defined
locations, so the line appears lengthened by a semi-circle at each
end.

LINEEND, LINEJOIN sample script  

Links:
Element GROUP  
Element PAGE  
LINEJOIN  
LINESTYLE  
BORDERS  

LINEJOIN

LINEJOIN = "pen"

Sets the profile of the (imaginary) pen used to draw any Polylines  and Bezier curves
 within the element. See also BORDERS .

The pen can take one of two values:

SQUARE Junctions are mitered, making sharp inner and outer corners (the
default).

ROUND Junctions naturally form a sharp inner corner and a rounded
outer corner.

See also LINEEND  attribute.

LINEEND, LINEJOIN sample script  

Links:
Element GROUP  
Element PAGE  
LINEEND  
LINESTYLE  
BORDERS  
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LINESTYLE

LINESTYLE = "pen"

This specifies the style of line to be used by any Bezier  curve or Polyline  found
between the element's opening and closing tags.

The pen may take these values:

SOLID A continuous unbroken line (the default).

DOTTED Dots and spaces are both one THICKNESS  wide. Dots are
square or round, depending on the value of LINEEND .

BROKEN Dashes are 3 times the THICKNESS long with spaces of one
THICKNESS.

Synonym: DASHED.

CUSTOM,d,s[,d,s...] Define a repeating sequence of dashes and spaces as a
comma-separated list of up to 20 numbers.
A dash is d times the THICKNESS long and a space is s times

the THICKNESS long.

LINESTYLE sample script  

Links:
Element GROUP  
Element PAGE  
STYLE  
BORDERSTYLE  

LOCATION

The LOCATION attribute is the URL added by EscapeE for a digital signature's security
certificate: see Element SIGNATURE .

Links:
LEFT  
TOP  
X,Y  
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MONOCHROME

A color image from a FILE  element may be displayed as "black and white" in an IDF
document using the MONOCHROME attribute.

MONOCHROME="threshold"

The threshold may take values in the range 0 to 255. Values less than the threshold
are treated as black, values equal to or greater than the threshold are treated as
white.

MONOCHROME sample script  

Links:
Element FILE  
COLOR  
TRANSPARENT  

NAME

NAME="name"

This attribute names the GROUP , FIELD  or PAGE  element being set up by the
tag.

Note:  the GROUPNAME  attribute is used to invoke a NAMEd GROUP from an
INCLUDE element .

Element FIELD sample script  

Double page sample script  

Links:
FILENAME  

ORIENT

ORIENT="o" 

Orientation of the page, where o takes one of the values: 

 P – portrait (the default)

 L – landscape 

 I – inverse (portrait rotated 180°)

 J – journal (landscape rotated 180°)

 ? – orientation is set to match the orientation of the first file loaded

ROTATE sample script  

Double page sample script  

Links: 
PAPER  
ROTATE  
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PAD

PAD="thickness"

Defines the thickness of the padding between the contents of an item and its border.
To specify the thickness of the padding on each side of the item independently, use
the PADLEFT , PADRIGHT , PADTOP , PADBOTTOM  attributes.
Note that padding is applied after ALIGN  and ROTATE .

Alternative spelling:
PADDING="thickness"
For example:
PADDING="0.250"

Links:
PADBOTTOM  
PADTOP  
PADLEFT  
PADRIGHT  
VSPACE  

PADBOTTOM

PADBOTTOM="thickness"

Thickness of the padding at the bottom of an item.
For example:
PADBOTTOM="0.200"

PADLEFT

PADLEFT="thickness"

Thickness of the padding at the left of an item.
For example:
PADLEFT="0.200"

PADRIGHT

PADRIGHT="thickness"

Thickness of the padding at the right of an item.
For example:
PADRIGHT="0.200"

PADTOP

PADTOP="thickness"

Thickness of the padding at the top of an item.
For example:
PADTOP="0.200"
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PAGE

PAGE="n"

'n' is an integer specifying the number of the page (or line-number  in TXT files) to
be used by a FILE , GROUP  or INCLUDE  element.

Alternatively, you may specify:

PAGE="NEXT" 

This syntax is used when extracting data: see REPEAT . It can also be used to place
all the text contained in a plain text file rather than a single line. Plain text files have
their FILETYPE  set to "TEXT" and usually have the extension "TXT".

For example: 
<FILE FILENAME = "FRED1.PCL" PAGE="2"/> 
<INCLUDE PAGE="3"/>

Element GROUP sample script  

INDEX sample script  

Links:
BOUNDS  
INDEX  
PAPER  
Notes on text  
Element PAGE  
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PAPER

This sets up the dimensions of the paper to be used.

PAPER="t"

where paper type 't' takes one of these values:

A0
A1
A2
A3
A4
A5
A6

ARCHA
ARCHB
ARCHC
ARCHD
ARCHE

ARCH30

LETTER

LEDGER

ANSIC

ANSID

ANSIE

EXECUTIVE

LEGAL

or for envelopes:

C5 DL MONARCH

The default value of 't' is "A4".

E.g. 
PAPER="LETTER"

Alternatively, specify the width and height of the paper: 

PAPER="width,height"

e.g. 
PAPER="6.5,8"

Use ORIENT  to define the orientation of the paper. Using orientation as a second
parameter of the paper attribute, e.g. PAPER="LETTER,P" is deprecated.

Element IDF sample script  

Element TEXT sample script  

Links: 
Element PAGE  
ORIENT  
PAGE  
UNITS  
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PARAM

PARAM="parameter[ parameter...]" 

Enables any number of extra PLUGIN  parameter(s) to be passed to a program being
called by an EXECUTE  command line, for example
<EXECUTE PLUGIN = "MYPROG.EXE" PARAM = "FIRST SECOND THIRD">

could run
MYPROG "EETMP12345.PRN" FIRST SECOND THIRD

(EETMP12345.PRN is an example name for the temporary file created by PLUGIN).

Links:
Element EXECUTE  
PLUGIN

PLEX

PLEX="value"

The default is to print on one side of the sheet of paper only (SIMPLEX). When both

sides are to be printed, the PLEX value also sets up the page binding:

SIMPLEX default

LONG long-edge binding duplex

SHORT short-edge binding duplex

Element GROUP sample script

Links:
ORIENT  
SIDE  
Element GROUP  
Element PAGE  
Element FILE  

PLUGIN

PLUGIN="file" 

The name of a Plugin or other external program to be EXECUTEd;  it must reside in
the EscapeE plugins folder. E.g.

PLUGIN = "IDFPLUGIN"

The contents of the item, including any sub-tags, are written to a temporary file. The
name of the temporary file is passed first, before any other parameters supplied by
the PARAM  attribute. Note that when calling a program, the temporary file must be
enclosed in quotes.
If the ENCODING  is set to BASE64 and there are no sub-tags then the body text is
decoded as base 64, otherwise it is written literally.

Links:
EXECUTE element  
PARAM
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POINTSIZE

POINTSIZE="pointsize"

Specifies the absolute font height for a piece of plain text .
It is never scaled.

Element FILE sample script

Element GROUP sample script

Links: 
FONT  
FONTSIZE  
Element GROUP  
Element PAGE  
Element FILE  
Element TEXT  

PREFIX

PREFIX="prefix"

This attribute may be used to add the prefix characters to the start of:

group names in INCLUDE  elements.
Group names in the included file all start with the prefix, to avoid conflict with
names in the main file.

field names defined by fields taken from CSV files.
This allows one to read a CSV file without danger of inadvertently redefining fields
that were defined in EscapeE or the IDF file. For example, if
PREFIX="XX_" 

then the field names read from the CSV file would all start with XX_ which would

distinguish them from other fields.

Mail-merge sample script  
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REPEAT

To step through a database file extracting data values, e.g. for merging files, use
REPEAT = "n" 

where n is a number: repeats n times or 

REPEAT="YES" 
This repeats until no new data is provided by a database or until all the text supplied
by a file of FILETYPE="TEXT" has been formatted onto a PAGE .

Element GROUP sample script  

Element FILE sample script

Technical note

New data is provided by reading a file whose page number is specified by:

setting the attribute PAGE = "NEXT" or 

calling a plugin whose return code must be ee_dataProvided to signify that it

produced new data.

Links:
Using data fields  
Notes on text  
PAGE  

ROTATE

ROTATE="n"

where n is the number of counter-clockwise right-angles to rotate text, lines and

other drawn items.  n may take these values:

 0 (the default) 

 1 (left-side down) 

 2 (up-side down) 

 3 (right-side down) 

Text is rotated after alignment. If ALIGN  is not specified then the initial position (i.e.
before rotation) may be taken from the LEFT  or X , TOP  or Y  attribute values.
When LEFT or TOP is used the string turns around the boundaries of its container;
when X or Y is used the string wheels around the leftmost point of the baseline.

PADDING , if specified, is applied after ROTATE.

ROTATE sample script

Alternatively text, lines and other drawn items may use:

ROTATE="n DEGREES"

where n is the number of degrees of rotation counter-clockwise.

Element TEXT sample script  

Note that while IDF documents using ROTATEd FILLed  TEXT  elements print
correctly, some systems cannot display the rotated text on top of the background
color.

Links: 
ORIENT  
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SCALE

SCALE="s" 

Multiplies both the current x and y scale factors by s, 

or

SCALE="FULL" 

Instead of a number, s can be set to "FULL" to set the scale back to 1, regardless of
the scale of any enclosing group.

Double-page sample script  

INFO element sample script  

Links: 
SCALEX  
SCALEY  

SCALEX

SCALEX="s" 

Multiplies the current scale in the x direction by s. 

SCALEY

SCALEY="s" 

Multiplies the current scale in the y direction by s.

SEPARATOR

IDF assumes that the separator for data-fields is a comma; enclosing the data-values
in each field in a pair of single-quotes or a pair of double-quotes as well is optional.

SEPARATOR = "s"

placed in a FILE  tag defines s as the separator instead. In this example s is set to ;

so that
<FILE FILENAME = "ADDRESS2.CSV" SEPARATOR = ";" />

can be used for a data file with fields separated by semicolons.

Note: if you set the separator to be a comma explicitly, i.e.

SEPARATOR=","

you can force any quotes to be treated as part of the field data.

Links
Element FILE  
FILENAME  
FILETYPE  
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SERIAL

The SERIAL number for a security certificate added by EscapeE, e.g.

SERIAL="7C 56 05 3F 88 42 13 88 45 95 4A 2B 03 C7 56 47 "

See Element SIGNATURE .

SHAPE

SHAPE="value"

Draws a shape bounded by the containing group. The value can be one of: 

RECTANGLE Rectangular area filled with solid COLOR  – the default.

BOX Solid line drawn with a square 'pen' centered on the boundary.

ELLIPSE Solid line drawn with a round 'pen'. The outer edge of the line is
drawn to just touch the boundary.

Drawing elements sample script  

ROTATE sample script  

Links: 
THICKNESS  
Notes on drawing  
BORDER  

SIDE

SIDE="side"

The 'side' of the sheet of paper – choose from: 

 FRONT (default) 

 BACK 

 NEXT 

Mail-merge sample script  

Links:
Element GROUP  
Element PAGE  
Element FILE  
PAGE  
PAPER  
PLEX  

288

300

332

336

321

277

295

340

283

287

282

312

313

314



319IDF syntax

STEPX

STEPX="distance"

Steps the horizontal print position LEFT  by the specified amount for each sub-item.

STEPX sample script  

Links: 
CLIPSTEPX   
STEPY  
UNITS

STEPY

STEPY="distance"

Steps the vertical print position TOP   by the specified amount for each sub-item.

STEPY sample script  

Links: 
CLIPSTEPY  
STEPX  
UNITS  
VSPACE  

STRING

STRING=""

The string for a "plain" TEXT  element to display on a PAGE , at the given position
using the specified FONT .

STRING='{""}'

The text to be used to prompt a user for input to a FIELD .

Element TEXT sample script  

Double page sample script

Links:
Notes on text  
Element TEXT  
FONT  
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STYLE

STYLE="n" 

where n is one of these integer values, specifying the style of font:

# description

  0  normal, upright

  1  italic

  2  oblique

  4  condensed

  5  condensed italic

 24  expanded

 32  outline

 64  inline

128  shadowed

160  outline shadowed

Element TEXT sample script  

Links: 
Notes on text  
Element TEXT  
<?FORMAT?> instruction  
FONT  
BORDERSTYLE  
LINESTYLE  
WEIGHT  

SYMBOLSET

The SYMBOLSET is used by TEXT  elements to determine which set of characters to
use.

SYMBOLSET="identifier"

The alphanumeric "identifier" for the default symbolset is "19U". Note that while

some characters (e.g. A to Z) commonly map to the same character in different
symbol sets, other characters are likely to map to different characters. Thus you may
only notice that the wrong symbolset is in use when accented characters or
mathematical symbols are output inappropriately. For example, plusminus in 19U

(equivalent to Microsoft® Codepage 1252) maps to Yacute in 8U (HP's Roman-8), and

a checkerboard in 10U!

Element FIELD sample script  

Links: 
Element TEXT  
ENCODING  
FONT  
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THICKNESS

THICKNESS="t"

Sets the (imaginary) pen's thickness for drawing Polylines,  Bezier  curves, BOX
and ELLIPSE SHAPEs . The pen may be flat, square or round, depending on the
settings given for LINEEND  and LINEJOIN  attributes.

LINESTYLE sample script

Drawing elements sample script

Links: 
Element Polyline  
Element Bezier  
SHAPE  
BORDERS  
BORDERWIDTH  

TOP

TOP="distance"

Sets up a vertical offset relative to the start of the container element, e.g.

TOP="600"

sets position to 1" down from the top of the container when using the default units
(1"/600).

TEXT note

For TEXT  elements, TOP offsets the position of the baseline of the characters. This
may be overridden using the ALIGN  attribute: e.g.
ALIGN="TOP"

specifies a vertical offset from the top of the character cell.

Element TEXT sample script  

ROTATE sample script

Links: 
Positioning and sizing  
LEFT  
HEIGHT  
VSPACE  
X,Y
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TRANSPARENT

TRANSPARENT="Y"

allows any white parts of a file to appear transparent (default). 
Note that some file formats apply a white background on which to place the file

content, which negates the effect.

or

TRANSPARENT="N"

places the file content on a white background.

Try the Element IDF sample script  to see the effect using an image file.

Links:
Element GROUP  
Element PAGE  
Element FILE  
ALPHA  
COLOR  
MONOCHROME  

TRAY

TRAY="n"

Specifies the Input tray number. 

Typically used only when the job uses more than one type of paper, for example,
when each page is to be printed on a different colored sheet.

Links: 
BIN  
PAPER  

TRIM

TRIM="YES"

Setting TRIM to "yes" removes any white space bordering an image or page of a file
that is being included. TRIM has no effect on the page being defined by the IDF, only
on external objects that are being incorporated. The default is:

TRIM="NO"

TRIM sample script  

Links: 
Element FILE  
Element INCLUDE  
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TYPEFACE

TYPEFACE="n"

Specifies the typeface using HP PCL numbers, e.g.

TYPEFACE="3"

to use Courier. This would be better expressed as FONT="Courier"  

Element FIELD sample script  

(See also 'Font attributes for specialists' topic.)

Links:
FONT  

UNITS

UNITS="value"

Where 'value' may be one of: 

INCHES, IN

DOTS (1"/300)

DOT600, D600 (1"/600, the default)

POINTS, PT

DE (decipoints)
CM
MM

or a number followed by one of the units, e.g. 

UNITS="0.01 IN"

ROTATE sample script  

STEPX sample script  

Links:
Positioning and sizing  
Element GROUP  
Element PAGE  
Element FILE  
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VSPACE

VSPACE="distance"

Steps the vertical print position TOP   by the specified amount for each sub-item.

This sets the vertical spacing for lines of text. It is inherited by child elements, so may
be used to set the spacing for the whole document (unlike the STEPY  attribute).
E.g.:
<TEXT BOUNDS="AGENT" BLANKLINES="NO" ALIGN="LEFT,TOP" PAD="0.04"
VSPACE="0.17">

Links: 
CLIPSTEPY  
HEIGHT  
PAD  
STEPY  

WEIGHT

WEIGHT="n" 

Supplies the weight of font for TEXT . To specify a precise weight you may use any
of the integer values (akin to HP-PCL values) described below. There are string
equivalents for the most commonly-used font-weights which may be used instead for
convenience: 

string # description

-7 ultra thin

-6 extra thin

-5 thin

-4 extra light

LIGHT -3 light

-2 demi light

-1 semi light

REGULAR  0 medium(default) 

 1 semi bold

 2 demi bold

BOLD  3 bold

 4 extra bold

 5 black

 6 extra black

BLACK  7 ultra black

Element TEXT sample script  

LINESTYLE sample script  

Links: 
FONT  
STYLE  
Notes on text  
<?FORMAT?> instruction  
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WIDTH

WIDTH="width"

Width of an item, e.g. 
WIDTH="2400"

sets width to 4" when default units (1"/600) used, or 

WIDTH="width units"

Width of an item, e.g. 
WIDTH="4 in"

sets width to 4", whatever units have been set up elsewhere.

ROTATE sample script  

Drawing elements sample script  

Links: 
Positioning and sizing  
BOUNDS  
BORDERWIDTH  
HEIGHT  
PAGE  
UNITS  
X,Y  

X,Y

X="distance"

Y="distance"

X specifies the horizontal offset from the origin of the containing element and Y

specifies the vertical offset. They are used primarily for specifying coordinates when
drawing: see B , M , P , CLIP , SHAPE . Although the X and Y attributes are
similar to the LEFT  and TOP  attributes, when text is rotated they behave
differently – see note  below.
<GROUP X="600" Y="900" WIDTH="1000" HEIGHT="500" SHAPE="BOX">

The default UNIT  is 1/600 inch.

TEXT rotation note

The location X,Y specifies the position of the leftmost point of (unALIGNed ) TEXT's
 baseline; if ROTATE  is applied then the string is pivoted about the point X,Y. If

the location were specified using LEFT  and TOP  instead, the position would be
rotated relative to the edges of its container, taking the string along with it.

Drawing elements sample script  

ROTATE sample script  

Links:
Positioning and sizing  
Notes on drawing  
LEFT  
TOP  
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Sample IDF scripts

These topics show example IDF scripts to demonstrate how IDF elements and
attributes may be used. An xml header may not be necessary if the document was
saved in UTF-8. Typical headers:
<?xml version="1.0" encoding="UTF-8"?>
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<?xml version="1.0" encoding="UTF-8" standalone="no"?>

Examples of elements:

Element DEFINE sample script , also GROUP, INCLUDE and PAGE elements.

Element FIELD sample script , also TEXT element.

Element FILE sample script , also GROUP, PAGE and TEXT elements.

Element GROUP sample script , also INCLUDE, PAGE and TEXT elements.

Element IDF sample script , also FILE and PAGE elements.

Element INCLUDE sample script , also PAGE and TEXT elements; command-line
tips.

Element INFO sample script , also FILE and PAGE elements.

Element TEXT sample script , also GROUP, PAGE and TEXT elements.

Plus an example to illustrate the Bezier, Polyline and Move elements:

Drawing elements sample script  

Examples of attributes:

COLOR sample script , also BGCOLOR, BORDERS, BORDERCOLOR,
BORDERSTYLE, BORDERWIDTH, FILL, POINTSIZE and WIDTH.

INDEX sample script , also PAGE attribute.

LINEEND, LINEJOIN sample script , also THICKNESS, X and Y attributes.

LINESTYLE sample script , also FONT, WEIGHT, X and Y attributes.

MONOCHROME sample script , also FILENAME and FILETYPE attributes.

ROTATE sample script , also ALIGN, HEIGHT, ORIENT, SHAPE, UNITS, X and Y
attributes.

STEPX sample script , also LEFT, TOP and UNITS attributes.

STEPY sample script , also ORIENT, PAPER and STRING attributes.

TRIM sample script , also ALIGN, TOP and DEBUG attributes.

Plus examples to demonstrate how to create "two-up" pages from a file nominated by
a user and USING the command-line:

Double page sample script : DEFINE, FILENAME, NAME, PAGE, SCALE, STRING,
and REPEAT attributes.

Command-line sample script : FONTSIZE, REPEAT and STYLE attributes; /
USING command-line option; LOF file.

Example of a script created by a wizard:

Mail-merge sample script : BLANKLINES, BOUNDS, FILETYPE, PREFIX, REPEAT,
SIDE attributes and FORMAT instruction.
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Element DEFINE sample script

The only attributes that an INCLUDE  element directly inherits from a GROUP  that
contains it are ROTATE , X  and Y . A DEFINE element can be employed to
propagate other attribute values from its containing group to an included element.
In this example, a temporary field is created by the DEFINE  element with the NAME

 GroupColour. This contains a STRING  value for the COLOR  of a group named

Arrow. A new temporary GroupColour field is defined to contain the new value for its

color each time that Arrow is invoked.
<IDF UNITS="INCHES" >
<GROUP NAME="Arrow" WIDTH="2" HEIGHT="2" THICKNESS="0.25"
COLOR="{GroupColour}" >
<M X="2" Y="0" />
<P X="3" Y="1" />
<P X="2" Y="2" />
<M X="1" Y="1" />
<P X="3" Y="1" />
</GROUP>
<PAGE >
<GROUP TOP="1" LEFT="2" WIDTH="4" HEIGHT="2">
<DEFINE NAME="GroupColour" STRING="RED"/>
<INCLUDE GROUPNAME="Arrow"/>
</GROUP>
<GROUP TOP="4" LEFT="1" WIDTH="4" HEIGHT="2" >
<DEFINE NAME="GroupColour" STRING="BLUE"/>
<INCLUDE GROUPNAME="Arrow" />
</GROUP>
</PAGE>
</IDF>

Links:
DEFINE  
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Element FIELD sample script

Example of two FIELD  elements: in the first the coordinates are taken from an EE
file, in the second the coordinates are taken from the IDF file itself.

The TEXT  elements demonstrate the use of different SYMBOLSETs .

<IDF UNITS="INCHES">
<PAGE>
<FIELD NAME="Field1" LEFT= "1" TOP="1" WIDTH="4" HEIGHT="2" DEFINE="AUTO"
 SHAPE="BOX">
<TEXT ALIGN="CENTRE,CENTRE" SYMBOLSET="8U">Text centered in field;
coordinates of the field can be moved
by editing the fields file with EscapeE
Symbolset 8U ÙµÁ</TEXT>
</FIELD>
<FIELD NAME="Field2" LEFT= "1" TOP="4" WIDTH="4" HEIGHT="2" DEFINE="YES"
 SHAPE="BOX">
<TEXT ALIGN="CENTRE,CENTRE" TYPEFACE="3" SYMBOLSET="10U">Text centered in
 the field; coordinates fixed by the IDF.
Symbolset 10U ÙµÁ</TEXT>
</FIELD>
</PAGE>
</IDF>

Links:
Element FIELD  
FIELD  

Element FILE sample script

Here, a plain text FILE  descriptionA.txt is to be printed. The number of pages

needed to print the document is not known, so PAGE="NEXT" and REPEAT="YES" are

specified. The area of the page to be printed is specified as the _PRINTABLE  area.
This "features" text is preceded by a BOX containing lists of (productA's) dimensions.

The TEXT for the sizes in 'mm' are supplied by file metricA.txt and listed on the left

(default ALIGNment). The TEXT for the sizes in 'inches' are supplied by file

imperialA.prn and listed on the RIGHT; note that FILETYPE="TEXT" is specified.
<IDF UNITS = "INCHES">
<PAGE BOUNDS="_PRINTABLE">
<GROUP HEIGHT="3" FONT="Times New Roman" POINTSIZE="12" SHAPE="BOX">
<TEXT FILENAME="metricA.txt" />
<TEXT FILENAME="imperialA.prn" FILETYPE="TEXT" ALIGN="RIGHT"/>
</GROUP>
<FILE FILENAME="featuresA.txt" FILETYPE="TEXT" PAGE="NEXT" TOP="4" FONT="Arial"
POINTSIZE="9" ALIGN="CENTRE"/>
</PAGE>
<PAGE BOUNDS="_PRINTABLE" ALIGN="CENTRE" REPEAT="YES" PAGE="NEXT" >
<FILE FILENAME="featuresA.txt" FILETYPE="TEXT" FONT="Arial" POINTSIZE="9" />
</PAGE>
</IDF>

Links:
Element FILE  
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Element GROUP sample script

The GROUP  in this example steps through the records of a CSV file, merging the
data into fields in a print file. Caching the static elements of the pages is not a
requirement, but if the printer is capable of storing overlays, it improves efficiency.
<IDF UNITS="INCHES" PLEX= "SIMPLEX" PAPER = "A4" FONT = "Times New Roman"
POINTSIZE = "12">
<GROUP REPEAT="YES">
<PAGE>
<INCLUDE FILENAME = "c:\escapee\users.csv" PAGE = "NEXT"/>
<INCLUDE FILENAME = "c:\escapee\letter.lsh" PAGE="1" CACHE="YES"/>
<TEXT BOUNDS ="ADDRESS" BLANKLINES="NO">
<?EE TITLE?> <?EE FIRSTNAME?> <?EE NAME?>
<?EE COMPANY?>
<?EE ADDR1?>
<?EE ADDR2?>
<?EE ADDR3?>
<?EE ADDR4?>
<?EE TOWN?>
<?EE COUNTY?>
<?EE POSTCODE?>
<?EE COUNTRY?>
</TEXT>
<TEXT BOUNDS =" SALUTATION"><?EE TITLE?> <?EE NAME?></TEXT>
</PAGE>
<PAGE>
<INCLUDE FILENAME = "c:\escapee\letter.lsh" PAGE="2" CACHE="YES"/>
</PAGE>
</GROUP>
</IDF>

Links:
Element GROUP  
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Element IDF sample script

This IDF file superimposes a graphic on page number 2 taken from a PDF file:

<IDF UNITS = "INCHES" PAPER="A4">
  <PAGE>
    <FILE FILENAME="manual.pdf" PAGE="2" />
    <FILE LEFT="1" TOP="0.3" FILENAME="logo.png" TRANSPARENT = "Y" />
  </PAGE>
</IDF>

Links:
Element IDF  

Element INCLUDE sample script

This script uses the REPEAT attribute to enable each page from a named PDF file to be

INCLUDEd one PAGE at a time, followed by a "Compliments" slip on another PAGE.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF>
<PAGE REPEAT="YES">
<INCLUDE FILENAME="Brochure.pdf" PAGE="NEXT"/>
</PAGE>
<PAGE>
<TEXT ALIGN="CENTRE,CENTRE" FONTSIZE="16 pt" STYLE="1">
With Compliments
</TEXT>
</PAGE>
</IDF>

 Command-line tips

Omit the FILENAME from the INCLUDE statement above:

<INCLUDE PAGE="NEXT"/> 

and specify the file on the command-line or Run box instead:
ESCAPEE c:\CustomerRecords\BrochureGarden.PDF /USING MailBrochure.idf

where MailBrochure.idf is the name of this sample IDF file and

BrochureGarden.PDF is the name of the file INCLUDEd in the document.

This frees you to customize the document "on the fly" – there is no need to open
and edit the IDF file each time you need to output a new variant of the document.

See also Command-line sample script .

Links:
Element INCLUDE  

284

339

285



331IDF syntax

Element INFO sample script

In this IDF script, information on its configuration is contained within an INFO
element . The odd (non-blank) pages from the specified BASEFILE  attribute are
extracted to make a new PDF. This ensures that no subtle features of the original file
are lost when the new PDF is exported. The "info" is not used by EscapeE when it
exports the new PDF.
<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF ENCODING="UTF-8" NAME="1COL" UNITS="INCHES" FONT="Arial"
POINTSIZE="10" PAPER="A4" ORIENT="P" BASEFILE="original.pdf">
<INFO>
:\PORTRAIT
:\SCALE 1
:\PAPER A4
</INFO>
<PAGE BOUNDS="_PAGE">
<FILE NAME="1" CLIPWIDTH="8.5" CLIPHEIGHT="11" TOP="0" PAGE="1"/>
</PAGE>
<PAGE BOUNDS="_PAGE">
<FILE NAME="2" CLIPWIDTH="8.5" CLIPHEIGHT="11" TOP="0" PAGE="3"/>
</PAGE>
<PAGE BOUNDS="_PAGE">
<FILE NAME="3" CLIPWIDTH="8.5" CLIPHEIGHT="11" TOP="0" PAGE="5"/>
</PAGE>
<PAGE BOUNDS="_PAGE">
<FILE NAME="4" CLIPWIDTH="8.5" CLIPHEIGHT="11" TOP="0" PAGE="7"/>
</PAGE>
</IDF>

Links:
Element INFO  

Element TEXT sample script

A heading, (left-aligned) in red bold italics, is placed on a page of A4 paper. The
baseline for the heading is at the TOP.
A paragraph of text, right-aligned (in black) is placed with its baseline 2 cm further
down the page on a grey background.
An "EXAMPLE" sticker is simulated using rotated text and a rectangular box shape.
<IDF UNITS = "INCHES" PAPER="A4">
<PAGE TOP="1" LEFT="0.5" WIDTH="7.25" HEIGHT="9" >
<TEXT STRING="IDF syntax" COLOUR=red FONT="Arial" WEIGHT="3" STYLE="1" />
<TEXT TOP="2.00cm" ALIGN="RIGHT" FILL="90,90,90" >IDF is a way of
describing in XML
the structure of a composite document
to the EscapeE viewer and transformation system.</TEXT>
<TEXT STRING="EXAMPLE" COLOUR="50,50,100" FONT="Arial"  FONTSIZE="14 PT" 
WEIGHT="3" TOP="1" LEFT="2" ROTATE="22.5 DEGREES"/>
<GROUP LEFT="1.5" TOP="1" WIDTH="2" HEIGHT="0.25" SHAPE="BOX" 
ROTATE="22.5 DEGREES"/>
</PAGE>
</IDF>

Links:
Element TEXT  
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Drawing elements sample script

This example code draws an ogee arch topped plaque. Note that the outer line is
made up of a Bezier curve  starting from the 'Move ' position (1,2) and a Polyline
, starting from the last Bezier point.

The first GROUP  places an image in a circle with a red border. The second places a
BOX .

<!DOCTYPE IDF SYSTEM "C:\REDTITAN\SOFTWARE\IDF.DTD">
<IDF UNITS="INCHES" PAPER="A4" ORIENT="P">
<PAGE THICKNESS="0.05" LINEEND="SQUARE" >
<M X="1" Y="2"/>
<B X="2" Y="2"/>
<B X="2" Y="1"/>
<B X="3" Y="1"/>
<B X="4" Y="1"/>
<B X="4" Y="2"/>
<B X="5" Y="2"/>
<P X="5" Y="5"/>
<P X="1" Y="5"/>
<P X="1" Y="2"/>
<GROUP LEFT="2.5" TOP="1.25" WIDTH="1.0" HEIGHT="1.0" SHAPE="ELLIPSE"
 THICKNESS="0.01" COLOUR="red">
<FILE FILENAME="LOGO60.PNG" />
</GROUP>
<GROUP LEFT="1.5" TOP="2.5" WIDTH="3" HEIGHT="2" SHAPE="BOX" />
</PAGE>
</IDF>

Links:
Element Bezier  
Element Move  
Element Polyline  
SHAPE  
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COLOR sample script

This example shows the four attributes for specifying colors in IDF.

The PAGE is cream (BGCOLOR ) with the string "original text". The string is partially
covered by a GROUP with grey background (BGCOLOR) and a green border
(BORDERCOLOR ). This contains an ellipse drawn in red (COLOR ) with a cyan FILL

. Another string "New!" in yellow (COLOR) on magenta (FILL) is added on top of the
GROUP.

<IDF UNITS="INCHES" PAPER="A4" ORIENT="P" >
<IDF UNITS="INCHES" PAPER="A4" ORIENT="P" >
<PAGE BGCOLOUR="100,100,80" >
<TEXT LEFT="0.75" TOP="2" STRING="original text" />
<GROUP LEFT="1" TOP="1.5" WIDTH="3" HEIGHT="2" BGCOLOUR="75,75,75"
BORDERS="L,R,T,B" BORDERSTYLE="DASHED" BORDERCOLOUR="GREEN"
BORDERWIDTH="0.01" SHAPE="ELLIPSE" COLOR="RED" THICKNESS="0.01"
FILL="CYAN" />
<TEXT LEFT="1.5" TOP="2.5" STRING="NEW!" POINTSIZE="18" COLOUR="YELLOW"
FILL="MAGENTA" />
</PAGE>
</IDF>

Links:
COLOUR  

INDEX sample script

This example is an extract from the index of a PDF file:
...
<IDF FILENAME="IDF.pdf">
...
<GROUP INDEX="IDF syntax" PAGE="15">
  <GROUP INDEX="Dimensions in IDF" PAGE="15"/>
  <GROUP INDEX="Notes on text" PAGE="15"/>
  <GROUP INDEX="Using data fields" PAGE="16"/>
</GROUP>
...
<PAGE PAGE="15"><INCLUDE/></PAGE>
<PAGE PAGE="16"><INCLUDE/></PAGE>
...

Three topics (Dimensions in IDF, Notes on text, Using
data fields) are contained within a parent group (IDF
syntax) shown in an open folder.

Folders may be opened and closed with a double-click of
the mouse.

Links:
INDEX  
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LINEEND, LINEJOIN sample script

Five chevrons are drawn using Polylines  in different colors. Each chevron
demonstrates the effect of a different combination of LINEEND  and LINEJOIN
attributes.

A BOX  provides reference lines for comparing the positions of the line-ends.

<IDF UNITS="INCHES" >
<PAGE THICKNESS="0.5" >
<GROUP LEFT="0" TOP="1" WIDTH="1" HEIGHT="2" COLOR="RED" >
<M X="1" Y="0" />
<P X="2" Y="1" />
<P X="1" Y="2" />
</GROUP>
<GROUP LEFT="1" TOP="1" WIDTH="1" HEIGHT="2" LINEEND="ROUND"
COLOR="GREEN" >
<M X="1" Y="0" />
<P X="2" Y="1" />
<P X="1" Y="2" />
</GROUP>
<GROUP LEFT="2" TOP="1" WIDTH="1" HEIGHT="2" LINEEND="ROUND"
LINEJOIN="ROUND" COLOR="CYAN"  >
<M X="1" Y="0" />
<P X="2" Y="1" />
<P X="1" Y="2" />
</GROUP>
<GROUP LEFT="3" TOP="1" WIDTH="1" HEIGHT="2" LINEEND="ROUND"
LINEJOIN="SQUARE" COLOR="BLUE" >
<M X="1" Y="0" />
<P X="2" Y="1" />
<P X="1" Y="2" />
</GROUP>
<GROUP LEFT="4" TOP="1" WIDTH="1" HEIGHT="2" LINEEND= "SQUARE"
LINEJOIN="SQUARE" COLOR="MAGENTA" >
<M X="1" Y="0" />
<P X="2" Y="1" />
<P X="1" Y="2" />
</GROUP>
<GROUP LEFT="1" TOP="1" WIDTH="1" HEIGHT="2" SHAPE="BOX" THICKNESS="0.01"
/>
</PAGE>
</IDF>

Links:
LINEEND  
LINEJOIN  
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LINESTYLE sample script

This is an example of lines found on a map.

<IDF UNITS="INCHES" >
<PAGE FONT="Arial" WEIGHT="2" >
<GROUP LEFT="1" TOP="1" WIDTH="5" HEIGHT="1" LINESTYLE="DOTTED">
<P X="2" Y="0" />
<TEXT LEFT="2.1" STRING="Path" />
</GROUP>
<GROUP LEFT="1" TOP="1.25" WIDTH="5" HEIGHT="1" LINESTYLE="DASHED"
THICKNESS="0.02" >
<P X="2" Y="0" />
<TEXT LEFT="2.1" STRING="Bridleway" />
</GROUP>
<GROUP LEFT="1" TOP="1.75" WIDTH="5" HEIGHT="1" LINESTYLE="SOLID"
THICKNESS="0.08" >
<P X="2" Y="0" />
<TEXT LEFT="2.1" STRING="Railway" />
</GROUP>
<GROUP LEFT="1" TOP="2.04" WIDTH="5" HEIGHT="0.1" LINESTYLE="SOLID"
THICKNESS="0.01" >
<P X="2" Y="0"/>
</GROUP>
<GROUP LEFT="1" TOP="1.96" WIDTH="5" HEIGHT="0.1" LINESTYLE="SOLID"
THICKNESS="0.01" >
<P X="2" Y="0" />
</GROUP>
<GROUP LEFT="1" TOP="2.00" WIDTH="5" HEIGHT="1" LINESTYLE="CUSTOM,60,60"
THICKNESS="0.08">
<P X="2" Y="0" />
<TEXT LEFT="2.1" STRING="Single track" />
</GROUP>
<GROUP LEFT="1" TOP="2.5" WIDTH="5" HEIGHT="1"
LINESTYLE="CUSTOM,40,20,10,20" THICKNESS="0.01" >
<P X="2" Y="0" />
<TEXT LEFT="2.1" STRING="County Boundary" />
</GROUP>
<GROUP LEFT="0.75" TOP="0.75" WIDTH="5" HEIGHT="1" LINESTYLE="SOLID"
LINEJOIN="ROUND" LINEEND="ROUND" THICKNESS="0.25" COLOR="CYAN" >
<M X="3.5" Y="0" />
<P X="4.5" Y="1" />
<P X="3.5" Y="2" />
<P X="0" Y="2" />
</GROUP>
</PAGE>
</IDF>

Links:
LINESTYLE  309
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MONOCHROME sample script

These examples show how changing the threshold values affect the rendering of the
same image:

<FILE FILENAME="COMPASS.PNG" FILETYPE="PNG" />

<FILE FILENAME="COMPASS.PNG" FILETYPE="PNG" MONOCHROME="25" />

<FILE FILENAME="COMPASS.PNG" FILETYPE="PNG" MONOCHROME="50" />

<FILE FILENAME="COMPASS.PNG" FILETYPE="PNG" MONOCHROME="100" />

<FILE FILENAME="COMPASS.PNG" FILETYPE="PNG" MONOCHROME="200" />

Links:
MONOCHROME  

ROTATE sample script

Example 1  shows how TOP,LEFT and X,Y positioning affect rotation of TEXT.

Example 2  shows an image  ROTATEd  and ALIGNed  in a grid of square
boxes.

Example 1

The strings in the first GROUP are offset from the GROUP origin and resemble a "+"
shape in a circle. The starting point for the second GROUP of strings ROTATEs around
the edges of the GROUP. The strings in the third group are ALIGNed around the edges
of a rectangular box.

<IDF UNITS="DOTS" PAPER="A4" ORIENT="P" >
<PAGE>
<GROUP X="500" Y="500" WIDTH="800" HEIGHT="800" SHAPE="ELLIPSE">
<TEXT X="400" Y="400" >X,Y offset 0</TEXT>
<TEXT X="400" Y="400" ROTATE="1">X,Y offset 1</TEXT>
<TEXT X="400" Y="400" ROTATE="2">X,Y offset 2</TEXT>
<TEXT X="400" Y="400" ROTATE="3">X,Y offset 3</TEXT>
</GROUP>
<GROUP X="500" Y="500" WIDTH="800" HEIGHT="800">
<TEXT >X,Y box 0</TEXT>
<TEXT ROTATE="1" >X,Y box 1</TEXT>
<TEXT ROTATE="2" >X,Y box 2</TEXT>
<TEXT ROTATE="3" >X,Y box 3</TEXT>
</GROUP>
<GROUP LEFT="500" TOP="500" WIDTH="800" HEIGHT="800" SHAPE="BOX">
<TEXT ALIGN="CENTRE" >LEFT,TOP box 0</TEXT>
<TEXT ALIGN="CENTRE" ROTATE="1" >LEFT,TOP 1</TEXT>
<TEXT ALIGN="CENTRE" ROTATE="2" >LEFT,TOP 2</TEXT>
<TEXT ALIGN="CENTRE" ROTATE="3" >LEFT,TOP 3</TEXT>
</GROUP>
</PAGE>
</IDF>
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Example 2

<IDF UNITS="INCHES" PAPER="A4" ORIENT="P">
<PAGE>
<FILE FILENAME="compass.png" SHAPE="BOX" Y="1" X="1" WIDTH="2cm"
HEIGHT="2cm" ROTATE="0" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="1" X="2" WIDTH="2cm"
HEIGHT="2cm" ROTATE="1" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="1" X="3" WIDTH="2cm"
HEIGHT="2cm" ROTATE="2" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="1" X="4" WIDTH="2cm"
HEIGHT="2cm" ROTATE="3" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="2" X="1" WIDTH="2cm"
HEIGHT="2cm" ROTATE="0" ALIGN="bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="2" X="2" WIDTH="2cm"
HEIGHT="2cm" ROTATE="1" ALIGN="bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="2" X="3" WIDTH="2cm"
HEIGHT="2cm" ROTATE="2" ALIGN="bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="2" X="4" WIDTH="2cm"
HEIGHT="2cm" ROTATE="3" ALIGN="bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="3" X="1" WIDTH="2cm"
HEIGHT="2cm" ROTATE="0" ALIGN="right,bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="3" X="2" WIDTH="2cm"
HEIGHT="2cm" ROTATE="1" ALIGN="right,bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="3" X="3" WIDTH="2cm"
HEIGHT="2cm" ROTATE="2" ALIGN="right,bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="3" X="4" WIDTH="2cm"
HEIGHT="2cm" ROTATE="3" ALIGN="right,bottom" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="4" X="1" WIDTH="2cm"
HEIGHT="2cm" ROTATE="0" ALIGN="right" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="4" X="2" WIDTH="2cm"
HEIGHT="2cm" ROTATE="1" ALIGN="right" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="4" X="3" WIDTH="2cm"
HEIGHT="2cm" ROTATE="2" ALIGN="right" />
<FILE FILENAME="compass.png" SHAPE="BOX" Y="4" X="4" WIDTH="2cm"
HEIGHT="2cm" ROTATE="3" ALIGN="right" />
</PAGE>
</IDF>

Links:
ORIENT  
ROTATE  
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STEPX sample script

Using STEPX  to set up column headings.

<IDF UNITS = "CM" PAPER="A4">
<PAGE TOP="4" LEFT="2.5" STEPX="4.0" >
<TEXT STRING="Date" />
<TEXT STRING="Registration number" />
<TEXT STRING="Time in" />
<TEXT STRING="Time out" />
</PAGE>
</IDF>

STEPY sample script

Using STEPY  to lay out a form.

<IDF UNITS = "INCHES" PAPER="A6" ORIENT="L">
<PAGE TOP="1" LEFT="1" STEPY="0.5" >
<TEXT STRING="Name:" />
<TEXT STRING="Address:" />
<TEXT STRING="Postcode:" />
<TEXT STRING="Telephone number:" />
</PAGE>
</IDF>

TRIM sample script

An image "logo.png" is placed 1inch from the top of a page being defined in IDF.
The same image is placed 3inches from the top of the IDF page, but with white pixels
at the edges TRIMmed  off.
The second page of the document "Results pdf" is placed, trimmed, at the lower-right
of the IDF page.
<IDF UNITS="INCHES">
<PAGE>
<GROUP LEFT= "1" TOP="1" WIDTH="0.5" HEIGHT="0.4" SHAPE="BOX" DEBUG="So
far">
<FILE FILENAME="logo.png" ALIGN="TOP,LEFT" TRIM="NO"/>
</GROUP>
<GROUP LEFT= "1" TOP="3" WIDTH="0.5" HEIGHT="0.4" SHAPE="BOX" DEBUG="So
good">
<FILE FILENAME="logo.png" ALIGN="TOP,LEFT" TRIM="YES"/>
</GROUP>
<FILE FILENAME="Results.pdf" PAGE="2" ALIGN="BOTTOM,RIGHT" TRIM="YES"/>
</PAGE>
</IDF>

A DEBUG  comment has been placed in each group for monitoring the progress of

the document composition. In this example, click the warning button on the 
EscapeE toolbar to display the message in the console log:

So far at byte 100
So good at byte 249

Links:
TRIM  
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Double page sample script

This IDF script prompts the user for an input file of pages in portrait orientation and
then shows it as double-page spreads on landscape pages.

The pages are scaled to fit the length of the input page into the height of the output
page. The location of each input page alternates between the top-left and the top-
centre of each landscape page so that two pages are placed side-by-side on the
output page.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF UNITS="INCHES" PAPER="A4" ORIENT="L">
<FIELD DEFINE="YES" NAME="INFILE" STRING='{"Input file name"}'/>
<GROUP REPEAT="YES" FILENAME="{INFILE}">
<PAGE>
<FILE LEFT="0" TOP="0" SCALE="0.7071" PAGE="NEXT"/>
<FILE LEFT="_PAGE.WIDTH/2" TOP="0" SCALE="0.7071" PAGE="NEXT"/>
</PAGE>
</GROUP>
</IDF>

Links:
Positioning and sizing  
FILENAME  
NAME  
REPEAT  
SCALE  

Command-line sample script

This example demonstrates the power of running from the command-line. It invokes
two control files – an IDF script file  and an LOF file  –  to concatenate a number of
data files and append a supplementary page. On the command-line or in the Run box,
enter:
ESCAPEE /FROM c:\CustomerRecords\Fruit.LOF /JOIN

where Fruit.LOF is the list of files containing the pages to be output:

 Fruit.lof

FruitTrees.pdf
FruitBushes.pdf
FruitSeeds.pdf /USING BrochureLast.idf

and BrochureLast.idf is the IDF file adding the extra page to a standard brochure:

 BrochureLast.idf

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF>
<PAGE REPEAT="YES">
<INCLUDE PAGE="NEXT"/>
</PAGE>
<PAGE>
<TEXT ALIGN="CENTRE,CENTRE" FONTSIZE="16 pt" STYLE="1">
With Compliments
</TEXT>
</PAGE>
</IDF>
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Mail merge sample script

This is the IDF code for a simple document created by the mail-merge wizard.

The "fixed" text of the letter is given in file Summer1.PCL. The positions on the page for

the "variable" data are given in its "EE" file, Summer1.ee. File contacts.csv contains

field-values in comma-separated format. The mail-merge wizard enables you to
associate the Summer1 fieldnames with the fieldnames given in the first line of

contacts.csv. It can then create an IDF file to generate one customized page per

data record.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF ENCODING="UTF-8" NAME="Mailmerge" UNITS="INCHES" FONT="Arial"
POINTSIZE="10" ORIENT="P" PLEX="SIMPLEX">
<INFO>
:\DOCUMENT MAILMERGE
</INFO>
<INCLUDE FILENAME="Summer1.ee"/>
<GROUP NAME="Repeat" REPEAT="YES">
<FILE PAGE="NEXT" PREFIX="CSV_" FILETYPE="CSV" FILENAME="contacts.csv"/>
<PAGE NAME="Page1" SIDE="FRONT">
<FILE NAME="OVERLAY" PAGE="1" FILENAME="Summer1.PCL"/>
<TEXT BOUNDS="SURNAME" FONT="Arial" WEIGHT="0" STYLE="0" POINTSIZE="10"
BLANKLINES="NO" ALIGN="LEFT,TOP">
<?EE CSV_SURNAME?>
</TEXT>
<TEXT BOUNDS="ADDRESS1" FONT="Arial" WEIGHT="0" STYLE="0" POINTSIZE="10"
BLANKLINES="NO" ALIGN="LEFT,TOP">
<?EE CSV_ADDRESS1?>
</TEXT>
<TEXT BOUNDS="ADDRESS2" FONT="Arial" WEIGHT="0" STYLE="0" POINTSIZE="10"
BLANKLINES="NO" ALIGN="LEFT,TOP">
<?EE CSV_ADDRESS2?>
</TEXT>
</PAGE>
</GROUP>
</IDF>

Links:
Mail merge wizard  359
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IDF wizards

EscapeE is equipped with "wizards" for quickly setting up specialized, but commonly
used, documents:

Composite documents  

Mail merge  

In addition, EscapeE includes dual-mode editor for creating and editing non-standard
documents:

Other documents  

Links:
IDF syntax
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Composite documents

Composite documents are created from parts clipped from one or more files which
may then be output in a choice of layouts.

Set up the layout of the new document in the Composite document wizard  

Set up the files from which clippings are extracted in the File pages table  

Booklet  layout

Multi-column  layout

Close packed  layout

Music part extraction  layout

Select clippings in the Page editor  window of the Trimming dialog

Enter the details of the clippings in the Trimming dialog; see Trimming options  

Page numbers and additional text may be added to clippings: see Setting up text

How to re-open the wizard for editing: see Editing a composite document file  

Links
Mail merge wizard  
Text mode wizard  
Tree mode wizard  
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Composite document wizard

First set up the document's layout parameters in the upper panel of the wizard (see
below ), then add file(s) and specify the regions to be clipped from them in the
lower panel, see File pages table .

1. Click New... and select IDF Document wizard from the 'File' menu. Or 
Press Ctrl Z keys.

2. Choose Composite document then click OK.

3. If a title page is required, tick Title page to display the 'Text for title' edit
window. Key in the title-text then close the window (Alt F4) to return to the
wizard. (You may re-edit the title-page text by clicking Text... to re-open the
'Text for title' edit window.)
'Title page' counts as page1.

4. Choose a layout from the drop-down list:

o Booklet of up to four pages per sheet, see Booklet .

To allow extra space at the fold, enter a Binding margin in the edit-box.
This is labeled with the measurement units (set up in the Trimming
options )

o Close packed to minimize gaps between clip-regions, see Close packed

o 1 column, 2 columns, 3 columns, 4 columns per page, see Multi-column
.

In addition, you may opt to:

Tick Interleave the files.
The default is to deselect to fill all the columns on a page before printing
the next page.

o Music part extraction of parts from a full score, see Music part extraction .
In addition, you may opt to:

Either tick Bar numbers to include the number of the first bar of each
staff.

Or tick Number staves to include the stave numbers instead.

5. Enter the type of Paper to be used, for example A4 (see also Paper types  and

Booklet ).

6. You may enter a PCL input tray number in the Tray edit-box, but it is not
normally required and so usually left blank.

7. Select orientation of paper: Portrait or Landscape. (See also Booklet ).

8. Tick Repeated to continue placing clip-regions until they have all been formatted
into the document.

9. Tick Duplex to print on both sides of the paper;
deselect to print on one side only (simplex).

o The exception is Booklet : this is always printed in duplex.

10. Enter the Scale at which to render the clip-regions.

o For Booklet  the default value is 0.7071.

o For all other layouts, the default value is 1.
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11. To set up a template for numbering pages, click Page numbers... button: see
Setting up text . The current template is shown in the panel alongside the
button. When the template's 'Alignment' is set to None (the default value), this

panel is blank and page numbering is switched off.
You may opt to offset the page-number text from the selected 'Bounds':

o Enter a horizontal offset distance of the Bounds corner to the closest text
corner in the X edit-box.

o Enter a vertical offset distance of the Bounds corner to the closest text corner
in the Y edit-box.

o Enter the vertical space allowed for the page numbers in the Height edit-
box. The default is the natural size of the selected font.

You now need to select the files and the regions within them which you would like to
put in your new document: see File pages table .

Closing the wizard

The Composite document wizard remains open while you set up the clip-regions for
the document, even if you have had the Trimming  dialog open. To close the
wizard and finish the document:

1. Click OK.

2. The IDF editor opens with the IDF code for the document completed.

o You may make further changes to the document by editing the IDF: see 

Text mode  and Tree mode .

3. Click Save or Save as....
Enter a File name for the file, then Save as type IDF files. 

The Composite document IDF file is created and displayed in EscapeE.

 Tips

 If you would like to take a quick look at the output but don't need to print the entire
file, enter a number in the Total pages edit-box. This sets an upper limit on the
number of pages processed.

 The setup of the wizard can be saved for future reference: click Save list... to
display a standard 'Save' dialog. Enter a File name for the file, then Save as type
List of files.

Links
File pages table  
Setting up text  
Paper types  
Page numbering  
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File pages table

Once you have set up the document's layout parameters in the Composite document
wizard , you need to specify how each page is to be composed in the wizard's 'File
pages' table.

When a file is added to the document, each of its pages is listed in a row of the 'File
pages' table. Clicking on a row selects it for processing; for example, you could open
the Page editor  and use the mouse to drag-out a clip-region. The 'Options' cell of
the table-row would be updated with the clip-region's parameters automatically. If
you add more than one clip-region from the same page, each new clip-region is added
to the table in a new row (with the same 'File page number').

1. Select the file(s) to be processed:
click Add files... and choose file(s) from a standard 'Open' dialog or highlight
file(s) in your usual File Manager and 'drag&drop' them onto the 'File pages'
table.
(Standard 'Ctrl+click' and 'Shift+click' hot-keys may be used for selecting
multiple files.)

o If you have selected 'Music part extraction', EscapeE will access the file and

display images of its page(s) for editing: see Music part extraction .
Otherwise 

o EscapeE enters the details in the 'File pages' table directly.

You will see the table of files and pages build at the foot of the wizard. The wizard
will take care of the positioning, rotation and ordering of pages dictated by the
chosen layout automatically.
To add more clippings from other files to the document, simply repeat this step.

2. Further features may be accessed by clicking the More... button:

o Add EscapeE fields 

Standard 'Open' dialogs are displayed for you to select a file and its EE file.
You may opt to:

use the Existing... fields, or 

set up New... fields.

o View fields 

Displays the Trimming dialog with any existing field(s) set up in the Options
editor .

o Text... 

Enter the text to be placed on the page: see Setting up text .

o Split up... 

When extracting music parts, the split between choirs  is deemed to occur
when there are no bar-lines joining the staves, other that at the start of the
line.

o Delete parts 

Opens 'Delete parts' dialog: enter the range of music parts to be removed,
e.g. 3-5.

o View IDF in EscapeE 

Runs another EscapeE and displays the IDF document in its window.

o Re-paginate  

Remove all page breaks 

Break at original page breaks 
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3. Select clip-regions to be extracted:

o Click Trimming... – see Trimming options  or 

o Right-click a table-row to display the pop-up menu then choose:

Show clip-regions – see Page editor  or 

Edit the options – enables you to edit the Element options box directly.
E.g.:
/WIDTH 8.2667 /HEIGHT 11.6933.

Show file in EscapeE – Select a clip-region in the newly opened
EscapeE window, and, while holding down the Alt key, 'drag-and-drop' it
onto the file-table.

The 'Options' cell of the selected table-row is updated with the clip-region's
parameters. If more than one clip-region has been set up from a page, extra rows
containing their details are added to the table.

4. To delete a clip-region from the file-table, click on its row in the table to select it,
then:

o click Remove or 

o right-click and choose Remove from the pop-up menu.

5. To change the order of the clips in the file-table, select it then:

o click Move up or Move down or 

o right-click and choose Move up or Move down from the pop-up menu.

6. Click OK. The IDF editor opens with the IDF code for the document completed.

o You may make further changes to the document by editing the IDF: see Text

mode  and Tree mode .

7. Click Save or Save as....
Enter a File name for the file, then Save as type IDF files. 

The Composite document IDF file is created and displayed in EscapeE.

Links
Composite document wizard  
Trimming options  
Page editor  
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Booklet

On the Composite document wizard , select Booklet layout from the drop-down
list.

When forming a Booklet, up to four clip-regions are placed on each sheet of paper  –
two on each side. If the clips' orientations are portrait then the Booklet should be
printed in Landscape and vice versa. EscapeE rotates, scales and places the clips on
the sheets such that, when folded, they read like a book. The default Scale factor is
0.7071 – the optimal value for 'A' series papers. For example, A4 paper folds into an

A5-size booklet. In the special case of a two-page booklet, both pages would be
printed beside each other on one side of a single sheet (in effect 'simplex').

In this example, a 7-page portrait booklet is constructed from two
landscape sheets of paper, folded in half. The paper is always printed
in duplex, so that the 2nd, 4th, 5th and 7th pages are on the 'back' of
the sheets (there is no 8th page, so its half-sheet is blank).

Multi-column

Clip-regions may be formatted into columns within each page.

On the Composite document wizard , select a layout from the drop-down list:

o 1 column 

o 2 columns 

o 3 columns 

o 4 columns 

Multi-column pages are normally filled by placing one clip-region after
the other down the left-hand column to the foot of the sheet then
continuing in the next column to the right. A new sheet is started
when there is not enough room at the foot of the right-hand column to
fit in the next clip-region. (E.g. news-sheet.)

Alternatively, the columns may be Interleaved. This allows the sheaf
of sheets to be cut into single-column stacks of single-column pages
in page-number order. EscapeE calculates the total number of
columns in the document and formats the clip-regions such that left-
hand column of every page would be filled before starting the next
column on the first page. (E.g. long list of items.)

Further options may be set up from the Trimming  dialog:

In the 'Margins' panel, enter a width in the Left edit-box and a height in the
Right edit-box.
In the 'Gaps' panel, enter a width in the Column edit-box and a height in the
Row edit-box.

Links
Paper types  
Composite document wizard  

344

361

344

354

361

344



349IDF wizards

Close packed

On the Composite document wizard , select close packed layout from the drop-
down list.

When the Close packed layout option is selected and Files added , EscapeE
automatically draws clip-regions around non-blank objects such as lines of text. These
clip-regions are rectangular and trimmed of blank (white) pixels. They are placed one
after the other down the page(s) with no vertical space between clip-regions.
This is useful for gathering lots of disparate pieces of information together in the
minimum of space as a resource document, rather than as a finished document for
general publication.

You may add 'Margins' to a Close-packed document from the Trimming dialog: 
enter a width in the Left edit-box and a height in the Right edit-box.

Links
Paper types  
Composite document wizard   
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Music Part extraction

This layout option separates a full score into sets of pages for individual 'Parts'.

1. Select Music part extraction from the drop-down list of layouts and set up the
document's parameters, see Composite document wizard .

2. You may specify how choir parts are to be assembled in the score. Click Choirs to
open the 'Defining choir parts' dialog.

o Key-in part-numbers to define each range e.g. 1-4.

o use a semi-colon as separator between ranges e.g.

1-4;5-8;9-14 

3. You may click Bar numbers to label the first bar of each staff its bar number or 
click Number staves to label the staves in the order that they are retrieved from
the File pages table . Or 
Clear both check-boxes (the default).

4. Click Add files... and choose a music file from a standard 'Open' dialog.
EscapeE will make TIFF images of each page of the music file and then display

its first page in the Trimming  dialog's Page editor .

5. Set up Part extraction:

Any blocks of text or staves that EscapeE detects will
be shown enclosed within coloured boxes. Each box
denotes a clip region and may labeled with a number
or letter on the right.

Size, position, labels and number of Parts can be
edited here, either now or later by re-opening this
page-editor: see Editing a composite document file .
In this example there are six pages containing
systems of four Parts, numbered 1 to 4, for extraction.
Note the double-headed arrow icon over a red box
edge: this demonstrates the mouse being dragged to
move that box's boundary. Further editing functions
may be accessed from a pop-up menu : hover the
mouse over a box and right click.

6. When you have finished editing the page, click OK to show the next page: it may
be edited  straight away or later. Repeat the showing/editing of each 'next page'
until the last page is done, then click OK to close the Page-editor.

7. Click OK; see Closing the wizard .
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EscapeE shows the first page for Part1:

The pair of Stave numbers shown on the left of each staff indicate
its original location. E.g. staff "2/1" is the first system on page 2
of the original score.

You may use the 'Next page' button to step through the all the pages created
by the IDF file. In this example, pages 1 and 2 are for Part 1, pages 3 and 4 are
for Part 2, etc..
Thus the last staff on (last) page 8 is for the last line of Part 4, from the original
6th page's 2nd system:

Links
Composite document wizard  
Page editor  
Trimming options  

344

352

354



IDF wizards352

Page editor

To display the Trimming  dialog's Page editor, open  or re-open  the
Composite document wizard, right-click a row of the File Pages table  then click
Show clip regions.

The Page editor opens with the clip-regions outlined in a window below the Options
editor  panel.

The Scale at which pages are shown is set up in the Options editor panel: 300%, 200%,

150%, 100%, 75%, 50%, 33%, 25% or Fit window (the default).

To draw a clip-region

In the Page editor  window:

1. Use the mouse to drag out the area of the page to define the clip-region's
boundaries then click OK.

2. You will be prompted to annotate the clip:

o If it is a music part , enter the number of the part.

o If it is a Header (repeated at the top of every page) enter H.

o If it is a Footer (repeated at the bottom of every page) enter F.

o Otherwise enter 0 or leave blank.

3. Click Yes.

To bring a boundary into view at your chosen Scale , press an arrow key: 

Arrow up  top boundary

Arrow left  left boundary

Arrow right  right boundary

Arrow down  bottom boundary

To adjust a boundary's position click on a boundary line then drag and release the
mouse button when the line is correctly placed. (The mouse position is shown on the 
Options editor  beside the Units drop-down box.) 

To shrink the boundary (trimming the white  line(s) bordering the inside edge of
the boundary), hold the Shift key down and press the appropriate Arrow key .
If there are no white lines bordering the boundary, the boundary skips to the next
white line outside the colored content. On an area of text, for example, pressing of 
Shift key with Down key steps the boundary up the to the next line of text.

To expand the boundary so that it includes any white  line(s) immediately outside
that edge of the boundary, hold the Ctrl key down and press an Arrow key .

 Tip:  by default, a line is deemed to be white if it contains no more than 3 colored
pixels. To optimize this setting, use the Threshold spin-box arrows.
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Editing options

Right-click inside the boundary line of a clip-region to display a pop-up menu of
editing options.

New page
Not new page
Front page

See Mail merge wizard .

Add field
Ctrl A 

Use the mouse to sweep out the new clip-region then
click 'Add field'.

Delete field Tip: it is often easier to 'Delete field' then 'Add field'
than to drag a misplaced boundary line to its proper
position.

Trim field Remove any horizontal and/or vertical white  lines
bordering the contents of the clip-region.

Align field See Setting up text .

Join to field below
Ctrl J 

Merges clip-regions.

Rotate field Enter the number of degrees to rotate the top-left
corner of the clip-region counter-clockwise, then click
'OK'. 

Field is a Header
Ctrl H 

Clip-region (labeled H ) repeated at top of each
page.

Field is a Footer
Ctrl F 

Clip-region (labeled F ) repeated at foot of each
page.

Set caption Enter the caption text in the edit box then click 'OK'.
(The text-origin is taken from the position of the
mouse on right-click.)

Tip: the mouse coordinates are shown below 'Scale'
on the Trimming options  panel.

Set Clip Region

Markup selected area
Ctrl M 

To return to wizard , click OK.

Links
Trimming options  
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Trimming options

The Trimming dialog is accessed from the Composite document wizard: see
Composite document wizard  or Editing a composite document file . It contains an
Options editor  panel and a Page editor  window.

To open the Trimming dialog, right-click a table-row to display the pop-up menu
then choose Show clip-regions.
Click OK to close the Trimming dialog and return to the wizard .

To open just the Options editor  panel click Trimming....
Click OK to close the Trimming dialog and return to the wizard .

Options editor

Select the Units used in the Trimming dialog from the drop-down list:  choose
from PIXELS, CM, MM, INCHES, 1/300 inch or 1/600 inch.

The mouse position is shown alongside.

Select the Scale at which pages are shown in the Page editor window: choose
from 300%, 200%, 150%, 100%, 75%, 50%, 33%, 25% or Fit window (the default).

Changes made with the mouse in the Page editor are fed directly into the Options
editor. Changes made in the Options editor can be seen into the Page editor by
clicking Apply. If there are no clip-regions shown in the Page editor when 'Apply' is
clicked, EscapeE defaults to displaying the clip-regions which it would have selected
for a Close packed  layout.

These boxes log the part of the original document to be extracted as a clip-region:

Left Distance between left side of clip-region and the origin of the 
container  element (typically the top-left of the PAGE or PRINTABLE
page): see CLIPX .

Top Distance between top of clip-region and the origin of the container
element: see CLIPY .

Width Width of clip-region: see CLIPWIDTH .

Height Height of clip-region: see CLIPHEIGHT .

There are a number of specialist options for music part extraction, see below .

344 357

354 352

344

354

344

349

276

299

299

299

298

355



355IDF wizards

Music options

EscapeE recognizes many features of musical notation and can mark out each staff as
a clip-region automatically. (You may also create/edit the clip-regions manually using
the mouse in the Page editor – see Music part extraction .) You can choose which
features are to be included in these clip-regions in the Options editor:

Has lyrics Tick box to expand each clip-region to include lyric text.

Headers Header text can be recognized and labeled (H).

Tick box to outline a clip-region around each header found.

Footers Footer text can be recognized and labeled (F).

Tick box to outline a clip-region around each footer found.

Tacets Tacets can be recognized, labeled (Tacet), and the clip-region

given a gray background.

Tick box to copy the line of another part if tacit.

Calculate bar
numbers

Recalculates the bar number for the piece of music it is
splitting up.

Field The field-number in the spin-box identifies the clip-region
which is outlined in red in the Page editor window .

To select a different clip-region, click the up/down arrow
buttons.

In the X / Y boxes, enter the horizontal / vertical distances
to step from one clip-region to the next .

The size of the field is shown in the Width and Height
boxes. Edit these values as required.

Choir Parts Combines the staves together in 'choirs' as specified in the 
Splitting  dialog.

Scanned Tick if the input file is an image produced by a scanner (rather
than constructed precisely by a program). The image is likely
to appear with various degrees of shading and you may need
to adjust the thresholds and alignment.

Threshold A number in the range 0 to 254 that sets the point below

which gray is deemed to be 'white'; a value equal to or above
this is deemed 'black'.
(Default is blank.)

Min stave The minimum number of black pixels required to recognize a
stave line.
(Default is blank.)

Max black between The maximum number of black pixels allowed between 
Systems of staves and between individual Staves.

(Default is blank.)

Auto-align Automatically rotate the graphic to correct slight
misalignments of staves to the horizontal, or 

Angle Enter a number (in degrees) to correct gross misalignments of
staves from the horizontal.

Links
Page editor  
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Setting up text

The 'Text' dialog is used for adding page numbers  and "more" text to the pages of
clippings, see File pages table .

1. Enter the text in the window (standard editing options such as cut, copy and
paste may be used).

o For page-numbering use a # character to indicate the insertion point for the
digits, e.g. page #.

2. Click Font... to display a standard Font dialog and set up the font (family, style,
colour etc.) to be used for the number string.

3. Select an Alignment option...

o Top Left 

o Top Centre 

o Top Right 

o Alternate Top Left/Right 

o Bottom Left  (the default page numbering option)

o Bottom Centre 

o Bottom Right 

o Alternate Bottom Left/Right or 

o None (the default for switching off page-numbering).

4. ... relative to one these Bounds areas:

o Group 

o Page 

o Printable area or 

o leave blank (the default).

5. Click OK.
The dialog closes and returns to the Composite document wizard .
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Editing a composite document file

You may fine-tune the IDF code that extracts the clip-regions when you first set up
the Composite document  or later, by re-opening the wizard  or using the IDF
editor .

Re-open the wizard

1. Select Edit control file from the Edit menu.

2. Click Yes to confirm that you would like to edit the Control file using the
wizard: the Composite document wizard opens.

3. Select the first of the rows in 'File pages' table for editing:

o Click Trimming... to edit the clip region set-up, see Trimming options  or 

o Right-click then

Edit the options: enter the clip-region definitions directly in the edit-
field or 

Show clip regions and use the mouse to define the clip-regions in
the Page editor .

4. Click OK when you have finished editing the page.

5. Click OK to exit the wizard.

Using IDF code

1. Select Edit control file from the Edit menu.

2. Click No when the 'Confirm' dialog prompts you to edit the Control file using
the wizard.

3. The IDF editor opens: see Tree mode wizard  for details on editing IDF
Elements  and IDF Attributes  for IDF syntax.
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Mail merge

Mail merge is normally used to personalize otherwise standard letters by adding
details (such names and addresses) read from a data-file.

How to set up the letter and select the data to merge into it: see Mail merge
wizard  

Setting up Advanced options – printing, orientation etc.: see Mail merge options
 

Changing the fields, text and letter files: see Editing a Mail merge file  

List of suitable Paper types  

Links
Composite document wizard  
Mail merge wizard  
Text mode wizard  
Tree mode wizard  
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Mail merge wizard

1. Click New... and select IDF Document wizard from the 'File' menu. Or 
Press Ctrl Z keys.

2. Choose Mail merge then click OK.

3. Enter or Browse to select, the CSV file containing the data to be used.
The fieldnames found in this file are listed in 'Select the data for this field' list
box, in the order in which they occur in the CSV.

o To list fieldnames in alphabetical order instead, tick Sort.

o Default PREFIX for fieldnames is set to CSV_.

4. Enter the Paper type  for the letter.

5. The tabbed notebook initially shows 'Page 1': enter, or Browse... to select, the
Name of the file containing the letter or text for this page.
This supplies the fieldnames to the 'Field giving the position on the page' drop-
down box.

o If the file contains more than one page, enter the number of the page

containing the required text in the Page edit box.

o Click Advanced... to configure further options: see Mail merge options . 

6. Select a Field giving the position on the page from the drop-down list of field
names found in the letter file, e.g. TOWN.

o Specify the origin of the field:

Choose one of these horizontal positions from the drop-down list: Left,

Centre, Right.

Choose one of these vertical positions from the drop-down list: Top,

Centre, Bottom, Baseline.

o Select the name of the data-field to provide the data-value for the selected

field position from the Select the data for the field box.
This enters the data field names from the CSV file into the Text edit-box.
Data field names are shown in upper case with a prefix , enclosed by
braces, e.g. {CSV_ADDRESS3}. Additional text may now be typed into the Text

edit-box (the  character indicates a place where the Text editor has wrapped
the text to fit the window.)

Repeat this step for each field on the page.

7. Click Font... to open the standard 'Font' dialog and set up the font to be used for
the text added to the page. In addition, these parameters may be set up directly
in the Mail merge dialog:

o The font's family and style, e.g. Arial,Bold.

o The font's Point size, e.g. 8.4.

o The Vertical spacing of the lines of text in Points.

8. If another page is required for the letter, select the New page tab then repeat
steps above . See also Editing a Mail-merge file .
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9. Click OK. 
The IDF wizard opens showing the mail-merged letter's parameters ready set up.

10. Click Save to display the standard 'Save' dialog. Name the file then click the
Save button. 
The IDF file is created and displayed in EscapeE.

Links
Mail merge options  
Editing a Mail merge file  

Mail merge options

A job may require several documents to be generated from each data record: for
example, an invoice and a delivery note. You may be set up these extra documents in
the 'Mail merge options' dialog.

1. Set up the first document in the Mail merge wizard  then click Advanced. The
'Mail merge options' dialog is displayed.

2. Select the printing mode for the document from the drop-down list:

o SIMPLEX – default

o LONG – Long-edge binding duplex

o SHORT – Short-edge binding duplex

3. With 'Copy 1' tabbed page on view, select the Paper to be used from the drop-
down list (see Paper types ).

4. Select the Orientation of the paper from the drop-down list:

o P – Portrait (the default) or 

o L – Landscape or 

o I – Inverse (portrait rotated 180°) or 

o J – Journal (landscape rotated 180°).

5. Enter the number of the Input tray to be used.

6. Enter the number of the Output bin to be used.

7. Enter, or Browse to select, the file containing the letter or text for this page in
the Front overlay edit-box.

o If duplex ('long' or 'short', see above ) is configured, enter (or Browse to

select) the file containing the letter or text for this page in the Back overlay
edit-box.

8. If another document is required for the job, click New copy tab. A new document
set-up is shown as 'Copy 2' and another 'New copy' tab appears. Repeat the
steps above  to set up the new document.

9. Click OK.

 Tip:  click Delete copy to remove any unwanted "copies"; click the last tab to add a
'New copy' tab.

Links
Editing a Mail merge file  
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Editing a Mail merge file

To edit an existing Mail merge  IDF file in EscapeE:

Open the IDF file and select Edit control file from the 'Edit' menu.
You will be prompted to edit using the wizard: choose

o Yes to reopen the Mail merge wizard – see below , or 

o No. The 'Source' page of the Console notebook will be displayed and may be

edited there like any other IDF source code.

Editing in Mail-merge wizard

1. To edit the fields giving the position on the page, click Edit fields.... The file
containing the letter/text for the page is opened in another EscapeE window.
Edit its fields as appropriate then close the window to return to the wizard.

o Click Reload: the wizard updates its field definitions.

2. To edit the file containing the letter/text for the page, click Edit letter.... A rich-
text editor such as WordPad® is displayed.
Open the appropriate letter file, then edit, save and close it as usual to return to
the wizard.

3. Similarly, to create a new letter/text for a page, click New letter... to open the
rich-text editor.
Set up a new filename for the letter file, then edit, save, and close it, returning to
the wizard.

4. To remove a page from the letter, select its tab and click Delete page.

Links
Mail merge  

Paper types

When setting up a Composite document  or Mail merge  using a wizard, enter one
of these values for the paper type:

A0
A1
A2
A3
A4
A5
A6

ARCHA
ARCHB
ARCHC
ARCHD
ARCHE

ARCH30

LETTER

LEDGER

ANSIC

ANSID

ANSIE

EXECUTIVE

LEGAL

Links:
PAPER  
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Other documents

IDF wizards documents may be customized using its dual-mode editor:

To type in the IDF script directly see Text mode wizard .

Tree mode wizard  presents an interactive schematic view of the IDF script. Its
"tree" structure provides an overview which is especially convenient when editing
complex documents.

Clicking on an element in Tree mode displays the Properties editor  – just
choose the options from its lists and EscapeE writes the IDF script for you.

Links
Composite document wizard  
Mail merge wizard  
Text mode wizard  
Tree mode wizard  

Text mode wizard

To build a new document

1. Click New... and select IDF Document wizard from the 'File' menu. Or 
Press Ctrl Z keys.

2. Choose Other then click OK.
This opens the schematic editor (see Tree mode wizard ) and writes the IDF
code necessary to construct a default document containing one blank page.

o To add to the code that EscapeE has created, select Text mode. The window

switches to listing the IDF code to construct a default new document .
Enter the code for your document between the <IDF> and </IDF> tags: see

IDF syntax  for descriptions of IDF elements and attributes.

3. To apply a digital signature  to the document, tick the Sign check-box.
You will be prompted to select a Container and enter a Description on saving
the document.

4. Click Save and set up an appropriate File name, folder and type in the standard
'Save as' dialog.

Default new document

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<IDF ENCODING="UTF-8" UNITS="DOT600" FONT="Arial" POINTSIZE="10"
ORIENT="P">
<PAGE/>

</IDF>

Links
Tree mode wizard  
IDF elements  
IDF attributes  
Sample IDF scripts
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Tree mode wizard

In Tree mode, the wizard displays the document's code schematically. For a new
document the window defaults to showing an empty page within the IDF document:

Editing an element

1. Display the Properties editor by:

o Clicking on an element  – it will expand/collapse to show/hide any elements

contained within it. Or 

o Right-click on an element and choose Properties... from the pop-up menu.

2. Set up the attributes and values for the element.
For example, clicking "PAGE" in the schema selects it:

and displays the Properties editor for the PAGE element  – see example in
Properties editor .

3. When you've finished editing the file, you may click Save to update the existing
file with the edits or 
click Save as and create a new file containing the edits while leaving the existing
file unchanged since it was last saved.

 Tip:  if you intend to store all of the files cited in the IDF in the same folder as the
IDF file, tick Relative paths.

Links
Text mode wizard  
Properties editor  

279

287

364

362

364



IDF wizards364

Properties editor

The Tree mode  Properties editor lists all of the attributes  defined for the particular
instance of the selected element, with their values .

To define a new attribute for the selected instance of the element, just select it
from the drop-down list on the tool-bar at the top of the editor: it will be added to
the Attributes panel.

 Tip:  IDF supports dozens of attributes; rather than showing  All items in the tool-

bar's list, you may choose to show a reduced list of the most Common items or just a

list of the Defined items instead.

This is an example of the Properties editor for a PAGE element :

Type

The type of element is shown at the top of the Properties editor's Attributes  panel
(PAGE in the example  above). This may be changed by selecting the new Type
from the drop-down list alongside.

Attributes

The attributes (and their values ) for the selected element are listed below Type .
In the example  above, the attributes shown in the toolbar's drop-down list have
been restricted those most commonly used only, for convenience.

Values

Attributes of the selected element are listed in the panel with their values alongside.
Many attribute values can be edited by choosing from drop-down list (e.g. Units ),

some can be edited by keying the new value directly into an edit box (e.g. Left ),

and those which are underlined can be clicked to display dialogs (e.g. Font... ).

When you have finished setting up the properties of the particular element, click
the OK button on the toolbar. Any alterations which you have made in the
Properties editor will be coded into IDF automatically. Or 

Click Cancel to ignore the alterations to that element and close the Properties
editor.

Links
Tree mode wizard  
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Running tasks

Experts may set up custom "jobs" and "shortcuts" and run EscapeE from the
"command line".

How to create shortcut icons to run tasks manually or automatically: see 
Shortcuts - the easy way to construct a command line  

How to construct command lines to run tasks: see Run from the command line  

How to set up and run jobs from customized INI files: see Run custom jobs  

About the GetExitCodeProcess call used by programs running EscapeE

automatically and the /PIPE command: see Run from a program .

(See Running EscapeE  for general usage instructions.)
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Shortcuts

You may change the EscapeE Configuration options and keep them as your default
set-up using Save, see Setting General export options . In addition, you may set up
one or more "Shortcuts" with alternative configurations, each customized for a specific
task. You may choose to place each of these shortcuts as an icon on your Start menu,
desktop or elsewhere: see To create a special shortcut icon , below.

If you wish to run EscapeE continuously and monitor a particular folder for files with
other extensions, you can add the special icon to the Windows StartUp group. See To
run EscapeE continuously from startup , below.

Expert users can set other options from the command line and to do this a special
icon can be created manually, with options added to the command line and the icon
can then be moved to the StartUp group. See Run from the command line .

To create a special shortcut icon

1. With EscapeE running, select Configuration... from the 'Options' menu.

2. Set up options as required on the tabbed pages (Printer , Viewing , TCP/IP
, Layout , Log file , Images , Automatic , General  and its further
format-specific options).

3. Click Shortcut...; the commands to carry out the special options are already
entered into the 'Arguments' box.

4. The default setting is to create the icon in the Windows Start menu, as shown
in 'Shortcut location'. To change the location of the shortcut, select:

o Desktop to create an icon on the desktop, or 

o Elsewhere and click Browse to select another path.

Every time you run this version of EscapeE the options you specified for it will be
used.

To run EscapeE continuously from startup

With EscapeE running, select Configuration... from the 'Options' menu.

1. On the Automatic page, set the folder you wish to monitor using wildcards .

2. Set any other options, such as the output format  and the time interval
between checks.

3. Click Shortcut....

4. Select Elsewhere and click Browse. 

5. Locate the Windows StartUp folder.

EscapeE will automatically run at startup and monitor the folder you choose.

Links
Run from the command line  
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Run from the command line
Applies to EscapeE Professional and Batch Automation editions  only

Advanced users can run EscapeE from the command line of the program for batch or
unattended usage. The Shortcut dialog provides a convenient way of setting up
options, see Shortcuts - the easy way to construct a command line.  It is also
possible to save a configuration as an *.INI file (use Save As... from the Options

menu's Configuration  dialog) and invoke it later using the syntax:
ESCAPEE ^^configname

The name of a file may be specified on the command line and may be followed by a
space and one or more options .

A wildcard specification may be given if desired, e.g.: 
ESCAPEE *.PRN or ESCAPEE C:\TIFFS\

which is equivalent to ESCAPEE C:\TIFFS\*.LSH 

To extract file data and incorporate it into the folder name you need to give an output
file specification that includes an equals sign, which will be substituted by the data
extracted from the field. For instance
escapee dir*.pcl /tiff /outspec s:\escapee\=\*.tif /mkdir

processes all PCL files with names starting with DIR and converts them to TIFFs, then
puts the result in a folder dependent on the field.

The format, the input specification and the output specification are interconnected.
If a format is specified on the command line then any default output specification is
ignored. For example, to create a PDF from the command line you need to specify the
option explicitly:
ESCAPEE c:\temp\test.pcl /PDF

(Note that specifying ESCAPEE c:\temp\test.pcl just displays the file.)

The default input and output specifications are mainly of use in continuous (timed)
mode: see To run EscapeE continuously from start-up  and Setting the Automatic
export options .
If you specify an output format then you should also specify the input file name (or a
wildcard specification) and if you wish to send the output to another folder you must
also specify the /TO  command (not /OUTSPEC  which is merely the default, and

therefore ignored in this case).

For example:
"C:\Program Files\RedTitan\software\ESCAPEE.EXE" ^^"c:\INIfiles
\ideatiff.ini"c:\inputfile.pcl /TO c:\output\*.tif /BORDER 0 /TIFF /X

(The purpose of the /X  command is "exit after processing the file or files specified

on the command line".)

Printing

To send output to a printer, use the /PRINT  command. For example,

ESCAPEE TEST.PRN /PRINT

would use the default printer, whereas
ESCAPEE TEST.PRN /PRINT 'My printer'

would use a printer named My printer. To ask the user to select a printer, use the ?

option:
ESCAPEE TEST.PRN /PRINT ?

Further options may be appended, e.g.
ESCAPEE TEST.PRN /PRINT 'My printer,S'

scales the page to fit the paper.
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Background processing

There is a /DISPLAY  option to show the file in EscapeE and also a /WINDOW HIDE

option to run minimized in the background while processing, instead. When hidden,
the program is not shown on the taskbar, so to close it:

1. Open your system's 'Task Manager' (Ctrl+Alt+Del).

2. Scroll down to the list of 'Background processes' and select

 View and Transform (32 bit)

3. Click End task.

 Examples: Command lines

The following topics define the syntax of the options:

 Command line syntax

 EscapeE configuration symbols

 Tips

 If TIFF generation is selected and there are some fields selected, then a log file in
CSV format will be generated. The first field (called FILENAME) contains the full file

path of each generated TIFF image and the selected fields are extracted from the text
for each page.

 The option(s) used for a job may be stored in an 'options file' and invoked simply
using the /OPTIONS  syntax, for example:
ESCAPEE /OPTIONS myoptions.OPT

 IDF note

IDF files  may be run from the command line just like any other EscapeE compatible
file, e.g.
escapee C:\Reports\Winter.idf

You may also specify a default file to supply data for the IDF file: add a comma and
the filename, e.g.
escapee C:\Reports\Winter.idf,North.txt

Any FILE  or INCLUDE  statements in Winter.idf which do not specify a filename

will use the default file North.txt.

Links
Shortcuts - the easy way to construct a command-line
Running EscapeE from a program
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Run custom jobs
Applies to EscapeE Professional and Batch Automation editions  only

Experts may set up custom jobs by creating  handy lists of the specialized
configuration (.INI) files likely to be needed in the job. You may then select  the

appropriate list file at the start of the job and simply choose  the INI file from the
list whenever you need to switch to a different configuration file.

A job list files may be saved as a simple .LOF file or as a .JOB file with Comments,

see Technical Notes .

Selecting a job

1. Display the General page of the 'Configuration options' dialog by selecting
Configuration from the 'Options' menu or by pressing function key f8.

2. Click Job types to display the 'Job selection' dialog.

3. Choose the job from:

o a Folder 

The 'Folder containing ini files' dialog opens: choose the appropriate Drive
and Folder then click OK. Or 

o a List of ini files 

The 'Job configuration files' dialog opens: select the appropriate .lof or

.job file then click Open. Or 

o an Ini file 

The 'Job configuration files' dialog opens: select the appropriate .ini file

then click Open.

o Alternatively, opt for None to cease running custom jobs. EscapeE reverts to

using the default RT.INI file.

The current configuration file is shown at the foot of the Configuration dialog,
e.g.
c:\ESCAPEE\SOFTWARE\JOBS\INVOICE1.INI 

4. Click Save.

Choosing an INI file

Having all of the relevant configuration (INI) files listed in one job file simplifies the
choosing and switching between customized INI files while processing the job. With
the job file selected :

1. Click Choose job configuration from the 'Options' menu.

2. Select the required job configuration (.INI) file.

3. Click Open.

 Tip:  you may also view .LOF job files using this dialog by choosing Lists of files
(*.lof) from the 'Files of type' drop-down list and .JOB files by choosing All files.
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Editing a job

1. Select Choose job configuration from the 'Options' menu.

2. The currently selected Job type (.ini file) path is shown: to choose a different
job click Browse and select it from the 'Job selection' dialog.

3. Click Edit to display a Text editor window. The first line of this code is
:\ESCAPEE JOBS

4. This line is followed by a list of job file paths, one per line.

o A Comment may be appended to each line provided that the file is saved

as .JOB instead of .LOF.

An * placed between the path and the Comment means that only the
Comment is displayed.

See Technical notes  below.

5. Edit the list using the Text editor's functions  and when done click Save (or
Save As...) on its 'File' menu.

6. Click the 'Exit'  button to close the Text editor.

Technical notes

Custom job files must begin with the identifier and option
:ESCAPEE JOBS 

LOF type files follow this with a simple list of INI file paths; if a path contains
space(s), the path must be enclosed in quotes.

 Users select from this list of file paths.

JOB type files may contain Comments to aid the identification of appropriate INI
files by Users.
Type in the list of INI file paths as for an LOF job file. To add a comment to an INI
file in the list, enclose its path in quotes and add the text string for the Comment
on the same line.

 Users see a list of the file paths and their Comments.

o Alternatively, the Comment may be preceded by an asterisk to suppress the file

path.
 Users see just the list of Comments.

See LOF details ,  Example .LOF files  and Example .JOB files .

Run from a program

EscapeE may be run and controlled from an external program such as EEview
using the /PIPE command.

When calling EscapeE from another program the /X  option must be specified to

cause EscapeE to exit after processing the specified file(s). For example:
c:\redtitan\software\escapee.exe d:\data\myfile1234.pcl /pdf /x

calls EscapeE, converts myfile1234.pcl to PDF format then exits EscapeE.

Return codes can be obtained using the Windows GetExitCodeProcess call. The

code is normally zero; non-zero codes indicate errors, see Error return codes . If
error(s) occur when running in continuous mode or when the /X option is supplied,

they are noted in an error-log file, see Command line option /ERRORLOG .

To suppress the reporting of return codes that would not affect your program
adversely, use Command line option /ERROROK .
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/PIPE command

Specify the name of the 'pipe' to be used for communication using syntax:
/PIPE pipename

The batch commands  in the table below can be sent to EscapeE on the pipe and will
return the result:

'OK' if successfully processed or 
'BUSY' if EscapeE is not idle when the command arrives.

ALPHA a Set the alpha-blend transparency value (1-255).
CLOSE Close the current file.
EXPORT opts Export the current file using the specified options, which can

be any of:
/TIFF p  Output in TIFF format, where p = 1 for single-page, 2 for

multi-page TIFFs.
/PNG p  Output in PNG format.

/PDF p  Output in PDF format with options as in PDFOPTS.

/PCL p  Output in PCL format with options as in PCLOPTS.

/PS p  Output in Postscript level 3 format with options as in PSOPTS.

/PAGE n-m or /PAGES n-m  Specifies page range (default is just the

current page).
/RES n  Output image resolution in dpi.

/RUN prog  Specifies a program to run, optionally with parameters all

in quotes. If prog is NO then do not run a program.
/TO fn  Specifies an output file name otherwise defaults to input

name with an appropriate extension.

N.B. the parameters for options such as /PDF are optional and
if omitted then the currently configured EscapeE options are
used. However in this case the next option, if any, must start
with a / or a ! character. The parameter may be in quotes so

the null string '' is equivalent to omitting it.

FIND s Find the specified string 's'.
MENU b Specify whether the Tool-bar and menus are to be shown or

not.
Y = Yes (default)

N = No, do not show.

OPEN f Open file f.
PAGE p Go to page p.

PCL [p] Export to PCL; optional mnemonic codes or numeric flag
parameter(s) may be included.

PDF [p] Export to PDF; optional mnemonic codes or numeric flag
parameter(s) may be included.

STATUS Returns the last error message stored by EscapeE and clears it.

TIPS n Whether to show the console window or not on encountering
errors.
n = odd: show the console window;

n = even: do not show the console window.

WINDOW s,l,t,w,h Specifies state of window on start-up:
s  0=Normal, 1=Minimized, 2=Maximized

l  Left offset in pixels

t  Top offset in pixels

w  Window width in pixels

h  Window height in pixels.

X Exit from EscapeE.
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The commands in the table below can be sent to EscapeE on the pipe and will take
effect immediately, irrespective of whether EscapeE is idle or not. All immediate
commands  begin with the ! character.

!DISPLAY b Sets the display mode, where parameter b can take the

values:

Y = Yes, display mode on or 
N = No, display mode off.

Defaults to returning Y (on) if no parameter is specified.

!PAGE Returns the number of the page currently on view; 0 if none.

!PROCESSID Returns EscapeE's process ID as a decimal number.

!VERSION Returns the version number of the EscapeE being run.

!X Abort.

!ZOOM Change the zoom factor, where:
1 corresponds to 600 dpi,

2 corresponds to 300 dpi

etc.

Links
Error return codes  
Run from the command line
Command line syntax
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Troubleshooting

In reality, a lot of documents contain imperfect code. A document which has been
rendered well on one printer may cause problems on another printer. EscapeE is able
to read a number of formats (see About EscapeE ) and is powerful enough to
recognize aspects of the document likely to cause difficulties.

When this happens, EscapeE displays a warning triangle on its menu-bar and logs the
error in the Error messages  page of the Console notebook.

To show a list of specific types of error, click Problems from the Help menu or 
click the warning triangle:

o A tick indicates the error found: click to view the appropriate topic in this

Help section.

o Click Clear the errors to remove ticks and messages from the Log.

These topics relate to the specific problems listed:

A plugin has been configured for a field but it is not enabled for use: see Plugins
are disabled

The page may contain marks in the unprintable area: see Printing beyond page
bounds

Fonts not downloaded: see Missing fonts  

Unknown, unsupported Ignored fonts or images  

Font just doesn't look right: see Poor text appearance  

Faulty or Unsupported download font format

Hewlett-Packard  Graphics Language printer-driver problems: see HP-GL

Dealing with printer-specific HP PJL  commands: see Printer Job Language  

Handling Kyocera Prescribe  commands.

Document specifies the use of an Unsupported printer language

Incorrect command line: see PDF output file not created

Obsolete or undocumented PCL commands; PCL commands with no useful effect:
see Unknown/Ignored command  

You can access these topics by selecting the Problems item on the Help menu; see
also Field problems,  Ignored fonts, images, shading , Handling fonts

If you have tried these suggestions but still cannot resolve the problem, you can
send us an example file: see Problem reporting.
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Plugins are disabled

 One or more fields in the document have been set up to use a Plugin, but Plugins
have not been enabled.

If you have Plugins installed on your system already, simply clicking the plugins
button on the Tool-bar enables  them. (If a field uses a plugin and plugins are not
enabled by default then you will be prompted to enable them.)

If Plugins have not been installed on your system yet, you will need to enter a
permission code. This is supplied when you buy Plugins: please contact
sales@redtitan.com.

Links
Using plugins

Printing beyond page bounds

 Some elements on the page have been drawn partly or entirely outside the printable
area of the page.

If you wish to find out which items are involved then click one of the View |
Unprintable Area options  or View | Whole Page. Note that the offending element
might be text, line, shading or graphics and could even be white, in which case it
would not normally be visible. If you select an area by dragging the mouse, any white
elements will become visible against the blue background of the selected area. Note
that merely lowering the pen in HP-GL mode causes a dot to be printed and whilst this
may not be easy to see it can cause this problem to be signaled. The presence of this
problem does not therefore necessarily mean that the result of converting the image
will be incorrect even though some items may not be included in the output.

Missing fonts

 Some of the fonts used were not fully recognized because they were not downloaded
when the PCL file was created.

A font will not be recognized if it is a resident font not supplied with the standard 
EscapeE Product or if an incorrect selection sequence has been used. The Error
messages  page of the Console notebook will give extra information e.g.
Unknown font {esc}(9E{esc}(s0p18.91h10vs2b3T used weight 3 not 2 at byte 313

The first part of the message gives the complete PCL font selection sequence  that
was used to select the font and there may follow an explanation of the most important
reason why no exactly matching font was found. In the example above, a weight of 2
(semi-bold) was requested but a bold font was the best that could be found. Almost
all of the fonts in the standard set are of weight 0 or 3 so that requesting Courier
(typeface 3 in the example) with weight 2 is an error.

EscapeE will substitute the most closely matching font and, in most cases, this will
yield the same result as on the target printer. There is a fixed-pitch font set that can
be downloaded if required, and there is a font pack containing some of the rarely used
fonts that can be purchased for a modest sum – contact RedTitan
(sales@redtitan.com) for details.

Links
Handling fonts
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Ignored fonts or images

 Click Ignored fonts or images on the Help menu's Problems list to show the
errors

This may indicate that EscapeE has encountered fonts or images which it has been
configured to ignore, see Optimizing the output . Alternatively, it may have
encountered a download font in an unknown or unsupported  font format.

Poor text appearance

 This usually means that the wrong font is being used.

There are a number of reasons why this might be. You could try checking whether:

EscapeE has been configured to ignore fonts: see Optimizing the configuration .

A font substitution has been requested: see Font tables .

The font would have been resident on the target printer but EscapeE does not have
it: see To display resident fonts table .

There was a problem in reading a download font: see Handling fonts .

Unsupported download font format

 The font is in an unsupported format such as Intellifont, or is faulty e.g. has a bad
checksum.

HP-GL

'Hewlett-Packard Graphics Language'

All commonly used features of HP-GL are currently supported apart from those that
are only appropriate to a continuous-feed plotter. Some plotter drivers make
unjustified assumptions about the default configuration which can cause problems.
The default HP-GL palette is set to RGB when an IN (initialize) command is
encountered, but prior to that only a black pen (1) and a white pen (0) are defined. If
the appearance of the page is not correct, contact RedTitan for advice and for news
about current releases.

Links
Configuring the printer defaults
Command line syntax  
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Printer Job Language

 Printer Job Language commands are largely ignored, as they are printer-specific.
Contact the RedTitan support desk help@redtitan.com for more help.

You may opt to remove PJL  commands or to output PJL Comments  when
exporting pages in PCL , PostScript , PDF  and PDF/A  formats: see Setting
General export options .

The PJL_ prefix can be used to construct a composed string  for extracting data from

a PJL command: see PJL field prefix  feature.

Links
PJL Comments  
Preamble and PJL options  
Unsupported printer language  

Kyocera Prescribe

 Full support for KYOCERA  PRESCRIBE  printer description language
 commands is not currently available though certain commands such as BARC
(barcode) are implemented.

The character sequence !R! in a print-stream denotes to a KYOCERA printer that one

or more KPDL  command(s) follow; EscapeE displays a warning message when it
encounters this sequence. Normally, EscapeE is configured to skip over these
command statements, but in the unlikely event that the !R! occurs in the data – not
as a command but simply as text – you may select the 'Ignore' option 'Kyocera !R!':
see Setting General export options .

Contact RedTitan for news about the latest releases.

Unsupported printer language

 A PJL  command requested a printer language which is not currently supported.

EscapeE supports:

PCL 5 and its variants.

PCLSLEEK, including differing x and y resolutions.

PCL XL (also known as PCL 6) including embedded JPEG graphics. For information
about our products for processing PCL XL please contact help@redtitan.com.

 Tip:  If you created the file under Windows then try using a PCL5 printer driver
instead.

Links
Printer Job Language  

447 64

169 186 175 180

125

249

214

64

170

378

448 448 447

447

125

447

378

mailto:help@redtitan.com
mailto:sales@redtitan.com
mailto:help@redtitan.com


379Troubleshooting

PDF output file not created

A command line  of the form:
ESCAPEE c:\temp\test.pcl 

just displays the file rather than outputting it as you might expect. This is so that
double-clicking a file in Windows Explorer views the file rather than creating it.

To create a PDF  from the command line you need to specify the option explicitly
e.g. 
ESCAPEE c:\temp\test.pcl /PDF

Unknown/Ignored command

EscapeE ignores any PCL commands which would have no tangible effect, such as
switching between draft and letter-quality mode.

EscapeE also ignores PCL commands which it does not recognize. There is a huge
range of printers supporting different levels of PCL, and some of these make use of
obsolete or undocumented PCL commands. There are also a number of obscure or
rarely-used commands that have not been implemented in EscapeE. These unknown
commands will be ignored, which will not usually cause a problem, but if the
appearance is incorrect see Problem reporting  for details of how to send RedTitan
the file for analysis.

Problem reporting

If you have a problem to report concerning EscapeE:

1. Please say what version of EscapeE was used. This can be determined from the 
About  dialog or from the creation time of the escapee.exe file.

2. It helps if you give the Email a specific subject (perhaps mentioning the
filename).

3. Specify exactly what the problem is e.g. "On page 2 when converting file x.pcl to
PDF the text in the first box is in the wrong font".

4. If the file is very large and the problem occurs near the beginning of the file then
please do not send the whole file but use EscapeE's File | Save subset option to
extract the first few pages of the file. If you start at page 1 then the resulting file
is simply a copy of the beginning of the original file, so will show the same
problem.

5. If it's a specially generated file, please try to give it a unique and meaningful
name and an extension such as .PCL, .PRN or .PLT appropriate to the type of file.

6. If the file originated on a different system (e.g. a mainframe or UNIX ® system)
then if possible, before sending us the file, it would be a good thing to try
printing a few pages to ensure that the file has not been damaged in
transmission.

7. Please send the problem to help@redtitan.com rather than a particular person;
then if they are on holiday, unwell or very busy your problem will still be looked
at quickly.

Links
Troubleshooting  
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Reference

This section brings together technical details and examples for easy reference.

See Command line syntax index  for links to command line options listed in:

Command line syntax  – tables of command line options with descriptions 

How to set up an Options file  for repeat jobs.

Notes on setting up print option code and flag parameters on the command line;
syntax tables in mnemonic and numerical order: see Print option flags  

The environment symbols in the .INI file: see EscapeE configuration symbols  

About Error return codes , with a list of their values

Composite fields syntax summary  lists the conventions used for setting up
composite fields in EscapeE. It includes links to topics which describe the syntax
in detail

Bit-wise logic  operators &, |, ¬ used in composite field expressions

The element tags necessary to create DICOM documents: see Required DICOM
tags

About command line options and initial identifiers used in 'List Of Files' Control
files and Job files: see LOF details  

About Dynamic Linked Libraries and other file types: see Associated files  

Table of the file-formats EscapeE can read, create and export: see File formats list
.

About PostScript import/export, language levels and font type numbers: see 
PostScript: levels and types .

PCL tray number, Windows driver number and Output bin lists: see Tray and bin
numbers .

Fonts simulated for the printer and Windows® fonts: see Fonts used by EscapeE
 

Commonly used fonts : their Typeface, Style, Weight attributes.

Tables of commonly used media: see Standard paper and envelope sizes .

Examples index

RedTitan contact details  lists our office addresses, telephone numbers and
websites etc.

Notes on some terms and acronyms mentioned in this User Guide: see 
Miscellaneous notes.

Glossary of programs mentioned in this User Guide: see Product References . 

Compare features  table of EscapeE editions.
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Command line syntax: index

/1BIT  

A
/ABORT  
/ABORTACTION p  
/ABORTLOG spec  
/AFP  
/AFP M  

B
/BIN n  
/BMP  
/BLANKPAGES y|n  
/BOOKLET  
/BORDER l,t,r,b  

C
/CALCHDR  
/CAPTURE  
/CLIP  
/COMMENTS x  
/COPIES n  
/CR rl,rh,gl,gh,bl,bh  
/CSV  
/CSVQUOTE  
/CSVSEPARATOR s
/CUSTOM [type,]w,h

D
/DCX  
/DEFINE name='string'

 
/DISPLAY  
/DRAW x  
/DRIVERDEFAULTS  
/DROP y|n  
/DUPLEX e  
/DUPSIM e  

E
/EDGE  
/ENCRYPT  
/ERASE  
/ERRORLOG  
/ERROROK  

F
/FDL  
/FDLRES  
/FDLRIF  
/FDLUNITS  
/FIELDCLR c  
/FIELDDEF file  
/FIELDNAMES 'string'
/FIELDS file  
/FIFO  
/FILE name  
/FIND 'string'  
/FLOW  
/FONTFILE file  
/FROM file

GH
/HEADER  
/HISTORY n  
/HOST h  
/HP  
/HPGL  
/HPTRAYS  

I
/IGNORE x  
/IMAGE x  
/IMAGECACHE n
/IMAGERES n  
/IMG  
/INI filename  
/INILOG  
/INPORT p  
/INPUT x  
/INSPEC  

JK
/JOIN  
/JPEG  
/JPEGOPTS  

L
/L  
/LIB 1  
/LINEEND  
/LINEHEIGHT n  
/LINES n  
/LOG f  
/LOGFILE <spec>
/LOGTEXT 'string'
/LP_DATASIZE n  
/LPR  
/LPRC 'class'  
/LPRJOB 'job'  
/LPRL 'L field'  
/LPRQ 'queue'  
/LPRU 'user'  

M
/MACRO nnn  
/MEDIA <name>
/MENU N
/MKDIR  
/MONO  

N
/NEXTPAGE p  
/NOCACHE  
/NOCAMP  
/NOFONTS  
/NOIMAGES  
/NP n  
/NQ  
/NQERROR xxx  
/NQLOG xxx  

O
/OPTIONS  
/ORIENT x  
/OUTPLEX [p]  
/OUTSPEC  

PQ
/PACK p  
/PAGE n-m*s  
/PAPER p  
/PCn r,g,b  
/PCL  
/PCLOPTS n  
/PCLPREAMBLE
/PCLRES r 
/PDF  
/PDF-A 'name'  
/PDF-K 'k1 k2...
/PDF-S 'string'  
/PDF-T 'string'  
/PDFOPTS n  
/PDFPASS p  
/PDFPASSR p
/PDFPREF  
/PDFREADPASS p
/PDFUSER p  
/PJLPREFIX p  
/PJLSEPARATOR s
/PNG  
/PNUM xxx  
/PNUMFONT f  
/PRINT  
/PROCESS  
/PS  
/PS3  
/PSOPTS  
/PSPREAMBLE  
/PSTRAYS  
/PW[n] width

R
/REGISTRY  
/RELOAD  
/REM 'remark'
/RENAME file  
/REPORT  
/RES x,y  
/RESIZE  
/RFFS  
/ROT r  
/RUN p  
/RUNWAIT  

S
/SANDBOX  
/SAVE f  
/SCALE s  
/SCALEMENU s1 s2
/SCALING n  
/SELCLR c  
/SELECT f  
/SHADING s  
/SHORTCUT  
/SIGN  
/SHIFT r,d  
/SORT s  
/SOURCE s  
/SPACEFILL  
/SPACEWIDTH  
/SPOT n  
/STEM s  
/SUBSET  
/SUBST file  
/SUBSTDEF file  
/SYMSET s  

T
/TAGCLR c  
/TAGFIELDCLR c
/TEMP ext  
/TEXT  
/TEXTHEIGHT v  
/TIFF  
/TIFFORIENT o
/TIFFORIENT r  
/TIFFRES  
/TIME t  
/TITLE 'string'  
/TO f  
/TRAY n  
/TRIM  
/TTSUBSET  

U
/UBERED  
/USELINES  
/UNINSTALL  
/UNITS x  
/USERUNITS n.m  
/USING file  

VW
/VIEWFIELDS  
/VIEWHINTS v  
/VIEWPAGE  
/WINDOW s,l,t,w,h

XYZ
/X  
/XML  
/XMLCODE x  
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Command line syntax
Applies to EscapeE Professional and Batch Automation editions  only

The syntax and description of each command is listed below. For convenience, the
commands are grouped into tables:

Main options , 

Printer configuration options , 

Composite document options , 

Other options  

plus some Special/obsolete options

There is also a list of the commands, in alphabetical order, which link directly to that
command's entry in its table; see Command line syntax index .

Command line options may be of the form:

/<option>

i.e. a symbol that opens with a / character, or:

/<option> <parameterstring>

where a parameter string follows the symbol and is separated from it by a space
character. The parameter may be composed of several values, generally separated by
a comma. There should be no spaces before or after a comma separator. If a value
contains a space character, that value must be enclosed in quotes.

/<option> <value1>,<value2>,<'value three'>

Options may be concatenated on the command line. Use a space character to end one
option before starting the next option with its opening / character, as in this example
command line:
escapee C:\MyDocuments\Design.pdf /HP /LOG AV

Alternatively, the options may be contained in an "options" file which is specified
using the /OPTIONS  syntax: see Options file .

Main export options >
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Main (export) command line options

/AFP Export  file to IBM-AFP  datastream.

/AFP M Generate FormDef  and export  file to IBM-AFP datastream.

/CSV Export  data fields to comma separated  values.
See also /CSVQUOTE  and /CSVSEPARATOR  below.

/CSVQUOTE "q"
or 
/CSVQUOTE "'"
or 
/CSVQUOTE N

Where q specifies the character (other than the default double-

quote) in which data-values are enclosed when outputting CSV
 records.

To specify the single-quote character, set q to "'".

To specify that the data-values are not to be enclosed within
quotes, set q to N.

See also /CSV  above and /CSVSEPARATOR  below.

/CSVSEPARATOR s
or 
/CSVSEPARATOR T

Where s specifies a character (other than the default comma)

which separates data-values when outputting CSV  records.
To specify the Tab character as the separator, set s to the

value T.

See also /CSV  and /CSVQUOTE  above.

/FDL Export  file to Forms Description Language .

/FONTFILE filename When exporting to HP-PCL®, the /FONTFILE option  requests
a separate file containing the downloaded fonts. Each font is
marked as "Permanent" and assigned a unique font "ID".
Wildcards may be used in the filename e.g.
ESCAPEE myfile /HP /FONTFILE *.HP

See also /HP  below.

/HP Export  file to Hewlett-Packard® Printer Command Language
 format.

This option produces entirely new PCL output, incorporating
any header pages , overlays  or  plugin  amendments.
See also /FONTFILE  above and /SUBSET  below.

/IMG Export  file to Xerox® IMG  format.

/INSPEC Defines the specification for input files when used in timed
mode , e.g.
ESCAPEE /INSPEC C: \REPORTS\*.PCL /PRINT /TIME 30

See also /FILE , /OUTSPEC  below.

/JPEG Export  file to JPEG  format.

/MACRO nnn Exports a range of pages as a macro  with the Permanent
Macro  flag set in the PCL export options. The macro number
defaults to 100 (maximum value 2147483647).

Tip:  you can use a batch file to create a PCL macro from a
non-PCL file by specifying a subsequent /HP  option.

/OUTSPEC f Defines the default specification for output files when used in 
timed mode . It is ignored if a format (e.g. /TIFF ) is
specified on the command line.
See also /INSPEC  above and /TO  below.

/PDF Export  file to Adobe ® Portable Document Format .

/PNG Export  file to Portable Networks Graphic  image.
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/PRINT [option
[,option...]]

Printer options can be any of:
D  formats the output and sends it directly to the printer,

bypassing the driver.
The output format may be appended, see example below;

I  images the page in memory before printing (useful for

printer drivers which handle fonts with difficulty);
N  used to inhibit immediate printing while setting the

defaults for future printing.
S  scales to fit on the paper when printing. EscapeE chooses

an appropriate integer factor automatically.
?  to prompt for printer selection.

In addition, you may specify:

the name of the driver/printer to be used; this may contain
field names enclosed in curly brackets. The whole string
should be enclosed in quotes.

option /TO : this sends the print file to a file (instead of the
printer) but using the printer's driver.

Examples:
ESCAPEE TEST.PRN /PRINT D /HP
ESCAPEE MyDocument.pcl /PRINT 'HP Color Laserjet
CP2025,I' /to c:\temp\temp.prn
ESCAPEE TEST.PRN /PRINT 'HP LaserJet 4 {field1},S'

See also Run from the command line .

/PROCESS Processes the whole file without outputting the document.
Plugins are called for each page when required, as if in a
normal print-run. No output is selected: Configuration is shown
as <none>.
See 'No output' note .

/PS Export  Postscript ® Format level 2.

/PS3 Export Postscript® Format level 3.

See also PostScript: levels and types .

/RESIZE n,m 

or 

/RESIZE x,y

or 

/RESIZE x,y"

or 

/RESIZE p%

This exports the image file in the specified format and scaled to
fit the specified size.

To specify the size in pixels, width n and height m must be

integers. E.g.:
ESCAPEE  C:\Images\background.bmp /RESIZE 1500,250 /
TIFF

To specify the size in centimeters, width x and height y must be

real (i.e. contain a decimal point). E.g.:
ESCAPEE  C:\Images\background.bmp /RESIZE 2.54,2 /TIFF

To specify the size in inches, add a double quote; x and y may

be integer or real. E.g.:
ESCAPEE  C:\Images\background.bmp /RESIZE 0.67,2" /PNG

To specify that the whole image be scaled by a percentage, add
% (p may be integer or real). E.g.:

ESCAPEE  C:\Images\background.bmp /RESIZE 33.3% /PNG

/SUBSET Exports a subset  of the file as HP-PCL .

See also /HP  above.
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/TEXT

or

/TEXT [option...]

Export  file to plain text  format.

If no options follow /TEXT, the current text settings are
retained.

When no fields are defined and no options follow /TEXT then all
of the text on the whole of each page is output as plain text.

These text options may be used in combination:

Y  Extract text.

N  Do not extract text.

If any options other than Y or N are specified then any default
settings are ignored.

T  Extracted text is to be in UTF8 Unicode.

U  Extracted text is to be in 16-bit Unicode.

X  Extracted text is to be in the user's original symbol set.

If none of the options T, U or X is specified, the text is
extracted in default Windows® Codepage (19U).

_  (Underscore character) Retain underlining.

H  Use the font's cell width for determining the spacing when

extracting text.
I  Reverse the order of the characters in inverse fonts.

L  Left justify.

M  Use character mapping derived from the TTLIB  character

database.
O  Obsolete option retained for backwards-compatibility.

P  Plain, with no Form Feeds between pages.

R  Right justify.

S  Nulls are treated as spaces.

V  Use the top of the character cell as the reference point

rather than the baseline when extracting text.
W  Ignore downloaded character widths and recalculate based

on raster dimensions.

For example /TEXT YR 

For plain text Log files , you may use:

C  to show the number of sides output.

E  to show the number of sheets output.

The information is put at the end of the output file.
The side count, if requested, is given first: 1 page or n pages
or, if nothing has been output, No pages produced.
If requested, the sheet count: 1 sheet or n sheets comes
next.

Tip:  Used in conjunction with /TO , an initial + in the

output name appends the output to an existing file if it exists,
creating a new file if not, e.g.:
ESCAPEE D:\REDTITAN\EscapeE\Report*.PCL /TEXT /TO
"+Extracts.txt"
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/TIFF
or
/TIFF Y
or
/TIFF Nn

Export  file to Adobe® Tagged Image File Format . An
optional parameter may be specified:

Y  sets TIFF as the default output,

N  shows that TIFF is not the default output and n is:

N1  to create a single page TIFF (the default) or 

N2  to create a multi page TIFF.

E.g. /TIFF N2 

/UBERED Export  file to HTML5  UberEd  format for subsequent
editing and document creation purposes.

/XML Export  data fields to Extensible Markup Language  values.

For convenience, files exported using any of these main options are named, assigned
the appropriate extension and placed in the originating folder automatically. Used in
conjunction with the /TO  option, however, you may set up other names and/or
destination folders instead.
The main command line options may be followed by a parameter which may begin
with V to request that the pages are shown on screen also. It may also specify a time,
t, for continuous operation where a scan is made every t seconds, e.g.:
ESCAPEE *.LSH /TIFF V5

Printer configuration options

The following options can be used to initialize some of the parameters that could have
been set manually using the printer's front panel:

/BIN n Sets the default output bin .
If n is negative then it forces this bin regardless of what is
specified in any data files, e.g. /BIN -2 forces the output to be

sent to bin 2. For Postscript  printing it may be necessary to
define bins corresponding to the PCL  numbers. The symbols
PSBINS1, PSBINS2 etc. define the output bin names associated
with PCL bins 1, 2 etc.

/BOOKLET To print four 'pages' on each sheet: EscapeE switches the
orientation (see /L ) of the paper (size /PAPER ). The pages
are scaled, rotated and composed so that they are printed in the
appropriate order to fold into a booklet.
Note: any plugins which print 'on the back'  cannot be honored,
and (because pages will be processed out of order) fields relying
on sequentiality may fail.

/COPIES n n is the number of copies  required.
If n is positive the copies are collated.
If n is negative they are uncollated.
Note that collated copies may result in up to an n-fold increase
in file size though fonts and images will only occur once.

/CR 
r_low,r_high,
g_low,g_high,
b_low,b_high

Sets the color range for HP-GL plotter pens defined by /PC ,
below. Expressed as three pairs of real numbers defining the
lower and upper limits of the red, green and blue values. The

default values are 0 and 255, i.e.
/CR 0,255,0,255,0,255

Only valid when the number of pen colors is also defined: see /
NP  below.
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/CUSTOM [type,]
width,height

Sets up a custom paper  size; width and height are in inches. 

For example, you may define paper for a letter (portrait) as:
/CUSTOM 11.3,17.1

When a paper type is included in the command, the specified

PAPER  size is redefined. So a "DL" (landscape) envelope may
be changed to 8.4in wide, 3.5in high by:
/CUSTOM DL,8.4,3.5

/DUPLEX e Specifies whether to print on one side of the paper only
(simplex) or both sides (duplex). A minus character may be used
to override the print file setting, so e may take these values:

L  Long-edge binding duplex.

N  Simplex (default).

S  Short-edge binding duplex.

U  Undefined duplex.

-L  force Long-edge binding duplex.

-N  force Simplex.

-S  force Short-edge binding duplex.

-U  force Undefined: removes any duplex specifications from

the file, allowing any output document to be printed either
simplex or duplex as required.

See also Setting the printer defaults  and /DUPSIM,  /
OUTPLEX  below.

/DUPSIM e Simulates simplex output using duplex; e may take these

values:

L  Long-edge binding

S  Short-edge binding

See also /DUPLEX  above and /OUTPLEX  below.

/EDGE Request edge-to-edge  printing, so that coordinates are
measured from the physical edge of the paper.

/HPGL p Where p specifies the parameter(s) for setting up EscapeE HP-

GL plotter emulation  mode:

Y  Engage HP-GL mode

N  Engage PCL mode

If neither N nor Y are specified, EscapeE defaults to engaging HP-

GL mode (equivalent to HPGL Y)

Supplementary options:

R  Specify when rotated  embedded bitmapped graphics are

required

X  Switch from HP-GL to PCL on encountering any Escape

sequence  (except Escape%#B for entering HP-GL mode!)

For example, to stay in PCL initially add N:

ESCAPEE /HPGL NX
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/HPTRAYS
a,b,c,...

Converts the tray numbers specified in the file to those needed
by the Windows printer actually being used (see Media
definitions ). It consists of an ordered list of tray numbers,
separated by commas: the 1st number corresponds to "tray 1"
specified in the input file, the 2nd number to "tray2" etc..

If the HPTRAYS symbol is not specified then it defaults to
HPTRAYS=1,4,6,2,11,5,7

giving:

source 1 –> upper
source 2 –> manual
source 3 –> manual envelope feed
source 4 –> lower
source 5 –> large-capacity feeder
source 6 –> envelope feeder
source 7 –> auto

(see Tray and bin numbers ); other numbers are passed
straight though.

See also /PSTRAYS , /TRAY  below.

/L Set landscape orientation.

/LINEEND The line-ending sequence:

 0   CR -> CR,    LF -> LF,    FF -> FF (the default)

 1   CR -> CRLF,  LF -> LF,    FF -> FF

 2   CR -> CR,    LF -> CRLF,  FF -> CRFF

 3   CR -> CRLF,  LF -> CRLF,  FF -> CRFF

/LINES n Set initial VMI to allow n lines per page (default is 66).

/MEDIA<name>
<tray number>

Associate special media with tray number. Note that there is no
space between the MEDIA keyword and the name, e.g.
/MEDIALETTERHEAD 2

/MONO Causes HP-GL mode to default to a two-pen monochrome palette
rather than an eight-pen color palette. See also /NP  below.

/NP n Sets up the number n of pen colors for an HP-GL plotter. See

also /MONO , /PW  and /CR .

/ORIENT x Set x equal to:

P  for Portrait,

L  for Landscape,

I  for Inverted portrait,

J  for Journal (inverted landscape) and/or 

A  for Automatic  font rotation to match orientation.

Add * to force the specified orientation: e.g. /ORIENT *L
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/OUTPLEX [p] This override feature is only relevant when printing or when
exporting to PCL, PDF and PS. It supersedes any other plex
configuration options. Normally p is omitted so that the plex
parameters specified in the input file pass through to the export
file. Alternatively, p may take these values:
N  simplex.

L  Long-edge binding duplex.

S  Short-edge binding duplex.

DL Long edge Duplex, with blank page on back to simulate

'simplex' sheets.
DS Short edge Duplex, with blank page on back to simulate

'simplex' sheets
U  plex is Unspecified: any 'plex' parameters are removed so

that there are no plex parameters in document output.
See Simplex and duplex options  and /DUPLEX  above.

/PAPER p Sets up a standard paper size , where p is one of:
A0, A1, A2, A3, A4, A5, A6,

LETTER, LEDGER, ANSIC, ANSID, ANSIE, 

ARCHA, ARCHB, ARCHC, ARCHD, ARCHE, ARCH30, 

EXECUTIVE,  LEGAL 

or COMMERCIAL, C5, DL, MONARCH (envelopes).

See also /CUSTOM , /TRAY .

/PCn r,g,b Where a number of pens have been defined for an HP-GL printer
(see /NP ), /PCn sets up relative color values for each pen. For
example:
/PC1 255,0,255
/PC2 0,128,255

The color values actually used are bounded by the range of values
set up using /CR .

/PSTRAYS n Defines the input tray name associated with PCL tray n.

See also /HPTRAYS  above, /TRAY  below and Tray and bin
numbers .

/PW[n] pen_width Where a number of pens have been defined for an HP-GL printer
(see /NP ), /PWn sets the width of pen n to the specified value

in standard HP-GL units of 1/40 mm (~1/1000 inch). E.g.
/PW1 40.0
/PW2 25.0

If n is omitted, all the pens are set to the specified pen_width. 

See also /PCn .

/SELECT f Define default font f where f is an HP-PCL font selection sequence
, for example:

/SELECT "^(19U^(s0p12h10vsB"

Note that the ^ character is used in place of the 'Escape'
character in a selection sequence, except when used on an MS-
DOS® command line with Windows® XP and later systems (a
single ^ character has special significance for these systems, so
^^ must be used instead).

Default font is Courier 10 pitch in PC character set (10U).
There is a RedTitan extension of the selection syntax to allow
explicit specification of the font name in single quotes instead of
a typeface e.g.
/SELECT "^(19U^(s0p11.8h11.73vsb'Lucida Console'"

See also /PNUMFONT , below.
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/SHADING s PCL shading  patterns, where s is:
0  standard

1  fine

2  gray-scale solid color.

/SPOT n Define spot color as RGB.
n is a three-byte color number: Red (low byte), Green, Blue

(high byte) converted to decimal e.g. cyan= 65535.

/TRAY n Sets the default PCL input paper tray .
If n is negative then it forces this tray regardless of what is
specified in any data files, e.g. /TRAY -2 forces the input media

to be taken from PCL tray 2.

For PostScript  printing it may be necessary to define trays
corresponding to the PCL  numbers.

See also /HPTRAYS , /PSTRAYS  above and Tray and bin
numbers .

Composite document options

/CAPTURE Used in conjunction with the the RedTitan ® CaptuRedTitan
generic Windows® print capture utility, this option is used to
pre-define some special fields for creating output filenames
using the /TO  option.
The document title defines the job title (equivalent to
specifying /LPRJOB 'job'  on the command line) and the
special field {_Title}.

The user name defines the user parameter (equivalent to
specifying /LPRU 'user'  on the command line).
The ID sets the special field {_Id}.

The default output file name is set to {_Title}{_Id}

For example, a Job titled My document with ID 1234 creates a

PDF named My document1234.pdf by default. This may be

overridden using the /TO  option.
See also Filenames and widcards.

/FROM filename Read the named LOF control file .
The default is to export each file in the list of files separately
unless the /JOIN  command is used.
Further options may be appended; in the example below, only
the first page of each file in the list of files is
exported.escapee /from mylist.lof /TIFF  /pages  1-1

/FROM filename
,filenamefield
[,startpagefield
,endpagefield]

Read the named CSV control file .
The component files will be treated as if they were a single file
with reset commands at file boundaries. A "start" and "end"
page may be specified as well as a "file name".
If a startpagefield is given but no endpagefield, then, if the

file name is the same as the previous one, the end page of the
previous file is set to one less than the start of the next. In the
absence of a filenamefield specification the filename field is

used if it exists, otherwise the first field in the CSV file is
assumed to contain the filename.
See also /PAGES  below and _numpages  symbol.
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/JOIN [filename] Use to treat a list of files as a single (composite ) document.
This is the default for control files which are in CSV format. /

JOIN may be followed by the control filename e.g

ESCAPEE /JOIN MYLIST.CSV

See also /FROM , above.

/SORT s Use to define an order for processing a list of files (instead of
the default order in which they are presented in the control file).
Up to three sort levels may be defined.

A single level sort is simply the value of 's' shown below. To
precede this by a second level of sorting, multiply the secondary
level 's' value by 16 then add the 's' value for the primary sort.
Similarly, a third level requires 256*s to be added to the value.

s      sort in order of
1  file path and name, case sensitive

2  file name, case sensitive

3  file extension

4  file size

5  update  date

6  creation date

7  access  date

8  short 8.3 name

9  uppercase path

10  uppercase name

For example, /SORT 2 orders by filename only, whereas /SORT

163 sorts by uppercase name (16*10) then by extension(3).

Other options

/ABORT a,b,c...

or

/ABORT ALL

Use to terminate the processing of the current file if the
errors specified occur and take alternative action defined by
option /ABORTACTION  instead.

The errors ("a", "b", "c" etc.) are specified as a comma-
separated list of return codes . For example:
/ABORT–134..-126,-140

aborts on encountering error code -140 and all the codes in

the range (denoted by ..) -134 up to -126 inclusive.

In the special case of /ABORT ALL, all errors not ignored by

the /ERROROK  specification will cause an abort.

See also /ABORTLOG  below

/ABORTACTION p This defines the action on aborting a file (see /ABORT
above).  p may be either one or both of the parameters:

A to Abort timed processing and exit.

The default is to ignore the file and continue processing
the file.

E to Erase the faulty input file.

The default is to rename it when there has been an error.

See also /ABORTLOG  below.

/ABORTLOG xxx Specifies the path of a folder into which aborted output files
and error logs are placed: see /ABORT . The input file’s
disposition depends on the value of the /ERASE  option.
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/BLANKPAGES y|n Show blank pages, Y(es) or N(o). The default is to suppress

blank pages.

/BORDER wl,wt,wr,wb
or 
/BORDER wlr,wtb
or 
/BORDER w

Adds borders  of specified widths to all four edges when
exporting an image or PDF.

If four values are specified, the first is used to set the left
border, the second the top border, the third to set the right
border and the fourth the bottom border.
If only two values are specified, the first is used to set the
left and right borders and the second to set the top and
bottom borders.
If only one value is specified, all four borders are set to that
width.

A double quote character in the parameters (integer or real)
denotes inches. If " is not specified, dimensions are

assumed to be in pixels (independent of resolution) when all
the parameters are integers, or else centimeters when there
are decimal point(s). For example:
BORDER 1,0.5

gives 1cm wide side borders and top and bottom borders of
0.5cm, whereas:
BORDER 1,0.5"

gives 1inch wide side borders and top and bottom borders of
0.5inches.

/CALCHDR Calculate the font header parameters from the font size
rather than using the ones supplied. This is sometimes
useful (e.g. for FDL forms generation) because some
Windows® drivers supply faulty header parameters for
download fonts.

/CLIP Set the Unprintable area  with parameters as follows:

Y  Crop.

N  Outline the valid region.

B  Outline if not blank.

/COMMENTS x Creates up to 26 dedicated fields per page, solely to hold the
PJL JOB command line and PJL comment lines. EscapeE
assigns each a letter: 'a to z' or 'A to Z'. These are output
when exporting to PCL , PDF , PDF/A  and PostScript .

N  No comments – the default

P  Plain text format, e.g.
% COMMENT "HEADER PCL" % COMMENT "Driver version
: 02.03"

X  XML format, e.g.
% <RT A='JOB NAME=&34;Magic&34;' B='COMMENT
&34;This is a comment&34;'/>

(the UNICODE hex code 34 outputs the double quote

character).
See also /PJLPREFIX  and /REM , below.

/DEFINE
 fieldname='string'

Defines a field with the given fieldname and assigns it the
specified value.

/DISPLAY Display the page whilst outputting TIFFs, PDFs, Postscript
etc.

See also /WINDOW HIDE  below.
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/DRAW x Specifies drawing mode, where x is:

2  rotates images and PDFs through 180°.

R  use rectangles to create horizontal or vertical lines

instead of drawing with the current pen in HP-GL.
S  draw HP-GL lines using strokes with the appropriate

ends (round or square).
RS both R and S options.

N  neither R nor S options.

M  filled areas are merged with the existing page contents.

Q  requests EscapeE to perform non-orthogonal image

rotation directly rather than using the Windows®

coordinate transformation. This technique may be slower,
but it handles heavily scaled images better.
X  in PCL, this allows cursor commands to set the actual

print position to any value, even if it is outside the
printable area. Unlike HP-GL printers, PCL printers locate
out-of-bounds positions to the boundary of the printable
area. This may cause a problem if any marks have been
placed in the unprintable area of the page (e.g. comments,
layout marks) so that they would not appear on the printed
page: kerned characters or rounded positions may protrude
into the printable area and show up as visible marks on the
page.
/DRAW X may be used to overcome this problem.

The default is to use strokes for all lines and no merge.

This option supersedes the /USELINES option.

/DRIVERDEFAULTS Specify /DRIVERDEFAULTS to ignore the settings given in
the original input file and use the printer driver's defaults
used instead.

You may choose these defaults (paper type, duplexing and
bin selection) from the standard 'Print setup' dialog: see 
Printer Setup... .

/DROP y|n Action on drag-and-drop. Y causes file to be exported, N

merely views it.

/ENCRYPT
recipient_profile

Sets up the default Security profile  for encrypting  PDF
files. A PDF file which has been encrypted on export may
only be viewed by the people cited in that profile. E.g.
/ENCRYPT my_music_group

See also /SIGN  below.

/ERASE or 
/ERASE OK or 
/ERASE N

When in timed mode (see Setting automatic export options
) this specifies how the input files are treated after
processing.

/ERASE  (i.e. without parameters) simply erases the input

files after processing.

/ERASE OK  erases the input files only if they have been

successfully processed.

/ERASE N  renames the processed input files (usually as

*.bak: see /RENAME ). This is the default action if the
erase option has not been specified.
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/ERRORLOG <file> Use to create an error-log file  for recording errors (a /
REPORT  is also generated to place an error  summary in
the Console notebook), see also Run from a program . For
example,
/ERRORLOG c:\temp\error.log

creates an error-log file named error.log in the temp

folder. If the error-log file reaches the size of 10 Megabytes
it is renamed with a ~ inserted in its extension (~log for the

example above, erasing any such previous file) and a new 
error.log file is started.

To suppress error log creation, just use
/ERRORLOG

without specifying a file.
See also /ERROROK  below and Error return codes .

/ERROROK a[,b]
[,c..d] etc

or

/ERROROK ALL

Use to ignore specified errors, where a, b, c etc. are Error

return codes  which are to be treated as acceptable and
ignored when setting the error return code from EscapeE.
For example, to prevent the red warning triangle  being
shown when a missing or unknown font is encountered, use:
/ERROROK –136

Use .. to denote a range of codes, e.g.
/ERROROK –134..-126,-140

ignores code -140 and all the codes in the range -134 up to

-126 inclusive.

In the special case of /ERROROK ALL, all non-vital errors are

ignored.
See also /ABORT , /ERRORLOG , /REPORT ERRORS  and
Run from a program .

/FDLRES <res> Sets the dot resolution for FDL form generation, where <res>

may take the values 300 or 600 dpi.

See also /FDLUNITS .

/FDLRIF [option
[,option]]

Sets up conversion and format options for exporting a
document to FDL.

Conversion options are:

A or Y to convert the whole page to a graphic (default)

G to convert all non-text items to a graphic

Format options are:

P to output images as PNGs

T to output images as TIFFs

When no options are specified, /FDLRIF defaults to

converting the whole page into a single image, format RIF

See FDL export options .

/FDLUNITS <n> Sets the units used for FDL forms, where n may be:

300 dpi (normally the default) or 

600 dpi: this also sets the resolution default to 600, see /

FDLRES .
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/FIELDCLR c Defines the color of field data area – such that c is the color
number:

c = 65536 * blue + 256 * green + red

where R, G, B values run from 0 to 255.
Defaults to green.

See also /SELCLR , /TAGCLR , /TAGFIELDCLR .

/FIELDDEF file file is the name and path of the default field definitions file

 to be used when no /FIELDS  option is given.
May contain wildcards .

/FIELDNAMES 'string' Redefines the characters that are allowed in field-names.

The default characters (acceptable to most programs) are:

-  hyphen
_  underscore
0..9  digits range
a..z  lower-case Roman alphabet
A..Z  upper-case Roman alphabet

where .. indicates a range of characters from first to last
inclusive.

Specify the new characters to be allowed as a string
enclosed in single- or double-quotes. For example:
/FIELDNAMES '%,A..Z,a..z£'

allows percent, upper- and lower-case alphabets and pound
characters.

Note that the single- and double-quote, full-stop and
comma characters are never allowed in fieldnames, even if
they are specified in the string either explicitly (as in the
example above) or within a range.

/FIELDS file Use file file as the field definitions file.

Defaults to x.EE where x is the data file name stem, or

DEFAULT.EE if x.EE is not found.

See Field definitions files  and /FIELDDEF  above.

/FIFO This 'First In First Out' option processes files in the order of
their creation date (i.e. oldest first), not ordered by their
update date (the default).

See Setting automatic export options .

/FIND 'string'

or 
/FIND "string"

Highlights the first occurrence of the string in the
document's text. To include a single quotation mark in the
string itself, enclose the string in double quotes. To include
a double quotation mark in the string itself, enclose the
string in single quotes, e.g.
/FIND '39.37"'
/FIND "The Winter's Tale"

/FLOW When creating FDL forms generate flowed text rather than
using absolute placement. This may result in less than
perfect alignment but does allow the text to be changed and
reformatted more readily.
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/HEADER filename

or

/HEADER filename+

Allows a file to be processed before the main file. This may
contain printable pages but is more often used for defining
some fonts or macros to be used by the main file. It
overrides the Header file specification in the ".EE" field
definitions file as set up in the File  page of the Field
dialog. If the filename is followed by a "plus" sign then the
PCL state is preserved after reading the file. Any fonts
defined in a such file are retained when reading subsequent
files.

See also To set up a header file.

/HISTORY n The number of files in the History list  at the foot of the
'File' menu is set to 8 by default. To extend the list, specify

the total number of files n to be shown, e.g.
/HISTORY 12 

In the special case where n is set to 0, the history list is

empty: the file names are never written to the INI file .

/HOST h Define the host name or IP address for LPR output , e.g.:
/HOST \\mainserver\ourprinter

or
/HOST 192.168.7.15

/IGNORE x Where x equal to:

F  ignores downloaded fonts,

I  ignores images,

K  ignores downloaded fonts if they have a substitute

defined,

P  ignores paper specifications,

S  ignores shading,

U  ignores fonts downloaded already,

W  ignores white areas,

Y  ignores Kyocera command !R!.

See Setting General export options .

For example /IGNORE IS sets printer to ignore images and

shading.
See also Optimizing the configuration  and Configuring the
printer defaults .
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/IMAGE x Where x is set to:

B to omit blank pages.

W to create transparent white backgrounds (only

relevant to PNG, TIFF).

M to force monochrome pages using default halftone

shading.

MD for monochrome output using dithering.

MT[n] for monochrome output  using threshold shading

where n is a value in the range 1 to 254 (if n is omitted,
value defaults to 127). For example:

/IMAGE=MT80 forces monochrome output with a

threshold value 80.

/IMAGE=MB outputs halftoned monochrome images with

any blank pages omitted.

See Image import/export options.

/IMAGECACHE n Sets the size, in Mbytes, of the cache which EscapeE may
use to retain images in memory so as to be able to have
multiple references to a single image when exporting to
formats such as PDF.

Default image cache size is 200 Mbytes, maximum 1000.

/IMAGERES n The default Image resolution , where if n is:

positive it applies to any images whose resolution is zero or
unspecified;

negative the resolution –n applies to all images, over-riding

any specified resolution.

/INI filename Uses the specified .ini configuration file.

This is the equivalent to specifying ^^ininame as the first

command line parameter but can be configured permanently
in the RT.INI file if required.

If the filename is * then it tries for a file with the same

name as the data file but with extension .ini.

See also Setting General export options .

/INILOG Use to log any errors, their date and time, encountered on
the EscapeE RT.INI file  in a file named escapee.log in the

Windows® temporary folder (normally C:\Users\<username>

\AppData\Local\Temp).

/INPORT p Define name or number of TCP/IP  input port.
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/INPUT x The input format, where x may be:

AFP – IBM AFP

BMP – Bitmap

CAPSL – Canon

DDF – RedTitan DDF language

DICOM – DICOM medical image

ESCP – Epson printer language (supersedes EPSON)*  

FORM – Field generation for a form*  

GIF – Graphic Interchange Format

IDF – Intelligent Document Format*  

JPEG – JPEG photo format

PCC – Lineprinter Control Codes*  

PCL – HP Printer Control Language

PCX – PC Paint format or DCX (supersedes DCX)

PDF – Portable Document Format

PNG – Portable Network Graphic

PS – PostScript

PTRX – Printrex

RS2 – RedTitan Scripting language

RTF – Rich Text Format

STAR – Star POS printer format

TIFF – Tag Image Format

XIMG – Xerox IMG (supersedes IMG)

XL – HP PCL 6 (supersedes PCL6)

ZJS – Zenographics format

This is useful when the extension or initial bytes of a file are
non-standard so that the file's format may not be detected

. For example, use
ESCAPEE /INPUT ESCP

*Some import DLLs may take further option(s) given as a
string following the import format and separated by a
comma.

RTESCPIN module options:
DPI n – dots per inch horizontally

STEP n – vertical step between rows (1, 2 or 3)

RTFORMIN module options:
ALL – Fields apply to all pages.

CHECKBOX n – Maximum size of a checkbox in 1/600".

KEEP – Save fields on exiting EscapeE.

MINFIELD n – Minimum size of a box to be considered a field.

PAD n – Padding inside the box containing a field.

RTIDFIN module option:
DEBUG, tag, tag – set debug for specified tags or 

DEBUG CONDITION, REPEAT, PARSE, COPY, CSV – to debug

these operations.

RTPCCIN module option:
ROW – fields' locations given by the 3-digit line-number in columns

1,2,3; the number of lines to skip before printing given in column 4.

For example:
ESCAPEE /INPUT PCC,ROW 

See Input options .
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/JPEGOPTS option,
[option,...]
decision,
quantisation

This sets up the rules for deciding when to use JPEG
compression for an IDF, PDF, PDF/A, PS or JPEG document's
image(s) and the compression parameters to be applied.

The option parameter(s) can be any combination of:

LQ  low quality colour

LR  low resolution colour

JP  to retain JPEG compression if, and only if, the image

was originally sourced from a JPEG file.

The decision parameter determines whether to use JPEG for

images or not, expressed as a percentage:

000 never

100 always

050 'if appropriate' (default)

(see JPEG compression options )

The quantisation parameter determines the fineness of the

detail of the image. It is specified as a percentage, where

100 is the highest quality. Values typically range from 40 for

a coarse image to 70 for a good quality image, see 

Compression parameters .

E.g. JPEGOPTS LQ,JP,50,40

/LIB 1 Define the font library  search path.

/LINEHEIGHT n In TXT , IDF , RTF  and UberEd  output formats, this

defines the minimum vertical distance between the

baselines of two words for them to be deemed on different

lines. The value of n is measured in the units currently

configured : dots, dot600, de, cm or in.

See also /TEXTHEIGHT  below.
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/LOG f Specifies which fields are to be logged when outputting

documents, see Setting Log file options .

The parameter consists of appropriate combinations of the

option 'flags' listed below. (Options may be dependent on

the export format and fields that are to be stored; some are

retained for backwards compatibility.)

A  all defined fields (see also S).

B  the log file is to contain Bates page numbers (see also #

and $).

C  the log file is to be in CSV format.

E  write a log record at end of file (see also +1).

F  the log file is to contain the filenames.

H  header-line containing field-names to be omitted from

CSV log files.

L  a new log file is to be generated for each output file.

N  no log file to be generated.

P  suppress page numbers in log file: the default for CSV,

TXT (see also #).

R  the log file is renamed on completion.

S  the selected fields (see also A).

T  all text: only applies to log files in TXT format).

V  make one log file entry for every page of output: the

default for CSV and XML log files (see also -).

X  the log file is to be in XML format.

#  include page numbers in log file: the default for XML

format (see also B, P and $).

$  include sheet numbers in log file: (see also B and #).

?  write a log file record only when a field specifies it.

-  suppress 'one log entry per page output': the default for

TXT (see also V).

~  ignore /LOGTEXT  definition when text logging.

1  makes one log file entry for each output file (see also V).

+1 write a log record as if having read the next page after

the end of file (see also E).

For example, use /LOG AX to output all fields to XML.

See also /SAVE

/LOGFILE <spec> Specifies the name of the log file. If the <spec> begins with

a plus sign the new data are appended to any existing file.

The <spec> can be a full path and name or a wildcard e.g.

*.INF 

/LOGTEXT 'string' Inserts a message in a TXT log file. The string must be

enclosed in a pair of single or double quotes, and may

contain Special fields in composed strings  within it. See

also /LOG , /SAVE  and Examples: Command lines.
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/LP_DATASIZE n Used to specify that the size of the file is unknown.

n  specifies value (likely user)

0  0 default (Xerox®, nQ )

-1  9999999 (HP ®)

-2  hex7fffffff maximum positive integer.

/LPR [hostname] Where hostname is a string  specifing the name or "ip

address" of the host  providing LPD  service. This is

usually a network printer or a spooling system e.g.:

escapee test.txt /hp /lpr 192.168.1.13 /x

The string may include field names in braces, e.g.

/LPR {hostname}

/LPRC 'class' Specifies the LPR job class identifier. The string  may

include the name of a field from which the class may be

derived. Field names must be enclosed in braces. E.g.:

ESCAPEE XX.PCL /PDF /LPR 123.45.67.89 /LPRC
C{classfield}

If the field named classfield contains the value 12 when

the first page is output then the LPR class would be C12.

/LPRJOB 'job' Specifies the name of an LPR output job. The string  may

include field names in braces, e.g.: 

/LPRJOB AB{field1}CD{field2}EF

if field1 contains xxxx and field2 contains yyyy, the job

name would be ABxxxxCDyyyyEF.

/LPRL 'L field' A string  to set LPRL field in the control file. The string may

include field names in braces.

/LPRQ 'queue' A string  defining the name of LPR output queue, e.g.

escapee /LPRQ HeaderPaper.

The string may include field names in braces, e.g.

escapee /LPRQ {queuefield}.

/LPRU 'user' A string  to set LPRL field in the control file. The string may

include field names in braces.

See also /LPRL  above.

/MENU N Inhibits display of the EscapeE Tool-bar and menus.

/MKDIR Create a new directory (folder) if necessary when exporting.

/NEXTPAGE p Use p as the next page number. A positive number assigns

that number to the first page of the file and starts
numbering the next document where it left off. A negative
value ensures that the page number is not saved for the
next document and that the number is adjusted by any
offset in the /PAGE  option.

/NOCACHE Ensures that EscapeE does not cache any images, which
may reduce memory requirements in some cases, though
possibly at the expense of speed.
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/NQ Used only for calling EscapeE from the RedTitan  spooler nQ
. Use /LPRQ  to specify destination spooler folder. To

force an exit from EscapeE on completion, use the /X
option.

/NQERROR xxx If an error is found with a file from an nQ  spooler, then 
/NQERROR moves it to folder 'xxx'. If 'xxx' is null then the

output file is left in the input folder, so effectively ignoring
the error. See also /NQLOG  below.

/NQLOG xxx Specifies the path of a folder to contain any faulty input file
and the error log file. Error log files are created with the
extension '.log'; for example, if DFAyyy is the input file name

the error log file will be called DFAyyy.log.

/OPTIONS filename Specifies an options file containing a list of one or more
command line options, one command line option per line.

See Options file  and Examples: Command lines .

/PACK p Defines the image data mode, where p is:

0  byte aligned (default: no bits set)

1  unpacked (raw)

3  CCITT group 3 fax compression

4  CCITT group 4 fax compression

5  LZW compression

TIFF  options  may be set up by adding flag bits to p:

16  bit reversal

64  End Of Line markers

128  single strip

256  carry odd bits over to next row

Use p = -1 to set Packbits compression .

/PAGE n-m*s

or

/PAGES n-m*s

or

/PAGES
firstpage,lastpage

Process pages n to m inclusive, broken into sets s pages

long.
Omit *s to process as one file (cannot apply to Subset

output).
If -m is omitted then process just page 'n'.

To process pages from 'n' to the end of the file, use /PAGE
n-

Used in conjunction with /FROM , fields containing the
numbers of a "starting" and an "ending" page may be
specified to process logical sets of pages. E.g.:
ESCAPEE /FROM CONTROL.CSV /PAGES
STARTPAGE,LASTPAGE /PDF /X

See also /NEXTPAGE.

/PCLOPTS n Define PCL options , where n is the decimal number made

by adding the required flag bits  or a string of mnemonic
codes .

/PCLPREAMBLE Use to output a Preamble in PJL on exporting a document to
PCL, see Preamble and PJL options

/PCLRES r Define the initial dot resolution (default is 300).
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/PDF-A 'name' Defines the author  of a PDF document. The 'name'

parameter is terminated by a space, so if a name includes

spaces it must be enclosed in quotes.

/PDF-K 'keyword1
keyword2 ...'

Defines the list of keywords  associated with a PDF

document. The 'keyword' parameter is terminated by a

space, so if there is more than a single word the string must

be enclosed in quotes.

/PDF-S 'string' Defines the subject  of a PDF document. Since parameters

are terminated when a space is encountered, if the

description string includes spaces it must be enclosed in

quotes.

/PDF-T 'string' The string defines the title  of a PDF document. Since

parameters are terminated when a space is encountered, if

the title string includes spaces it must be enclosed in

quotes.

Superseded by /TITLE , /PDF-T is retained for backward

compatibility. If /TITLE and /PDF-T are both defined for a

document, /TITLE takes precedence.

/PDFOPTS n Define PDF options , where n is the decimal number made

by adding the required flag bits  or a string of mnemonic

codes

/PDFPASS p Define password  required to have full access to a PDF.

PDFs encrypted this way cannot be decoded if the password

is lost.

/PDFPASSR p Define password  required to have full access to a PDF.

RedTitan can recover this type of password if lost.

/PDFPREF Defines which features of a PDF reader are to be displayed

on the screen. Add the flag values:

1  Hide the tool-bars

2  Hide the menu-bar

4  Hide the window interface, i.e. scroll bars and other

navigation tools

8  Resize the window to fit the first page

16  Position window to center of screen

32  Put document title in title-bar instead of filename

64  Use the full-screen display mode

128  Opening display to fit horizontal width

256  Opening display to fit vertical height (use 384 for fit-

page)

For example:

ESCAPEE C:\Sales\Accessories1.pdf  /PDFPREF 128

See also PDF Viewer Preferences

/PDFREADPASS p Defines a password  for PDF input (independent of the

password for output).
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/PDFUSER p Define password  to have specified access to a PDF;
see /PDFOPTS .

/PJLPREFIX p Sets up a prefix string such that any PJL comment, PJL JOB
and PJL JOBATTR items create fields with a name beginning
with the prefix.

See also /COMMENTS  above and /PJLSEPARATOR  below.

/PJLSEPARATOR s Defines the separator to be used when parsing PJL

commands so that prefixed fields may be created: see /

PJLPREFIX  above. (If no separator is given then separators

"colon", "equal" and "space" are sought in that order.)

/PNUM xxx Define the page number template.

See also /PNUMFONT  below.

/PNUMFONT f

or

/PNUMFONT *

Defines the font to use for printing the page number.

f is the full HP-PCL font selection sequence , with ^ used

to denote the 'Escape' character, e.g.
/PNUMFONT ^(19U^(s0p10h12vsb3T

Note on Windows® XP and later systems, ^^ must be used
to denote the 'Escape' character. (A single ^ character has
special significance when used on an MS-DOS® command
line for these systems.)

* is a special case: it suppresses page-numbering by
nullifying the font.

See also /PNUM  and /SELECT  above.

/PSOPTS Define PostScript options , where n is the decimal number

made by adding the required flag bits  or a string of

mnemonic codes .

/PSPREAMBLE Used for setting up the preamble  when exporting a

document in PostScript format, see PS export options . For

example, if re-exporting a file originally from a Xerox printer

to PostScript format, the XRX commands can be propagated

to the output using

ESCAPEE filename /PS /PSPREAMBLE {RT_XRX}

/REGISTRY This option associates  the EscapeE program with its

standard file extensions in the Registry. Consequently, if you

double-click a file listed in your File manager with with any

of these extensions:

IDF , LSH , PRN , PCL , PLT , RS2  

EscapeE will be called, the file will be opened  and on

display.

/RELOAD Automatically reloads a file if it changes (normally the user

is asked whether it should reload the file of not).

/REM 'remark' Enables a comment to be included which is not interpreted

by EscapeE.

See also /COMMENTS , above.
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/RENAME filename Specify the new filename to be given to input files  after

they have been processed e.g.
*.done

The default is to rename processed input files *.BAK.

See also /ERASE  above.

/REPORT

or
/REPORT ERRORS

Puts an error summary into the Error Log  when errors

occur in batch  or automatic  mode. This gives more

details of errors such as missing fonts, plus the EscapeE

version number and calling command line.

Appending the parameter ERRORS omits any errors ignored

by /ERROROK  option from the report. May be abbreviated

to E, for example:

ESCAPEE *.pcl /ERROROK -136 /ERRORLOG bad.log /
REPORT E

/RES r
or
/RES x,y

Sets the resolution for image generation (default is 300dpi).

Different resolutions may defined for 'x' and 'y' directions by

specifying two numbers in the range 25 to 600dpi. For

example
/RES 204,198

/ROT r Specify that pages are to be rotated  as follows:

0   not rotated (default).

1   90 degrees counter-clockwise.

2   180 degrees (upside down).

3   270 degrees counter-clockwise (90 degrees clockwise).

/RUN p When EscapeE exports a file, it can run the output to

another program.

/RUN Y runs the associated program  on outputting the

file, even in timed  mode.

/RUN N does not run the output file to an associated

program.

If p is set up to be a program name, that program will be

called on completion of the output file and the output file

name passed as a parameter. For example:
ESCAPEE /RUN myprog

runs program myprog (which would be found in the EscapeE

software folder since no path is specified).

See also /RUNWAIT  below.

/RUNWAIT Waits until the output file is complete before running the
associated program.

See also /RUN  above.

/SANDBOX This is used to prevent writing to any folders other than the
one from which the input file is sourced.

See also SANDBOX  configuration symbol.
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/SAVE f This parameter defines which fields are to be output during 
export  to CSV, XML or TXT. Most are identical to the /LOG

 options:

A  All defined fields

B  the log file is to contain Bates page numbers (see also

#)

C  the log file is to be in CSV format

E  write a log record at End of file

F  the log file is to contain the Filenames

H  Header-line containing field-names to be omitted from

CSV log files
L  a new Log file is to be generated for each output file

N  No log file to be generated

P  suppress Page numbers in log file: the default for CSV,

TXT (see also #)

S  the Selected fields

T  all Text: only applies to log files in TXT format

V  make an entry in the log file for every page of output:

the default for CSV and XML log files (see also -)

X  the log file is to be in XML format

#  include page numbers in log file: the default for XML

format (see also P)

?  write a log file record only if a field specifies it

-  suppress 'one log entry per page output ': the default

for TXT (see also V)

~  do not use /LOGTEXT  definition when doing text

logging
1  makes one log file entry for each output file (see also

V).

Note that:

R   Renames the main output file (not the log file) on

completion.

In addition, /SAVE can also take these options:

D  Discard list of files previously created; a new output

file will overwrite one of the same name created in this run
I  for TIFF output: an individual file is created for each

page
O  a suffix of #1, #2 etc. is added to the filename to

make it unique if it would Overwrite an existing file.

/SCALE s Set viewing scale for when a file is first opened. The scale
may be defined as a percentage from 20% to 600% or a
scale factor where:

-2  View full width of page

-1  View all printed data

0  View full page 

1  600% 

2  300% 

3  200% etc.

/SCALEMENU s1 s2... Set up Zoom menu scale list. A scale of 1 corresponds to
600 dpi, 2 to 300 dpi etc.

232

401

401
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/SCALING n Set up gray-scaling of scaled images to improve appearance
when they are scaled down in size, where n = c x 4 + m.
'c' is the mode for color output and 'm' for monochrome. The
values of c and m are:

0  simple scaling

1  two-bit scaling

2  four-bit gray shading

For example /SCALING 9 would request four-bit shading for

colored output and two-bit for monochrome.

/SELCLR c Defines the color of highlighted text such that c is the color
number:

c = 65536 * blue + 256 * green + red

where R, G, B values run from 0 to 255.
Defaults to cyan.

See also /FIELDCLR , /TAGCLR , /TAGFIELDCLR .

/SHIFT r,d Moves the whole page, where r is the distance right and d is

the distance down. Use negative values to move the page
left/up. Units: 1/600 of an inch. Alternatively, use a double-
quote character after the number to denote "inches".

For example, /SHIFT 1",-2.5" moves the page 1 inch right

and 2.5 inches up.

See Configuring the view.

/SIGN
certificate_profile

Sets up the default Security profile  for digitally signing
PDF files. This enables the recipients of the signed PDF file
to verify the authenticity of the document. Example:
/SIGN prof_academy

See also /ENCRYPT  above.

/SOURCE s Source of data:

R  RedTitan software e.g. Dynamic Document Formatter,

W  Windows HP driver,

O  Other.

/SPACEWIDTH n In TXT , IDF , RTF  and UberEd  output formats, this
sets the minimum width of space required to separate two
words.
n is normally given in 1/600th inch dots; when followed by

the % character this indicates that it is a percentage of the

width of the space character; if negative it specifies a
percentage of the font height.
The default minimum width is 33% of the space width .

/STEM s Default stem of filename. This is substituted for = in any
output file spec if not overridden by a field or special PJL
COMMENT .

/SUBST f Gives the name of a file containing font substitutions to be
used in the current run, and may contain wildcards .

See also /SUBSTDEF , below.

/SUBSTDEF f Gives the default file to be used when no /SUBST  option is
given.
May contain wildcards .
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/SYMSET s Set default symbolset .

Commonly used values for s are 2, 3, -29.

To set up automatic symbolset recognition, set s to *  

/TAGCLR c Defines the color of search tag area, such that c is the color

number:

c = 65536 * blue + 256 * green + red

where R, G, B values run from 0 to 255.

Defaults to yellow.

See also /FIELDCLR , /SELCLR , /TAGFIELDCLR .

/TAGFIELDCLR c Defines the color of tag+field area such that c is the color

number:

c = 65536 * blue + 256 * green + red

where R, G, B values run from 0 to 255.

Defaults to yellowish-green.

See also /FIELDCLR , /SELCLR , /TAGCLR .

/TEMP ext Define the extension to be used for temporary files.

/TEXTHEIGHT v Specifies the inter-line spacing for text extraction ,

determining whether blank lines are inserted between lines.

The line spacing v is expressed in the currently configured

units.

See also /LINEHEIGHT  above.

/TIFFORIENT r Define orientation for TIFFs, where 'r' is:

0   no rotation

1   90 degrees counter-clockwise

2   180 degrees counter-clockwise

3   270 degrees counter-clockwise

p   rotate landscape pages clockwise to become portrait

l   rotate portrait pages clockwise to become landscape.

The addition of an asterisk to any of these options stores the
TIFF rotation as zero even when it has been rotated, e.g.
/TIFFORIENT p*

/TIME t Define the time, t, for continuous operation where a scan is

made every t seconds. See Exporting files automatically.

/TITLE 'string' Defines the title of a TIFF  or PDF  document. If the

string includes spaces it must be enclosed in quotes.

81
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/TO f Defines the default specification for output files. For

example:

c:\MyFolder\*.pcl /TIFF /TO c:\Images\*.tif

exports PCL files found in MyFolder to the Images folder in

TIFF format. If /FROM  is also specified then the resulting

output files are joined together.

Note that the /OUTSPEC symbol (if defined) in the INI file
is unchanged.

In the special case of /TEXT  export, the specification for
output file names may start with a "plus" sign: this appends
the output to an existing file or if it does not exist, creates a
new file. E.g.:
ESCAPEE D:\REDTITAN\EscapeE\Dept*.PS /TEXT /TO
"+AllDeptsData.txt"

See also Filenames and wildcards  and /OUTSPEC  above.

/TRIM 

or

/TRIM m

or

/TRIM m,w,h

Remove white space from around any generated images (i.e.
printed areas).
The value m specifies the chosen area to which any clipping

is applied:
0  Full page

1  Printed region only

2  Selected region only

3  Printable region only

Specifying w and h too produces an image w units wide, h

units high.
The default unit is pixels. Using a " specifies inches; a

decimal point specifies centimeters (see /BORDER ).

/TTSUBSET On export to PDF, only that subset of characters actually
used in the document are included in any embedded
TrueType font. See PDF export options .

/UNINSTALL Uninstalls  EscapeE.

/UNITS x Engages the dimensions  for the mouse coordinates, where
x is:

IN  for inches

CM  for centimeters

DE  for decipoints (1/720")

DOTS  for 1/300"

DOT600  for 1/600"

USER  for user-defined units (see Configuring the view ).

If x is preceded by an asterisk then mouse coordinates are

not shown on the page view.

See also /USERUNITS  below.

/USERUNITS n.m When setting up user-defined units, n.m  is the factor by

which 1/600" pixels are multiplied before being shown, e.g.
/UNITS USER /USERUNITS 23.62

would set up and show "mm" units. For "mile" units on a
1:50000 map use 760.32.

See also /UNITS  above.

391

417

386

136 384

393

175

25

55

58

410

410



411Reference

/USING file Allows the name of a script file to be given separately from

the data file e.g.
ESCAPEE DFA0001 /USING MAILSHOT.RS2 /NQ /X

 New:  the default stem for output files is taken from  the
main file rather than the script file. So, for example:
ESCAPEE data121219.pcl /USING MAILSHOT.RS2 /PDF

creates a file called data311219.PDF.

Previously, this would have created MAILSHOT.PDF. To output

the file with this name now, specify scriptfile,mainfile,

e.g.

ESCAPEE MAILSHOT.RS2;data311219.pcl /PDF 

/VIEWFIELDS Option(s) to show fields on a page (see Defining fields and
tags ), where:
A shows All fields,

F shows fields only if Found;

Y is for "Yes, show field names".

For example,
/viewfields AY

shows all the fields and their names.

/VIEWHINTS v Turn hints  on and off. If v is N then no hints are shown.

/VIEWPAGE Sets the page extent  with parameters as follows:
P  Printable area.

A  Unlimited (All). This is the default for plotter mode.

S  Paper size. This is the default for PCL mode.

/WINDOW s,l,t,w,h Specifies state  of window on startup:

s  0=Normal, 1=Minimized, 2=Maximized or

HIDE=background processing .

l  Left offset in pixels.

t  Top offset in pixels.

w  Window width in pixels.

h  Window height in pixels.

See also /DISPLAY  above.

/X Exit after processing the specified file(s).
See Run from a program .

/XMLCODE x Defines the XML encoding scheme, x, where:

1 = "UTF8"  the most compact Unicode encoding (XML

default)
2 = "ASCII" ASCII (strictly 7 bit)

3 = "ANSI"  ISO-8859-1 extended ASCII similar to the

Windows® 8-bit codes
4 = "UCS2"  2-byte Unicode as used by Windows NT® 

5 = "UCS4"  4-byte Unicode (very bulky).
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Special options

These options are obsolete or used for special purposes.

/1BIT Use Windows® scaling for images rather than 2-bit scaling.

/BMP Export  to MS Windows BMP  format.

/DCX Export  file to DCX  fax file format.

/FILE filename Specifies the name of a file which EscapeE will process by
default, e.g.
/FILE BILLS_0000_1234567890.PRC

It is a rarely used, since specifying ESCAPEE /FILE xxx is

equivalent to using the simpler command ESCAPEE xxx.

See also /INSPEC , /OPTIONS , /OUTSPEC  above

/NOCAMP Do not use the Windows option to camp on a directory
(folder) waiting for changes.

/NOFONTS Ignore download fonts; use /IGNORE F  instead.

/NOIMAGES Ignore downloaded images; use /IGNORE I  instead.

/PCL This command for exporting files to Hewlett-Packard Printer
Command Language format is now obsolete. Use /HP
instead to create the PCL output afresh.

/RFFS Scan the RedTitan fonts rather than using font information
files. 

/SHORTCUT Call up the shortcut creation dialog at once. 

/SPACEFILL Space-fill fields. 

/TIFFORIENT O Defined the orientation for TIFFs. Default was P for portrait
(i.e. no rotation), L (landscape), I (inverse P) or J (inverse
L). Use /TIFFORIENT r  instead.

/TIFFRES A synonym for /RES . 

/USELINES x Superseded by /DRAW . 

Links
Run from the command line  
IDF syntax  
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Options file

The command line option /OPTIONS  is particularly useful when a routine job
requires several options or there are several jobs each requiring different options.

It specifies an options file (the extension .OPT is generally used) which contains a list of

one or more command line options. Each line of the file specifies one option. The
options – without a preceding / character – should be of the form:

option=value 

Options that take values of "yes" or "no" only may be abbreviated to Y or N, e.g.

DISPLAY=Y
MKDIR=N

Options that would not normally have a command line parameter need to be in the
form:

option=Y 

For example:

PDF=Y 

Boolean options are simply stated, e.g.
X

A file name can be put in the INI file  using the FILE  option in the options file:
FILE=escapee.prn

 Tip:  For backward compatibility, the "equals" sign may be omitted from options
statements, but using the = instead is preferred as it brings the syntax into line with
that used in INI files.

See Examples: Command lines .

Links
Command line syntax  
Print option flags  

Print option flags

Command-line options to specify print job set-ups (/PDFOPTS , /PCLOPTS , /
PSOPTS ) often include one or more parameters. When saving options you may
choose whether mnemonic  (alphabetic) or numeric  parameters are used. The
default format (for backwards compatibility) is numeric unless all options have been
read in mnemonic form.

Mnemonic parameters

To use mnemonic parameters, a sequence of two-character codes is used. The initial
letter (upper case) in these two-character codes defines the Class of option:

C  Comments 

F  Fonts 

G  Graphics 

M  Macros 

N  No or do not allow 

O  Output 

S  Substitute fonts 

403
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For clarity, the codes can be separated by commas:

PDFOPTS FT,NP,NN,OP

or for conciseness, the commas may be omitted and the parameters run together:

PDFOPTS FTNPNNOP

For human readability, however, using upper case for the first letter and lower case
for the second letter of each code, e.g.:

PDFOPTS FtNpNnOp

may be a better approach. It also has the advantage that parameters in the same 
Class  can then be compounded, omitting any repeated initial capital letters, e.g.:
PDFOPTS FtNpnOp

 See the option flags table arranged in Mnemonic code order  below.

Mnemonic code order

Code Flag Decimal Output Description

Co $4000000 67108864 All Store comments in the output file.
See also Ox , Np .

Cx $1 1 PCL only If PJL comments are to be saved then save
them as XML.

Fa $800 2048 PDF, PS only Do not download fonts: all fonts are to be
substituted by standard Postscript or Acrobat®
fonts.

Fp $40000 262144 Print
formats*

Download fonts before use.

Ft $1000 4096 Print
formats*

Include TrueType fonts in the output file.

Ga $10000 65536 All Image the whole page as a graphic.

Gt $20000 131072 Print
formats*

Image all but the text.

Ma $40 64 PCL only Macro is to be positioned absolutely.

Mp $1000000 16777216 PCL only Make a permanent macro

Mt $2000000 33554432 PCL only Make a temporary macro 

N4 $1000000
0

268435456 All Inhibit CCITT group 4 compression.

Nb $400000 4194304 PDF only Skip blank pages.

Nc $4 4 PDF only Disable copying of text and graphics from the
document.

Ne $2 2 PDF only Disable changing the document other than by
adding or changing text notes.

Ni $100000 1048576 PCL only No scaled images output.
See also No .

Nj $80 128 PCL only Do not use any PJL commands.

Nn $8 8 PDF only Disable adding and changing text notes.

No $100000 1048576 PDF only Omit the table of contents.
See also Ni .

Np $1 1 PDF only Disables printing the document.
See also Cx , Ox .

Ns $2000000
0

536870912 PCL only Scaled printing forbidden.

O6 $400 1024 All Request 600 dpi resolution.

Oa $20 32 PDF only AES encryption

Oc $200 512 Print
formats*

Combine words into longer text strings where
possible.

413
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Oe $200000 2097152 PDF only Use 128 bit encryption.
See also Ol .

Og $8000000 134217728 PDF, PS only Output graphics on pass 1, text on pass 2

Oi $80000 524288 PCL, PDF
only

Allow inverse orientations to be displayed upside
down

Oj $4000000
0

1073741824 All Jog offsetting required

Ok $800000 8388608 PDF, PS
only 

Suppress reordering of shading and graphics.

Ol $200000 2097152 PCL only PCL Lightweight Imaging Device.
See also Oe .

Op $100 256 All Compress the PDF output using Flate
compression.

Os $8000000
0

2147483648 All Stapling required.

Ox $1 1 HTML only Save as XML, not simple HTML.
See also Cx , Ox .

Sb $4000 16384 Print
formats*

Use substitutes instead of any bitmap fonts.

Sn $8000 32768 Print
formats*

Do not use substitute fonts even a substitute
font has been specified in the font library.

St $2000 8192 Print
formats*

Use substitutes instead of any True type fonts.

Numeric parameters

The value of an option when expressed numerically is the sum of all the flag-bits.
For example, the flag bits ($1000+1+8+$100) add up to $1109; in decimal this
option would be keyed-in as:

PDFOPTS: 4361

 See the option flags table arranged in Numeric flag bit order  below.

Numeric flag bit order

Flag Decimal Code Output Description

$1 1 Cx

or

PCL only If PJL comments are to be saved then save them as
XML.

Ox

or

HTML only Save as XML, not simple HTML.

Np PDF only Disables printing the document.

$2 2 Ne PDF only Disable changing the document other than by adding
or changing text notes.

$4 4 Nc PDF only Disable copying of text and graphics from the
document.

$8 8 Nn PDF only Disable adding and changing text notes.

$10 16 (unassigned)

$20 32 Oa PDF only AES encryption

$40 64 Ma PCL only Macro is to be positioned absolutely.

$80 128 Nj PCL only Do not use any PJL commands.

$100 256 Op All Compress the output (e.g. using Flate compression
for PDF).

$200 512 Oc Print
formats*

Combine words into longer text strings where
possible.

$400 1024 O6 All Request 600 dpi resolution.

415
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$800 2048 Fa PDF, PS only Do not download fonts: all fonts are to be
substituted by standard Postscript or Acrobat®
fonts.

$1000 4096 Ft Print
formats*

TrueType fonts are to be included in the output file.

$2000 8192 St Print
formats*

Use substitutes instead of any True type fonts.

$4000 16384 Sb Print
formats*

Use substitutes instead of any bitmap fonts.

$8000 32768 Sn Print
formats*

Do not use substitute fonts even a substitute font
has been specified in the font library.

$10000 65536 Ga All Image the whole page as a graphic.

$20000 131072 Gt Print
formats*

Image all but the text.

$40000 262144 Fp Print
formats*

Download fonts before use.

$80000 524288 Oi PCL, PDF
only

Allow inverse orientations to be displayed upside
down.

$100000 1048576 Ni

or

PCL only No scaled images.

No PDF only Omit the table of contents.

$200000 2097152 Ol

or

PCL only PCL Lightweight Imaging Device.

Oe PDF only Use 128 bit encryption.

$400000 4194304 Nb PDF only Skip blank pages.

$800000 8388608 Ok PDF, PS
only 

Suppress reordering of shading and graphics.

$1000000 16777216 Mp PCL only Make a permanent macro.

$2000000 33554432 Mt PCL only Make a temporary macro.

$4000000 67108864 Co All Store comments in the output file.

$8000000 134217728 Og PDF, PS only Output graphics on pass 1, text on pass 2.

$1000000
0
268435456 N4 All Inhibit CCITT group 4 compression.

$2000000
0
536870912 Ns PCL only Scaled printing forbidden.

$4000000
0
107374182

4
Oj All Jog offsetting required.

$8000000
0
214748364

8
Os All Stapling required.

-1 All Resets export options to their default values.

*"Print formats" are those which include the text of the document as strings of characters (e.g. PCL, PDF, PS) rather than just
images (e.g. JPEG, PNG, TIFF).
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EscapeE configuration symbols

The default configuration is stored in a number of environment symbols which will
normally be set from the program's configuration or main (export) menus.

Most of these symbols are stored in the [PCLVIEW] section of the RT.INI file and have

the same names as the corresponding command-line option. For example
INPUT=PCL
IMAGECACHE=400

The following symbols are in the main [REDTITAN] section of the RT.INI file:

INSTALLROOTDIR The path to the RedTitan folder containing folders such as
Software, e.g. c:\Program files\Redtitan\ 

RTINI The name and path of the RTZ licence file , e.g.
d:\Software\Redtitan\RTlicence.exe

RTLANG Set the language version of EscapeE:

33 = French

34 = Spanish

44 = English

49 = German

55 = Portuguese.

RTLIBROOT The path to the library  root folder containing folders such as
Macros.

RTPCLDL The folder in which the downloaded fonts will be stored.

RTPCLLIB The folder where the resident fonts are stored.

RTPCLMACROS The folder in which macros are stored.

SANDBOX To confine EscapeE to accessing files in the starting folder and its
sub-folder(s) only (e.g. for testing purposes), set:

 SANDBOX=Y

See also /SANDBOX  command line option.

TTLIB Defines the filename of a specific character recognition database
to be used by EEfonts, e.g.

ESCAPEE /TTLIB TEMP.TTK.

Setting the symbol to N in the rt.ini file instead, however, prevents the
creation of the character recognition database:
TTLIB=N

See also /OPTIONS  command line option.

 Technical notes

If any errors are encountered in the RT.INI file, EscapeE logs the date, time and
details in a file named escapee.log in the Windows® temporary folder (normally C:

\Users\<username>\AppData\Local\Temp). See also /INILOG .

If the /INI  option is specified and the REDTITAN symbol is not found, EscapeE sets
up the REDTITAN symbol in WIN.INI if it can write to it, otherwise in the Registry 
KEY_CURRENT_USER\SOFTWARE\REDTITAN\REDTITAN or else HKEY_LOCAL_MACHINE 
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Error return codes

If a program  calls EscapeE and waits for it to complete, it can obtain the return
code using the Windows® GetExitCodeProcess call. The code is normally zero.

A positive  return code indicates an I/O or system error; a negative  number
indicates an internally generated error return code. In the case of an error when
running in continuous mode or when the /X  option is supplied, there will be an
entry in the ERROR.LOG file, see Command line option /ERRORLOG .

To suppress the reporting of return codes that would not affect your program
adversely, use Command line option /ERROROK . For example, to ignore errors
concerning missing fonts  and printing beyond the page bounds  use
/ERROROK -133,-136

Error return codes

1 Illegal file name 

2 File not found

3 Illegal path or directory not found

4 Too many open files

5 File access denied

6 Invalid file handle.*

12 Invalid file access code.*

15 Invalid drive letter

16 Cannot remove current directory

17 Cannot rename across drives

32 File open to another user

87 Invalid parameter to a Windows call

100 Reading beyond end of file

102 Attempting to open a file that has no name assigned

103 Reading from or writing to a file that is not open

104 Reading from a file that is not open.*

105 Writing to a file that is not open.*

106 Invalid numeric format

110 The INI file specified on the command line does not exist

112 Not enough disk space

161 Invalid file path

199 Premature end of file encountered.

200 Division by zero.*

201 Range check error.*

202 Stack overflow error.

203 Not enough memory.

204 Invalid pointer operation.*

Codes marked with an * indicate internal errors which should not occur – in the
unlikely event that you encounter one, please contact help@redtitan.com.
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-1 No file name given

-2 Bad file format

-3 Wrong file type

-11 Key not found

-12 Record too large for buffer

-13 End of file

-14 Bad key

-15 Bad Keyfiles version

-16 Record too large

-17 Operation not allowed

-18 Internal fault

-19 File not open

-29 Bad disk address

-30 Bad block

-33 Bad last block address

-34 Bad record header

-35 Newly allocated block already exists

-36 Block is of wrong type

-37 Bad backward link

-38 Bad forward link

-39 Bad disk address of self

-40 Bad file identifier

-41 Block remains locked

-42 Incorrect index

-100 Zero width image

-101 Null image specified

-102 Unsupported compression mode for type of image

-103 Too many strips

-104 Faulty image

-105 Unable to access raster

-120 Unknown option

-121 No fields defined

-122 Invalid page range

-123 Canceled by user

-124 PDF, Postscript® or PCL® export error

-125 XML error

-126 FDL error

-127 Image error

-130 TCP/IP error

-131 Transform error

-132 Invalid font substitute file
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-133 Printing beyond page bounds

-134 Unknown PCL command

-135 Unsupported printer language

-136 Missing/unknown fonts

-137 Unsupported Download Font Format

-138 LZW compression not authorized

-139 AFP error

-140 Unsupported transform

-141 CSV error: invalid comma-separated field

-142 Too many concurrent users

-143 Feature not authorized

-144 Print2PC box not operational

-145 Bad DICOM field

-146 Problem with the Color Management System

-147 Illegal field expression

-148 Invalid control file

-149 Unsupported feature – ignored

-150 Unimplemented feature – problems likely

-151 Minor error reported

-152 Major error reported

-153 Bad file format

-154 Too many colors or patterns

-155 Security Certificate not found

-198 Unable to install font

-199 OpenType® fonts not supported on this system

-200 Not a TIFF file

-201 Unexpected end of TIFF file

-202 Need to use TIFFJPEG unit.*

-203 TIFF & JPEG data inconsistent

-204 Bad JPEG data

-205 No JPEG interchange data present

-206 Unsupported TIFF format

-207 TIFF warning messages given

-208 TIFF – no image present

-300 Not a font database file

-301 Wrong database file version

-302 No suitable character encoding found

-303 Bad TrueType® font

-304 Inconsistent character encoding between fonts with same name

-305 This type of databases cannot be merged with yours

-306 Characters too large to generate
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Composite fields syntax summary

Topic Syntax Function

Defining field values {fieldname:=value} Assign field value.

Partial fields {fieldname.size} Returns attribute(s) of a
field.

{fieldname:range} Extracts the part of a field
value specified by range.

{fieldname[n]} Extracts the nth sub-string

from the named field.

{fieldname[#n]} Extracts the nth line from

a multi-line field.

Numerical conditions {+fieldname=[integer1],
[integer2]
[[,integer3],integer4,
[integer5]]}

Defines a counter.

String conditions {+fieldname=['string1']
,['string2']}

Defines string1 to be

used if a field is found
and string2 if a field is

not found.

Page conditions {=fieldname} Assign a null value if the
field is not on current
page.

{+=fieldname['string1']
,['string2']}

Defines string1 to be

used if a field has not
changed and string2 if a

field has changed.

User input data fields {"query"} Question prompting the
User to enter a value.

Links
Special fields in composed strings  

Bit-wise logic

Binary logic calculations can be made when fields contain integer values.
This example shows the 5 lowest binary bits (all of the higher bits are zeroes) for two
numbers A, B:

Decimal
Lowest 5 binary bits

bit5 bit4 bit3 bit2 bit1

A 7 (=4+2+1) 0 0 1 1 1

B 21 (=16+4+1) 1 0 1 0 1

253
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A "bit-wise" logic operator works with a pair of bits, one from each integer. So in this
example, it operates on the bit1 values of 1 and 1, the bit2 values of 1 and 0 etc.,
until the entire integer has been done: so in the case of '32-bit' numbers, this means
32 operations are done in parallel for every pair of integers!

Boolean fields may take one of two values: "-1" equating to True (represented by all
bits set to 1) or "0" equating to False (all bits set to 0).

The outcome of the operation depends on the operator – see AND , OR  and NOT
tables below:

& operator AND

Outcome is 0 except when both bits are 1.

If A is:

...and B is 0 1

0 0 0

1 0 1

Example:
Binary 111&10101 is 101 (i.e. 5 in decimal).

| operator OR

Outcome is 1 except when both bits are 0.

If A is:

...and B is 0 1

0 0 1

1 1 1

Example:
Binary 111|10101 is 10111 (i.e. 23 in decimal).

¬ operator NOT

This is used to invert the values of the bits. It is commonly used in combination with
AND  and OR  operators.

In integer calculations

If bit is: 0 1

...then outcome is: 1 0

Example:
¬1 is 0.

In Boolean expressions

If value is: False (0) True (-1)

...then outcome is: True (-1) False (0)

Example:
¬0 is -1.

See Composite field expressions .

Links
Composite field expressions  
Partial fields  
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Required DICOM tags

It is a requirement that certain DICOM tags must be defined to make a valid DICOM
document. These tags are listed in the tables below.

The DICOMDIR file indexes these values:

Group Element Tag name

0008 0020 Study date

0008 0030 Study time

0010 0020 Patient's ID

0020 0010 Study ID

0020 0011 Series number

These tags must be set up on the first page of a DICOM document:

Group Element Tag name

0008 0020 Study date

0008 0030 Study time

0008 0050 Accession Number

0008 0090 Referring Physician's Name

0010 0010 Patient's name

0010 0020 Patient's ID

0010 0030 Patient's date of birth

0010 0040 Patient's sex

0020 0010 Study ID

0020 0011 Series number

0020 0020 Patient orientation

Each succeeding page in a multi-page document steps the "Instance Number" tag by
1, and two "Unique IDentifier" tags are generated automatically by EscapeE:

Group Element Tag name

0020 0013 Instance Number (starts at 1)

0020 000D Study UID

0020 000E Series UID

In addition, these tags are propagated (if present) from the first page to all other
pages in the set:

Group Element Tag name

0010 0010 Patient's name

0010 0030 Patient's date of birth

0010 0032 Patients birth time

0010 0040 Patient's sex

0010 1010 Patients age

Links
DICOM medical image export  
DICOM export options  
DICOM Element Tags  
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LOF details

EscapeE uses "LOF" (List Of Files) files in a number of ways. All are, in essence, a list
of file paths specified in a text file, typically

<filename>.lof 

Control files

When used as control files , the files in the list are of the form
<filename> /<option> /<option> ... 
and will be processed in order (usually, though not necessarily, utilizing the /JOIN
option) to create a single composite output file. The file processing options are
initialized as specified in configuration files (usually RT.INI ), modified by any
EscapeE command-line  options.
See Example .LOF file .

The initial identifier
:\DOCUMENT
enables EscapeE to recognize Intelligent Document Format  LOF control files. For
example, the first line of an LOF Booklet  file created by composite document wizard
would be
\DOCUMENT BOOKLET 

See Example .LOF file  

LOF files created by the EscapeE Remember file feature take the initial identifier
:\ESCAPEE
by itself on the first line, followed by the list of files: see Example .LOF file . When
the LOF file is viewed in the Text Editor, double-clicking the name of a file in the list
will run it, with the specified options, in the EscapeE window, see Creating a data
control file .

 EscapeE's Command-line options  may be appended to any component
document's filename in an LOF file, see Example Command lines . The options
commonly used in LOF files are listed below .

Job files

If the initial identifier :\ESCAPEE is given the option "JOBS",
:\ESCAPEE JOBS
EscapeE will recognize the file paths as a list of INI configuration files. These files are
not processed like control files : they are provided as a convenient resource for Users
to select appropriate INI files for the job in hand, see Run custom jobs . If the file is
saved with the extension .JOB instead of .LOF, Comments  may be appended to the
file paths: see Example .LOF file  example and Example .JOB file .
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Frequently used options

/DEFINE fieldname=value
Defines a field.

/ERASE
Erases that input file once the LOF has been exported.

/FIELDS fieldsfile
Specifies that ".EE" fieldsfile is used to provide the field definitions for that

component document.

/REM 'remark'
For placing a comment in the code which will be ignored by EscapeE.

/PAGES n-m
To include a sub-set of pages from the specified file rather than the whole file; for
example
"s:\escapee\archive\reviews.pcl" /pages 2-3

Associated files

Separate DLLs (Dynamic Link Libraries) are used for import  and export  – they
should be installed in the EscapeE program directory.

Import DLLs

Import DLLs of the form RTxIN.DLL found in the EscapeE folder are used

automatically when files with the extension x are opened or the /INPUT  command

used.

RTAFPIN.DLL AFP input

RTDCMIN.DLL DICOM input

RTDDFIN.DLL Dynamic Document Formatter  files (PPO, PPG etc.)

RTESCPIN.DLL Epson® Esc-P  input (also OKI ® Esc %9)

RTGERIN.DLL Gerber plotter input

RTHTMLIN.DLL Used by Ubered2  to read its generated output into EscapeE

RTIDFIN.DLL Intelligent Document Format  files

RTPCCIN.DLL Printer Control Code  input

RTPDFIN.DLL PDF input

RTPSIN.DLL PostScript® input

RTPTRXIN.DLL Printrex printer format input

RTRS2IN.DLL RS2  files

RTRTFIN.DLL Rich Text input

RTXLIN.DLL PCL XL (PCL6) input
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Export DLLs

RTHPOUT.DLL PCL output for LIDL printers

RTHTMOUT.DLL HTML output

RTIPDOUT.DLL IPDS output

RTPCLOUT.DLL PCL output

RTPDFOUT.DLL PDF output

RTPSOUT.DLL PostScript output

RTXMLOUT.DLL XML output

RTXPSOUT.DLL XPS output

Other DLLs

PCLLIST.DLL PCL listing

RTAFPFONTS.DLL
RTAFPIMAGES.DLL
RTAFPIOA.DLL

Used by AFP import  

RTCMS.DLL Colour management system used for handling ICC profiles

RTERR32.DLL Translates error codes into text messages (replaces obsolete
16-bit RTERROR.DLL)

RTPACK.D32 Data compression

RTPDFPKC.DLL PDF encryption/decryption interface

RTSEC32.DLL Licence checker (replaces obsolete 16-bit RTSEC.DLL)

RTSIGN.DLL Digital signatures

RTUNPACK.D32 Data decompression

Font Information Files

PSFONTS.FIF Font widths are read from this file and used to improve
spacing of substituted text.

WINFONTS.FIF Resident font definitions.

Other files

EEDATA.HTM HTML file for display of HTML output

EENAVBAR.HTM Navigation-bar for HTML output

EPSON.DAT Epson® Esc-P command descriptions for RTESCPIN

PP.JSL JSL file for Xerox IMG® output

Other extensions

.EE When you mark up data fields and extract them, EscapeE
creates an "EE " file with the field name definitions.

.SUB Font substitutions file .

.LOG Log file in plain text .

.CSV Log file in CSV format .

.XML Log file in XML format .

.TMP The output file may be created using this temporary
extension and then renamed when complete. The temporary
extension can be changed using /TEMP  option.

Links
HTML export options  
Associated programs  
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File formats list

EscapeE works with these formats:

Input Export AFP  – IBM advanced function printing format images

Input Export BMP  – Bitmap images

Input CAPSL  – Canon

Export data CSV  Comma separated fields

Input Export DCM  – DICOM medical images
Input Export DCX  fax file format
Input DDF  – RedTitan Dynamic Document Formatter language

Export EMF  Enhanced Metafile

Input ESCP  – Epson printer language

Export FDL  forms

Input GIF  – Graphic interchange format

Input
Create

Export  
Export

HTML  document – WEB page
HTML5  UberEd Format
HTML MIME-encoded: see MHT .

Input
Create

Export IDF  – Intelligent Document Format

Input Export  
Export

IMG  images (Xerox)
IMG  images (Xerox, Barr)

Export IPDS  (if installed)

Input Export JPEG  – JPEG photo format images

Create Export MCR  Macro file

Export MHT  (MIME-encoded HTML)

Input PCC  – Lineprinter control codes
Input PCC,ROW  – Lineprinter row number format
Input Export PCL  – HP printer control language document
Input Export PCX  – PC Paint format
Input Export  

Export
PDF  – Portable document format document
PDF/A

Input Export PNG  – Portable network graphic images
Input Export PS  – PostScript levels  2 and 3.
Input PTRX  – Printrex

Input RS2  – RedTitan scripting language
Input Export RTF  – Rich Text Format

Input STAR  – Star POS  printer format

Input Export TIFF  – Tag image format
Export TXT  Plain Text

Input Export XIMG – Xerox IMG

Input XL  – HP PCL 6
Export data XML  fields
Export XPS  document – XML paper specification

Input ZJS  – Zenographics format
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PostScript: levels and types

PostScript import

The RedTitan PostScript engine interprets files conforming to Adobe 'level 2'
specification and supports many popular 'level 3' features, such as:

Flate  decompression

ReusableStreamDecode

CID fonts

Masked images

Rather than just paint the pages, EscapeE is able to flatten (and thus simplify) them,
facilitating conversion to other formats or document modification.

PostScript export

Compressed files generated for (older) level 2 PostScript  printers will work on the
(newer) PostScript level 3 printers. These PostScript 3 printers accept more efficient
methods of compression (e.g. Flate ) than PostScript level 2 and so even smaller
files may be generated, but these files may not be usable by PostScript level 2
printers.

PostScript font types

The PostScript language encompasses the specification of fonts. There are several
'types' of PostScript fonts.

type 1 The original PostScript outline font.
Converted to OpenType  in EscapeE.

type 2 Type1 format updated to a more compact form.
Converted to OpenType in EscapeE.

type 3 'User-defined' fonts – fonts sourced from documents. The characters in
bitmapped fonts can be recognized as text, but those in vector drawn fonts
cannot.

type 4 Cartridge fonts: converted to OpenType in EscapeE.

type 42 Converted to TrueType  in EscapeE.

type 0 These are fonts constructed from characters extracted from other fonts. A
type 0 font may contain characters used in Western fonts (8-bit, e.g.
Roman), Eastern fonts (larger, e.g. Chinese) or a mixture of the two.
EscapeE works with the component fonts directly.

Links
PostScript file export  
PostScript export options

445

445

118

445

446

448

182

183



429Reference

Tray and bin numbers

This topic lists some of the technical details which EscapeE media definitions
manage behind the scenes.

 A PCL file will normally specify the media that it expects the whole document to be
printed on. It does this by quoting a  source tray number . This is not the number
written on a printer tray, but an index number referring to the sort of tray that the
media may be found in. For example, 2 for paper or 3 for envelopes.

PCL tray numbers

1 = Feed paper from a printer-specific tray
2 = Feed paper from manual input
3 = Feed envelope from manual input
4 = Feed paper from lower tray
5 = Feed paper from optional paper source
6 = Feed envelope from optional envelope feeder
Note: '0' in the tray list represents the default tray.

Selecting Print from the File menu engages the Windows® printer driver. This too
uses 'sorts' of media trays referenced by number  – confusingly, not the same as the
PCL ones (and the same printer run in PostScript mode may use yet another tray
number). EscapeE uses the symbol HPTRAYS  to translate the PCL source tray
numbers to Windows printer tray numbers.

Windows driver numbers

1 = Upper 
2 = Lower 
3 = Middle 
4 = Manual 
5 = Envelope feed
6 = Feed envelope manually
7 = Auto

11 = Large-capacity feeder

The numbers on the actual physical trays depend on the model of printer and do not
occur in the file's printing set-up! For example, on the Xerox N40 printer, a PCL file
requesting the lower tray "4" should be output as "2" by the Windows driver and the
paper would actually be found in the printer tray labeled "3".

Output bin numbers are simpler, typically:

0  Automatic
1  Upper
2  Lower (rear)

Technical note

Instead of selecting the tray by number, some printers allow an alphanumeric ID
associated with a specific tray to be used in the {escape}&n#W command.

Links
Media definitions
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Fonts used by EscapeE

Simulated for the printer:

Filename PCL font name Used for Typeface number(s)

COUR Courier 3, 4099

ELGO Letter Gothic 6

LYRA Univers 52, 4148

RTLP Lineprinter 0

RTSTICK HP-GL Stick 48

System's standard Windows fonts:

ARIAL Arial 16602

TIMES Times New Roman 5, 4101, 16901

SYMBOL Symbol 16686

WINGDING Wingdings 31402

Link
Handling fonts 33



431Reference

Commonly used fonts

Weight Style Typeface Famly Name

0 4 4362 Albertus ExtraBold
0 0 4362 Albertus Medium
0 0 4168 Antique Olive
0 3 4168 Antique Olive Bold
1 0 4168 Antique Olive Italic
0 0 16602 Arial
0 3 16602 Arial Bold
1 3 16602 Arial Bold Italic
1 0 16602 Arial Italic
0 0 4113 CG Omega
0 3 4113 CG Omega Bold
1 3 4113 CG Omega Bold Italic
1 0 4113 CG Omega Italic
0 3 4101 CG Times Bold
1 3 4101 CG Times Bold Italic
1 0 4101 CG Times Italic
0 0 4101 CG Times Roman
4 0 4140 Clarendon Condensed
1 0 4116 Coronet
0 3 4099 Courier Bold
1 3 4099 Courier Bold Italic
1 0 4099 Courier Italic
0 0 4099 Courier Medium
0 0 4197 Garamond Antiqua
0 3 4197 Garamond Antiqua Bold
1 3 4197 Garamond Antiqua Bold Italic
1 0 4197 Garamond Antiqua Italic
0 0 48 HP-GL Stick font
0 0 4102 Letter Gothic
0 3 4102 Letter Gothic Bold
1 0 4102 Letter Gothic Italic
0 0 4297 Marigold
0 3 16901 Times New Bold
1 3 16901 Times New Bold Italic
1 0 16901 Times New Italic
0 0 16901 Times New Roman
0 0 4148 Univers
0 3 4148 Univers Bold
1 3 4148 Univers Bold Italic
4 0 4148 Univers Condensed
4 3 4148 Univers Condensed Bold
5 3 4148 Univers Condensed Bold Italic
5 0 4148 Univers Condensed Italic
1 0 4148 Univers Italic
0 0 31402 Wingdings

Links
Using font attributes as tags  
Fonts used by EscapeE  
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Standard paper and envelope sizes

Paper
width x height

mm inches

A0 841 x1189 (33.1 x 46.8)

A1 594 x 841 (23.4 x 33.1)

A2 420 x 594 (16.5 x 23.4)

A3 297 x 420 (11.7 x 16.5)

A4 210 x 297 ( 8.3 x 11.7)

A5 148 x 210 ( 5.8 x 8.3 )

A6 105 x 148 ( 4.1 x 5.8 )

letter (216 x 279) 8.5 x 11.

ledger (432 x 279) 17 x 11

ANSIC 432 x 559 17 x 22

ANSID 559 x 864 22 x 34

ANSIE 864 x1118 34 x 44

ARCHA 229 x 305 09 x 12

ARCHB 305 x 457 12 x 18

ARCHC 457 x 610 18 x 24

ARCHD 610 x 914 24 x 36

ARCHE 914 x1219 36 x 48

ARCH30 00(76.2 x 106.67) 30 x 42

executive (184 x 267) 7.25 x 10.5

legal (216 x 356) 8.5 x 14.

RA3 305 x 430 (12.0 x 16.9)

RA4 215 x 305 ( 8.5 x 12.0)

SRA3 320 x 450 (12.6 x 17.7)

SRA4 225 x 320 ( 8.9 x 12.6)

Envelope
width x height

mm inches

COMMERCIAL10 (241.3 x 104.8) 009.5 x 4.125

C5 229 x 162 9.0 x 6.4

DL 220 x 110 8.66 x 4.33

Monarch (190.2 x 98.4 ) 007.5 x 3.875

To specify media on the command line, use /PAPER .

Links
Viewing page information  
Configuring the printer defaults  
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Examples index

.EE file  

.JOB file  

.LOF file  

Command lines  

Composite fields  

File prefix

Local file path  

PDFPREF options  

Strings  

Search tags  

URI path  

Links
Sample IDF scripts  
Examples using Plugins [Plugins Help]

.EE file

This is a page of a PCL® document
displayed in EscapeE with 3 fields
defined and shown:

name

date

address

The fields are defined in this ".EE" file:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<ESCAPEE UNITS="DOT600">
<_TAG SS=" "/>
<name LEFT="2442" TOP="1134" WIDTH="1824" HEIGHT="204"/>
<date UNITS="CM" LEFT="2" TOP="6.33" WIDTH="7.5" HEIGHT="0.75"/>
<address LEFT="450" TOP="6306" WIDTH="2052" HEIGHT="108"/>
</ESCAPEE>

Note that the units of measurement for the document have been set up in line2 as
1/600 inch dots but the units used for specifying the "date" field's dimensions have
been changed to centimeters in line5.
The UNITS attribute may take these values:

IN inches
CM centimeters
DE decipoints (1/720 inch)
DOTS 1/300 inch
DOT600 1/600 inch

Links
About exporting data  
Defining fields and tags  
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.JOB file

.JOB files  contain a list of .INI file paths (like .LOF files ) but they may also
include "Comments" for a User to see. If an asterisk is inserted between a file path
and the Comment then the display of the file path is suppressed and the User sees
just the Comment.

When this job file:

:\ESCAPEE JOBS
"c:\REDTITAN\SOFTWARE\JOBS\Atlanta12.INI" English USA
"c:\REDTITAN\SOFTWARE\JOBS\Berlin34.INI"German
"c:\REDTITAN\SOFTWARE\JOBS\High Wycombe56.INI" *English
"c:\REDTITAN\SOFTWARE\JOBS\Verneuille78.INI"*French
c:\REDTITAN\SOFTWARE\JOBS\Copenhagen90.INI

named ExampleJob.JOB is selected, the User sees this list:

Job type (.ini file)

c:\REDTITAN\SOFTWARE\JOBS\ExampleJob.JOB

"c:\REDTITAN\SOFTWARE\JOBS\Atlanta12.INI" English USA

"c:\REDTITAN\SOFTWARE\JOBS\Berlin34.INI" German

English

French

"c:\REDTITAN\SOFTWARE\JOBS\Copenhagen90.INI"

 shown in the EscapeE window.

Links
Run custom jobs  

.LOF file

There are several ways of using 'List Of Files' files in EscapeE.

Example 1

Enter file paths in a plain text editor and save the file as type ".LOF". EscapeE can
open this file and create a composite document, e.g.:

c:\Resources\Images\broccoli.BMP
c:\Veg\Summaries\broccoli.TXT
c:\Resources\Images\cauliflower.BMP
c:\Veg\Summaries\cauliflower.TXT

Example 2

The EscapeE Remember file feature could be used to assemble the same files into an
LOF composite document, see Creating an LOF control file automatically . The LOF
file created would be shown in the text editor window:

:\ESCAPEE
c:\Resources\Images\broccoli.BMP
c:\Veg\Summaries\broccoli.TXT
c:\Resources\Images\cauliflower.BMP
c:\Veg\Summaries\cauliflower.TXT

371 434
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Example 3

This LOF file was created by the IDF Composite document wizard to extract music
parts  from a score:

:\DOCUMENT MUSICPARTS
:\PORTRAIT
:\UNITS INCHES
:\LEFT 0 \TOP 0
:\REPEATS 4
:\SCALE 1
:\PAPER A4
"c:\Music\IDF\Tallis2.pdf" 1 /PART 1 /CLIPX 0.5967 /CLIPY 4.7767 /WIDTH
7.0767 /HEIGHT 0.5633
"c:\Music\IDF\Tallis2.pdf" 1 /PART 2 /CLIPX 0.5967 /CLIPY 5.4033 /WIDTH
7.0767 /HEIGHT 0.5667
"c:\Music\IDF\Tallis2.pdf" 1 /PART 3 /CLIPX 0.5967 /CLIPY 6.0333 /WIDTH
7.0767 /HEIGHT 0.51

Example 4

This file named "ExampleJob.LOF" provides a list of INI files for a custom job :

:\ESCAPEE JOBS
c:\REDTITAN\SOFTWARE\JOBS\Atlanta12.INI
c:\REDTITAN\SOFTWARE\JOBS\Berlin34.INI
'c:\REDTITAN\SOFTWARE\JOBS\High Wycombe56.INI'
c:\REDTITAN\SOFTWARE\JOBS\Verneuille78.INI
c:\REDTITAN\SOFTWARE\JOBS\Copenhagen90.INI

The User chooses an INI file from this list shown in the EscapeE window:

Job type (.ini file)

c:\REDTITAN\SOFTWARE\JOBS\ExampleJob.LOF

"c:\REDTITAN\SOFTWARE\JOBS\Atlanta12.INI"

"c:\REDTITAN\SOFTWARE\JOBS\Berlin34.INI"

"c:\REDTITAN\SOFTWARE\JOBS\High Wycombe56.INI"

"c:\REDTITAN\SOFTWARE\JOBS\Verneuille78.INI"

"c:\REDTITAN\SOFTWARE\JOBS\Copenhagen90.INI"

 Tip:  if the purpose of an INI file isn't clear from its name or location, save the job
file with the extension ".JOB" instead of ".LOF" and add Comments to make it easier
for the User make their choice – see Example .JOB file .

Links
LOF details  
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Command lines

Example 1

This command line in the Run box

escapee /from REPORT.CSV,FILENAME,PAGE

calls file REPORT.csv containing this text:

"FILENAME","PAGE"
"REPORT.prn","2"
"REPORT.prn","5"
"REPORT.prn","6"

The PAGE field supplies the value of 'startpagefield' but as no 'endpagefield' values
are supplied, EscapeE fills in default values for you. This results in the first segment
consisting of pages 2, 3 and 4; the second segment of just page 5 and third segment,
just page 6.

You might then go on to use this command line:

escapee REPORT.PRN /csv /save fecr#? /fields COUNT.EE

to create a log file containing the file name and page number. A log record is written
every time a field is encountered that has the 'Write log record' option selected (see 
Setting field actions ), and also at the end of file. This file can then be read back and
have the number of pages added using the {_numpages}  special field. For example

escapee /from REPORT.CSV /pcl /fields MARKUP.EE

Example 2

A plain text log file may contain a "Text log file message". This can be set up on the
'Log file' page of the Configuration dialog (see Setting log file options ) or on the
command-line using the /LOGTEXT  option. It can contain Special fields in composed
strings  as well as text. For example
escapee myfile.pcl /pdf /log 1T /logtext '{_Day}/{_Month}/{_Year} {_Hour}:
{_Minute} input file {_ifilename}{_crlf}Exported as: {_ofilename}:
{_sheets} pages'

The resulting log file "myfile.log" contains:
24/09/2009 15:15 input file C:\temp\myfile.pcl
Exported as: C:\temp\myfile.PDF: 5 pages
24/09/2009 15:15 input file C:\temp\myfile.txt
Exported as: C:\temp\myfile1.PDF: 2 pages

Should you wish to suppress the message on occasion, just add "~" to the /LOG

options; there is no need to delete the "message":

escapee myfile.pcl /pdf /log 1T~ /logtext '{_Day}/{_Month}/{_Year}
{_Hour}:{_Minute} input file {_ifilename}{_crlf}Exported as: {_ofilename}:
{_sheets} pages'

Then if you want to return to showing the message, you only need to remove the ~
character.

Example 3

Command line options may be appended to component files specified in a LOF control
file; see LOF details .

:\ESCAPEE
'C:\TEST\first file.pcl' /REM 'A3 example' /PAPER A3
'C:\TEMP\second file.pcl' /REM 'A4 example' /PAPER A4
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Example 4

The syntax
/OPTIONS filename

allows an Options file  to be specified which contains a number of options. Each line
of the file should be a statement of the form
option=value

as in this example file myopts.OPT:

PDF=Y
To=\\123.123.123.123\mine_pdf\maturity\{CNtext}_{IDtext}_{datetime}
_{_bates:-6}.pdf
Fields=c:\nqroot\files\mine1.ee
ERRORLOG="C:\NQROOT\MINE-ERRORS\!!LPRJ;.LOG"
INI=c:\progra~2\RedTitan\software\RTEE.ini
x

The command line to export the file would simply be:
ESCAPEE /OPTIONS myopts.OPT

Example 5

Here each page in a PDF report is split into a separate file:

ESCAPEE C:\Reports\Spring.PDF /TIFF 1 /TO {_front}{_back}page{_page}.tif

Each file output is given a name determined by its page-number and whether it is a
"front" or a "back" page:

C:\Reports\FRONTpage1.tif
C:\Reports\BACKpage2.tif
C:\Reports\FRONTpage3.tif
C:\Reports\BACKpage4.tif

...etc.

Links
Run from the command line  

413

368



Reference438

Composite fields

Example 1: string condition

In this example, you use the "plus " composite field notation to set up two possible
string values for a field. One of the strings will be used if a tag finds a particular
search string, the other string will be used if a tag finds any other value (or null).

Start by sweeping out the text to be checked and define a tag  named Report

containing 'Any text'. Then, on the Searching  page of the Field dialog , set the
'Tag string' to Paperless and tick 'Match'.

Define a composite field  named Send and enter {+Report='EMAIL','PRINT'} in the

'Value' box.

When a data-record contains Paperless as its value for Report, the value of Send is

set to EMAIL.

When a data-record does not contain Paperless as its value for Report, the value of

Send is set to PRINT instead.

Example 2: find a graphic

In this example you have a tag (named EndGraphic) which looks for a 'Graphic' on the

page. You can test the tag to see if the graphic is present (True) or missing (False) by
setting up a composite field (named EndGraphicFound):

EndGraphicFound:={+EndGraphic='T','F'}

You can also just test for 'True' by changing the composite field to:
{+EndGraphic='T',}

Now the composite field EndGraphicFound will be true when the graphic is found and

null when the graphic is not found, making the test for the presence of the graphic
simple.

Example 3: counter

{+chapter=2,,0}

Initially, composite field is set to the value 0. Each time the field named "chapter" is
found, the composite field value is incremented by 1. The field width of 2 means that
a leading space will be present until the field value reaches 10.
To have leading zeros use {+chapter=02,,0} instead.

Example 4: splitting a field

In this example, one field is used to define two new fields. The data value of an
existing field fullname is:

Constable, John

Use:
lastname:= {fullname:1:','}

to extract the surname (i.e from column1 up to the comma) and 
firstname:={fullname:{lastname.length+2}}

to extract the forename (everything after the comma).

Links
String conditions  
Numerical conditions  
Special fields in composed strings  
Composite field expressions
Partial fields
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File prefix

This sets up the way that resource files associated with an HTML document are
named.

Example 1

To export an HTML document named "Garden" requiring one PNG image file. Set file

prefix to:
*

An associated file is created, named "Garden1.PNG".

NB: Leaving the file prefix blank produces the same result as Example 1.

Example 2

To export an HTML document named "Garden" requiring two PNG image files. Set file

prefix to:
My*

Two associated files are created, named "MyGarden1.PNG" and "MyGarden2.PNG".

Example 3

To export an HTML document named "Garden" requiring two PNG image files. Set file

prefix to:
Plot

Two associated files are created, named "Plot1.PNG" and "Plot2.PNG".

Links
HTML export options  

Local file path

Use the local file path box to specify where the resource files associated with the HTML
document  are to be placed. (Leave the box blank to place the associated files  in
the same location as the output HTML document.)

Example 1

Specify the full path.
D:\MySite\Images

The associated files will be placed in "D:\MySite\Images" irrespective of the location
of the HTML document.

Example 2

Specify a relative path.
Images

The associated files will be placed in a folder named "Images" in the location set up
for the HTML document in the HTML export dialog.
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PDFPREF options

/PDFPREF 1

Tool-bar is hidden when the PDF
document is opened.

/PDFPREF 2

Menu-bar is hidden when the PDF
document is opened.

/PDFPREF 4

User interface elements associated with
the document window (e.g. scroll bars)
are hidden leaving only the document's
contents displayed.

/PDFPREF 8

Resize the window to fit the first page.
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/PDFPREF 16

Window placed in the center of the
screen.

/PDFPREF 32

Document title is merged into the main
title-bar; filename no longer displayed.

/PDFPREF 64

"Full screen mode". Press "Esc" key to
revert to normal view.

/PDFPREF 128

Page scaled to fit width of window.
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/PDFPREF 256

Page scaled to fit height of window.

/PDFPREF 384

128 + 256 = 384 results in the width
and height of the page being scaled by
the same percentage so that one page
fills the full width or height.

Links
PDF Viewer Preferences  

Search tags

Search tags can be set up by right-clicking on a piece of text or graphic and choosing
New tag. You may need to edit the text of the tag to exclude variable data: e.g. it
might be Total: 123.45 when you want to search for Total: alone. Options for

search tags are set up in the Searching section of the 'Field Definitions' window, see
Setting search tag options.

Should you decide to use an image as a tag and find that its position varies slightly
from page to page, set up the search tag as part of a graphic rather than graphic.
Sweep out an area for the tag big enough to surround any occurrences of the image;
the 'part of a graphic' mechanism will search for the 'colored' part of the image in the
defined area. It will not matter how much 'white' there may be on each edge.

Normally, search tags are used to locate fields positioned relative to the tag itself. In
this example, however, data is extracted from fields positioned relative to the record,
and the tag (if present) may located anywhere in the record:

1. Define a field that must be present, say OVERDUE.

2. Define a composite field, say RENEW defined by the composed string  {?

OVERDUE}.

This field will be set to T only if RENEW is found, otherwise it is set to F.

3. Set up a search tag for RENEW set to T.

4. Define sub-fields from which data is to be extracted.

Links
Setting search-tag options
More on defining composite fields
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Strings

Strings that do not contain spaces or slashes do not need to be enclosed in quotation
marks. E.g.
MyDocument

Strings that do contain spaces or slashes must be enclosed in matching quotation
marks: single or double quotes may be used. E.g.
'My Document'

Strings that contain single quotes be enclosed in double quotes. E.g.
"Adam's Documents"

Strings that contain double quotes be enclosed in single quotes. E.g.
'1/300"'

URI path

The Universal Resource Identifier is used to make HTML document resources
accessible to Internet web browsers. Enter a suitable URI path to create a web page
automatically.

Example 1

Absolute path:
https://www.mysite.com/images

This would result in a resource named "garden1.png" being accessed as
"https://www.mysite.com/images/garden1.png"

Example 2

Relative path:
images

This would result in a resource named "garden1.png" being accessed as

"images/garden1.png"
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RedTitan contact details

For the most up-to-date information see https://www.pclviewer.com/about.html.
These are the RedTitan office details current at publication:

France

Tel:  (+33) [0]2 32 60 20 53

Fax: (+33) [0]2 32 60 21 35

Email: RTfrance@RedTitan.fr

Link to RedTitan France site.

Germany

Tel: (+49) [0] 30 60985629 

Email: deutschland@redtitan.com

United Kingdom

RedTitan Limited

Aston Court,
Kingsmead Business Park
Frederick Place,
High Wycombe
Buckinghamshire
HP11 1JU
United Kingdom

Registered in England No. 1698238

Tel: (+44) [0]1494 811420

Email: help@redtitan.com

VAT: GB410896747

United States

RedTitan LLC

3761 Shallow Court
Marietta GA 30066

Pre-sales Tel: 770.924.1226

Email: help@redtitan.com

US Technical Support Tel: 404.437.7206

https://www.pclviewer.com/about.html
mailto:RTfrance@RedTitan.fr
https://www.redtitan.fr
mailto:deutschland@redtitan.com
mailto:help@redtitan.com
mailto:help@redtitan.com
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Miscellaneous notes

This is Help v6.36 for EscapeE 10.51 and above in English. EscapeE is available in
several languages; select Change language from the Options menu and choose from
 Deutsch, English, Espanol, Francais, Portuges.

AcroForm – an interactive PDF form with buttons and boxes which users can
complete and submit. See Special fields for PDF export .

AFP – 'Advanced Function Presentation ' – (formerly 'Advanced Function Printing') is
a data-stream format from IBM ®. Presentation Text input data-elements
may span data-records.

bitmap fonts Each character in a bitmap font is defined by a mosaic of black and
white pixels. It cannot be scaled (unlike outline fonts), so contains the
characters for one particular size and resolution only.

CaPSL – 'Canon Printing System Language' – predates PCL®; used by Canon ®

printers.

CID font – 'Character IDentifier' font – designed to contain a large number of Eastern
pictographic characters as well as Western alphabetic characters. May be used
by PS  and PDF  files.

ClearType  A way of rendering fonts designed for flat-screens from Microsoft ®. It
may improve the readability of text, but edges may exhibit color fringes.

clip region An area cut from a file for insertion into an IDF document: see CLIP .
CMYK – 'Cyan Magenta Yellow Key (black)' – a color-space used for specifying the

inks used by printers. To display colors specified as CMYK values on-screen,
EscapeE converts the color into RGB color-space using RTcms. See Image
import/export options .

composite document A document created in EscapeE from other files, or extracts of
files, and IDF  code.

CSV – 'Comma Separated Variables ' – data files in which field-values are delimited
by specified characters, usually a comma. Data values are often enclosed
within a pair of double-quotes. Each line of data-values corresponds to one
data-record, usually with field-names defined in the first record of the file.

EE An ".EE" file is an EscapeE field definitions file which supplies field names found in

the first record of the associated control file. Using the EscapeE composite field
mechanism, field definitions may be constructed to compute filenames from
the fixed data values in subsequent records in the control file. The named files
are assembled into the composite document .

EPS – 'Encapsulated PostScript' – self-contained documents which may be placed
within a PostScript® document, e.g. for forms overlays.

Escape sequence PCL  printers work with commands that start with an 'Escape'
character. For example, the sequence Esc E resets the printer and sequence 

Esc%#B sets up HP-GL  mode.

ESC/P, ESC/P 2 – 'Escape P' – the Epson ® Standard Code for Printers; a printer
control language used by older printers. Epson files have various extensions
but the generic .PRN is the most commonly used.

FIF – 'Font Information File' – a convenient package of the selection sequences,
metrics etc. derived from a number of font files. Used by EscapeE for
outputting font files in the appropriate printer-specific formats (for example
.HPP files for HP printers ).

file specified The file specification can be a full file path or just a name, in which
case it is assumed to be in the same folder as the input file. It can also be
wildcarded, for example ???xyz.ee or xyz*.ee 

Flate – Deflate/Inflate loss-less compression method suitable for PDF , PDF/A ,
PostScript level 3  and XPS  document export.
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GIF – 'Graphics Interchange Format' – an image format limited to 256 colors; more
suitable for diagrams than photographs.

GOCA –  'Graphics Object Content Architecture' – vector graphics for AFP. If color is
set to white then it is treated as opaque.

History list  A list of the names of the most recently opened files. It is added at the
end of the 'File' menu – just click to open the file . A ^ character generally
precedes the name of a Control file  but this does not apply to IDF files .

HSB – 'Hue Saturation Brightness' – an alternative method of specifying a color in
RGB color-space; used for drawn objects in PostScript ® files.

HTML – 'HyperText Mark-up Language' – files for display by a web browser such as
Internet Explorer ®, see HTML document file export . Early HTML versions
cannot contain embedded resources and call on separate resource files unless
MIME encoded.
HTML5 files can contain embedded resources such as images and may be
edited in UberEd .

IDF – 'Intelligent Document Format' – the RedTitan (XML-based) document
description language. This is the user-friendly format used by EscapeE for
creating composite documents but is powerful enough to be used to write and
export entirely new documents. Scripts in IDF have the extension ".idf". See 
About Composite documents and IDF  and Element IDF .

LIDIL – 'Lightweight Imaging Device Interface Language' – for 'host-based' HP ®

printers. These low-cost printers simply print images; they rely on the host
computer to effect text etc..

LPD, LPR – 'Line Printer Remote' – is the UNIX ® Internet protocol for sending pre-
formatted files to remote systems for printing e.g. spoolers using LPD – 'Line
Printer Daemon' – receivers. The data is processed before LPR connection is
made, so there may be a delay before a large file is transmitted. See also To
use LPR output .

LSH – LIST HP ® – the RedTitan ® default extension for PCL data files.

macro  Document files may be simplified by packaging any recurring blocks of
statements as "macro" (.MCR ) files. These are easily invoked and frequently
used as overlays .

MCR  The extension used by EscapeE for storing macros in the Resident macro library
. EscapeE defaults to naming the first new macro file in a document 100.MCR

then adds 1 to each subsequent file number (maximum value

2147483647.MCR).

Meta data  A term used to refer to any "data about data" such as a document's
keywords. See also Field TYPE attribute .

MHT  The extension for MIME encoded HTML files for display in web-browsers. In this
format a single file is created that contains all the resources packaged as a
Multipart/Related MIME document. See HTML MIME encoded file export .

MIME  – 'Multipurpose Internet Mail Extensions' – for creating a single MHT file that
contains all the resources needed to display an HTML web-page in a browser
(Internet Explorer ® version 5 and later).

OCR  – 'Optical Character Recognition' – techniques for matching shapes in images to
characters of text.

OEM – 'Original Equipment Manufacturer' – EscapeE may be purchased  directly
from RedTitan ® or as an OEM part of other systems, see automatic  update
checking.

OpenType® font A quadratic spline outline font supported by Windows®. May be
coded as 'Compact Font' format with extension '.OTF' or as 'TrueType' font with
extension '.TTF'.
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outline fonts such as TrueType®, OpenType® and Type 1 contain a glyph for each
character in the font. The glyphs are drawn as outlines defined by equations
(splines) and filled in, rather than an arrangement of dots like bitmaps. The
advantage of this is that they can be scaled to produce a range of sizes. The
disadvantage is that the shape of the glyph may become indistinct at small
sizes. Good outline fonts include rules (hints) for each character to improve
their appearance at small sizes.

overlay On long print-runs of pages with variable data, it may be faster and more
efficient to split jobs into 'static' and 'dynamic' content. The static content
(printed on every page – like pre-printed stationery) is known as an "overlay".
For more on generating and handling overlays, see Page Designer  and 
Dynamic Document Formatter .

PCC – 'Printer Control Channel' – standard data-file format for line-printers. The
character in 'column 1' is used to locate the fields (+ = overprint, 1 = skip to
channel 1, 2 = skip to channel 2 etc.). See also PCC,ROW  option.

PCL® – 'Printer Command Language ' from Hewlett-Packard ® – the default
extension for EscapeE's output.

PCL source file "Source" files for printing on a "PCL" printer contain not only the
document's text and image data, but instructions to the printer on how the
data is to be placed, the fonts to use etc..

PDF – 'Portable Document Format ' from Adobe . See also PDF/A  documents
archive format.

PDL is a general term for a Printer Description Language. PDL commands control the
printer. Printer-manufacturers typically have their own PDLs, e.g. KPDL ®.

PJL – 'Printer Job Language' – is used to set up jobs on Hewlett-Packard ® printers.

PLT The extension used by EscapeE for input files in HP-GL  intended for plotters
(rather than the HP-PCL® used for general printing).

POS  – 'Point Of Sale' printers, e.g. for check-out receipts.

Printrex copyright by Transact. Thermal printers/plotters.

PRN The default extension usually used for files output by a 'Print' dialog.

PS – 'PostScript ®' language from Adobe ®.

RFF – 'Redtitan Font Format' files – contain bitmap images of text, barcode or logo
fonts used in a job and stored in the Resident font library .

RGB – 'Red Green Blue' – the color-space used by most file formats to specify colors.
RGBA images contain Alpha-channel  transparency information in addition to
the Red, Green and Blue values.

RIF – 'RedTitan Image Format' – for storing images. Composed of color-planes of
bitmaps, it is often used for logos.

RS/2 – 'RedTitan Script Two' – is a lightweight, Pascal-like scripting language which
provides dynamic document features and extended field processing for
EscapeE Software Development Kit. RS/2 scripts may be opened with EscapeE
and its resources used to create a page from scratch. See also evaluate plugin
[Plugins Help].

RTF – 'Rich Text Format' – a file format from Microsoft ®. RTF documents contain
pages of formatted text in which attributes such as font family, style, weight
and size defined.

Text editor  The window in which you may edit LOF control files . All of the text
found in the file is simply displayed, rather than interpreted and rendered on-
screen. It shows the instructions for building the pages of a composite
document .

TIFF – 'Tagged Image File Format ' – a ".TIF" file may contain more than one image
and is often used to image pages for archive.
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TrueType® font  An OpenType outline font from Apple ® supported by Windows
®: each character is described by quadratic splines. These glyphs can be
scaled to generate fonts at a range of sizes.

TXT – "Plain text " – files containing lines of text which is not formatted (unlike RTF
). See also IDF  Notes on text .

Type 1 font A cubic spline outline font. It is the Adobe ® font format based on
PostScript® language and is used in PDF documents. Type 1 fonts can be
scaled; 'hinting' may be included do improve their appearance at small sizes.

URL – 'Uniform Resource Locator' – a URI  specifying a web-address such as
https://www.redtitan.com.

XML – 'eXtensible Markup Language ' – an "open standard" language used for data
files in which each value is "marked up" with its field name.

XPS – XML Paper Specification  – is an open-architecture format, and the default
output format for Windows Vista®. The output is paginated and may contain
JPEG, TIFF, PNG and text elements with good color support. Documents may
be digitally signed. The format is well suited to printing, viewing and archiving,
making it a good standard to choose for general use. For more information on
XPS, see www.pclviewer.com/XPS 

ZjStream  Zenographics © page description language for driving printers made by
several manufacturers. Consequently, file extensions vary: EscapeE recognizes

 these files from their opening bytes.

Product References

There are references to the following programs in this EscapeE User Guide:

Adobe registered trade mark of Adobe Systems Inc.
Acrobat Reader, PDF, PostScript.

Apple registered trade mark of Apple Inc.
TrueType 

Barr  Systems, Inc.
PRINT370 is a trademark of Barr Systems, Inc.

Canon registered trade mark of Canon Inc.

DICOM is the registered trademark of the National Electrical Manufacturers
Association for its standards publications relating to digital communications of
medical information.

Epson refers to the Seiko Epson Corporation.

HP Hewlett-Packard Development Company, L.P.

IBM is a trademark of International Business Machines Corporation, registered in
many jurisdictions worldwide.

KYOCERA is a trademark of Kyocera Corporation.
KPDL, PRESCRIBE.

Microsoft and MS are registered trade marks of Microsoft Corporation in the United
States and/or other countries.
ClearType, Explorer, Office, Outlook, Vista, Windows, Word, WordPad.

OKI is a trademark of Oki Electric Industry Company, Ltd..

QRCODE is a registered trademark of DENSO WAVE INCORPORATED.
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RedTitan trademark of RedTitan Technology Ltd: see redtitan.com
CaptuRedTitan (pclviewer.com/resources/disk/) is a generic Windows® XP
utility which installs and manages a Port Monitor to intercept Windows® print.
Output from a selected driver is stored on disk. See pclviewer.com/resources/
capture/.
DataBase Manager "RTDB" makes it easy for Users to create, update and

manipulate databases.
DataStream Converter "DSC" system converts fixed-pitch paginated data
(e.g. line-printer datastreams) to other printer formats: see redtitan.com/
legacy.htm.
Dynamic Document Formatter "DDF" is a special software package which

manages dynamic reformatting of text in multi-page documents and which
connects printers to the network so that pages can be printed easily to either
desktop or centralized printers. See redtitan.com/formattr.html. Scripts in DDF
have the extension ".ddf". See also Element DDF .
EEcerts "Certificate management" program for creating Security profiles and

Recipient lists for PDF documents. See the EEcerts Help file.
EEfonts creates character recognition databases for fonts which have been

downloaded from documents. You may install these fonts so that they may
viewed on-screen or used on a different printer. You may reassign the
character codes of bitmap fonts. See EEfonts Help file.
EEview runs two copies of EscapeE in tandem so that two documents may be

compared side-by-side from a single Control panel. See the EEview Help file.
FONTEDIT reads and displays fonts such as TrueType, OpenType, RFF and

RIF, along with their details. It may be used to add, delete and recode
characters within the fonts: see the FONTEDIT Help file.
HPFONTS can split a PCL download font file into individual fonts or
concatenate individual PCL download font files into a single font file.
nQ "Enterprise Queue" system is based on the Windows® PC platform. Easily
interfaced to host applications, nQ acts as a batch control system for automatic
data processing: see pclviewer.com/nq/ppnq.htm. nQ Spooler is one of the
nQ applets: a TCP/IP based spooling and queuing system. It will accept data
from a number of sources using FTP, LPR/LPD, HTTP, FTP and TELNET protocols
on a TCP/IP network. Separate script-files and data-files (e.g. CSV , TXT ,
XML ) may also be used. See Setting TCP/IP options  and /NQ , /
NQERROR , /NQLOG , /USING  command-line options.
Page Designer is a part of Document Design System, a set of interlinked

software modules for designing page layouts, compiling pages for printing, font
conversion and editing, clipboard reading, image scanning and editing, and file
transfer using Forms Design Language . See redtitan.com/design.htm
RTIMAGE is used to read, view and write image files in BMP, RIF, TIFF, PNG

and JPEG formats. You may also compare, rotate, trim, center and even set up
the image resolution.
UberEd is a multi-page document creation and editing program based on

HTML5 format.

Solimar is a registered trademark of Solimar Systems Inc. (North America), Solimar
Systems Ltd. (Europe).

STAR copyright STAR MICRONICS CO., LTD.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

VMware registered trademark of VMware, Inc. in the United States and/or other
jurisdictions.

XEROX registered trademark of Xerox Corporation.

Zenographics copyright Zenographics Inc.
ZjStream 
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Compare features

Features

EscapeE version

Viewer Edition
Transformer

Edition

Batch
Automation

Edition

Professional
Edition

View PCL5, PCL6, PCL3GUI
and HPGL.

View PDF.

View multi-page TIFF

Print sub-sets with page
numbering.

Bookmark pages.

Maintenance. (Includes
technical support and
software updates for 1 year)

Page limits for each file
processed

up to 5000
pages

up to 5000
pages

up to 5000
pages

no limit

Command line and automation options

user interactive
command line

options
single named file

spooling and
directory
scanning

with wildcard
filenames

Note In the Batch Automation Edition and Professional versions
all the program functions can be controlled from command
line switches. The Command line execution feature will act as
an API to client systems.
The Transformer version is NOT suitable for automated
document production.

Runs in multi user environments. i.e. Citrix,
Terminal Server or via Remote Desktop

Create PDF with data compression, security
and form filling

Export to Postscript, TIFF, PNG, HTML and
image formats

Mark-up and recover text in CSV, XML and
plain formats.

Create composite PCL, PDF and image
documents

TCP/IP integration and LPR output

Print to AFPDS or Xerox Metacode (priced
separately)

Plug-in options

Barcode impositions
Add barcodes from page text data. Includes PDF417, Datamatrix,
and all UPC/EAN types.

Move and add text Dynamically move or color part of a document

Add image Add graphics or watermarks to the document

© RedTitan Technology 2019

https://www.pclviewer.com/dscrape1.htm
https://www.pclviewer.com/pdf417.htm
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Index

*

*non-alphabetic characters*    

! commands     371

! icon     301

!R! Kyocera     59

" file specification     136

" in page numbering     240

#, in counters     254

* file specification     136

... Field dialog button     236

.EE file     212, 264

.EE file example     433

.INI file     417

.JOB file example     434

.LOF file example     434

.OPT file     413

/ command-line options     382

:\DOCUMENT     424

:\ESCAPEE     424

?condition     257

?FORMAT?     290

@PJL     170

_PAGE symbol     276

_PRINTABLE symbol     276

_symbols     247

+ in filename     136

+ in page numbering     240

+=condition     258

+condition     254, 257

=condition     258

128-bit encryption     176

2-bit smoothing option     135

2-up printing     106

40-bit encryption     176

4-bit gray option     177

4-bit smoothing option     135

8-bit gray option     177

8-bit smoothing option     135

PDF encryption     176

A

A0, A1, A2, A3, A4, A5, A6, A7     313

A3, booklet and 2-up option     104

abort, processing     392

Abort, program     63, 371

About .EE files for contol files topic     264

About Control files topic     260

About EscapeE topic     18

About exporting data topic     38

About exporting pages topic     36

About fields and tags topic     37

About IDF and Composite doc... topic     39

About page numbers topic     240

About printing topic     35

About symbol sets topic     81

About viewing pages topic     32

absent field     208, 210

absolute path     439, 443

Acroforms     217

action condition     208, 210, 244

Adaptive, monochrome option     134

Add as two sections to IDF, option     267

Add button, composite field     245

Add field     352

Add files...    

Composite document wizard     344

File pages table     346

LOF option     262

Add font to CR database, option     83

Add media, printer option     109, 111

Add selection as paragraphs of IDF     267

Add to resident library     83

Add whole file to IDF, option     267

Add whole page to IDF, option     267

Add, fonts     76

AddFile plugin     229

AddImage plugin     229

Adding media definitions     111

Adding Tagged text     202

AddText plugin topic     228

Advanced options, field definitions     210

Advanced..., mail-merge options     360

AFP    

export topic     144

fonts     89

format     119
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AFP    

options topic     145

recognition     45

agreement, accept     19

agreement, topic     26

ALIGN attribute topic     292

Align field     352

Align using top of cell, TXT option     193

Alignment     356

All Defined Fields, option     233, 235, 236

All Text, TXT export option     192

ALL, FORM input option     47

All, replace option     67

All, Show option     52

ALNUMeric field TYPE     225

ALPHA attribute topic     292

ALPHabetic field TYPE     225

Alpha-channel images     34

Always    

condition     245

save definitions file     212

use JPEG compression     166

use standard fonts     154, 168

use these definitions     213

amber warning triangle     55, 62

AND operator     422

Angle, staves     354

annotating pages     73

ANSI A, B, C, D, E paper     313

answer fields     258

ANY content field TYPE     225

Any graphic, option     200

Any mark, option     200

Any text, option     200

ARCH A, B, C, D, E, E1 paper     313

archive format PDF/A     179

archiving pages     36

arrow keys     50, 70, 213

As a macro, export option     100

As in the file, plex override     113

Ask, to save definitions file     212

Assign character codes... option     193

Assigning character codes topic     82

Assignment, field values     246

Associated files topic     425

Associated programs topic     136

associated resources, HTML     439

At end of file, log option     237

At end of file+1, log option     237

attaching a plugin     227

Attribute ALIGN     292

Attribute ALPHA     292

Attribute BASEFILE     293

Attribute BGCOLOR     293

Attribute BIN     294

Attribute BLANKLINES     294

Attribute BORDERCOLOR     295

Attribute BORDERS     295

Attribute BORDERSTYLE     296

Attribute BORDERWIDTH     296

Attribute BOUNDS     297

Attribute CACHE     297

Attribute CERTIFICATE     297

Attribute CLIP     298

Attribute CLIPHEIGHT     298

Attribute CLIPSTEPX     298

Attribute CLIPSTEPY     299

Attribute CLIPWIDTH     299

Attribute CLIPX     299

Attribute CLIPY     299

Attribute COLOR     300

Attribute CONDITION     300

Attribute DEBUG     301

Attribute DEFINE     301

Attribute DESCRIPTION     302

Attribute ENCODING     302

Attribute FIELD     302

Attribute FIELDFLAGS     302

Attribute FILENAME     303

Attribute FILETYPE     304

Attribute FILL     304

Attribute FONT     305

Attribute FONTSIZE     305
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Attribute GROUPNAME     305

Attribute HEIGHT     306

Attribute IMAGERES     306

Attribute INDEX     307

Attribute LEFT     307

Attribute LINEEND     308

Attribute LINEJOIN     308

Attribute LINESTYLE     309

Attribute LOCATION     309

Attribute MONOCHROME     310

Attribute NAME     310

Attribute ORIENT     310

Attribute PAD     311

Attribute PADBOTTOM     311

Attribute PADLEFT     311

Attribute PADRIGHT     311

Attribute PADTOP     311

Attribute PAGE     312

Attribute PAPER     313

Attribute PARAM     314

Attribute PLEX     314

Attribute PLUGIN     314

Attribute POINTSIZE     315

Attribute PREFIX     315

Attribute REPEAT     316

Attribute ROTATE     316

Attribute SCALE     317

Attribute SEPARATOR     317

Attribute SERIAL     318

Attribute SHAPE     318

Attribute SIDE     318

Attribute STEPX     319

Attribute STEPY     319

Attribute STRING     319

Attribute STYLE     320

Attribute SYMBOLSET     320

Attribute THICKNESS     321

Attribute TOP     321

Attribute TRANSPARENT     322

Attribute TRAY     322

Attribute TRIM     322

Attribute TYPEFACE     323

Attribute UNITS     323

Attribute VSPACE     324

Attribute WEIGHT     324

Attribute WIDTH     325

Attribute X,Y     325

attributes, editing     271, 364

attributes, table     291

Author, PDF     219

Auto format detection     45, 46, 124

AUTO paper size     108

auto, DEFINE attribute     301

Auto, printer option     109

Auto-align, staves     354

automatic file export     127, 136

Autopopup feature     42

axial shading     34

B

B(ezier), element     280

B(ezier), example     332

Back overlay, mail-merge     360

back page, options     205, 208, 210

BACK, SIDE attribute     318

background color     293

background processing     368

banner page     213

Bar numbers     344, 350

Barcodes plugin     229

Barr    

export     161

format     120

BASE64 encoding     225

BASE64, ENCODING attribute     302

BASEFILE attribute topic     293

baseline criterion     193

BASELINE, ALIGN attribute     292

batch commands     371

Batch job running topic     40

batch operation     368

Bates numbers     237, 239, 240

BC39Reader plugin     229
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BGCOLOR attribute topic     293

bin    

field setup     208

mail-merge     360

PCL export     168

printer default     108

BIN attribute topic     294

binary data     282, 302

binding edge     108, 112

Bit reversed, option     190

bitmapped graphics     34

Bit-wise logic topic     421

BLACK color     293, 295, 300, 304

BLACK weight     324

blank pages, showing     57

BLANKLINES attribute topic     294

Blankout plugin     229

blends     34

BLUE color     293, 295, 300, 304

BMP images    

exporting     141

format     120

options     141

recognition     45

bold font     87

BOLD weight     290, 324

Booklet topic     348

Booklet, print option     104

Booklets and 2-ups topic     106

bookmarks     73

Boolean logic     250, 251, 421

border    

images     141

PDF     178

BORDER, FIELDFLAGS attribute     302

BORDERCOLOR attribute topic     295

BORDERS attribute topic     295

BORDERSTYLE attribute topic     296

BORDERWIDTH attribute topic     296

BOTTOM, ALIGN attribute     292

BOUNDS attribute topic     297

Bounds, page numbering     356

BOX, SHAPE attribute     318

break    

page, IDF     267, 271

set     185

BROKEN, BORDERSTYLE attribute     296

BROKEN, LINESTYLE attribute     309

by 4 to 4-bit gray, option     177

by 8 to 8-bit gray, option     177

Byte aligned, option     190

C

CACHE attribute topic     297

Calculate Download Font Character...     124

Call Plugin     208, 210

cancel security certificate     176

CAPSL recognition     46

caption     352

CaptuRedTitan utility     449

Case sensitive, Find option     67

CCITT3 compression     133

CCITT4 compression     133

cell width option     193

CENTER, ALIGN attribute     292

CENTRE, ALIGN attribute     292

CERTIFICATE attribute topic     297

certificates, signing/cancelling     176

Change language, option     445

Change Style, font option     83

Change substitute font, option     83

Change symbolset, font option     83

Change typeface, font option     83

Change weight, font option     83

Changed, field option     245

changing    

character recognition database     79

font attributes     83

font libraries     79

graphics folder     79

language     445

macro library     79

substitute fonts     90

symbolset     81

typeface     77
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changing    

viewing scale     50

Changing font and image libraries topic     79

Changing the PDF/PS substitute font     90

Changing the scale of view topic     50

Changing the symbol set     81

Character codes topic     82

character codes, problems     215

character codes, TXT export     193

character recognition    

about     82

assign codes     82

database     53, 81, 234

optical     229

Characteristic matching     87

Check box, PDF special field     217

check for updates     127

CHECKBOX, FIELDFLAGS attribute     302

CHECKBOX, FORM input option     47

Choir Parts     354

Choirs..., defining     350

Choose job configuration option     370

Choosing an export format topic     122

Choosing the view of the page topic     49

CID font     445

Clear log, option     63

Clear the errors, option     375

clip    

editing IDF     271

moving     97

region, IDF     267

CLIP attribute topic     298

clipboard, copying text to     98

CLIPHEIGHT attribute topic     298

clip-region     352

CLIPSTEPX attribute topic     298

CLIPSTEPY attribute topic     299

CLIPWIDTH attribute topic     299

CLIPX attribute topic     299

CLIPY attribute topic     299

clock, automatic export     127

close    

EscapeE     43

file     44

folder     283

Page editor     350

search     72

Trimming dialog     354

wizard     344

Close after search, Find option     72

Close EscapeE     43

Close packed topic     349

Close packed, layout option     344

Close, File menu     44

CM, UNITS attribute     323

Coarse color quantisation, option     165

codes    

character     82

error return     418

Collapse, fields list     211

Collate, option     104

color    

background     293

border     295

pens     114

profile     143

COLOR attribute topic     300

Color Management System     143

COLOR sample script     333

color, spot     108

columns     344, 348

Combine selected fields, option     211

Combine text strings together, option     131

Combine with next field, option     211

COMBO, FIELDFLAGS attribute     302

comma separated fields, export     233

command line    

batch jobs     40

examples     339, 436

EXECUTE     281

IDF tips     284, 301, 330

index     382

run program from     368

shortcut     367

syntax     383

Command line sample script     339
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Command line syntax index topic     382

Command line syntax topic     383

command usage statistics     65

commands, PJL     168

comment    

/REM     424

creator     62

font     83, 94

JOB     424

PJL     64, 168, 185, 208

Commonly used fonts topic     431

Compare features topic     450

complex composite fields     245

Components, Field dialog     244, 245

Composed strings     247

Composite document wizard topic     344

composite documents    

about     39

creating     267

editing     268

viewing     266

Composite documents section topic     343

composite field    

defining     244

example topic     438

expressions     250

numeric conditions     254

partial values     251

special symbols     247

string conditions     257

syntax summary     421

Composite field expressions topic     250

Composite field wizard     245

Composite fields and conditions topic     38

Composite fields section topic     243

Composite fields syntax summary topic     421

compression    

image     133, 141

JPEG     165, 177

PCL     168

PDF     174, 177, 180

Condensed style     320

condition    

numeric     254

page     258

string     257

CONDITION attribute topic     300

conditional GROUP     283

configuration    

automatic     127

export     36

general     124

images     141

layout     239

log file     237

optimizing     59

plugin     227

printer     108

symbols     417

TCP/IP     129

view     57

Configuring files for export topic     36

Configuring the emulation     108

Configuring the input format topic     46

Configuring the printer defaults topic     108

Configuring the view topic     57

Console    

Error messages     62

IDF coding     68

Log messages     63

PJL Comments     64

Properties     62

Source code     65

Console log window     301, 338

Console notebook section topic     61

Container, digital signature     362

Contents..., PDF/A option     180

continuous file export     127

Control files    

about     260

creating     262

editing     268

IDF     266

viewing     261

control point, Bezier     280

Convert pages to other formats section     117

converting files automatically     367

Copies, option     104, 110

Copy & Add selection to IDF, option     267
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Copy clip to control file, option     268

copy document, mail-merge     360

Copy Page, option     98

Copy, page contents     98

copying and saving pages     35

Copying page contents topic     98

Count pages, log option     237

Counter setup     246

Counter, syntax     254

cpi, matching     87

create a special shortcut icon     367

Create New Folder if Necessary option     127

Create New Log File for each Output...     237

create stylesheets     235

Create XSL, CSS and HTM files, option     237

Creating a CSV control file     263

Creating a data control file topic     262

Creating an IDF document topic     267

Creating an LOF control file     262

Creating page numbers topic     239

Creating the .EE file topic     264

Creating XML stylesheets topic     101

creation date, automatic option     127

Criterion is text baseline... option     193

Crop, printing option     51, 104, 105

CSS stylesheet, exporting     235

CSV    

control files     260

data, extracting     237

file, exporting     233

format     121

CSV fields prefix     315

CSV file     359

CURrency field TYPE     225

cursor position     276

curve, Bezier     277, 280

Custom jobs     370

CUSTOM paper size     108

CUSTOM, LINESTYLE attribute     309

customizing the view     57

CYAN color     293, 295, 300, 304

D

D600, UNITS attribute     323

DASHED, BORDERSTYLE attribute     296

DASHED, LINESTYLE attribute     309

Data Control files section topic     260

data fields    

CONDITION attribute     300

defining     200

exporting     232, 233, 234, 235, 237

FIELD element     281

GROUP example     329

problems     215

reusing     213, 220

selecting     52

using     278

viewing     52

data tags    

about     37

importing     151

DataBase Manager program     449

DataStream Converter     449

Date field TYPEs     225

date, DICOM     223

DCM format     119

DCX    

export topic     146

format     119

options     141

recognition     45

DCX/PCX fax image file export topic     146

DDF    

about     449

element     280

files     45

DE, UNITS attribute     323

DEBUG attribute topic     301

DEBUG, IDF input option     48

DECimal field TYPE     225

default    

compression     133

font selection string     108

font substitutes     83, 92

general export     124

log file     237
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default    

printer     107

printer setup     108

TCP/IP     129

DEFINE attribute topic     301

DEFINE element sample script     327

Define fields automatically     156, 158, 187

DEFINE, element     280

Defining a composite field topic     244

Defining field values topic     253

Defining fields and tags topic     200

definitions file    

data control files     264

default     212

locating     212

reuse     213

saving     212

set up     212

definitions tab     200

DEGREES, ROTATE modifier     316

delete    

copy     360

fields     158, 187, 199, 203

input files     127

music parts     346

page     361

PS tray definitions     183

tags     203

text     228

zoom option     57

Delete copy, mail-merge option     360

Delete existing fields     156, 158, 187

Delete field     352

Delete page, mail merge option     361

Delete parts, music option     346

Delete, processed input files option     127

demonstration edition, download     19

DESCRIPTION attribute topic     302

details, viewing     53

detecting file format     45

Deutsche Sprachversion     445

diagonal, swept area     58

DICOM    

export topic     147

format     119

options topic     148

recognition     45

required tags     423

DICOM Element Tags topic     223

Different/same condition fields     258

digital signature     288

Dimensions, Viewing option     57

Direct printing topic     115

directories, font, image     79

Disable field..., option     203

disabled Plugins     376

distance measuring     58

Dither, monochrome option     134

DLL list     425

DLL, EXECUTE     281

DMatix plugin     229

DMY field TYPE     225

Do Not Allow options     174, 180

Do not overwrite files, option     123, 127, 129

Do not use PJL commands     168, 169, 170

dock fields list/tree     212

Document Formatter program     449

Document Properties topic     62

Done, composite field setup     245

dot patterns, shading options     135

DOTS, UNITS attribute     323

DOTTED, BORDERSTYLE attribute     296

DOTTED, LINESTYLE attribute     309

Double page, sample_script     339

double-byte fonts     131

download fonts     83

calculate characteristics     125

ignore     125

installing     76

troubleshooting     33

Downloading EscapeE from the internet topic    
19

DPI, ESCP input option     47

dpi, resolution     306

drag and drop     97, 127, 267

Draw border, PDF special fields     217

Draw button, PDF special fields     217
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drawing    

Bezier     280

Move     286

notes     277

Polyline     287

SHAPE     318

Drawing elements sample script     332

driver    

HP-GL     377

numbers     429

source     81, 124, 215

Drop down, PDF special fields     217

DSC system     449

Duplex    

Composite document wizard     344

IDF     360

override     113

printing options     109, 112

simulate     112

duplex, IDF     314

Dynamic Document Formatter program     449

E

Each Time Field Found, Action     208

easy way to construct a command line     367

Edge to edge printing, option     108

edit    

clip-region     352

Composite document     357

data fields     203

font details     85

IDF control file     268

IDF properties     364

IDF tips     271

LOF control file     263

Mail-merge     361

media definition     111

options     346

Table of Contents     220

tags     203

wizard     362

Edit fields..., mail-merge option     361

Edit letter..., mail-merge option     361

Edit the options, wizard option     346, 357

Editable text field, PDF special field     217

Editing a composite document file topic     357

Editing a data control file topic     263

Editing a Mail merge file topic     361

Editing an IDF document topic     268

Editing fields and tags topic     203

EE file    

about     38

creating     264

example topic     433

fields and tags     200

for contol files     264

IDF     276

reusing     213

EEcerts program     176, 449

EEfonts program     82, 449

EEview program     371

Eight-bit smoothing option     135

Element Bezier topic     280

Element DDF topic     280

Element DEFINE sample script     327

Element DEFINE topic     280

Element EXECUTE topic     281

Element FIELD sample script     328

Element FIELD topic     281

Element FILE sample script     328

Element FILE topic     282

Element GROUP sample script     329

Element GROUP topic     283

Element IDF sample script     330

Element IDF topic     284

Element INCLUDE sample script     330

Element INCLUDE topic     285

Element INFO sample script     331

Element INFO topic     286

Element Move topic     286

Element PAGE topic     287

Element Polyline topic     287

Element RS2 topic     288

Element SIGNATURE topic     288

Element TEXT sample script     331

Element TEXT topic     289

elements    
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elements    

drawing order     167

editing     271, 364

HTML options     154

section topic     279

table     291

ELLIPSE, SHAPE attribute     318

EMF    

export topic     149

format     120

options     141

EML field TYPE     225

emulated printer     108

Emulating a plotter     114

Enable LPR output, option     130

Enable plugin, option     227

Enable substitutions, font option     83

Enable TCP/IP input, option     129

Enable, font substitution     124

Enabled, field option     203

ENCODING attribute topic     302

Encrypting certificates     176

encryption, PDF     172, 174, 176

End point     280

End set option     208

Ending column, sub-field option     245

English language version     445

English, configuration symbol     417

Enhanced MetaFile     149

envelope sizes     432

EOL markers     190

erase files     127

error diffusion, monochrome conversion     134

error logging     371

Error messages     62

Error return codes topic     418

EscapeE    

about     18

download     19

exiting     43

registering     21

run custom job     370

run from command line     368

run from program     371

running     43

transferring     23

uninstall     25

upgrading     23

EscapeE configuration symbols topic     417

EscapeE Professional     18

EscapeE Transformer     18

EscapeE Viewer     18

ESCP recognition     45

Español, versión de idioma     445

Evaluate plugin     229

Every page, log option     237

example    

.EE file     433

.JOB file     434

.LOF file     434

Command-line     339, 436

composite fields     438

double page     339

drawing B, M, P     332

element DEFINE     327

element FIELD     328

element FILE     328

element GROUP     329

element IDF     330

element INCLUDE     330

element INFO     331

element TEXT     331

file prefix     439

INDEX     333

LINEEND     334

LINEJOIN     334

LINESTYLE     335

local file path     439

LOF     339

Mail merge     340

MONOCHROME     336

PDFPREF options topic     440

ROTATE     336

search tags     442

STEPX     338

STEPY     338

string     443

TRIM     338

URI path     443
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Examples index topic     433

Exchange width & height     114

EXECUTE, element     281

EXECUTIVE, PAPER attribute     313

Existing..., file     346

exit codes     371

exit EscapeE     43

Expand, fields list     211

Expanded style     320

Export data section topic     232

Export files section topic     140

Export formats topic     118

export options    

automatic     127

DICOM     148

FDL     151

general     124

HTML     154

HTML5     156

IDF     158

images     141

IMG     162

IPDS     164

JPEG     165

PCL     168

PDF     174

PDF/A     180

PJL     170

Preamble     170

PS     183

RTF     187

TIFF     190

TXT     193

XPS     196

Export PJL commands, option     169

Export PJL comments, option     168, 170, 213

Exporting CSV data fields topic     233

Exporting data fields topic     232

exporting fields     237

to CSV     233

to Plain text     234

to XML     235

Exporting files automatically topic     127

Exporting files manually topic     123

exporting pages, about     36

Exporting plain TeXT data fileds topic     234

exporting to    

AFP image     144

BMP image     141

DCX/PCX fax image     146

DICOM medical image     147

EMF file     149

FDL form     150

HTML document     152

HTML5 document     156

IDF file     158

IMG image     160, 161

IPDS file     163

JPEG image     165

MHT file     153

PCL document     167

PDF document     172

PDF/A document     179

PNG image     141

PS file     182

RTF file     187

TIFF images     189

TXT file     192

XPS document     195

Exporting XML data fields topic     235

expressions, in composite fields     250

extensions, file    

associated files     425

FILENAME attribute     303

FILETYPE attribute     304

opening a file     44

external program     281

Extract data section topic     198

Extract sub-field     245

Extracted text options topic     99

extracting data    

about     38

actions     208

advanced options     210

command line     368

field problems     215

partial fields     251

search tag     442

sub-field     245

to CSV     233
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extracting data    

to plain text     234

to XML     235

extracting text     193, 219

F

Factor viewing option     57

false_value     257

fax    

compression     133

format     119

resolution     132

TIFF     190

FDL    

export topic     150

format     118

options topic     151

field     215

absent     208, 210

clip region     97, 268, 271

composite     244

coordinates     203

counter     254

defining fields and tags     200

deleting     203

delimiters     151, 205

disabling     203

editing     203

enabling     203

exporting     38, 232, 233, 234, 235, 237

found/not found     254

input data     258

length     251

list     211

moving     205

numeric     254

partial     251

pre-defined special fields     247

prefix     170

selecting     203

sizing     205

string     257

text extraction     251

tree     211

type     200, 225

FIELD attribute topic     302

Field attributes     250

field definition, viewing     52

Field definitions file    

creating     264

data control     264

options     213

topic     212

FIELD element sample script     328

Field is a footer     352

Field is a header     352

Field is in all parts     352

Field problems topic     215

Field TYPE attribute topic     225

FIELD, element     281

Field, Trimming dialog     354

FIELDFLAGS attribute topic     302

Fields from comments     213

Fields list/tree topic     211

Fields to be logged     236

FIFO, input files option     127

file    

closing     44

EE field definitions     212

exporting automatically     127

exporting manually     123

format     427

opening     44

options     413

overwriting     129

print to     104

recognition     45

saving     96

FILE element sample script     328

File format recognition topic     45

File formats list topic     427

File name of header page, option     213

file names    

fields in     208, 210

header page     213

input     136

output     136

renaming     127

wildcards     136

File pages table topic     346

File prefix example topic     439
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FILE, element     282

FILENAME attribute topic     303

Filenames and wildcards topic     136

Filenames, option     233, 236, 237

FILETYPE attribute topic     304

FILETYPE, FILE attribute     282

FILL attribute topic     304

find a page     72

Find Next, search option     71

Find page on view, in source code     65

Find Text..., search option     71

Find..., in source code     65

finding    

bookmark     73

pages     72

source code     65

text     71

finishing     111, 177

First, search option     71

fixed pitch font     33, 87, 210

flag bits, PDF preferences     221

flag bits, print options     413

Flowed text, option     156, 158, 187

Folder, job selection     370

font    

add to CR database     53

attributes     87

changing     79

default     44, 86, 108

details     83

download     76, 125

edit details     83

external     172

fixed pitch     210

ignore     125

information     53

installing     77

list     431

mail-merge     359

matching in tags     205

mismatches     376

OpenType     77

page numbers     239

PostScript     428

properties     53

sample     83

search string     205

selection sequences     86

set     430

set up CR database     81, 234

standard     154

substitute     89

tables     83

troubleshooting     376, 377

TrueType     77

types     428

viewing     53

FONT attribute topic     305

font packs, installing     76

Font set-up section topic     75

Font substitutes dialog     90

font substitution    

about     89

PDF, PS set up     92

screen font set up     92

selection     92

syntax     93

wildcards     94

Font tables topic     83

Fonts dialog     92

Fonts used by EscapeE topic     430

fonts, commonly used     431

FONTSIZE attribute topic     305

Footers, option     352, 354

Force back page, option     208

Force front page, option     208

Force monochrome    

AFP     144

FDL     150

HTML     152

IDF     158

IMG     160

IPDS     163

MHT     153

options     134

PCL     167

PDF     172

PDF/A     179

PS     182

RTF     187
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Force monochrome    

TIFF     189

FORM recognition     46

format    

choosing     122

export     118

input     45

list     427

save     123

FORMAT instruction topic     290

FormDef, AFP     145

Forms Description Language     118

Found, field option     245

Four-bit smoothing option     135

Français, version linguistique     445

French, configuration symbol     417

From end, sub-field option     245

From left, field definition     200

From start, sub-field option     245

From top, field definition     200

Front overlay, mail-merge     360

FRONT, SIDE attribute     318

Full, image export option     141

FULL, SCALE attribute     317

Full-width select, IDF editor option     270

G

Generate Flowed Text in FDL Forms     151

German, configuration symbol     417

GIF recognition     45

Go to    

Bookmark command     73

line number     67

Page     72

Graphic Details, viewing     55

GRAphic field TYPE     225

Graphic of this height, option     200

Graphic of this width, option     200

graphics    

details     55

handling     34

save     98

search tags     200

troubleshooting     377

type     225

Gray, monochrome option     134

Grayed-out, unprintable area     57

Gray-scale options, images     143

Gray-scale options, PDF     178

Gray-scale, image option     135

GREEN color     293, 295, 300, 304

GROUP element sample script     329

GROUP, element     283

GROUPNAME attribute topic     305

H

Halftone, monochrome option     134

Handling fonts topic     33

Handling graphics topic     34

hard mask     34

Has lyrics, music option     354

header    

field     352

file     213

font     124

xml     326

Headers, music option     354

Height    

clip-region     354

field definition     200

page numbers     344

swept area     55

HEIGHT attribute topic     306

hide processing     368

Hints     51

History list     44, 266

Home page     18

Host name, setting     129

HP-GL features topic     377

HP-GL plotter     108

HP-PCL    

export topic     167

format     118

options topic     168

PJL options     170

Preamble     170

shading patterns     135
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HTM stylesheet, creating     235

HTML    

export topic     152

format     118

options topic     154

UberEd options     156

HTML5 UberEd export options topic     156

HTML5 UberEd format export topic     156

Hyperlink, PDF special field     217

Hyper-Text Mark-up Language     118, 153

I

I(nverse), ORIENT attribute     310

IBM AFP image     144

ICC profile     141

icon, creating     367

ID    

composite string     247

computer     21, 23

DICOM     223, 423

font     53, 83, 86, 124, 168

tray     108

IDF    

about     39

attributes section     291

coding     68

create     267

edit     268

editor options     270

element sample     330

elements section     279

export topic     158

format     119

open     266, 268

options topic     158

recognition     45

samples section     326

source code     65

syntax notes     275

syntax section     274

tips     271

tools     66, 68

IDF attributes section topic     291

IDF Document wizard, New     344, 359

IDF documents section topic     266

IDF editing tips topic     271

IDF editor options topic     270

IDF element sample script     330

IDF elements section topic     279

IDF file, open     368

IDF source, viewing     65

IDF syntax section topic     274

IDF wizard documents topic     39

IDF wizards section topic     342

IDF, Console notebook     68

If field changed, condition     245

If field found, condition     245

If found, option     52, 201

If not blank, unprintable area     57

If same header, font     125

If substituted, font     125

Ignore    

Download fonts     125

Images     59, 125

Kyocera !R!     59, 125

Name for font     82

Null clips     59

PJL commands     59, 125, 170

Shading     59, 125

space-width     193

underlining     193

White areas     59, 125

Ignored fonts or images topic     377

Ignored PCL command     379

image    

compression     133

creating     123

export     141

handling     34

ignore     59, 125

options     141

page     105

resolution     132

save     98

saving page as     151

search tag     200

TIFF options     190

trimming     178

viewing details     53, 55
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Image compression topic     133

Image format file export topic     141

Image import/export options topic     141

Image resolution topic     132

IMAGERES attribute topic     306

IMG    

Barr export topic     161

export topic     160

format     120

options topic     162

immediate commands     371

import formats     18, 44, 45, 427

in new EscapeE, IDF tools option     68

IN, UNITS attribute     323

INCLUDE element sample script     330

Include font information, option     224

Include graphic field data, option     224

Include width and height, option     224

Include XY coordinates, option     224

INCLUDE, element     285

index    

command line syntax     382

composite fields syntax     421

creating     174

examples     433

INDEX attribute topic     307

INDEX sample script     333

INFO element sample script     331

INFO, element     286

INI file     417

Ini file, job selection     370

Initial window, viewing option     57

Inline style     320

input file specification     127, 136

Input options topic     47

input resolution     141

input/output options     136

Insert a Form Feed for each page     193

installing    

EscapeE     19, 23

font packs     76

fonts     76

OpenType fonts     77

RTZ licence file     21, 23

TrueType fonts     77

Installing fonts topic     76

Installing TrueType and OpenType fonts     77

INSTALLROOTDIR symbol     417

instruction, FORMAT     290

Intelligent Document Format    

about     39

attributes     291

Composite document     344

documents, section     266

elements     279

export topic     158

format     119

Mail merge     359

notes     275

options topic     158

sample scripts     326

syntax     274

Text mode     362

Tree mode     363

Interleaved     348

internet, downloading software     19

introduction to EscapeE     18

IPDS    

export topic     163

format     119

options topic     164

Italic style     87, 290, 320

J

J(ournal), ORIENT attribute     310

JOB    

batch     40

command, keep     168

file example     434

selecting     370

TCP/IP     129

ticket     170

troubleshooting     378

Job type options     370

Jog offsetting and stapling for PS     177, 185

JPEG    

compression     165

export topic     165

format     120



467Index

JPEG    

options     141, 165

recognition     45

JPEG compression options topic     165

JUSTIFY, ALIGN attribute     292

K

Keep coordinates, IDF editor option     270

Keep original element order     131, 168, 174

KEEP, INPUT option     47

Keywords, PDF     219

Kyocera !R!     59

Kyocera Prescribe topic     378

L

L(andscape), ORIENT attribute     310

Landscape, printer option     109

Landscape, TIFF option     190

language option     445

language symbol     417

layout of page numbers     239

layout of page, changing     97

layout, composite document     344

Left    

Align data option     210

field definition     200

trim option     354

LEFT attribute topic     307

LEFT, ALIGN attribute     292

LEGAL, PAPER attribute     313

letter, mail-merge     359

LETTER, PAPER attribute     313

levels, PostScript     428

library    

changing     79

root folder     100

licence agreement     26

licence, installing     23

LIGHT weight     290, 324

Likely font files     76, 77

Limit, counter     246

line    

Bezier     280

details     55

extract sub-field     245

go to     67

height options     193

notes     277

Polyline     287

set ending defaults     108

Line Details, viewing     55

LINEEND attribute topic     308

LINEEND, LINEJOIN sample script     334

LINEJOIN attribute topic     308

LINESTYLE attribute topic     309

LINESTYLE sample script     335

LINK, FIELDFLAGS attribute     302

list box, PDF special field     217

List Of Files    

about     260

creating     262

details     424

editing     263

List Of Files sample script     339

List of ini files, job selection     370

LIST, FIELDFLAGS attribute     302

lists    

associated files     425

command line syntax     382

composite field symbols     247

composite field syntax     421

configuration symbols     417

DICOM tags     423

envelopes     432

error return codes     418

examples     433

export formats     118

field TYPE     225

file formats     427

flag bits     413

font attributes     87

fonts     430, 431

IDF attributes/elements     291

input formats     45

mnemonic codes     413

paper     432

PDF fields     217

PDF flag bits     221

plugins     227
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lists    

print options     413

Load..., LOF option     262

Local file path example topic     439

locating a page     72

LOCATION attribute topic     309

LOF    

control files     260

creating     262

details     424

editing     263

file example     434

LOF details topic     424

LOF sample script     339

Log file export topic     236

LOG files    

CSV     233, 237

exporting     236

format     237

options     237

page numbering     237

plain text     234, 237

renaming     237

text message     237

XML     235, 237

Logged messages topic     63

Logic expressions     250

LONG edge binding     314

Low resolution color, option     165

LPD/LPR protocol     445

LPR output, enable     129

LSH file, opening     44

lyrics, music option     354

LZW compression     133

M

M(ove) sample script     332

M(ove), element     286

macros    

about     121

creating     100

exporting     100, 168

library     79

saving     100

viewing     32, 55

MAGENTA color     293, 295, 300, 304

Mail merge options topic     360

Mail merge sample script     340

Mail merge section topic     358

Mail merge wizard topic     359

Make one new log file entry...     237

Manage certificates, PDF security     176

manually exporting files     123

Manually review pages... topic     193

masks, transparency     34

Match Case, option     71

Match Whole Words Only, option     71

Match, Text String tag option     205

Max black between     354

Maximize, current window     43

Maximized, initial window     57

MDY field TYPE     225

measurements     55

Media definitions topic     111

media, setup     109

medium map     145

MEDIUM weight     290

menu-bar, PDF     221

meta data field TYPE     225

Metafile     149

MHT    

export topic     153

format     118

options topic     154

MIME-encoded HTML     153

Min stave, music option     354

MINFIELD, FORM input option     47

Minimize, current window     43

Minimized, configuration     57

Minimum line height, option     193

Minimum space width, option     193

Miscellaneous notes topic     445

Missing fonts topic     376

MM, UNITS attribute     323

mnemonic codes     413

MONARCH, PAPER attribute     313
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MONOCHROME attribute topic     310

Monochrome conversion topic     134

MONOCHROME sample script     336

monochrome, configuration option     141

More on defining composite fields topic     245

More options for PDF export topic     177

More options for PS export topic     185

More..., wizard options     346

Mouse coordinates     56

mouse units     57

Move down, clip-region     346

Move down, fields list     211

Move up, clip-region     346

Move up, fields list     211

MoveText plugin     229

Moving and sizing fields and tags topic     205

moving clip areas     97

Moving EscapeE to another PC or...     23

MS Word, field delimiter option     151

Multi-column topic     348

multi-page    

DCX/PCX, exporting     146

sets of data     210

TIFFs, exporting     189

Multiple Occurrences Allowed, option     205

Music options     354

Music part extraction topic     350

N

NAME attribute topic     310

Name for this font in the database     82

Name of the file containing the letter...     359

name space     279

names of fields     200

names of files     136

Naming Log files     237

Navigating around a document section     70

Navigating to a page topic     32

nesting, expressions     254, 257

New back page, Action     208

New copy, mail-merge     360

New field..., defining     200

New IDF file, File option     267

New letter..., mail-merge option     361

New list of files, File sub--option     262

New page tab     359

New tag..., option     201

New..., field definition     244, 346

New..., File option     267, 344, 359, 362

Next page, action option     208

Next page, view option     70

Next sheet, action option     208

Next Unknown, character for coding     82

Next, character for recoding     82

NEXT, PAGE attribute     312

NEXT, SIDE attribute     318

Next, text search     71

No output, export     121, 123, 126

No plex, duplex override     113

NONE color     304

None, cancel signature     176

None, custom jobs     370

None, data fields     237

Normal style     320

Normal, window configuration     57

Not found, field option     245

NOT operator     422

Notebook    

Error messages     62

IDF coding     68

Log     63

PJL     64

Properties     62

Source code     65

Notes on drawing topic     277

Notes on IDF syntax section topic     275

Notes on text topic     277

nQ system     36, 129, 449

Null clips, ignore option     59

Number for Next Page     239

Number of columns, sub-field option     245

numbers    

bar     344

bin     429
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numbers    

drivers     429

overlay     208

page     239, 240, 247, 344, 356

pages in set     247

part     352

sheets in set     247

staves     354

tray     111, 429

Numeric expressions     250

NUMeric field TYPE     225

numeric flag bits     413

Numerical conditions topic     254

O

Oblique style     290, 320

Oce printers     108

OCRust plugin     229

offset, page numbers     344

offsetting     177, 185

Omit blank pages, option     141, 168, 174, 180,
183, 196

Omit fieldnames, log option     237

Omit from Output, advanced option     210

Omit graphics and character downloads     65

Omit text and binary data option     65

opaque background     322

opaque pixels     34

Open wizard    

Booklet     344

Close packed     344

columns     344

Composite document     344

Mail merge     359

Music part extraction     344

Other     362

Opening a file topic     44

OpenType fonts, installing     77

operators, bit-wise logic     421

operators, Composite field expressions     250

operators, CONDITION attribute     300

OPT file     413

Optical Character Recog...     229

Optimizing the configuration topic     59

Option format parameter     126, 413

options    

AFP export     145

Automatic, configuration     127

codes     413

configuration     47, 124

DICOM     148

ESCP input     47

export     140

FDL export     151

file     413

flags     413

font and image libraries     79

FORM input     47

gray scale     177

HTML export     154

HTML5 export     156

IDF editor     270

IDF export     158

IDF input     47

image export     141

IMG export     162

IPDS export     164

jog offsetting     185

JPEG     165

language     445

Layout     239

Log file     237

Mail-merge     360

page numbers     239

PCC input     47

PCL export     168

PDF export     174

PDF security     176

PDF/A export     180

PJL commands     170

PJL comments     185

PostScript export     183

Printing, configuration     108

RTF export     187

search tags     205

source code     65

TCP/IP     129

text extraction     193

TIFF export     190

TXT export     193

UberEd export     156

XPS export     196
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Options editor, Trimming...     354

Options file topic     413

Options, File pages table     346

OR operator     422

order of drawing elements     167

ORIENT attribute topic     310

orientation of page    

mail merge     360

setting defaults     109

TIFF export     190

viewing     55

Other documents section topic     362

Other documents, Tree mode wizard     363

Other plugins topic     229

Outline if not blank, view option     51

Outline style     320

Outline the valid region, view option     51

output    

bin     429

file specification     127, 136

LPR     129

printer     108

Outputting to XML topic     224

Overlay number, action option     208

overlays    

about     37

IDF     283, 285, 297, 360

number     208

view     55

Override HP-GL rotation, option     57

override options, PDF export     177

Override PCL tray, option     104

Override print file setting, option     108, 112

override, Duplex     113

override, resolution     141

Overview section topic     31

Overwriting files topic     129

P

P(olyline) sample script     332

P(olyline), element     287

P(ortrait), ORIENT attribute     310

Packbits compression     133

packed, composite document     349

PAD attribute topic     311

PAD, FORM input option     47

PADBOTTOM attribute topic     311

PADDING attribute     311

Padding, XML option     224

PADLEFT attribute topic     311

PADRIGHT attribute topic     311

PADTOP attribute topic     311

page    

archiving     36

blank     57

break, IDF     267, 271

copying     35

default     108

exporting     36

extent     50

IDF attribute     312

IDF element     287

imaging     105

Mail merge     359

multiple     136

naming     136

navigating     32

numbers     240

position     57

printing     104

range     129

rotation     48, 57

saving     35

saving subset     96

scale of view     32, 49, 50

scaling, print     105

scrolling     70

searching for     72

viewing details     55

width     49

Page 1 Number, option     129

PAGE attribute topic     312

Page conditions topic     258

Page Designer program     449

Page editor topic     352

Page extent, setting     50

Page imaging, scaling and cropping     105

Page numbers    
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Page numbers    

about     240

adding     344, 356

creating     239

logging     237

range     129

page on view, find in IDF     65

PAGE, element     287

PageDown/PageUp keys     70

pages, limit     344

pagination     277

PAPER attribute topic     313

paper size    

Composite document     344

defaults     108

option     50

standard     432

Paper types topic     361

PARAM attribute topic     314

parameter, INPUT options     47

parameter, print options     413

Part of a graphic, option     200

Partial fields topic     251

Partial page...     346

parts    

choir     354

extraction     350

number     352

Password, PDF, PDF/A     174, 176, 180

path, drawn     277

Paths    

input     136

local     439

output     136

PCC recognition     46

PCL    

attrbutes     87

Download Font Library     79

Download Graphic Library     79

export topic     167

fonts     89

format     118

language     378

options topic     168

PJL options     170

Preamble     170

recognition     45

shading patterns     135

tools     65

tray numbers     429

unknown command     379

PCL font selection sequences topic     86

PCL shading patterns     135

PCL source, viewing     65

PCL5, PCL6, PCL XL     378

PCX    

export topic     146

format     119

recognition     45

PDF     293

compression     177

export options     174

export topic     172

fields     217

font substitution     92

format     118

forms     217

More options     177

notes     173

print option flags     413

recognition     45

security options     176

summary     219

PDF document summary topic     219

PDF output file not created topic     379

PDF Table Of Contents topic     220

PDF viewer preferences topic     221

PDF/A    

export topic     179

format     118

options topic     180

PDF/PS font, substitute     92

pen, drawing     295, 308, 318

Pens, plotter option     114

Percent, Viewing option     57

Permanent, macros     168

permission code     23, 227

Persistent composite fields, checkbox     213

PJL    
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PJL    

commands     170

comments     64, 170, 185

composed string     247

Console notebook     64

field prefix     170

options     168, 170, 174, 180, 185

problems     378

separator     170, 214

PJL field prefix     214

plain text    

data fields     234

element     289

export topic     192

format     121

IDF sample script     331

notes     277

options topic     193

PJL coments     177, 185

PLEX attribute topic     314

plex options and overrides     112

Plotter options topic     114

plotter, configuring     57, 108

plotter, HP-GL     377

PLT extension     445

PLUGIN attribute topic     314

Plugins    

addfile     229

addimage     229

addtext     228

attaching     227

barcodes     229

bc39reader     229

blankout     229

calling     208, 210

disabled     376

dmatrix     229

evaluate     229

movetext     229

ocrust     229

other     229

qrcodereader     229

resolution     132

rocr     229

script     229

tesseract     229

using     227

Plugins are disabled topic     376

PNG image    

exporting     141

format     120

options     141

recognition     45

Point Size of page numbers     239

Point, mail-merge     359

Point, Polyline     287

POINTS, UNITS attribute     323

POINTSIZE attribute topic     315

Poor text appearance topic     377

pop-up menu     352

Port name or number, setting     129

Portable Document Format     172, 179

Portrait, printer option     109

Portrait, TIFF option     190

Portugués, versión de idioma     445

Portuguese, configuration symbol     417

position    

data fields     52, 200, 203, 205

page numbers     239

page on screen     57

Positioning and sizing topic     276

PostScript    

export topic     182

fonts     428

format     118

jog offsetting     177, 185

levels     428

options topic     183

PJL comments     177, 185

stapling     177, 185

types     428

PostScript levels and types topic     428

Preamble and PJL options topic     170

Preamble..., PCL option     168

Preamble..., PS option     183

preferences, PDF     221

PREFIX attribute topic     315

prefix, file     154, 439

prefix, PJL     214



Index474

PRESCRIBE     378

Previous Page, View option     70

Print option flags topic     413

Print to file, printing option     104

Printable area, View option     50

Printable region only, option     141, 177

Printed region only, option     141, 177

Printed Region, View option     49

Printed Width, View option     49

printer    

default configuration     108

duplex     112

EMF option     149

setup     107

simplex     112

trays     111

Printer Job Language topic     378

Printer Language, troubleshooting     378

Printer Setup topic     107

printing    

about     35

booklet     104

dialog     104

direct     115

topic     104

Printing beyond page bounds topic     376

Printing pages section topic     103

privacy policy, RedTitan     21

Private keys, PDF signing     176

PRN file    

export     104

opening     44, 104

Problem icon     53

Problem reporting topic     379

Problems list     375

Process oldest first, input files option     127

processing, hide     368

Product References topic     448

Professional edition     18

Profile, security     176

Program parameters, XML option     224

Program to process XML output, option     224

program, run EscapeE from     371

Progress bar     32

Properties editor topic     364

Properties, viewing     62

PS    

export topic     182

fonts     428

format     118

jog offsetting     177, 185

levels     428

options topic     183

PJL comments     177, 185

recognition     45

stapling     177, 185

types     428

PT, UNITS attribute     323

PTRX recognition     46

Public keys, for encrypting     176

Q

QRCodeReader plugin     229

Quantisation, JPEG options     165

question fields     258

Queue name, setting     129

quotes, string example     443

R

Radio button, PDF special filed     217

RADIO, FIELDFLAGS attribute     302

range of pages, selecting     129

Rearranging page contents topic     97

Recipient list, PDF security     176

recognizing    

character codes     82

file format     45

RECTANGLE, SHAPE attribute     318

RED color     293, 295, 300, 304

red warning triangle     53, 62

RedTitan contact details     444

RedTitan EscapeE section topic     18

RedTitan products     449

RedTitan Script 2     288

RedTitan software licence agreement     26

RedTitan Support Desk     379

Reference section topic     381



475Index

Refresh, fields     199

Registering your software topic     21

REGULAR weight     290, 324

Relative path     270, 439, 443

Relative path, Tree mode wizard     363

Reload, mail-merge option     361

remark, LOF comment     424

Remember Bookmarks, option     73

Remember file, LOF option     262

Remember line, code option     67

Remember number for next time     239, 240

Remember, show option     201

Remove from resident library, option     83

remove text, plugin     228

Remove, clip-region     346

Remove, font option     76

Rename LOG file when finished, option     237

Rename output when complete, option     128

Rename, processed input files option     127

Render all but text as a graphic, option     131

Render as graphic, option     131, 151, 154,
164, 168, 196

rendering intent, image export     141

Renumber parts     352

REPEAT attribute topic     316

Replace with, Find option     67

reporting problems     379

reprinting pages     96

re-purpose documents     18

Required DICOM tags topic     423

Reset button, PDF special field     217

Reset sheet count, Action     208

Reset, counter limit     246

RESET, FIELDFLAGS attribute     302

resident font library     33, 76, 79, 83

resident fonts, viewing     53

resident macro library     79

resolution    

/IMAGERES     398

image export topic     141

image, about     132

IMAGERES     306

PDF export     174

PDF/A export     180

PS export     183

Restore Down, window     43

Restore position if fail, text search     71

return codes     418

reusing data fields     213, 220

Rich Text Format    

export topic     187

format     121

options topic     187

recognition     45

RIF, FDL export     151

RIGHT, ALIGN attribute     292

Right, Align data option     210

RL4, AFP compression     133

Rocr plugin     229

ROTATE attribute topic     316

Rotate field, option     352

Rotate graphics, option     114

ROTATE sample_script     336

Rotating the page topic     48

rotation, TIFF     190

ROUND pen     308, 318

ROW, input option     48

RS2 recognition     45

RS2, element     288

RT.INI     417

RTcms     141

RTF    

export     187

format     121

options topic     187

recognition     45

RTIMAGE program     449

RTINI symbol     417

RTLANG symbol     417

RTLIBROOT symbol     417

RTPCLDL symbol     417

RTPCLLIB symbol     417

RTPCLMACROS symbol     417

RTXML     342

RTZ licence file     21
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Run custom job topic     370

Run from a program topic     371

Run from the command line     368

Run the associated program after...     136

Run-length, DICOM compression     133

Running EscapeE topic     43

Running tasks     366

S

Same/Different condition fields     258

Sample IDF scripts section topic     326

sample script    

COLOR     333

Command-line     339

double page     339

drawing elements     332

element DEFINE     327

element FIELD     328

element FILE     328

element GROUP     329

element IDF     330

element INCLUDE     330

element INFO     331

element TEXT     331

INDEX     333

LINEEND     334

LINEJOIN     334

LINESTYLE     335

LOF     339

Mail merge     340

MONOCHROME     336

ROTATE     336

STEPX     338

STEPY     338

TRIM     338

Sample text, substitute fonts     92

sample, font     83

SANDBOX symbol     417

Save    

Composite document     344, 346

field definitions file     212

fonts     168

graphic     98

Log     63

macros     100

Mail merge     359

pages     96

subset     35

Text mode     362

Save and copy section topic     96

Save as...     213, 344, 346, 363

Save definitions on close or exit     212

Save downloaded macros in the library     100

Save fonts separately in file, option     168

Save format, option     123

Save graphic option     98

Save list..., Composite document     344

Save list..., fonts     83

Save Log, option     63

Save page as macro..., option     100

Save Subset..., option     35, 96

Saving and copying pages topic     35

saving field definitions files     212

Saving macros topic     100

Saving pages to a PCL file topic     96

Scale     352

Composite document wizard     344

Page editor view     354

SCALE attribute topic     317

scale of view    

changing     50

choosing     49

configuring     57

Scale to     141

SCALEX attribute topic     317

SCALEY attribute topic     317

scaling, page for printing     105

scaling, smoothing options     135

Scanned     354

score, music     350

screen    

EMF option     149

image resolution     132

PDF preferences     221

substitute font     90

Script plugin     229

Scrolling the document topic     70

Search defined fields only, option     71

Search selected fields only, option     71



477Index

Search single page only, option     71

search tag    

about     37

example     442

options     205

Search tags example topic     442

searching    

for a bookmark     73

for text     71

IDF code     271

improving in PDF     174, 180

LOF code     263

source code     65

Searching for a page topic     72

Searching for text topic     71

Security options for PDF export topic     176

Security options, change     174

Security profiles     176

Select all fonts, option     83

Select all, option     83, 98

Select for export, option     236

select text criterion     193

Select the data for the field option     359

Selected area only, option     141, 177

Selected Fields Only, option     233, 234, 235,
236

Selected text only, Find option     67

selecting a field     203

Selecting a job     370

Selecting page ranges topic     129

Selecting substitute fonts topic     92

selection string, default font     86, 108

SEND, FIELDFLAGS attribute     302

separate fonts file, PCL opton     168

SEPARATOR attribute topic     317

separator character     170, 251, 262, 383

sequence, font select     86, 90
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Set Bookmark..., option     73

Set caption     352

set of fonts     430

Set Part number     352

Set rotation to zero in output file     190

set stapling, jogging     177, 185, 208

Setting advanced options in field...     210

Setting automatic export options topic     127

Setting field actions topic     208

Setting fields file options topic     213

Setting General export options topic     124

Setting Log file options topic     237

Setting search tag options topic     205

Setting TCP/IP options topic     129

Setting the page extent topic     50

Setting up a Counter     254

Setting up field definitions files     212

Setting up Font Substitue file topic     90

Setting up text topic     356

shading    

handling     34

ignore     59, 125

options     135

view details     55

Shading options topic     135

Shadowed style     320
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Sheet numbers, log option     237

shift page contents     57

SHORT edge binding     314

Shortcuts topic     367

Show all including binary, option     65

Show blank pages, option     57, 109

Show clip regions, wizard option     357

Show clip-regions     346

Show command usage statistics, option     65

Show field details, log option     63
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Show Fields form, option     156, 158, 187

Show fields, option     201

Show file in EscapeE     346

Show font details, option     83

Show font sample, option     83

Show Fonts, library option     76

Show graphics, option     156, 158, 187
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Show lines, option     156, 158, 187
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Show names, option     52, 201

Show, Errors page option     62

Show, Fields option     203

Show, IDF tools option     68

Show, LOF document     263
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SIGNATURE, element     288

Signing certificates     176

Simple, scale smoothing option     135, 141

Simplex and duplex options topic     112

SIMPLEX, mail merge     360

SIMPLEX, PLEX attribute     314

Simplex, printing option     109

Simulate duplex using simplex     109

Single strip, TIFF option     190

size    

BOUNDS     297

element     276

font     87

page view     50

paper     108, 432

swept area     55
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Smoothing options topic     135

soft mask     34

SOLID, BORDERSTYLE attribute     296

SOLID, LINESTYLE attribute     309

Solimar finishing     177

Source code topic     65
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Space width, options     193
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Spanish, configuration symbol     417

Special composite symbols     247

Special fields for PDF export topic     217

Special fields in composed strings topic     247

Split up...     346

spot color, setting     108

SQUARE pen     308, 318

standard fonts     154

Standard paper and envelope sizes...     432

stapling     177, 185, 208

STAR recognition     46

Start a new file, Action     208

Start a new log file, Action     208

Start a new set, Action     208

Start point, Bezier     280

Start, counter     246

Start, page number option     129
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StartUp: running EscapeE     367

statistics, command usage     65

status bar     55, 208

Staves, music option     350, 354

STEP, ESCP input option     47

STEPX attribute topic     319

STEPX sample script     338

STEPY attribute topic     319

STEPY sample script     338

Stop at Page Number, option     71
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string    

composed     247

default font     86

example     443

STRING attribute topic     319

String conditions topic     257

Strings example topic     443

style    

attribute     290, 320

border     296

font     83, 87

line     309

sheet     101
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STYLE, <?FORMAT?> option     290

stylesheet, creating     101, 235

Subfields May Precede Tag, option     205

Subject, PDF     219

Submit button, PDF special field     217

SUBMIT, FIELDFLAGS attribute     302
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exporting     96

format     118
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substitute font    
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syntax     93
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wildcards     94

Substitute fonts sub-section topic     89
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summary, composite field syntax     421
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superscript, alignment     193

Support Desk     379

Suppress Output, option     63

suppress page numbering     239

sweep and click, IDF     39
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configuration     417
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changing     84

conversion option     33
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syntax    

command line index     382
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font substitution     93
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IDF sample scripts     326

IDF, about     274

LOF     424
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T

Table of Contents, PDF     220

table, File pages     346
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Tacets, music option     354

Tag entirely in the field, option     205

Tag string     205

Tag type     205
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tags    
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TCP/IP input, setting     129
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text control files .LOF     260
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LOF     263
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adding in transforms     210
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Text log file message, option     237

Text mode wizard topic     362

Text options topic     131

text strings    

adding     202
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searching for     71

TEXT, element     289
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text, IDF notes     277
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Text..., Title page     344

The Field dialog topic     199
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This graphic, option     200

This page only, option     97

This page, action option     208

This page, Export     129
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This text, option     200

Threshold     352

MONOCHROME     310

monochrome option     134

music option     354

TIFF    

compression method     133
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format     120

opening     44
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recognition     45

transparent white     141

time, checking for new files     127

time, DICOM     223

timed mode     367, 368

Time-stamp, PDF security     176

title    

PDF     219, 221

TIFF     189

Title page     344

To add fonts to font library     76

To assign a bookmark     73

To assign a value     245

To assign character code(s)     82

To change the default printer     107
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To delete a field or tag     203

To disable a field or tag     203

To edit a table of contents, PDF     220

To enlarge or reduce the scale of view     50

To export data fields to CSV     233

To export data fields to plain text     234

To export data fields to XML     235

To export files automatically     127

To export files manually     123

To export files to AFP images     144

To export files to BMP images     141

To export files to DCX/PCX fax images     146

To export files to DICOM     147

To export files to EMF     149

To export files to FDL forms     150

To export files to HTML     152

To export files to HTML5 UberEd     156

To export files to IDF     158

To export files to image formats     141

To export files to IPDS     163

To export files to JPEG images     165

To export files to MIME-encoded HTML     153

To export files to PCL     167

To export files to PDF     172

To export files to PDF/A     179

To export files to plain text     192

To export files to PNG images     141

To export files to PostScript     182

To export files to RTF     187

To export files to TIFF images     189

To export files to Xerox IMG     160

To export files to Xerox IMG Barr     161

To extract CSV data fields     233

To extract TeXT data fields     234

To extract XML data fields     235
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To find a bookmark     73

To install download fonts     76

To install soft fonts and font packs     76

To make a table of contents, PDF     220

To open a print or image file     44

To redefine coordinates     205

To reuse an existing file of field names     213

To search for a page     72

To search for text     71

To select a field for editing     203

To select page ranges     129

To select the image compression     133

To set a precise scale of view     50

To set automatic export options     127

To set field end options     205

To set General export configuration     124

To set More options     177, 185

To set options for AFP export     145

To set options for DICOM export     148

To set options for FDL export     151

To set options for HTML export     154

To set options for HTML5 export     156

To set options for IDF export     158

To set options for image export     141

To set options for IMG export     162

To set options for IPDS export     164

To set options for PCL export     168

To set options for PDF export     174

To set options for PDF/A export     180

To set options for plain text     193

To set options for PostScript export     183

To set options for RTF export     187

To set options for the LOG file     237

To set options for TIFF export     190

To set options for TXT export     193

To set options for Xerox IMG export     162

To set options for XPS export     196

To set tag options     205

To set up a header file     213

To set up a substitute screen font     92

To set up PDF and PS substitute fonts     92

To set up tags     201

To turn off automatic file export     127

To turn off the Hints     51

To use LPR output     129

To use TCP/IP input     129

To view Font Properties     53

To view hints     51

To view IDF control file     267

To view IDF document     266

To view macros     55

To view page details     55

To zoom in on a specific area     50

TOC, INDEX attribute     307

tool-bar, EscapeE     43

tool-bar, PDF     221

TOP attribute topic     321

TOP, ALIGN attribute     292

top, field definition     200

Top, trim option     354

Top-level tag name     224

Total pages, limit     344

Transferring EscapeE to a new computer     23

Transformer edition     18

Translated code     82

translucency     292

Transparency issues     34

TRANSPARENT attribute topic     322

Transparent white, image option     141

Tray and bin numbers topic     429

TRAY attribute topic     322

Tray, option     344

trays    

advanced options     208

for AFP output     145

for PCL outout     168

for PS output     183

mail merge     360

numbers     429

output printer defaults     108

Treat as single file, option     123, 261

Tree mode wizard topic     363

Tree view, fields     211
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TRIM attribute topic     322

Trim field, composite document option     352

TRIM sample script     338

Trim to, image cropping     141

Trim, extracted data     210

Trimming options topic     354

Trimming..., clip region     357

Troubleshooting section topic     375

true_value     257

TrueType fonts, installing     77

TTLIB    

add font to     83

assign codes     193

symbol     417

Turning off automatic file export     127

Two-bit, smoothing option     135

TXT    

export topic     192

format     121

options topic     193

type     225

field     200

job     370

media     183

paper     361

PS font     428

tags     205

TYPE attribute     225

typeface    

change     77

data tag option     87

list     431

substitute     90

tag option     77

TYPEFACE attribute topic     323

typeface, change     83

U

Unchanged, field option     245

underline, TXT option     193

underscore character     244, 247

Undo field changes     213

unencrypted PDF/A     179

Uninstalling EscapeE topic     25

unique, font     124

units     55, 57, 354, 433

UNITS attribute topic     323

unknown character, assign code     82

Unknown/Ignored PCL command topic     379

Unlimited, page extent option     50

unprintable area    

configuration     57

printer     104

problems     376

scale to fit     105

viewing     51

Unselect for export, log option     237

Unspecified plex     113

Unsupported download font format     377

Unsupported printer language topic     378

Up to here, option     65

Updating and upgrading EscapeE topic     23

Upright style     290, 320

URI path examples topic     443

URI, setting up     154

URL field TYPE     225

URL, LOCATION attribute     309

Use existing fields, option     156, 158, 187

Use JPEG for images, option     165

Use PCL trays, option     178

Use PostScript trays, option     178

Use printer parameters... option     104

Use same fields on...     156, 158, 187

Use same options...     156, 158, 187

Use standard fonts if subst...     168

Use this field, Advanced options     210

Use tray numbers, option     178

Use trays appropriate to inut format...     178

User input data fields topic     258

user-defined units     58

Using bookmarks topic     73

USING command     383

Using data fields topic     278

Using fields as clip regions     268

Using font attributes as tags topic     87

using macros     100
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Using plugins sub-section topic     227

V

values    

assigning     246, 250

composite fields     244, 245

editing     364

vector graphics     34

version number     445

view    

automatic export option     127

changing     50

configuring     57

Console notebook     61

data control file     261

data fields, tags     52

Error messages     62

font information     53

hints     51

IDF coding     68

IDF control file     267

IDF document     266

IDF in EscapeE     346

Logged messages     63

page information     55

Page Width     49

PJL comments     64

Printed Region     49

Printed Width     49

Properties     62

Source code     65

unprintable area     51

Whole Page     49

View control file, View option     261

View fields     346

View IDF in EscapeE     346

View trays, option     178

Viewer edition     18

Viewing a data control file topic     261

Viewing an IDF control file     267

Viewing an IDF document topic     266

Viewing data fields and tags topic     52

Viewing files section topic     42

Viewing font information topic     53

Viewing hints topic     51

Viewing page information topic     55

Viewing the unprintable area topic     51

VSPACE attribute topic     324

W

warning triangle    

amber     55, 62

red     53, 62

WEIGHT attribute topic     324

WEIGHT, <?FORMAT?> option     290

Weight, data tag option     87

When a field specifies it, log option     237

When field absent, Action     208

White    

areas, ignore     125

Transparent option     141

unprintable area     57

WHITE color     293, 295, 300, 304

Whole file, option     115, 129

Whole Page, option     49, 376

Whole words only, Find option     67

WIDTH attribute topic     325

Width, field definition     200

width, swept area     55

Width, trim option     354

Wildcards in font substitution topic     94

wildcards, file specifications     136

Wildcards, Find option     67

Windows    

BMP export     141

BMP format     120

font     77

Microsoft     448

wizard    

about     342

Booklet     344

Close packed     344

columns     344

Composite document     344

Mail merge     359

Music part extraction     344

music parts     350

re-open     357

Text mode     362, 363
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word break     99, 193

Word, sub-field option     245

Write log record, Action     208

X

X attribute topic     325

X difference to be vertical...     156, 158, 187

X offset, page numbers     344

Xerox IMG file, exporting     160, 161

Xerox IMG, options     162

XHTML     154

XIMG recognition     46

XL recognition     46

XML    

extract data     235

field prefix     213

format     121

IDF header     326

log export     237

new level     210

output options     224

PJL comments     177, 185

stylesheets     101, 235

XPS    

export topic     195

format     119

options topic     196

XRX commands     183

XSL stylesheet     224

Y

Y attribute topic     325

Y offset, page numbers     344

YELLOW color     293, 295, 300, 304

YMDF field TYPE     225

Z

Zero, fixed length counter     246

ZJS recognition     45

Zoom     50, 57
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